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Introducing AudioMulch
This section contains preliminary information about AudioMulch, including system

requirements, a list of new features in this version and how to check for software updates.

The Welcome to AudioMulch page (linked below, or click Next to go to the next page)

provides an overview of AudioMulch and links to various resources on how to use the

program.

If you're keen to start using the program straight away, jump ahead to the How to Create

and Edit Your First Patch (p. 17) tutorial in the Getting Started section.

Welcome to AudioMulch ..................................................................................................2

Learn what AudioMulch is, how to get started, and find links to resources that can teach

you more about AudioMulch once you've mastered the basics.

System Requirements........................................................................................................7

Learn about the types of computers and operating systems we support.

What's New in This Version...............................................................................................8

Learn about the features we've added in this version of AudioMulch.

Checking for Software Updates ......................................................................................14

Get the most out of AudioMulch by using the latest version. Learn how to check for

updates.

Purchasing AudioMulch ..................................................................................................15

Learn how to buy AudioMulch. We need to eat too!
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Welcome to AudioMulch
Welcome to AudioMulch! In this module we introduce you to what AudioMulch is and

what you can use it for. We link to the sections of this Help File that will help you to get

started using AudioMulch. You'll find links to a number of other resources including

tutorials and online material. We explain how to get help while using the program and

suggest other things to try once you've learned the basics. You'll also find links to online

communities so you can connect with other users and learn more from them.

What is AudioMulch?

AudioMulch is real-time audio software that lets you create and process sound for music

performance, production and sound design. With AudioMulch, you can apply effects to

alter live audio input and pre-recorded sounds. You can also use AudioMulch to create

music with rhythmic and melodic patterns using audio samples and synthesized sounds.

In AudioMulch there are individual sound generating and processing modules called

contraptions (p. 33). By connecting and combining these contraptions together, you create

audio processing networks called patches (p. 83). Every contraption has its own graphical

interface with a range of controls that you can adjust to change the sound. Beyond these

built-in contraptions, you can extend AudioMulch's capabilities by adding VST (p. 345)

and VSTi (p. 345) plugins, and Audio Unit (p. 350) plugins on Macintosh.

You can create both pre-planned and more spontaneous forms of music with AudioMulch.

If you're an improviser or want to perform live with AudioMulch, the real-time nature of

the program lets you control the sound from moment to moment. You can also use MIDI

controllers (p. 145) and the Metasurface (p. 156) to manipulate the program during

performance. If you like composing in advance, AudioMulch's automation (p. 129) feature

will help you do this.

AudioMulch has been used by musicians across a diverse range of styles, including

industrial, pop, electronic dance music, ambient, electroacoustic and acousmatic

composition. To find out about some of the musicians using the program, visit the

AudioMulch web site (http://www.audiomulch.com) and see the discography
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(http://www.audiomulch.com/discography) for a list of commercially released music made

with AudioMulch.

Using this Help File

There are several quick and easy ways to open the Help File while using AudioMulch. See

How to Get Help While Using AudioMulch (p. 48) for more information.

Starting points

See these Help File pages to get started using AudioMulch:

Getting Started (p. 16)

Learn how to create contraptions and patches, how to hear audio, and get a brief
introduction to some of the other key features of the program.

Video Tutorials at AudioMulch.com (http://www.audiomulch.com/tutorials )

Step through a series of online video tutorials designed to get beginners up and
running quickly.

Guide to the Example Files (p. 353)

Explore the example files that come with AudioMulch. These files demonstrate the
capabilities of the program by showing how various contraptions can work together.

What's New In This Version (p. 8)

Find out about new features and changes to existing functions in this version of
AudioMulch.

Next steps

Once you've got the basics down we recommend that you learn about the following areas

of AudioMulch:
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Adjusting Contraption Properties (p. 49)

Learn the fundamentals of working with contraptions.

Working in the Patcher Pane (p. 83)

Learn to patch together contraptions using simple and more advanced methods.

Automation Overview (p. 129)

Learn how to pre-plan your composition by controlling AudioMulch parameters and
presets on the automation timeline.

Performing common tasks

These Help File pages will teach you how to perform common AudioMulch tasks:

To learn how to See this Help File page

Get sound files into AudioMulch Loading Sound Files (p. 122)

Output audio to a file Export to Sound File (p. 125)

Record live to disk SoundOut (p. 200),
FileRecorder (p. 210) and
MultiFileRecorder (p. 192)

Connect MIDI devices to AudioMulch to control
contraption parameters and other features

Controlling AudioMulch
Parameters from MIDI (p.
145)

Synchronize a MIDI sequencer or external MIDI clock
source with clock-based contraptions and
parameters

Synchronizing AudioMulch to
Other MIDI Hardware and
Software (p. 152) (p. 129)

Switch between AudioMulch documents Guide to the Document
Switcher Window (p. 161)
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Perform using live sound, and optimize performing
with live sound.

Optimizing Real-Time
Performance (p. 179)

Change multiple contraption parameters at once,
and move smoothly between snapshots of
parameter settings, simply by moving the mouse.

Metasurface (p. 156)

Learning more about AudioMulch online

The following links are from the AudioMulch web site. Here you can find out more about

AudioMulch, get further advice on how to use it, and connect with online communities to

discuss the program.

AudioMulch web site (http://www.audiomulch.com)

Tutorials (http://www.audiomulch.com/tutorials )

Includes video tutorials for beginners and links to offsite tutorials.

Blog (http://www.audiomulch.com/blog)

Provides in-depth information for the more advanced user. Written by the creator of
AudioMulch, Ross Bencina.

FAQs (http://www.audiomulch.com/faq.htm)

Provides answers to frequently asked questions.

AudioMulch forums (http://www.audiomulch.com/forum)

Discuss AudioMulch, get help, report bugs, request new features and share ideas with
other users of the program.

Mulch-Discuss mailing list (http://www.audiomulch.com/mulch-discuss-mailing-list)

Discuss AudioMulch, get help, report bugs, request new features and share ideas with
other users of the program.
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Discography (http://www.audiomulch.com/discography)

Find out who's used AudioMulch in commercial music releases.

Online communities (http://www.audiomulch.com/community)

• Facebook
• Twitter
• AudioMulch Twitter Twibe
• AudioMulch on last.fm
• AudioMulch YouTube Channel

Software updates

AudioMulch is regularly updated with improvements and new features. All version 2.x

updates are available free to users who have purchased a version 2 license. See Checking

for Software Updates (p. 14) for instructions on how to check for software updates.

Twitter and Facebook updates

Follow us on Twitter or like us on Facebook to keep up to date with the latest release

news:

• http://www.twitter.com/audiomulch

• http://www.facebook.com/AudioMulch
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System Requirements

AudioMulch runs on PC and Mac. AudioMulch is tested on the lastest system update of

the supported operating systems. Minimum system requirements are:

PC

Windows XP, Vista, Windows 7, or newer.

Windows-compatible audio interface

Macintosh

Intel processors only (PowerPC not supported)

OS X 10.5 (Leopard), 10.6 (Snow Leopard), 10.7 (Lion), 10.8 (Mountain Lion) or newer.
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What's New In AudioMulch 2.2

AudioMulch 2.2 introduces the following new features and refinements:

Lower latency

We've been working to reduce latency with high-end sound cards. AudioMulch's sound

processing engine has been overhauled, resulting in even lower latency response to MIDI

events, and improved real-time audio processing stability with very low latency buffer

settings. On Mac OS the 256 sample lower limit on audio buffer sizes has been removed -

this limit was never present on Windows. We've also added a Disable Desktop Window

Manager MMCSS scheduling setting for Windows Vista and Windows 7. This reduces

graphics-related audio glitching on some systems.

MIDI output contraptions

AudioMulch 2.2 lets you route MIDI data from plugins to external MIDI devices using

MidiOut contraptions (p. 205). You can use MidiOut contraptions to control hardware

MIDI synthesizers or outboard effects processors. This adds to the existing functionality,

which allows MIDI sequencing and VST instrument plugins to be connected using MIDI

routing in the Patcher Pane (p. 117). MidiOut contraptions are intended to be used with

VST and Audio Unit plugins that send MIDI output, such as control generators, data

transformers and sequencing plugins. When combined with MidiIn contraptions, this also

lets you use AudioMulch to process and route MIDI. AudioMulch doesn’t currently include

any built-in MIDI processing contraptions. There are lists of recommended plugins at the

web site for Mac (http://www.audiomulch.com/forums/mac-plugins/midi-processing-and-

generating-plugins-mac) and for Windows (http://www.audiomulch.com/forums/pc-

plugins/midi-processing-and-generating-plugins-windows).

Improved MIDI and network clock (beat) synchronization

AudioMulch 2.2's new timing engine improves timing stability when chasing MIDI and

network synchronization. MIDI synchronization (p. 152) is now compatible with a broader

range of sound cards and MIDI interfaces. We've also improved timing stability for MIDI

sync output on Macintosh. A new pattern mode option provides compatibility for

sending MIDI clock to simple pattern-based step sequencers such as Korg Electribes and
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the Nord Micro Modular. We've made sync offset settings more consistent (positive values

always make the slave later), and added sync offset settings for network synchronization.

New community patch sharing and discography at AudioMulch.com

AudioMulch.com has recently been updated with a new patch sharing area, and a

discography that users can edit. In the patch sharing area, you can download and share

patches ranging from simple examples to a complex compositions. You can learn about

releases by other AudioMulch users in the discography, and also promote your own

releases. Follow the links to visit the patch sharing area (http://www.audiomulch.com/

patches), and the AudioMulch discography (http://www.audiomulch.com/discography).

Display and edit frequency parameters as musical pitches

You can now work directly with musical pitch names when using frequency parameters

that are usually displayed in Hertz. Frequency values are now annotated with the musical

note name and deviation from the pitch in cents. In the Set Value Dialog Box (p. 67), you

can enter frequencies as musical pitches using a piano keyboard interface.

New SChorus stereo chorus contraption

We've added a new, versatile stereo chorus contraption called SChorus (p. 282). SChorus

is the result of research into the behavior of classic chorus units.

Contraption preset improvements

A new header bar in the contraption Presets Window (p. 75) gives you a more streamlined

method of working with presets. By clicking on the buttons on the bar, you can store a

new preset and browse between presets. The Presets Window's auto-hide behavior can

now be toggled on or off. We've also removed the limit on the number of presets you can

store in each contraption.

Use MIDI control to switch Metasurface snapshots

You can now use MIDI control to switch between Metasurface (p. 156) snapshots. Use a

MIDI pedal board or other MIDI controller to switch snapshots in live performance when

you don’t want to have to reach for the mouse.
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New Welcome Screen

When AudioMulch launches you can now have quick access your recent documents via

the Welcome Screen. The Welcome Screen also provides links to other common tasks and

web site resources.

Improved plugin compatibility on Mac with a new Cocoa-based user interface

AudioMulch is now using Apple’s “Cocoa” framework. This brings improved compatibility

with Audio Unit plugin user interfaces. This is also a step in the direction of future support

for 64-bit operation.

Improved Help File with step-by-step instructions

AudioMulch's help system has been updated and restructured with a clear, step-by-step

tutorial format to get you started quickly. This is a long-term project and we're about half

way through. So far we've taken care of these sections: Getting Started (p. 16), Working

in the Patcher Pane (p. 83) and Adjusting Contraption Properties (p. 49).

Other improvements and bug fixes

Version 2.2 includes a range of other enhancements, tweaks and bug fixes. We've listed

the enhancements that will impact on your workflow below. For the full list of changes

see the History of AudioMulch Changes (p. 413) page in this Help File.

• We've added the ability to clear automation points without deleting the time range.

Using the DELETE key or selecting the Clear item in the Edit menu deletes the

selected points. Using the Delete Time item in the Edit menu deletes the time

range, which used to be the default behavior.

• Added clock-synchronous period and phase mode to SSpat (p. 294) contraption. This

lets you synchronize spatialization paths to the global clock pulse. Note: as a result of

this change, documents saved with AudioMulch 2.2 (or later) that use SSpat will not

load correctly in AudioMulch 2.1 (see important note below).

• The Metasurface parameters tree now supports multiple selection (using drag,

SHIFT+click and CTRL+click). Enable Selected Parameters and Disable Selected

Parameters shortcut menu items have been added. See The Metasurface (p. 156)

page of this Help File for details.
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• You can now adjust the brightness and contrast of the user interface color scheme on

the Appearance page of the Settings/Preferences Dialog Box.

• The interpretation of MIDI Control Change and Program Change messages has been

updated to conform more with the MIDI specification when controlling presets and

Metasurface snapshots. By default, the first (0th) MIDI value now maps to the first

(1st) preset/snapshot. There’s also an option to change the offset. See Controlling

AudioMulch Parameters from MIDI (p. 145) for more information.

• We've unified handling of drag-and-drop behavior between Metasurface snapshots,

contraption Presets, Document Switcher document entries, File Player and File

Recorder. These should now all behave consistently.

Important Note: Due to changes made to the SSpat contraption in this release,

documents saved with AudioMulch 2.2 (or later) that use SSpat will not load correctly in

AudioMulch 2.1. Users who wish to continue using these documents with AudioMulch

2.1 are advised to make backup copies before saving them with AudioMulch 2.2.

Mac Users Note: AudioMulch 2.2 no longer supports Mac OS X 10.4 (Tiger), but does

support all recent Mac OS X versions including the new OS X 10.8 Mountain Lion.

If you haven't used AudioMulch for a while, read on for information about the key

enhancements that were added in AudioMulch 2.0 and 2.1.

What Was New in AudioMulch 2.1

The main new features added in AudioMulch 2.1 are:

• New rhythmic matrix pattern editors for Arpeggiator (p. 213), SouthPole (p. 312) and

Bassline (p. 219). All contraptions with rhythmic pattern editors (including Drums (p.

229)) now support user-selectable pattern lengths, matrix resolutions, non-4/4 time

signatures and time signature changes. You can also click and drag to "paint"

multiple triggers in the matrix pattern editors.

• Support for custom and user-defined time signatures and rhythmic units (p. 140).

Automation supports time signature changes. This opens a world of potential for

polyrhythmic and polymetric music. Everything that used to be hard-wired to 4/4 time

now lets you select a time signature (including CanonLooper (p. 245), LiveLooper (p.

262) and LoopPlayer (p. 234)). Everything that used to be hardwired to 16ths

(semiquavers) lets you select a rhythmic unit (including BubbleBlower (p. 224),

DLGranulator (p. 253), Drums (p. 229), LoopPlayer (p. 234), Nebuliser (p. 303),

PulseComb (p. 275), SDelay (p. 286) and SouthPole (p. 312)).
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• New Compressor (p. 318), Limiter (p. 322) and NoiseGate (p. 325) contraptions in

mono and stereo versions. These contraptions are useful for shaping the dynamics

(loudness) of your sound. They can be found in the new Dynamics category of the

contraptions palette.

• Support for Audio Unit plugins (p. 350) on Mac OS X, giving you access to a new

range of third-party audio effects and instruments.

• A new, alternative light gray color scheme. You can select between light and dark

color schemes on the Appearance page (p. 178) of the Settings/Preferences Dialog

Box.

• Support for hot-plugging MIDI devices. AudioMulch now remembers selected MIDI

devices when they're not connected. You can connect them while AudioMulch is

running. Just toggle the Enable MIDI button to activate them.

• Improved Help File including reorganized contraption reference pages for every

contraption (p. 182) and MIDI parameter control (p. 145) help page to make it easier

for you to find the information you're looking for.

What Was New in AudioMulch 2.0

AudioMulch 2.0 was the first version of AudioMulch available for both Windows and

Macintosh computers. The user interface has been re-coded from the ground up and a

number of enhancements have been made along the way. The main new features added

in AudioMulch 2.0 are:

• A new Patcher Pane with drag-and-drop contraption creation and auto-connection,

re-connectable patch cords, multichannel patching, in-line audio level indicators, and

MIDI routing (see Working in the Patcher Pane (p. 83) for details).

• MIDI and Automation control for clock transport (tempo, stop, start) and Metasurface

interpolation.

• Enhanced Drums (p. 229) contraption with 8 channels and a new pattern editor

supporting arbitrary length high-resolution patterns.

• New "Startup Actions" settings let you enable audio, MIDI, transport, sync, and to

load documents when AudioMulch starts. See the Settings/Preferences Dialog Box (p.

177) page for more details.

• Expanded multichannel audio I/O capability to support up to 256 channels in each

direction and improved compatibility with consumer multichannel audio interfaces

using DirectSound and Windows Multimedia drivers.

• Increased audio processing efficiency.

• Nameable contraption presets.
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• Faster access to parameter values and MIDI control by double-clicking sliders and

knobs. Double click a knob or slider to show the Set Value dialog box (p. 67),

ALT+double-click to show the Quick-map MIDI Control dialog box (p. 145), or

CTRL+double-click to display the Parameter Control window (p. 145).

• The Parameter Modulation dialog box has been renamed Parameter Control. You

can access it via the View menu. It is now a floating window – so you can leave it

open while you do other things.

• Dockable Patcher and Automation Panes for improved multi-monitor operation.
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Checking for Software Updates

AudioMulch is regularly updated with improvements and new features. All version 2.x

updates are available free to users who have purchased a version 2 license.

To check for updates:

1. Open the Help menu
2. Choose Check for Updates

Your computer will check for updates on the Internet.

Twitter and Facebook updates

Follow us on Twitter or like us on Facebook to keep up to date with the latest release

news:

• http://www.twitter.com/audiomulch

• http://www.facebook.com/AudioMulch
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Purchasing AudioMulch

AudioMulch can be purchased via the AudioMulch website at

http://www.audiomulch.com/purchase. A number of payment options are provided

including popular internet software stores Share-it and PayPal.

Discounts are offered to education institutions who wish to purchase five or more licences.

Australian residents may pay by cheque, money order or direct bank transfer by contacting

the author directly. For these and any other enquiries about purchasing AudioMulch

please email sales@audiomulch.com.

Once you have purchased AudioMulch you will be provided with a Licence Authorisation

Key. To enter the key choose Enter Authorisation Key from the Help menu.

Please consult the AudioMulch web site at the time of purchase for any alterations to

current purchase policy.
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Getting Started
This section helps you get started making sound and music with AudioMulch by teaching

you the basics:

Tutorial: How to Create and Edit Your First Patch ............................................................17

Start by learning how to create your first patch. Learn how to create and connect

contraptions, how to use contraption controls to change the sound, and how to process a

sound.

Contraptions: What They are and What They Do ............................................................33

Learn about the different categories of AudioMulch contraptions (including plugins) and

their various attributes.

When and How to Use the Clock ....................................................................................37
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Introducing Other Main Features of AudioMulch.............................................................40

Learn about some of the other main features of AudioMulch, including Automation and
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Troubleshooting: What to do if You Can't Hear Anything................................................44

If you get stuck, this troubleshooting page provides tips to help you get a sound out of

AudioMulch.

How to Get Help While Using AudioMulch .....................................................................48

Learn about the different ways to access this Help File, which contains detailed

information about all aspects of AudioMulch.
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Tutorial: How to Create and Edit Your First
Patch

In this tutorial you will learn how to create your first AudioMulch patch. A patch is a

network of sound-creating and processing modules called contraptions. You need to

know how to make a patch in order to create sound in AudioMulch, so this tutorial is

useful for everyone. You will learn about the main components of the patch, how to

create and connect them, and how to get a sound out of your patch. You will also learn

how to adjust the sounds you make and how to process sound by adding another

contraption to the patch.

Stage one: creating a simple patch with the TestGen
contraption

The first part of this tutorial focuses on creating a simple patch with a TestGen

contraption, which is one of AudioMulch's Signal Generator contraptions. Signal

Generators make their own sound, so this is an easy way to get started as you don't have

to import sound into the program from elsewhere.

Getting Started - Tutorial: How to Create and Edit Your First Patch 17



HOW TO CREATE AND CONNECT CONTRAPTIONS

First, create your contraptions for the patch:

1. Find the TestGen contraption in the Contraptions Palette. The Contraptions
Palette is on the left of the Patcher Pane. It contains a list of all the AudioMulch
contraptions. You'll find the TestGen in the Signal Generators category.
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2. Drag a TestGen into the Patcher Pane.

3. In the Patcher Pane there should already be a SoundOut contraption. If not,
drag one across from the Contraptions Palette (it's listed in the Input / Output
category).

Next, we will connect the contraptions. This allows audio to flow from the output of the

TestGen contraption to the input of the SoundOut. From there the SoundOut routes the

audio to your computer's audio output.
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Connect the TestGen contraption to the SoundOut contraption:

1. Click on the output at the bottom of the TestGen and drag a patch cord to the
left input of of the SoundOut contraption with the mouse.

2. Repeat, this time dragging from the TestGen output to the right input of the
SoundOut.

You have now created your first patch! You won't be able to hear any sound yet. To do

that you'll have to turn up the volume of the TestGen contraption. We'll do that next.

Note: it doesn't matter where your contraptions are located in the Patcher Pane. As long

as the patch cords are connected in the same way as shown in the picture above, the

patch will function in the same way.
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CONTROLLING CONTRAPTION PARAMETERS WITH THE PROPERTY EDITOR

In this section you'll learn how to open a contraption's Property Editor so you can

control the sound you make with the patch. Property Editors have controls you can adjust

to change the contraption's sound. These controls include knobs, sliders, control arrows,

number edit boxes, and buttons.

Most contraptions have a Property Editor. Buses and AuxIn/AuxOut contraptions don't

have Property Editors as they don't have properties to edit.

Open TestGen's Property Editor:

• Double-click on the TestGen contraption in the Patcher Pane. A Property Editor
will open for the contraption in the Properties Pane

.
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Note: You can use this method to open the Property Editor for any contraption.

ADJUSTING CONTRAPTION PARAMETERS

Let's now try adjusting some of the controls on the Property Editor and see what changes

they make to the sound.

First, adjust the volume knob:

• Click the mouse pointer over the knob and drag the knob upwards so that you
can hear the sound.

Note: Dragging upwards on a knob increases whatever value it controls, while
dragging downwards decreases it. In this case the volume is increased or decreased
but other knobs control different properties.

If you can't hear any sound coming from your computer, visit the Troubleshooting: What

to do if You Can't Hear Anything (p. 44) page of this Help File for some tips.

TestGen is a contraption that generates its own sound. It can produce a sine wave (Sine),

or white noise (Noise). A newly created TestGen defaults to the Sine setting.

Getting Started - Tutorial: How to Create and Edit Your First Patch 22



Change the type of sound TestGen is making:

• Click the button to the left of Noise. Now you can hear that the sound has
changed to white noise.

When TestGen is generating a sine wave you can also change its frequency.

Change the frequency of the sound:

1. First, switch the TestGen back to generating a Sine wave by clicking on the
button to the left of Sine.
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2. To the right of the Sine button is a number edit box. It displays the current
frequency in Hz (Hertz). Next to this is a button with up-and-down arrows on it.

3. Click-and-drag the pointer up and down over the arrow button to change the
frequency up or down. The number edit box will display the new frequency in
Hz (Hertz).

Note: The number edit box displays the value of the parameter. You can type a new
value into this box, or you can drag on the up-and-down arrows to change the
value. Dragging upwards increases whatever value it controls, while dragging
downwards decreases it. In this case the frequency is raised or lowered when the
numbers are increased or decreased.

FINDING OUT MORE ABOUT THE CONTRAPTIONS YOU'RE USINGFINDING OUT MORE ABOUT THE CONTRAPTIONS YOU'RE USING

You can find out more about the contraptions you use by clicking on the ? button on the

title bar (top) of the Property Editor. This will open the Help File page for that contraption.
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SAVING YOUR WORK

To save your work:

1. Open the File menu and choose Save As...
2. Navigate to where you want to save your work
3. Name your .amh (AudioMulch) document by typing a file name in the text box
4. Click on the Save button

• When you save a document, you save all the parameter settings for that
document.

• To save your work again when you are working on the same document later,
open the File menu and choose Save.

• To open a document later, open the File menu, choose Open..., and navigate
to the document on your computer. Double-click on the document to open it.

MOVING AND CLOSING PROPERTY EDITORS

You can also hide (close) and move Property Editors.

To hide a
Property Editor:

Click on the X button on the title area of the Property Editor
(at the top of the Property Editor). The Property Editor will be
hidden.
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To move a
Property Editor:

Click on the title area and drag the Property Editor around the
Properties Pane.

Stage two: adding another contraption to the patch to
process the sound

In this section of the tutorial you will learn how to add another contraption (a Flanger) to

the patch, which you will use to process sound from the TestGen contraption.

HOW TO SET UP THE NEW PATCH

First, disconnect the patch cords from your first patch:

1. Click on the left patch cord to select it. The patch cord will appear thicker when
selected.
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2. Press DELETE on the keyboard. The patch cord will disappear.

3. Repeat steps 1. and 2. for the right patch cord. There should be no patcher
cords left between the contraptions.

Next, create a Flanger contraption:

1. Find the Flanger contraption in the Contraptions Palette. You'll find the
Flanger in the Effects category.

2. Drag it into the Patcher Pane.
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Connect the Flanger to the other contraptions:

1. Click on an output at the bottom of TestGen and drag a patch cord to the input
on top of the Flanger contraption.

2. Now drag two patch cords from the bottom of the Flanger to the left and right
inputs of the SoundOut contraption.

Your completed patch should look something like this:

The sound output from TestGen is now being processed by the Flanger. Switch the

TestGen to output Noise. You should be able to hear the effect of the Flanger filter

repeatedly sweeping across the noise.
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EXPLORING CONTRAPTION PARAMETERS

Open the Flanger's Property Editor:

• Double-click on the Flanger contraption in the Patcher Pane. The Flanger's
Property Editor will open in the Properties Pane

You'll notice that there are different kinds of controls on the Flanger's Property Editor.

There are sliders (Rate, Feedback, Wet/dry mix) and a range slider (Range). You can

use sliders to control a single parameter value. Range sliders function similarly to sliders,

except you use them to control both the minimum and maximum of a range of values.

To change the value of a slider:

• Click-and-drag the pointer left or right anywhere on the control. Horizontal
sliders have the minimum value at the left and the maximum at the right.
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To move the range slider:

• Click-and-drag left or right anywhere in the background of the range slider.
Both the minimum and maximum slider thumbs move simultaneously in the
same direction.

To move the minimum and maximum values independently:

• Click the pointer directly over the desired slider thumb and drag it left or right.

Try experimenting with the sliders on the Flanger and see what new sounds you can make.

Try the following:

• Increase the Rate control: move the slider towards the right. This makes the
sweep repeat faster.
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• Decrease the Rate control: move the slider towards the left. This makes it sweep
slower.

• The Range control determines the limits of the frequency sweep. Change the
upper and lower limits of the sweep by adjusting the thumbs individually, or by
dragging them both at once (see instructions in the table above).

You can read more about the Flanger and its other parameters on its Help File page. Click

on the ? button in the title area of the Flanger's Property Editor to open the page directly.

Note: clicking on the ? button on any contraption's Property Editor will take you to the

Help File page for that contraption. This is a quick way to find out more about a

contraption while you're working.

EXPLORING FURTHER

In this tutorial you've learned how to create contraptions and connect them together to

make patches that generate and process sound. You've also learned how to use

contraption Property Editors to change properties that affect the sound of each

contraption. Now you've learned the basics, you can explore further.

To see some patches other people have made with AudioMulch, check out the Example

Files directory in AudioMulch. To open the directory, go to the File menu, select Open,

and double-click on the Examples folder. Start with the Basic Examples files first, then

progress later to the Applied Examples. You can read descriptions of these files in Guide to

the Example Files (p. 353).

To build further on the patches you've created in this tutorial, try substituting other

contraptions from the effects category for the Flanger, or other contraptions from the

SignalGenerators category for the TestGen.

Read on to the next page, Contraptions: What They are and What They Do (p. 33), to

learn about the different types of contraptions in AudioMulch.

You can find out more about the individual contraptions and what they do by clicking on

the ? button on the contraption's Property Editor. This will open the Help File page for that

contraption.
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See Also

Contraptions: What They are and What They Do (p. 33)

Contraptions Guide (p. 182)

Using Common Contraption Controls (p. 60)

Guide to the Example Files (p. 353)

Flanger (p. 258)

TestGen (p. 243)

SoundOut (p. 200)
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Contraptions: What They are and What They
Do

AudioMulch has its own sound-creating and processing modules called contraptions.

Some contraptions generate sound, others process sound, while some have rhythmic

patterns that you can edit. Others can help you to perform certain tasks, such as

inputting, outputting and recording sound, or mixing sounds together. This module gives

you an overview of the different types of contraptions and what they do.

As well as its own built-in contraptions, AudioMulch supports various kinds of plugins.

Plugins are audio generating and processing modules that are developed by third parties.

AudioMulch lets you use these plugins in the same way as you use AudioMulch's inbuilt

contraptions. You'll learn below about which kinds of plugins are compatible, and where

you can download them.

Contraption categories

AudioMulch organises contraptions into the categories below. This categorization is used

for the New Contraptions Palette and in the New Contraptions shortcut menu in the

Patcher Pane.

Contraption
category

What they do

Input/Output Control the flow of sound and MIDI data into and out of
AudioMulch. This includes live input/output and basic playback
and recording of sound files.

Signal
Generators

Create (synthesize) sound, or play back sound files synchronized
with AudioMulch's internal clock (beat).

Effects Transform, shape or distort an input sound. Includes delay,
looping, granulation and modulation effects.
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Filters Transform or shape the input sound through some kind of
filtration, equalization, or resonance.

Dynamics Limit, reduce or alter the dynamic range of a sound.

Mixers Combine multiple inputs into a single output or stereo output
pair. Mixers have individual volume controls for each input or
stereo input pair.

Buses Buses are similar to mixers except that they do not provide
volume controls. They are provided for backward compatibility
with old AudioMulch documents created before AudioMulch
supported connecting multiple patch-cords to a single input.

Beta When present, this includes new and developmental contraptions
that may not be completely bug-free. At times this category may
feature a range of contraptions that would otherwise be placed
in one of the above categories.

Table of contraptions by function and main attributes

The table below lists AudioMulch's contraptions, grouped by the function they perform or

special attributes they posess.

Function Contraptions that perform this function

Generating sound Arpeggiator, LoopPlayer, Bassline, Drums, BubbleBlower,
RissetTones, 10Harmonics, TestGen.

Processing sound PulseComb, DLGranulator, SDelay, CanonLooper, LiveLooper,
DigiGrunge, Shaper, SSpat, NastyReverb, Flanger, Phaser,
FrequencyShifter, SChorus, RingAM, Nebuliser, SouthPole,
RissetFilters, *ParaEQ, 5Combs.

Contraptions that
have rhythmic
patterns

Arpeggiator, Drums, Bassline, SouthPole.
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Contraptions that
can optionally
synchronize their
rhythmic pulse to
the clock

BubbleBlower, CanonLooper, DLGranulator, LiveLooper,
PulseComb, SDelay, SSpat, Nebuliser.

Inputting sound (live
and from sound
files)

SoundIn, AuxIn contraptions, FilePlayer contraptions.

Outputting sound /
recording sound to
a file

SoundOut, AuxOut contraptions, FileRecorder contraptions.

Mixing and/or
adjusting the
volume of sounds

Matrix contraptions, Frosscader, Crossfader, Invert, *Gain,
M*Mixer, P*Mixer, S*Mixer contraptions, M*Bus and S*Bus
contraptions.

Manipulating the
dynamic range of a
sound

MCompressor, MLimiter, MNoiseGate, SCompressor, SLimiter,
SNoiseGate.

MIDI input and
output

MidiIn contraptions (input), MidiOut contraptions (output).

Finding out more about the contraptions you're using

To find out more about the contraptions you're using, you can open the Help Files for

them while using AudioMulch.

To open a Help File page for a contraption, do one of the following:

• Click on the ? button on the title bar (top) of the contraption's Property
Editor.

• Right click (or CTRL+left-click on Macintosh) on a contraption's name in the
Contraptions Palette and choose Help from the shortcut menu.

• Right click (or CTRL+left-click on Macintosh) on a contraption in the Patcher
Pane and choose Help from the shortcut menu.
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Plugins

Plugins are audio generating and processing modules that are developed by third parties.

There are many plugins available, giving you access to a wide range of third-party effects

and instruments that you can expand AudioMulch with. AudioMulch supports the industry

standard VST (Virtual Studio Technology) and VSTi (also known as VST2) plugin formats on

both Windows and Macintosh computers. Apple's Audio Unit plugins can also be used

with AudioMulch. Some plugins are effects plugins, while others are signal generators -

these are usually "virtual instruments": synthesizers that take MIDI input.

WHERE TO GET PLUGINS

There are literally thousands of free, shareware and commercial plugins available on the

Internet. Check the AudioMulch web site (http://www.audiomulch.com) for links to some

relevant sites, and check out the KVR Audio website (http://www.kvraudio.com), which

has a searchable plugin database and lots of information and news about plugins.

See Also

Contraptions Guide (p. 182) (p. 182)

VST Plugins (p. 345)

Audio Unit Plugins (p. 350)
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When and How to Use the Clock

AudioMulch has a clock that keeps musical time in bars and beats. The clock can be

started and stopped and has a tempo (speed) that you specify in beats per minute (more

precisely, quarter-notes per minute). Using the clock is not always required. Some

contraptions are not dependent on the clock, but may optionally use it. Other

contraptions, parameters and features of AudioMulch depend on the clock. In some

cases you will not be able to hear any sound at all until you start the clock.

You'll need to start the clock when you're using contraptions that synchronize to a beat,

such as Drums, Bassline and Arpeggiator. These contraptions have pattern editors that

can be used to create time-based rhythmic and melodic patterns. Other contraptions use

the clock to synchronize the rate of pulses, delays, or other time-based parameters that

have a rhythm. The Automation feature is also time-based and is dependent on the

clock.

To find out if a contraption depends on the clock, look at the Help File page for the

contraption. To do this, click on ? at the top right of the contraption's Property Editor.

See the table below for instructions on how to start and stop the clock and reset it to

zero.

Starting, stopping and resetting the clock

THE TRANSPORTHE TRANSPORT TOOLBART TOOLBAR

The Transport toolbar, at the top of the AudioMulch window, contains all of the controls

for the clock. It looks like this:
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The Transport toolbar has buttons to start and stop the clock, and a control for the

tempo (next to the metronome symbol). The other buttons are related to Automation,

you'll learn about them later.

To perform this
action

Do one of the following:

Start or stop the
clock • Click the Play or Stop buttons on the

Transport toolbar.
• Open the Control menu and choose Play or Stop.
• Press the SPACE bar on the keyboard.

Reset the clock to
zero • Click the Go to Start button on the Transport

toolbar.

• Click the Play From Start button on the Transport
toolbar.

• Press ENTER on the keyboard.

Adjust the tempo
(make the pulse
faster or slower)

• Click and drag on the up and down arrows at the right

of the number box .
• Enter a tempo in beats per minute by typing into the

number box.

MIDI control and synchronization of the clock

Like many other AudioMulch parameters, you can control AudioMulch's clock from an

external MIDI controller. For example, you can map buttons to start and stop the clock,

and map a knob or slider to change the tempo. See Controlling AudioMulch Parameters

from MIDI (p. 149) for details.

The AudioMulch clock can be synchronized to other MIDI software and hardware (e.g.

sequencers, drum machines, groove boxes) using the MIDI clock sync standard.
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AudioMulch can generate and chase MIDI clock. See Synchronizing AudioMulch to Other

MIDI Hardware and Software (p. 152) for details.

Network clock synchronization

AudioMulch can also synchronize its clock with other copies of AudioMulch running on

the same computer, or across a local area network using its network sync feature.

See Also

Automation Overview (p. 129)

Controlling AudioMulch Parameters from MIDI (p. 145)

Synchronizing AudioMulch to Other MIDI Hardware and Software (p. 152)

Drums (p. 229)

Bassline (p. 219)

Arpeggiator (p. 213)
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Introducing Other Main Features of
AudioMulch

Now you've learned about patches, contraptions and the clock (see the other pages in

this section if you haven't already), there are several other main features of AudioMulch

that you should be aware of. These include the Metasurface, Automation, and MIDI

control of contraption parameters. On this page we give a brief overview of these

features, tell you what they're useful for and who might want to use them.

Metasurface

The Metasurface lets you change multiple contraption parameters at once, just by moving

the mouse. You can store snapshots of parameter settings for an entire AudioMulch

(.amh) document and selectively choose which of these parameters will be addressed by

the Metasurface. Once you've stored the snapshots you can either recall them in their

original state, or you can morph between them, resulting in a smooth transition from one
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snapshot to another. To do this, you place the snapshots on the Interpolation Surface

and click and drag between them with the mouse.

The Metasurface can be particularly useful if you like to improvise, or work with fluid sonic

states. It can be good for live performers and people working with installations and

theatre sound design.

To read more about the Metasurface and for instructions on how to use it, visit the

Metasurface (p. 156) page of this Help File.

Automation

With Automation you can define the way selected contraption parameters change over

time. You automate contraption parameters in the Automation Pane. Each automated

parameter has its own Automation Channel Panel that you can edit. Automation can

be applied to most contraption parameters including the values of knobs, sliders, check

boxes and contraption Presets. It can also be applied to some global parameters such as

clock tempo and Metasurface location.

Automation is particularly useful for people who like pre-planning aspects of their work,

including musicians, composers and studio music producers.
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To read more about Automation and for instructions on how to use it, visit the

Automation Overview (p. 129) and Editing an Automation Sequence (p. 137) pages of this

Help File.

MIDI control, routing and clock synchronization

MIDI (Musical Instrument Digital Interface) is the industry standard used by computers and

electronic music devices to talk to each other. Combining AudioMulch with MIDI devices

expands the ways in which you can perform, giving you a physical control interface

beyond the computer screen and the mouse.

AudioMulch's MIDI capabilities span three areas. You can:

1. CONTROL CONTRAPTION PARAMETERS USING MIDI CONTROLLERS

In AudioMulch you can use MIDI to control contraption parameters. A knob, slider or

other MIDI controller can be quickly and easily mapped to a parameter using

AudioMulch's Quick-Mapping (p. 145) feature. You can also create and fine tune your

mapping settings via the Parameter Control (p. 145) window.

This feature is particularly useful for anyone who uses MIDI in live performance,

installation artists and theatre sound designers.

To learn more about MIDI Control and for instructions on how to set it up and use it, visit

Controlling AudioMulch Parameters from MIDI (p. 145).

2. WORK WITH VIRTUAL MIDI INSTRUMENT AND MIDI PROCESSING
PLUGINS

You can use AudioMulch to host VST and Audio Unit virtual instrument plugins. You can

route MIDI data between plugins in the Patcher Pane, and use MIDI processing and

sequencing plugins to manipulate MIDI data. Use MidiIn contraptions to bring MIDI data

into your patches from external MIDI controllers (keyboards, drum pads, etc.), and use

MidiOut contraptions to send MIDI data from plugins out to hardware devices

(synthesizers, drum machines).

This feature is particularly useful for musicians who use MIDI virtual instrument plugins in

live performance, such as keyboardists and percussionists.
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To learn more about using MIDI with virtual instruments, and MIDI processing and

sequencing plugins, visit Routing MIDI in the Patcher Pane (p. 117).

3. SYNCHRONIZE AUDIOMULCH'S CLOCK WITH OTHER MIDI DEVICES

With AudioMulch's MIDI clock synchronization feature you can synchronize AudioMulch

to any device that can send or receive MIDI clock sync (e.g. drum machines, groove boxes,

hardware MIDI sequencers, or other software). This means that the tempo/rhythmic timing

of AudioMulch and the external device stay locked in tight synchronization.

This feature is particularly useful for musicians who perform live, rhythmic electronic music

that combines AudioMulch with hardware sequencers, synthesizers and drum machines.

To learn more about using AudioMulch's MIDI clock synchronization features, visit

Synchronizing AudioMulch to Other MIDI Hardware and Software (p. 152).

See Also

Using Contraption Property Editors (p. 50)

Using Contraption Controls (p. 60)

The Metasurface (p. 156)

Automation Overview (p. 129)

Editing an Automation Sequence (p. 137)

Controlling AudioMulch Parameters from MIDI (p. 145)

Routing MIDI in the Patcher Pane (p. 117)

Synchronizing AudioMulch to Other MIDI Hardware and Software (p. 152)
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Troubleshooting: What to do if You Can't
Hear Anything

If you're having trouble hearing the audio output once you've created a patch, check

through the list below to make sure you've got things set up correctly. Steps 1, 2, 3, 5 and

6 are relevant for everyone to follow, while step 4 is only relevant if you're using certain

kinds of contraptions.

1. Check that you have a SoundOut contraption in the
Patcher Pane and that your contraptions are connected
to it

SoundOut is a very important contraption as it represents the audio output of

AudioMulch. If you don't have a SoundOut in the Patcher Pane, you will not hear any
sound. When you open a new document, you will find a SoundOut contraption already in

the Patcher Pane. If you need to add a new SoundOut later, drag one across from the

Contraptions Palette on the left of the Patcher Pane.

However, simply having the SoundOut in the Patcher Pane will not ensure that you will

hear anything. You must make sure that you connect all the other contraptions in the
Patcher Pane to the SoundOut contraption. You can do this either by connecting a

contraption to the SoundOut directly, or indirectly through other contraptions. If a

contraption is not connected to the SoundOut via some path, you will not be able to hear

it.

Note: you can only ever have one SoundOut contraption in the Patcher Pane.
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2. Enable Audio

To hear sound in AudioMulch, you must make sure the Enable Audio button in the

Transport toolbar is activated. When you first install AudioMulch, Enable Audio is

activated.

When deactivated, the Enable Audio button looks like this: .

To activate/deactivate Enable Audio, do one of the following:

• Click the Enable Audio button on the Transport toolbar
• Open the Control menu and choose Enable Audio

3. Turn up the volume

ON CONTRAPTIONS

If you're using a contraption that has a volume knob on it, make sure you turn the volume

up. If you're not sure how to do this, see Using Common Contraption Controls (p. 60).

Some contraptions have more than one volume knob. For example Drums and Mixer

contraptions have one knob for each channel, as well as a master volume knob. Make

sure you turn up all the required volume knobs. You may also need to check that Mute

and Solo buttons are set correctly.

ON THE COMPUTER/SYSTEM MIXER

You will also need to make sure the volume is turned up on your computer/system mixer.

On Windows you can access this directly via AudioMulch.
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To turn up the volume on the Windows mixer (Windows only):

• Open the View menu and choose Windows Volume Control... The Windows
Volume Mixer window will open.

4. Press Play if you're using clock-based contraptions

If you're using a contraption that depends on the clock, make sure you press the Play

button on the Transport toolbar. To find out which contraptions depend on the clock,

visit When and How to Use the Clock (p. 37).

5. Check that AudioMulch is correctly configured to use
your computer's audio interface

If you've followed the steps above and you still can't hear anything, do the
following:

Check the AudioMulch settings in the Settings/Preferences dialog box to make sure
they're configured to use the correct audio interface on the computer.

• To do this in Windows: open the Edit menu and choose Settings... The
Settings/Preferences dialog box will open.

• To do this on a Macintosh: open the AudioMulch application menu and
choose Preferences... The Settings/Preferences dialog box will open.

Audio device settings are located on the Audio Driver, Audio Input, and Audio
Output pages of the Settings/Preferences dialog box. Depending on the selected
driver type you may need to check that your audio interface is selected on both the
Audio Driver and Audio Output pages. Visit Settings/Preferences Dialog Box (p. 166)
to learn more about adjusting AudioMulch's settings.

6. Check for audio delay ("latency") issues

You may notice that AudioMulch's sound output is lagging or delayed. There may be an

audible delay between audio input and output when processing sound, or a delay

between controlling parameters/triggering events and hearing the result. To resolve these

issues you need to configure your audio driver settings for low latency. Low latency

settings make it possible to hear sound output without noticeable delay.

Latency problems can be resolved by:
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1. Reducing buffer sizes and/or the number of buffers (depending on your system). For

detailed information on how to tune your system to reduce latency, see Optimizing

Real-Time Performance (p. 179).

2. On Windows, we strongly recommend you use an ASIO driver. See the Audio Driver

section of the Settings/Preferences Dialog Box (p. 166) page for information on

selecting your ASIO driver. If you don't have an ASIO driver installed, please check

with your audio interface manufacturer for instructions on how to install an ASIO

driver.

See Also

SoundOut (p. 200)

Creating and Deleting Contraptions (p. 84)

When and How to Use the Clock (p. 37)

Ways to Connect and Disconnect Contraptions (p. 99)

Using Common Contraption Controls (p. 60)

Settings/Preferences Dialog Box (p. 166)

Optimizing Real-Time Performance (p. 179)
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How to Get Help While Using AudioMulch

There are several ways you can access AudioMulch's Help File.

To access this Help File while using AudioMulch, do one of the following:

• Open the Help menu and choose AudioMulch Help
• Press the F1 key (Windows) or COMMAND+1 (Macintosh)

You can also access individual Help File pages while using AudioMulch.

To access the Help File page for an individual contraption, do one of the
following:

• Click on the Help button (?) in the title bar of the contraption
• Right-click on the contraption in the Patcher Pane and choose Help from the

shortcut menu

To access the Help File page for a window or dialog box:

• Click on the Help button in the window or dialog box
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Adjusting Contraption
Properties
Most contraptions have their own Property Editors; these are displayed in the Properties

Pane. Property Editors have various controls on them that you adjust to change the sound.

This section teaches you how to use contraption Property Editors to control contraptions.

Using Contraption Property Editors .................................................................................50

This section shows you the basic operations on Property Editors such as opening, closing,

moving. We also describe and explain the title bars of Property Editors, their buttons and

shortcut menu.

Using Common Contraption Controls .............................................................................60

Learn about about contraption controls such as knobs, sliders and number boxes, what

they do, and how to use them.

Using the Parameter Shortcut Menu ...............................................................................65

Gain quick access to parameter options that allow you to type in a parameter value,

automate a parameter, or set up MIDI parameter control.

Making Fine Adjustments to Parameter Values ................................................................67

Learn about ways to ways to accurately fine tune parameter values.

Editing Rhythmic Patterns ...............................................................................................71

Some of AudioMulch's contraptions have rhythmic pattern editors, which you can use to

create rhythmic and melodic patterns; we show you how.

Storing, Recalling and Managing Contraption Presets .....................................................75

Once you've adjusted a contraption's properties to make a sound you like you can store

and recall the property settings using contraption presets.
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Using Contraption Property Editors

Most contraptions have their own Property Editors, which are displayed in the

Properties Pane. Property Editors have controls (such as knobs and sliders) that you can

use to change properties, resulting in changes to the sound. In this module we show you

how to open and hide Property Editors, how to move them, what the title bar buttons

mean, and how to use shortcut menus.
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How to open and hide Property Editors

To open a Property Editor do one of the following:

• Double-click on the contraption in the Patcher Pane

OR
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• Right-click (CTRL+left-click on Macintosh) and choose Edit from the shortcut
menu.

The Property Editor will open in the Properties Pane.
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To hide a Property Editor:

• Click on the close button (X) of the Property Editor

OR
• Right-click (CTRL+left-click on Macintosh) and choose Close from the shortcut

menu.

The Property Editor will disappear from the Properties Pane.

Note: hiding a Property Editor doesn't delete the contraption. You can only delete a
contraption in the Patcher Pane. Once you've hidden a contraption's Property Editor
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you can reopen it using the method above. The Property Editor will reappear in the
same location with its settings intact.

Buses and AuxIn/AuxOut contraptions do not have Property Editors as they do not have

properties to edit.
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How to use title bar buttons

Each Property Editor has a title bar - this is the area at the top of the Property Editor that

contains the name of the contraption, and three buttons. The layout of the title bar is

slightly different on Windows and Macintosh, as shown below:
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Button How to use it and what it does

?
(Help)

Click on the ? button to open the Help File for that contraption.

X
(Close)

Click on the X button to hide the Property Editor.

Note: If you have multiple Property Editors that you want to hide,
SHIFT+click on one of the X buttons to hide them all at once.

--
(Preset)

Click on the -- button to open the Contraption Presets window.

Note: The preset button will only display as -- if no presets have been
stored. Once presets have been stored, this button will display a number

instead, like this: . The number displayed is the number of the preset
that you most recently stored or recalled. See Storing, Recalling and
Managing Contraption Presets (p. 75) for details.

How to move Property Editors

Property Editors can be moved around the Properties Pane, which is useful if you want to

organize them.

To move a Property Editor:

1. Click on the title bar of the Property Editor you want to move.
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2. Drag the Property Editor around the Property Pane to move it.

How to use the Property Editor shortcut menu

Property Editors have their own shortcut menu that you can use to close the Property

Editors and to open the Parameter Control window.
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To open this shortcut menu:

• Right-click (CTRL+left-click on Macintosh) on the Title Bar or in the background
of the Property Editor

You can then choose from the following menu items:

Close Closes the Property Editor. An alternative to using the X button.

Close All Closes all of the Property Editors in the Properties Pane. An alternative
to using the X button.

Close All
But This

Closes all of the Property Editors in the Properties Pane, except for the
one you are clicking on. An alternative to using the X button.

Parameter
Control

Opens the Parameter Control window with the current contraption
selected. This allows you to map contraption parameters to a MIDI
control source or to make changes to parameter mappings.

Note: contraption controls such as knobs and sliders have a different shortcut menu.
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See Also

Creating and Deleting Contraptions (p. 84)

Storing, Recalling and Managing Contraption Presets (p. 75)

Using Common Contraption Controls (p. 60)

Controlling AudioMulch Parameters from MIDI (p. 145)
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Using Common Contraption Controls

The Property Editors for the various contraptions share a number of common controls,

which you use to edit the properties of a contraption. This module includes descriptions of

each of these controls, what you can do with them, and gives instructions on how to use

them.

Control What you can do with it / How to use it

Knob Use knobs to control a single parameter value.

To change the value of the knob:

• Click-and-drag the pointer up and down on the
control. Dragging upwards increases the value.
Dragging downwards decreases the value.
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Number Edit Box Use number edit boxes to set a parameter.

To do this:

• Type a number into the text area OR
• Click-and-drag the pointer on the up/down arrows.

Dragging upwards increases the value. Dragging
downwards decreases the value.

Other things you should know:

• The parameter value will change as soon as you type
new digits.

• You can select, type text, and right-click (CTRL+left-
click) to cut, copy and paste as you would in any
other text area.

• Double-click to select the entire text value.
• When typing new values, you can enter any value

into the box. If the value is outside the acceptable
range for the parameter, a red + (indicating a value
above the accepted range), a - (indicating a value
below the accepted range) or an x (indicating an
invalid value) will be displayed to the right of the
value.

• When the number edit box is highlighted, you can
increase or decrease the value using the mouse
wheel, or by using the up and down arrow keys on
the keyboard.

• The parameter shortcut menu (described below) is
only displayed when you click the up/down arrow
button.
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Slider Use sliders to control a single parameter value. There are
both vertical and horizontal sliders.

To change the value of the slider:

• Click-and-drag the pointer anywhere on the control:
up and down for vertical sliders, left and right for
horizontal sliders.

Note: Vertical sliders have the minimum value at the
bottom and the maximum value at the top. Horizontal
sliders have the minimum value at the left and the
maximum at the right.

Range Slider Range sliders function similarly to sliders, except you use
them to control both the minimum and maximum of a
range of values.

To move the range slider:

• Click and drag on an empty space within a range
slider. Both the minimum and maximum slider
thumbs move simultaneously in the same direction.

To move the minimum and maximum values
independently:

• Click the pointer directly over the desired slider
thumb and drag it.

Note: For information on enhanced control of the range
slider, useful for live performance, see the section below.

ENHANCED CONTROL OF THE RANGE SLIDER

As well as using the range sliders in the simple ways described above, there is the option

for enhanced control of the range sliders by using modifier keys on the keyboard. These

modifier key combinations let you move rapidly between slider thumbs without multiple

mouse clicks. For live editing this means you can execute the entire variety of range

parameter controls by altering the modifier keys. The selected slider thumb or thumbs are

highlighted during use. There are two basic categories of behavior of the range slider,
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based on whether you're click-dragging in empty space (the slider area excluding the

thumbs) or click-dragging a thumb.

When dragging in empty space:

• As described in the section above, the default (with no modifier keys) is that
both thumbs move simultaneously in the same direction.

• If you hold down SHIFT, it will select the maximum thumb (Tip: remember that
the SHIFT key is higher than the alt key on the keyboard, therefore it selects the
maximum thumb).

• If you hold down ALT, it will select the minimum thumb (Tip: remember that
the ALT key is lower than the shift key on the keyboard, therefore it selects the
minimum thumb).

• Holding down both SHIFT+ALT will move both thumbs but in opposite
directions.

When dragging a thumb:

• As described in the section above, the default (with no modifier keys) is that the
thumb you clicked moves.

• SHIFT will move both the minimum and maximum thumb together (Tip: SHIFT
is usually used to select multiple items)

• ALT will select the opposite thumb (Tip: ALTernate, as in, the other thumb)
• Holding down both SHIFT+ALT will move both thumbs, but in opposite

directions.

The table below provides a quick-reference summary of the information above:

Modifiers Minimum thumb Maximum thumb Empty space

none minimum maximum both

SHIFT both both maximum

ALT maximum minimum minimum

SHIFT+ALT both/opposite
directions

both/opposite
directions

both/opposite
directions
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See Also

Using Contraption Property Editors (p. 50)

Using the Parameter Shortcut Menu (p. 65)

Making Fine Adjustments to Parameter Values (p. 67)
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Using the Parameter Shortcut Menu

With the parameter shortcut menu you can gain quick access to parameter options that

allow you to type in a parameter value, automate a parameter, or set up MIDI parameter

control.

To open this shortcut menu:

• Right-click (CTRL+left-click on a Macintosh) on a control (e.g. button, knob,
slider, number editor up/down arrows) in the Property Editor to open the
parameter shortcut menu.

You can then choose from the following menu items:

Set Value... Opens the Set Value dialog box. In this box:

1. Set an exact value by typing it in, or use the up/down
arrows.

2. Click OK to apply your changes.

Parameter
Control

Opens the Parameter Control window so you can map a
contraption parameter to a MIDI control source or make
changes to the parameter's mapping.
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Quick-Map MIDI
Control...

Opens the Quick-Map MIDI Control dialog box so you can
quickly map a contraption parameter to a MIDI control source.

Automate Opens an Automation Channel Panel for that parameter so
you can control the parameter in a pre-planned way.

You can also access some of the above functions by double-clicking on a parameter's

knob or slider as follows:

Set Value... Double-click

Parameter Control CTRL+double-click (COMMAND+double-click on Macintosh)

Quick-Map MIDI
Control...

ALT+double-click

See Also

Using Contraption Property Editors (p. 50)

Using Common Contraption Controls (p. 60)

Making Fine Adjustments to Parameter Values (p. 67)

Controlling AudioMulch Parameters from MIDI (p. 145)

Automation Overview (p. 129)
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Making Fine Adjustments to Parameter
Values

You can view and adjust the values of parameters in a number of ways. In this module

we show you how to adjust values more precisely, and how to set exact values by typing

them into the Set Value dialog box. We also demonstrate how you can change

frequency parameters using a pop-up piano keyboard that you can access from the Set

Value dialog box.

To view the value of a parameter:

• In the Property Editor of a contraption, roll over the parameter with the mouse.
The value will be displayed in a pop-up window.

Note: This pop-up window will also appear when you edit a parameter.

To adjust values more precisely:

• Click-and-drag the pointer over knobs, sliders or up/down arrows while holding
down the CTRL key (COMMAND on Macintosh). This will slow down the
movement of the individual controls, letting you locate exact values. You can
press the CTRL key (COMMAND on Macintosh) at any time while adjusting the
value.

To type values into the Set Value dialog box, do one of the following:

1. Double-click on any knob or slider.
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2. The Set Value dialog box will appear.
3. Type the value into the box, or use the up/down arrows to select a value.

4. Click OK to apply your changes.

OR

1. Right-click (CTRL+left-click on Macintosh) on a parameter and select Set
Value... from the shortcut menu.

2. Type the value into the box, or use the up/down arrows to select a value.
3. Click OK to apply your changes.

Note: When the parameter represents a frequency, the Set Value dialog box also
displays the parameter value as a musical pitch name at the right of the value box.
When the frequency doesn't correspond exactly to a musical pitch, the distance
from the exact pitch is shown in cents (+ means that the frequency is above the
exact note frequency, and - means below).
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To display and change frequency parameters using the pop-up piano
keyboard:

1. Double-click on a frequency parameter to open the Set Value dialog box.

OR Right-click (CTRL+left-click on Macintosh) on a parameter and select Set
Value... from the shortcut menu.

2. To the right of the value box the frequency is displayed as a musical pitch name
(e.g. A5). Click on this pitch name; a pop-up piano keyboard will be displayed.

3. Choose a new frequency by clicking on the keys of the piano keyboard.

4. The keyboard will close and the new frequency name (and value in Hz) will be
displayed in the Set Value dialog box.

5. Click OK to apply your changes.
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See Also

Using Common Contraption Controls (p. 60)

Using Contraption Property Editors (p. 50)
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Editing Rhythmic Patterns

Some contraptions in AudioMulch are beat based and allow you to set up rhythmic

patterns. You do this by selecting units on grids, called rhythmic pattern editors.

Contraptions that use rhythmic pattern editors include Drums, Bassline, Arpeggiator,

and SouthPole. With Bassline and Arpeggiator, you can also create melodic sequences.

Editing pattern rhythms

Pattern editors deal with rhythmic events displayed on a grid. You can toggle events on

and off by clicking on the pattern cells on the grid. Most pattern editors allow you to

"paint" multiple cells by clicking and dragging over them. The Drums pattern editor works

more like automation: you can drag drum hits by clicking and dragging.

Each contraption's pattern editor works differently, based on its specific use. Information

about specific pattern editors is available in the Help File for the corresponding

contraption.

Time signatures

Pattern editors have bar and beat numbers and divisions, which are indicated near the top

of the pattern editor in the time ruler. They also have time signatures that you can
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change. To read more about how to change time signatures, see Time Signatures and

Rhythmic Units (p. 140).

Looping and changing the length of rhythmic patterns

Rhythmic patterns have a finite length, and loop at that length. You can, however, change

the length of the pattern.

To change the length of a rhythmic pattern:

1. Hold the mouse over the pattern end marker (the thick vertical line), located at
the end of the pattern in the time ruler. A double-ended arrow will appear in
the time ruler.

2. Click and drag to the left to make the pattern shorter, or to the right to make it
longer.
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3. Release the mouse button once you've chosen the new length. The area at the
end of the pattern will be a different color (darker or lighter than the area
containing the rhythmic pattern).

Zooming in and out

You can also zoom in and out along the horizontal (time) axis, so you can see the pattern

editor at different resolutions.

Zoom in and out along the time axis using one of the following methods:

• (A) Use the zoom in and zoom out buttons located at the bottom right of the
pattern editor, on the right side of the horizontal scroll bar OR

• (B) Click on the thin button located between the zoom in and zoom out
buttons and drag the mouse horizontally (left and right) while holding the
mouse button down to zoom in and out OR
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• (C) The horizontal scroll bar thumb has a small indentation at either end. Click
one of these indentations with the mouse and drag horizontally (left and right)
while holding the mouse button down to zoom in and out.

See Also

Time Signatures and Rhythmic Units (p. 140)

Drums (p. 229)

Bassline (p. 219)

Arpeggiator (p. 213)

SouthPole (p. 312)

Automation Overview (p. 129)
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Storing, Recalling and Managing
Contraption Presets

A preset is a snapshot of all parameter settings that you've chosen or modified for a

single contraption. Presets let you store and recall previously used settings, such as drum

patterns or filter settings. You can store any number of presets, so you can switch

between different parameter settings that you've stored at different times. In this module

we explain how to store, recall and manage presets, and how to navigate the various parts

of the Presets Window and its shortcut menu.

How AudioMulch contraption presets work

The basic principles for using contraption presets are as follows:

• You need to store them

• You can recall them

• If you make any changes to the parameter settings on the contraption, you need to

save (store) the preset again.

• If you don't store changes that you make, they will be lost when you recall the same

or a different preset.
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Accessing the Presets Window

To access a preset by opening the Presets Window:

1. Click on the presets button at the top of the contraption's Property Editor.
2. The Presets Window will appear.

Note: The number displayed on the Property Editor's presets button is the number
of the preset that you recalled or stored most recently.
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How to use the Presets Window

Now you know how to access presets in the Presets Window, you can start using it to

store, recall and organize presets (renaming, deleting and moving them). You can perform

many of these actions in the presets list/slots and in the Header Bar. You'll find instructions

on how to perform all of these actions below.

HEADER BAR

At the top of the Presets Window is a Header Bar that lets you quickly and easily add a

new preset and switch between presets. It displays the name of the currently selected

preset and also allows you to store (overwrite), recall and rename the current preset. It has

Add New Preset, Recall Previous and Recall Next buttons. The Header Bar also

duplicates some of the buttons (Recall, Store and Clear) found in the presets list.
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PRESETS LIST

Below the Header Bar is the presets list: a list of numbered preset slots. Slots that contain

a preset display the preset's name or "(Untitled)". These contain previously stored settings.

Empty slots containing no preset are blank. The preset slots have buttons that allow you to

store, recall or clear individual presets. You can rename presets, and reorder them by

dragging them from one slot to another.

WAYS TO STORE PRESETS

To perform this action Follow these instructions

Create a new preset • In the Header Bar: click on the Add New Preset

button . This creates a new preset in the first
empty slot.

• In an empty preset slot: click on the Store button

OR right-click (CTRL+left-click on Macintosh) in
the preset slot and select Store from the shortcut
menu.

Store new settings into
the current preset • In the Header Bar: click on the Store button

once you've made changes to the settings. The
settings will be stored in to the preset named in the
Header Bar.

Note: This will overwrite the previous settings you had
stored in the preset named in the Header Bar.

Store new settings into an
existing preset (overwrite
an existing preset)

• In a preset slot that already stores a preset: click on

the Store button OR right-click (CTRL+left-click
on Macintosh) in preset slot and select Store from
the shortcut menu.

Note: This will overwrite the previous settings you had
stored in that preset slot.
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WAYS TO RECALL PRESETS

To perform this action Follow these instructions

Recall a previously stored preset • In a preset slot: double-click the preset OR

click on the Recall button OR right-click
(CTRL+left-click on Macintosh) on the preset
and select Recall from the shortcut menu.

Recall (revert to) the current
preset

1. In the Header Bar: click on the Recall button

. This will recall the current preset again
(the last preset you Recalled or Stored).

Note: You will lose any changes to contraption
settings that you made if you didn't store them.

Cycle through presets (using
Recall Next/ Recall Previous)

• In the Header Bar: click on the Recall

Previous and Recall Next buttons.
These buttons cycle through and recall the
presets in order.
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WAYS TO ORGANIZE AND MANAGE PRESETS

To perform this action Follow these instructions

Name or rename a preset In the Header Bar: click in the naming area
in the middle of the bar to select the name
text. Type a new name.

In a preset slot:

1. Right-click (CTRL+left-click on
Macintosh) on the preset and select
Rename from the shortcut menu.

2. Type a new name into the slot.

OR

1. Click the preset to select it. Pause.
2. Click again and you will be able to

edit the name

OR

1. Click the preset to select it.
2. Press F2 (if you're using Windows) and

you will be able to edit the name

Reorder a preset in the list • In the presets list: Click and drag a
preset to move it from one slot to
another. OR

• Right-click (CTRL+left-click on
Macintosh) a preset and use the Cut,
Copy and Paste commands to move
a preset from one slot to another.

Adjusting Contraption Properties - Storing, Recalling and Managing Contraption Presets 80



Duplicate a preset • In the presets list: Right-click
(CTRL+left-click on Macintosh) a
preset and use the Cut, Copy and
Paste commands to duplicate a preset
from one slot to another.

Copy a preset from one contraption to
another

• In the presets list: Right-click
(CTRL+left-click on Macintosh) a
preset and use the Cut, Copy and
Paste commands to duplicate preset
settings from one contraption to
another (provided the source and
destination contraptions are of the
same type).

Clear a preset • In the Header Bar: click on the Clear

button to clear the preset that's
currently displayed.

• In a preset slot: click on the Clear

button OR right-click (CTRL+left-
click on Macintosh) on the preset and
select Clear from the shortcut menu.

OTHER THINGS YOU SHOULD KNOWOTHER THINGS YOU SHOULD KNOW::

• The number on a Property Editor's presets button indicates the preset that was most

recently used.

• After recalling a preset, the preset button text becomes bold to indicate that the

current settings match those of the preset. After changing a contraption parameter,

the text will return to normal (non-bold), indicating that the current settings are

different to those of the preset. You need to store the preset again if you want to

update the preset to include your changes.

• You can store presets for VST and Audio Unit plugins. This is the recommended way

to handle preset switching in AudioMulch. AudioMulch also supports the native VST
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program system, including the VST fxb program file format. See the VST Plugins (p.

345) page for more information.

See Also

Using Contraption Property Editors (p. 50)

Using Common Contraption Controls (p. 60)

VST Plugins (p. 345)
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Working in the Patcher Pane
The Patcher Pane is one of the three main panes of the AudioMulch window. In the

Patcher Pane you can do things such as creating and deleting contraptions, and

connecting them together into patches. This section shows you different ways to perform

these tasks and explains the various components of the Patcher Pane.

Creating and Deleting Contraptions................................................................................84

Learn about the different ways to create and delete contraptions, including using shortcut

menus to do so, and ways to create and connect contraptions using a single gesture.

Contraption Inputs and Outputs .....................................................................................96

Learn about the different types of contraption inputs and outputs, information tooltips

and activity indicators.

Ways to Connect and Disconnect Contraptions...............................................................99

Learn useful shortcuts for quickly connecting contraptions together, including creating

multiple patch cords at once, reconnecting existing patch cords and inserting contraptions

within existing signal paths.

Ways to Select Contraptions .........................................................................................111

Learn how to select and move contraptions.

Cutting, Copying and Pasting Contraptions ..................................................................114

Learn how to use the cut, copy and paste functions.

Routing MIDI in the Patcher Pane..................................................................................117

Learn how to route MIDI data using the Patcher Pane. This is useful when using VST and

Audio Unit plugins.

Renaming Contraptions ................................................................................................120

Learn how to rename contraptions so you can identify them more easily.
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Creating and Deleting Contraptions

Before you can join contraptions together in the Patcher Pane, you must first create a

contraption. This module shows you several ways to create contraptions, how to delete

contraptions, and how to duplicate them. We explain how to perform more advanced

procedures, including how to create and connect contraptions at the same time, how to

duplicate contraptions with their existing connections, and how to insert a new

contraption in a particular place in your patch. We also describe the various Patcher Pane

shortcut menu items that are relevant to these procedures, and explain how to open this

menu.
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Creating contraptions

To create a contraption, do one of the following:

• Click on the contraption you want to use in the Contraptions Palette and
drag-and-drop it into the Patcher Pane.
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• Double-click on the contraption you want to use in the Contraptions Palette. It
will appear in the Patcher Pane.
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• Right-click (CTRL+left-click on Macintosh) on the contraption you want to use
in the Contraptions Palette and choose Create Contraption from the shortcut
menu. It will appear in the Patcher Pane.
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• Add a contraption to the Patcher Pane directly using the shortcut menu. Right-
click (CTRL+left-click on Macintosh) in the Patcher Pane to open the shortcut
menu, choose New, then select the contraption you want from the sub-menus.
It will appear in the Patcher Pane.

Deleting contraptions

To delete a contraption from the Patcher Pane:

First, select the contraption you want to delete by clicking on it in the Patcher Pane.
This will highlight the contraption. Then, do one of the following:

• Press the DELETE key to delete the contraption
• Open the Edit menu and choose Clear
• Right-click (CTRL+left-click on Macintosh) on the selected contraption and

choose Delete from the shortcut menu.
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Creating and connecting contraptions at the same time

You can create and connect contraptions at the same time by dragging a new contraption

from the Contraptions Palette over an existing one in the Patcher Pane.

To create and connect contraptions at the same time:

This operation has two modes: (1) when the mouse pointer is just above an input (or
below an output) the new contraption is inserted between any existing patch cords;
(2) when the mouse pointer is over the contraption you are connecting to, the new
contraption is attached separately, alongside any existing patch cords.

1. Drag a new contraption from the Contraptions Palette over the input or output
of the contraption you want to connect it to. While you're dragging, a gray
outline of the proposed connection is displayed, showing you whether the
contraption will be inserted or attached.

Working in the Patcher Pane - Creating and Deleting Contraptions 89



2. One or more patch cords will be created, connecting the contraptions.

Note:

• As some contraptions have multiple inputs or outputs, sometimes more than
one patch cord will be created when connecting contraptions.

• You can also connect any unconnected contraptions that are already in the
Patcher Pane using the same method.
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Duplicating contraptions using CTRL+drag

You can also duplicate a contraption by using the CTRL key (COMMAND on Macintosh)

and dragging with the mouse. You can duplicate just the contraption, or the contraption

along with any existing connections.

To duplicate a contraption using CTRL (COMMAND) +drag:

1. Hold down the CTRL key (COMMAND on Macintosh)
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2. Click on the contraption you wish to duplicate and drag the duplicated
contraption to the desired area of the Patcher Pane.

To duplicate a contraption with its existing connections:

1. Click the mouse button in a clear area of the Patcher Pane, next to the
contraption you want to select.
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2. Drag the pointer, using a diagonal motion, over the contraption. The area you
select becomes highlighted.

3. Release the mouse. The contraptions and any connecting patch cords will now
be highlighted.

4. Hold down the CTRL key (COMMAND on Macintosh)
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5. Click on the highlighted contraption and drag it to the desired area of the
Patcher Pane. Release the mouse. Any connections will stay intact.

Using the Patcher Pane's shortcut menu

You can open the Patcher Pane's shortcut menu (see screen shot above) by right-clicking

(CTRL+left-click on Macintosh) on a contraption or group of selected contraptions. This

shortcut menu gives you quick and easy access to functions from the main Edit menu,

such as Cut and Copy. There is also a range of other functions that help you edit the

structure of the patch. These functions allow you to rearrange contraptions more easily
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and make it possible to maintain uninterrupted audio while you restructure the patch. In

the table below we explain each of the shortcut items relevant to this module.

Menu
Item

What it does

Delete Deletes the chosen contraption or group of contraptions.

Replace Deletes the highlighted contraption and inserts a newly selected
contraption in its place.

Substitute Removes the highlighted contraption from the signal path and inserts a
newly selected contraption in its place. The original contraption is
disconnected and left in the Patcher Pane to be used later.

Insert
Before

Inserts the new contraption into the patch before the highlighted
contraption.

Insert
After

Inserts the new contraption into the patch after the highlighted
contraption.

Insert Inserts a new contraption into the patch. Only available when right-
clicking (CTRL+left-click on Macintosh) on patch cords.

Note: when inserting a stereo contraption into a mono path only the
left side of the new contraption will be connected. To insert a stereo
contraption into a stereo path both patch cords must be selected.

See Also

Contraption Inputs and Outputs (p. 96)

Ways to Connect and Disconnect Contraptions (p. 99)

Ways to Select Contraptions (p. 111)
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Contraption Inputs and Outputs

Different kinds of inputs and outputs

Inputs and outputs can be seen on the tops and bottoms of contraptions. Some

contraptions have multiple inputs and outputs. Most contraptions have audio inputs and/

or outputs at the top and bottom left edge. Some contraptions have MIDI inputs and/or

outputs at the top and bottom right edge.

ON CONTRAPTIONS THAT GENERATE SOUND

Contraptions that generate sound (such as those in the Signal Generators category)

have audio outputs, found on the bottom left edge of the contraption. These contraptions

don't usually have inputs because they only generate sound and cannot usually process

sound from other contraptions.

Note that a few contraptions, such as the Bassline contraption, usually act as signal

generators but can optionally process an input. These contraptions also have inputs.

ON CONTRAPTIONS THAT PROCESS SOUND
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Contraptions that process sound (such as those in the Effects, Filters, Dynamics, Buses

and Mixers categories) have inputs on the top of the contraption and outputs on the

bottom.

MIDI INPUTS AND OUTPUTS

MIDI inputs and outputs are displayed on the top right and bottom right edges of

contraptions. This is in contrast to inputs and outputs for other kinds of contraptions,

which are displayed on the left edges. Patch cords carrying MIDI messages appear as

dotted lines in the patcher. MIDI outputs can only be connected to MIDI inputs. A MIDI

output can't be connected to an audio input nor an audio output to a MIDI input.

Tooltips

ToolTips are pop-up boxes that contain information about inputs and outputs. They

appear when you roll over an input or output with the mouse. ToolTips will only appear if

they are switched on in the View menu.

To switch ToolTips on or off:

• Open the View menu and check or uncheck Show Contraption Input/
Output Info.
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Contraption input/output activity indicators

Contraption input/output activity indicators show the level of audio and/or MIDI activity at

an input or output. These indicators are located inside each contraption's inputs and

outputs. Activity is indicated with a colored, pulsating "eye". The activity indicators will

only appear if they are switched on in the View menu.

Audio inputs and outputs display a pulsating "eye" that gets larger to indicate higher

(louder) levels. Much like the level meters, they also change color from green (low level)

through yellow, to red for louder levels. Red indicates that the signal is over 0dBfs, and

would clip if it was connected to an audio output.

MIDI inputs and outputs blink on and off when MIDI messages flow through them.

To switch contraption input/output level meters on or off:

• Open the View menu and check or uncheck Show Contraption Input/
Output Activity Indicators

See Also

Contraptions: What They are and What They Do (p. 33)

Controlling AudioMulch Parameters from MIDI (p. 145)
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Ways to Connect and Disconnect
Contraptions

In AudioMulch you can connect contraptions together in several different ways.

Contraptions are always connected with patch cords. You can see these in the screen

shot above: they are the lines that join the outputs to inputs of contraptions. Inputs and

outputs can be seen on the tops and bottoms of the contraptions. Audio flows in the

direction of the arrows on the patch cords. Once audio enters the SoundOut contraption,

it is routed to your computer's audio output.

When you connect MIDI inputs and outputs together, the patch cords appear dotted, not

as solid lines like those in the image above. You can connect audio outputs to audio inputs

and MIDI outputs to MIDI inputs; you cannot connect an audio output to a MIDI input or

vice versa.

In this module we show you the various ways of connecting contraptions, how to

reconnect patch cords, and describe shortcut menu items that relate to connecting

contraptions together.
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Connecting and disconnecting contraptions with single
patch cords

To connect contraptions together:

1. Click on an output of one contraption.
2. Drag a patch cord to an input of another contraption with the mouse.

To disconnect contraptions:

First, click on the patch cord to select it.
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Then, do one of the following:

• Press DELETE on the keyboard
• Open the Edit menu and choose Clear.
• Right-click (CTRL+left-click on Macintosh) and choose Delete from the shortcut

menu.
• Click on the arrow at the end of the patch cord and drag it to the left or right,

away from the input.

When you release the mouse button the patch cord will disappear,
disconnecting the contraptions.

Connecting contraptions by dragging them over one
another

To connect contraptions together:

This operation has two modes: (1) when the mouse pointer is just above an input (or
below an output) the new contraption is inserted between the existing patch cords;
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(2) when the mouse pointer is over the contraption you are connecting to, the new
contraption is attached separately, alongside any existing patch cords.

1. Drag a new or unconnected contraption over the input or output of the
contraption you want to connect it to. While you're dragging, a gray outline of
the proposed connection is displayed, showing you whether the contraption
will be inserted or attached.
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2. One or more patch cords will be created, connecting the contraptions.

Connecting and disconnecting multiple patch cords

Multiple patch cords may be taken from any output and joined to any input. When

multiple cords are joined to an input the signals are automatically mixed. In more complex

patches, Buses or Mixers can be used to combine multiple outputs into a single input.
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You can connect multiple patch cords one at a time as described above. You can also

connect multiple patch cords all at once.

To connect multiple patch cords at once:

These instructions apply when connecting one multichannel contraption to another
multichannel contraption (e.g. connecting a FilePlayer to an SMixer).

1. Hold the SHIFT key down.
2. Drag from the first input or output you want to connect to another

contraption.

Note:

• AudioMulch will connect as many patch cords as possible depending on which
input or output you drag the patch cords from and to. The potential patch
cords will be indicated as you drag with the SHIFT key held down.

• Holding down the CTRL key (COMMAND on Macintosh) while SHIFT+dragging
multiple patch cords to the second or later inputs will cause excess connections
to "wrap around" to the first and later inputs. For example, dragging from the
first output of a FilePlayer to the second input of SoundOut with the SHIFT and
CTRL (COMMAND on Macintosh) keys depressed will connect the first input to
the second output and vice versa.

To connect multiple patch cords to a single input:

1. Hold down the SHIFT+ALT keys while dragging the patch cords from the output
of a multichannel contraption.
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2. The patch cords will be grouped inwards to the single input, so you won't have
to connect each cord separately.

To connect a single output to multiple inputs:

1. Hold down the ALT key while dragging the patch cords to the inputs of the
multichannel contraption.

2. The patch cords will be "fanned" outwards to the multichannel contraption's
inputs, so you won't have to connect each cord separately.

To disconnect multiple patch cords at once:

First, select the patch cords you want to delete using one of the following methods:

• Hold down the SHIFT key while clicking on the cords you want to delete. OR
• Click on the end point just above the output or just below the input where the

cords are connected. Then, click all the patch cords connected to that input or
output. OR
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• Click the mouse button in a clear area of the Patcher Pane and drag the pointer
around or over the patch cords you want to select. The area you select becomes
highlighted. Release the mouse.

Then, do one of the following to delete the cords:

• Press the DELETE key.
• Open the Edit menu and choose Clear.
• Right-click (CTRL+left-click on Macintosh) and choose Delete from the shortcut

menu.
• Click-and-drag the cords away from the connection and release the mouse in

empty space.

Reconnecting patch cords

You can reconnect patch cords. This means you can click on a patch cord at either end

with the mouse, and drag it to the input or output of any other contraption to reconnect

it.

You can also reconnect multiple patch cords at once. If multiple cords are connected to an

input or output and you only want to reconnect specific cords from the group, you must

select them before they can be reconnected. If no cords are selected, all the cords

connected to a point will be reconnected simultaneously. See below for information on

how to perform these actions.
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To reconnect a single patch cord when there is more than one cord
connected to a point:
1. Select the cord you want to reconnect by clicking on it.

2. Click on the patch cord at the end you want to reconnect.
3. While holding the mouse button down, drag to the input or output of any

other contraption.
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To reconnect multiple patch cords at once:

To reconnect all the patch cords connected to a contraption at once:

1. Make sure none of the patch cords has been selected. If no cords are selected,
all the cords connected to this point will be reconnected simultaneously.

2. Click on the patch cords at the end you want to reconnect.
3. While holding the mouse button down, drag the cords to the input or output

of any other contraption.

To reconnect specific patch cords, do one of the following:

1. Hold down the SHIFT key while clicking on the cords you want to reconnect.
This selects the cords.

2. Click on the patch cords at the end you want to reconnect.
3. While holding the mouse button down, drag the cords to the input or output

of any other contraption.

OR

1. Click the mouse button in a clear area of the Patcher Pane. Drag the pointer,
using a diagonal motion, over the cords you want to select. The area and cords
become highlighted. Release the mouse.
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2. Click on the patch cords at the end you want to reconnect.
3. While holding the mouse button down, drag the cords to the input or output

of any other contraption.

Note: You can use the click+drag method outlined in step 1 above to select patch
cords that are next to each other, or all of the patch cords.

Patcher shortcut menu

You can open the Patcher Pane's shortcut menu by right-clicking (CTRL+left-click on

Macintosh) on a contraption or group of selected contraptions.

This shortcut menu gives you quick and easy access to functions that help you edit the

structure of the patch. Using the shortcut menu lets you rearrange contraptions more

easily and makes it possible to maintain uninterrupted audio while you restructure the

patch.
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Menu
Item

What it does

Replace Deletes the highlighted contraption and inserts a newly selected
contraption in its place.

Substitute Removes the highlighted contraption from the signal path and inserts a
newly selected contraption in its place. The original contraption is
disconnected and left in the Patcher Pane to be used later.

Insert
Before

Inserts the new contraption into the patch before the highlighted
contraption.

Insert
After

Inserts the new contraption into the patch after the highlighted
contraption.

Insert Inserts a new contraption into the patch. Only available when right-
clicking (CTRL+left-click on Macintosh) on patch cords.

Note: when inserting a stereo contraption into a mono path only the
left side of the new contraption will be connected. To insert a stereo
contraption into a stereo path both patch cords must be selected.

Swap Swaps the position of two contraptions. Can be used to swap
contraptions between parallel signal paths or to change the order of
contraptions within a common path. You can only use Swap when two
contraptions are selected.

Bypass Removes the highlighted contraption from the signal path. The
contraption is disconnected and left in the Patcher Pane to be used
later.

See Also

Creating and Deleting Contraptions (p. 84)

Contraption Inputs and Outputs (p. 96)

Ways to Select Contraptions (p. 111)
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Ways to Select Contraptions

You can select contraptions in order to move them around the Patcher Pane. This can

be useful if you want to visually organize the patch, or move the whole patch around in

the pane at once. You can also select contraptions to delete them from a patch, or to

duplicate contraptions. In this module we show you how to select one or more

contraptions and how to move them around the Patcher Pane.

Selecting single contraptions

To select a single contraption:

1. Click on the contraption.
2. The contraption will now be highlighted.

Selecting multiple contraptions

To select multiple contraptions:

1. Hold down the SHIFT key.
2. Click on the contraptions you want to select.
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3. The contraptions will now be highlighted.

OR

1. Click the mouse button in a clear area of the Patcher Pane.
2. Drag the pointer, using a diagonal motion, over the contraptions you want to

select. The area you select becomes highlighted with a green box.
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3. Release the mouse. The contraptions and any connecting patch cords will now
be highlighted.

Note: if you want to unselect a contraption from a selection of multiple
contraptions, hold down the SHIFT key while clicking on the contraption.

Moving contraptions

To move selected contraptions around the Patcher Pane:

1. Click on one of the selected contraptions.
2. Drag with the mouse to move the contraptions.

See Also

Creating and Deleting Contraptions (p. 84)

Cutting, Copying and Pasting Contraptions (p. 114)
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Cutting, Copying and Pasting Contraptions

You can cut, copy and paste contraptions in AudioMulch's Patcher Pane. These

functions can be accessed via the Patcher Pane's shortcut menu or the Edit menu. In this

module, we describe the various functions and how to access and use them.

What Cut, Copy and Paste do

Menu
Item

What it does

Cut Parameter settings and Presets for a contraption are cut and stored on
the clipboard.

Note: This is useful if you want to recreate an effect elsewhere in the
current document or copy from one AudioMulch document to another.

Copy Duplicates parameter settings and presets of a contraption.

Note: This is useful if you want to recreate an effect elsewhere in the
current document or copy from one AudioMulch document to another.

Paste Pastes the duplicated contraption(s), complete with parameter settings and
presets into the Patcher Pane.

Note: cutting and pasting contraptions does not duplicate MIDI mappings or

Automation channels.

Accessing these items from the Edit menu

You can access Cut, Copy and Paste from the Edit menu.

To Cut or Copy:

1. Click on the contraption you want to cut or copy to select it. The contraption
will be highlighted.

2. Open the Edit menu and choose Cut or Copy
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To Paste:

• Open the Edit menu again and choose Paste. The contraption will be pasted
into the Patcher Pane.

Accessing these functions via shortcut menus

You can also access Cut, Copy and Paste using shortcut menus in the Patcher Pane.

CUT AND COPY

To access Cut and Copy, you need to first open the shortcut menu on a contraption (see

screen shot above).

To open the shortcut menu:

1. Right-click (CTRL+ left-click on Macintosh) on a contraption or group of
selected contraptions in the Patcher Pane. The shortcut menu will open.

2. Choose Cut or Copy.

Note: If you don't know how to select contraptions, visit the Ways to Select
Contraptions (p. 111) page.
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PASTE

To access Paste, you need to access the shortcut menu in open space in the Patcher Pane

(see screen shot above).

To access Paste:

1. Copy or cut a contraption (or contraptions) to the clipboard (see instructions
above).

2. Right-click (CTRL+ left-click on Macintosh) in an open space in the Patcher
Pane. The shortcut menu will open.

3. Choose Paste from the shortcut menu. The contraption will paste into that
position in the Patcher Pane.

See Also

Creating and Deleting Contraptions (p. 84)

Ways to Select Contraptions (p. 111)
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Routing MIDI in the Patcher Pane

You can route MIDI messages in the Patcher Pane by connecting MIDI patch cords from

a MIDI output on one contraption to a MIDI input on another contraption. MIDI routing

is usually used in conjunction with VST (p. 345) and (on Macintosh) Audio Unit (p. 350)

plugins.

When to use MIDI routing in the Patcher Pane

You use MIDI patch cords in conjunction with AudioMulch's MidiIn and MidiOut

contraptions (p. 205) and with VST and Audio Unit plugins. AudioMulch's MidiIn

contraptions let you route MIDI messages from external MIDI sources (such as keyboard

controllers, drum pads or sequencers) into a patch. AudioMulch's MidiOut contraptions

let you send MIDI messages to external devices (such as hardware synthesizers, drum

machines and effects units).

COMMON USES OF MIDI ROUTING IN THE PATCHER PANE INCLUDE:

• Using an external MIDI source (such as a keyboard controller, drum pad or sequencer)

to "play" a virtual instrument plugin. Do this by connecting a MIDI patch cord from a

MidiIn contraption to a VST or Audio Unit plugin.

• Transforming a stream of MIDI data using a MIDI processing plugin (VST or Audio

Unit), to create results including pitch transposition, delay, velocity processing and to

filter key ranges. Do this by inserting a MIDI processing plugin between a MIDI source

and MIDI receiver contraption.

• Using a MIDI source contraption (such as a MIDI sequencer, arpeggiator, or on-screen

keyboard plugin) to "play" a virtual instrument plugin. Do this by connecting a MIDI

patch cord from the MIDI source contraption to a VST or Audio Unit plugin.

• Controlling an external MIDI device, such as a hardware synthesizer or effects unit

from a MIDI sequencer plugin. Do this by connecting a MIDI patch cord from the

plugin to a MidiOut contraption.

Note: MIDI routing in the Patcher Pane is distinct from AudioMulch's MIDI Parameter

Control features.
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Contraption MIDI inputs, outputs and MIDI patch cords

MIDI inputs and outputs are displayed on the top right and bottom right sides of

contraptions. This is in contrast to audio inputs and outputs, which are displayed on the

left side. Patch cords carrying MIDI messages appear as dotted lines in the Patcher Pane.

MIDI outputs can only be connected to MIDI inputs. A MIDI output can't be connected to

an audio input nor an audio output to a MIDI input.

Connecting MIDI patch cords

To connect a MIDI patch cord:

1. Click on a MIDI output (or input).
2. Drag a patch cord to a MIDI input (or output) with the mouse.

Note:

• The same method is used for connecting audio patch cords. The Ways to
Connect and Disconnect Contraptions (p. 99) module has images that
demonstrate this. Refer to that module if you need extra assistance with
connecting patch cords.

• Unlike connecting audio patch cords, you can not establish a MIDI connection
by dragging one contraption over another.

THINGS TO KEEP IN MIND WHEN CONNECTING MIDI CONTRAPTIONS

• MIDI patch cords carry all 16 channels of a MIDI data stream. However, many plugins

are designed to receive data from a single channel only. You can filter which channel
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is routed to the plugin using the Parameter Control window. See the VST (p. 345)

and (on Macintosh) Audio Unit (p. 350) plugins modules for details.

• Any plugin with outputs (MIDI or audio) must be connected directly (or indirectly) to

either a MidiOut or SoundOut contraption to operate.

Disconnecting MIDI patch cords

To disconnect a MIDI patch cord:

1. First, click on the patch cord to select it.
2. Then, do one of the following:

• Press DELETE on the keyboard
• Open the Edit menu and choose Clear.
• Right-click (CTRL+left-click on Macintosh) and choose Delete from the shortcut

menu.
• Click on the arrow at the end of the patch cord and drag it to the left or right,

away from the input. When you release the mouse button the patch cord will
disappear, disconnecting the contraptions.

Note: The same methods are used for disconnecting audio patch cords. The Ways to
Connect and Disconnect Contraptions (p. 99) module has images that demonstrate
this. Refer to that module if you need extra assistance with disconnecting patch
cords.

See Also

Contraption Inputs and Outputs (p. 96)

Ways to Connect and Disconnect Contraptions (p. 99)

Controlling AudioMulch Parameters from MIDI (p. 145)

MidiIn / MidiOut contraptions (p. 205)

VST Plugins (p. 345)

Audio Unit Plugins (p. 350)
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Renaming Contraptions

You can rename contraptions in AudioMulch. This can be useful if you've got several

versions of the one kind of contraption in the same patch, as it helps you to differentiate

between them. You can also rename contraptions in order to identify them more easily.

To rename a contraption do one of the following:

1. Right-click on the contraption in the Patcher Pane and select Rename from the
shortcut menu. The contraption will be highlighted with a dotted border
around it.

2. Edit the name of the contraption by typing in it. Only letters (upper and lower
case), numbers, and underscores are allowed.

3. Press the ENTER key or click outside the contraption and the new name will
become permanent.

The name change will be visible in the Patcher, Properties, and Automation Panes,
and also the Parameter Control dialog box.

OR

1. Select the contraption in the Patcher Pane by clicking on it. The contraption will
be highlighted.
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2. Click on the contraption again, wait until a dotted border appears around it,
and type the new name into it. Only letters (upper and lower case), numbers,
and underscores are allowed.

3. Press the ENTER key or click outside the contraption and the new name will
become permanent.

The name change will be visible in the Patcher, Properties, and Automation Panes,
and also the Parameter Control dialog box.

Note: Name changes are specific to the contraption and document you are using,
and are saved as part of the document. Renaming contraptions will not affect other
contraptions, which will keep their default names.
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Loading Sound Files
Some contraptions in AudioMulch operate directly on sound files that have been loaded

into the contraption. FilePlayer, MultiFilePlayer and SoundIn stream directly from disk and

therefore use less memory, making them ideal for playing long soundfiles; while

LoopPlayer, Drums and BubbleBlower keep the entire sound file in memory. LoopPlayer

plays looped samples in time with the beat. Drums triggers short samples in time with the

beat based on a repeated pattern. BubbleBlower granulates a sound file.

Supported Sound File Formats

AudioMulch supports:

• WAV and AIFF files

• sound files of varying bit and sample rates (including 24bit and floating point files)

AudioMulch does not support:

• MP3s

• sound files created using ADPCM or other compressed formats

Note: AudioMulch can only run at a single sample rate at any one time. To change the

sample rate setting, go to the Audio General page of the Settings/Preferences Dialog Box

(p. 166). Any files created at a different rate to that specified will be converted when

loaded into AudioMulch. This sample rate conversion feature is optimised for real-time

performance rather than quality. It may therefore cause some audio degradation of

unmatched files. For optimal audio quality and processing efficiency, convert all sound files

to a single sample rate before you use them in AudioMulch. To do this use a sound file

editor such as Audacity, Audition, CoolEdit or WaveLab.

How to Load Sound Files into Contraptions

You can use either of the following two methods to load sound files:

1. Drag a sound file into the contraption's sound file slot directly from the Macintosh

Finder or Windows Explorer.
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2. Click on the Select Sound File button, found on all sound file recording and

playback contraptions. This opens the Select Sound File dialog box. To open a sound file,

navigate to the file on your computer, select a sound file with the mouse and click Open.

You can press the Play button in the Select Sound File dialog box to preview sound files. If

you check the Auto play check box in this dialog box, sound files are previewed

automatically every time you select a file. If you have a multi-channel audio interface or

two sound cards, the audio output for previewing sound files can be configured to output

to a separate output (such as to headphones). To change the sound file preview output,

go to the Sound File Preview page of the Settings/Preferences Dialog Box (p. 166).

To close a sound file, click on the Close Sound File button.

Automatic Sound File Location

Once you start working with sound files, if you keep your sound files in a fixed location,

AudioMulch will be able to locate them easily every time you open an .amh document. If

you need to move the files, you can ensure that AudioMulch can locate them again by

keeping the sound files used by the .amh document in the same folder, or a sub-folder of

the folder that the .amh document is saved in. Make sure you move both the document

and the folder(s) containing the sound files together. The Save a Copy with Sound Files...

(p. 364) item of the File menu allows you to save the .amh document along with a copy

of all the sound files that it uses. This is the easiest way to store all referenced sound files

along side the relevant .amh document.

If a file does happen to go missing, AudioMulch has an Automatic Sound File Location

feature that finds any files that may have gone astray.

The auto-locate feature searches for sound files in the order listed below. The first location

found is used.

1. The location the sound file was in relative to the document when it was last saved.

2. The location the sound file was in relative to the AudioMulch application file, when

the document was last saved.

3. The absolute location of the sound file, when the document was last saved.
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Manually Locating Missing Sound Files

Once AudioMulch has tried to locate missing sound files using the automatic location

system, it will display a message asking if you want to manually locate the files it hasn't

found. If you choose Skip, or Skip All, the files that have been skipped will remain missing

and you will be asked to locate them again the next time the document is opened.

If you manually locate a missing sound file, AudioMulch uses the new location of the file

to try to locate other missing sound files that were stored in the same folder or a relative

folder. This means that if all of your sound files were stored in one location, and you

moved them all together to a different location, you will only need to manually locate one

missing file in order for AudioMulch to automatically find the rest.
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Export to Sound File
The Export to Sound File function is useful for exporting specific, precisely timed segments

of sound, automated sequences or beat-based music. It can also be used to rapidly export

unstructured sound textures as an alternative to recording in real-time with SoundOut (p.

200) or a FileRecorder (p. 210) contraption.

Select Export to Sound File... from the File menu to display the Export to Sound File

Dialog Box. The dialog box provides settings that you can adjust to control the start and

end times of the exported segment, duration of pre-roll and tail segments, and the sample

rate.

Once you have chosen your settings, click Export to generate the sound file or Cancel to

abort the operation. If you click Export a save dialog box will pop up so you can select a

location to save the file to. This save dialog box also contains the Sample format drop-

down list, which allows you to save at different bit-depths. Click the Save button to save

the file.

The Export to Sound File Dialog provides three different export modes:

1. Clock Synchronised Pattern allows you to create a file with its duration specified in

bars and beats, using the existing time signatures. Sounds exported in this way will

loop exactly from beginning to end, which can make them easy to use in

contraptions like LoopPlayer (p. 234).

2. Timed Segment lets you specify the the duration of the exported segment in

seconds. You can also specify in bars and beats (based on existing time signatures)

where you want the file to start and stop exporting.

3. Processed SoundInFile requires that the SoundIn (p. 196) contraption is configured

to use an input file (not a live input). When you use this option, the input file is

always played from the beginning. The duration of the entire SoundIn file will be

automatically copied to the Duration parameter. The end time of the file can be

changed by editing the End Time setting. This setting selects the bar and beat

number that the file will stop at; it will stop at the beginning of the specified bar and

beat. You can also change the end time of the file with the Duration setting by
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adjusting the length of the file in seconds. The End Time and Duration settings can

also be used to record some extra silence past the end of the input file. The Start

Time can also be changed by adjusting the bar and beat numbers (based on existing

time signatures).

Note: when specifying times in bars and beats in the Export to Sound File dialog box,

AudioMulch always uses the existing time signatures to determine the duration.

When working with clock-synchronised patterns or automated sequences (p. 129) you

may want to select a specific range of bars to be exported. If you select a portion of an

automated sequence with the mouse, then click on Export to Sound File... the Start Time

and End Time will reflect the time range you selected. The exported segment begins at

the start of the bar shown in Start Time and the segment will stop at the start of the bar

specified in End Time. The Duration parameter may be used instead of End Time to select

the number of bars you want to export. This feature is suitable if you're not using an

automated sequence and want to export a fixed number of bars starting at the first bar.

When you adjust either End Time or Duration the alternate parameter will be updated

with the corresponding value.

Note: If you choose an End Time which precedes the Start Time you will not be allowed to

proceed with the Export to Sound File... operation.

The Pre-roll parameter determines how many bars and beats or seconds will be played

before the actual export starts. This can be use if your patch contains reverberating

contraptions (for example reverbs and delays) which you want to be reverberating at the

time the File starts to record. This parameter ensures that all sounds have started, reverbs

are primed and any delay repeats are synchronized. It's usually a good idea to allow at

least 2 bars pre-roll before recording processing which features delays or other

reverberating elements. When exporting loops with any reverberating elements, pre-roll

can be used to ensure that the exported loop wraps around more smoothly. Note that the

pre-roll is always performed so that it completes exactly at Start Time.

Some contraptions continue to reverberate even when no sound is being processed

through them. This reverberation is sometimes called a "tail". You can include the tail in

the exported sound file in the following ways. With the Fixed Tail Duration you can

specify the tail duration in bars and beats or seconds. The Automatic option records the

tail until it has decayed to silence, but you still need to specify a Maximum Duration for

the tail (in bars and beats or seconds) in case it never decays to zero. If you don't want to
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export the tail at all, select No Tail. The tail setting automatically defaults to No Tail unless

one of the other options is chosen.

The Sample Rate parameter allows you to select the sample rate that you export your file

at. You would normally set this to the same rate that you selected for real-time operations,

however, you can select a different rate if you want a higher or lower quality output. You

can select any sample rate, even if your audio interface does not support it. A higher

sample rate can also be used to export a sound file when your computer is not powerful

enough to play the document in real-time at that sample rate.
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Automation Overview

Setting up Parameter Automation........................................130

The Ruler .............................................................................131

The Automation Channel Panels ..........................................132

Automation Grid..................................................................134
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Automation Looping............................................................135

Automation Recording.........................................................135

The Automation Pane allows you to define the way selected parameters change over

time. Automation can be applied to most contraption parameters including the values of

knobs (p. 60), sliders (p. 60) (both single-value sliders and Range Sliders (p. 60)), check

boxes and Contraption Presets (p. 75). Automation can also be applied to some global

parameters such as clock tempo and Metasurface location.

The Automation Pane can be shown or hidden (like the Patcher and Parameter Panes)

from the View menu or by clicking the icon on the View toolbar.

This screenshot of the Automation Pane shows automated parameters from Bassline and

BubbleBlower contraptions.
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This page covers automating parameters and working with the Automation Pane. The

next page, Editing an Automation Sequence (p. 137), describes how to select, cut and

paste, delete and insert time regions of automation to support such tasks as duplicating

and reorder automation segments.

Setting up Parameter Automation

There are two ways to automate a parameter:

1. Right-click on a knob, slider, checkbox or other on-screen control in a contraption's

Parameter Editor and choose Automate from the pop-up context menu. The selected

parameter will be added to the Automation Pane.

2. Select the desired parameter in the Parameter Control dialog box's Parameters tree.

Check the Automate checkbox and the selected parameter will appear in the

Automation Pane. You can open the Parameter Control dialog box by selecting it

from the View menu or by pressing F3. Alternatively you can jump straight to a

specified contraption or parameter in the Parameter Control dialog box by right-

clicking in the background of a contraption's Parameter Editor or on a specific on-

screen control and choosing Parameter Control... from the pop-up context menu,

or Ctrl-double-clicking on an on-screen control.

To remove a parameter from the Automation Pane, you can right-click within the

Automation channel and select Unautomate. Alternatively, you can open the Parameter

Control dialog box via the context menu or the View menu, locate the parameter in

question and uncheck the Automate check box.

You can also temporarily deactivate an Automation channel by depressing the Mute

button at the left hand side of that channel.

To hear the results of changes made in the Automation Pane, you must start the clock by

pressing the Play button on the Transport toolbar. This is because the Automation feature

is time-based.
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Working in the Automation Pane

THE TIME RULER

The Time Ruler at the top of the Automation Pane displays time in bars and beats. There

is a moving cursor (called a Playback Location Indicator) that indicates the current time

position. Clicking and dragging on the Playback Location Indicator allows you to

reposition the current playback position.

At the left end of the Ruler is the Scroll to Follow Playback icon . By clicking this icon

the entire Automation Pane will automatically scroll in synchronization with the clock. You

can also activate this feature by selecting Scroll Automation With Playback from the View

menu. To disable this feature, click on the Scroll to Follow Playback icon again, or click

anywhere within the Automation Pane. This will stop the scrolling but will not stop the

clock or disable the audio output. Clicking once more on the Scroll to Follow Playback icon

will cause the Automation pane to quickly scroll to the current playback location and

continue scrolling from there.

The Time Signature Channel

Above the Time Ruler is a time signature channel, which lets you select and insert time

signature changes. Click on the horizontal line in the time signature channel to insert new

time signatures. To change a time signature, click on it, and select a new one from the

drop down list, or create your own by selecting Other... You can move time signatures by

clicking and dragging the heavy vertical bar line at the left of each time signature change.

Drag a time signature vertically outside the channel to delete it. Go to the Time Signatures

and Rhythmic Units (p. 140) and Editing Rhythmic Patterns (p. 71) pages of this Help File

for more information.

Zooming the Time Axis

There are three ways to zoom in and out along the time axis:

1. Use the zoom in and zoom out buttons located at the bottom of the Automation

Pane, on the right side of the horizontal scroll bar.
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2. Click on the thin button located between the zoom in and zoom out buttons and

drag the mouse horizontally (left and right) while holding the mouse button down to

zoom in and out.

3. The horizontal scroll bar thumb has a small indentation at either end. Click one of

these indentations with the mouse and drag horizontally (left and right) while holding

the mouse button down to zoom in and out.

THE AUTOMATION CHANNEL PANELS

The Automation Pane displays each parameter in an Automation Channel Panel.

To the left of each Channel Panel there is a small control panel with Mute and Record

buttons and handles for resizing the height of the Channel Panel.

• The Mute button disables the automation in the Channel Panel. Toggling the button

will re-enable the automation.

• The Record button enables you to record the Automation in that particular channel.

Toggling the button will enable or disable Automation recording for that channel (see

below for more information about Automation recording).

• Dragging on the handle on the lower edge of a channel panel (or the line between

channel panels) will vertically resize the Channel Panel. This only applies to single and

range value panels, not preset, check-box or trigger panels. (See below for definitions

of these types of panels).

• Dragging on the body of the control panel allows you to reorder the Channel Panels

in the Automation Pane.

There are different types of Channel Panels for displaying different types of parameters.

The five types of Channel Panels allow you to automate:

1. Single value parameters - knobs (p. 60) and single-value sliders (p. 60).

2. Range value parameters - Range Sliders (p. 60).

3. Contraption Preset (p. 75) parameters.

4. Checkbox parameters.

5. Triggers - buttons.

Each of these types of Channel Panels has its own characteristics and set of controls:
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Single Value Channel Panels

• To add a point on the graph, click anywhere on the value line.

• To delete a point, grab it with the mouse and drag it up or down out of the Channel

Panel.

Range Value Channel Panels

• To add a point, click on the upper or lower lines. These indicate the maximum and

minimum values of the range.

• To move both values simultaneously, Shift-Drag on either point.

• To move the opposite point to the one you're currently working with, use the Alt key.

• To move both values simultaneously in opposite directions, Alt-Shift-Drag on either

point.

• To delete a point, grab it with the mouse and drag it out of the Channel Panel.

Contraption Preset Channel Panels

• To add a preset change, click on the horizontal line near the bottom of the Channel

Panel. This creates a preset change marker on the line.

• To move the preset change in time, grab the drag handle at the left hand side of the

marker and drag horizontally.

• Clicking the rollover preset number indicator on the preset change marker opens a

popup menu. Choose the appropriate preset from this list.

• To delete a preset change, grab it with the mouse and drag it out of the Channel

Panel.

Checkbox Channel Panels

• To add a checkbox parameter, click on the horizontal line near the bottom of the

Channel Panel. This creates a checkbox marker on the line.

• To move the checkbox marker in time, grab the drag handle at the left hand side of

the marker and drag horizontally.

• Click the checkbox marker to enable or disable the parameter.

• To delete a checkbox marker, grab it with the mouse and drag it out of the Channel

Panel.
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Trigger Channel Panels

• To add a trigger parameter, click on the horizontal line near the bottom of the

Channel Panel. This creates a trigger marker on the line.

• To move the trigger marker in time, grab the drag handle at the left hand side of the

marker and drag horizontally.

• To delete a trigger marker, grab it with the mouse and drag it out of the Channel

Panel.

As in Contraption Editors (p. 67) the Ctrl key can be used to make fine adjustments to all

automation points and markers. For more information about this see the Making Fine

Adjustments to Parameter Values (p. 67) page of this Help File.

A pop-up value display is revealed whenever the mouse pointer rolls over an automation

point or marker. These pop-ups contain information regarding both the time position and

parameter value of the point or marker.

AUTOMATION GRID

In addition to the time markings in the Ruler at the top of the Automation pane, a time

Grid can be displayed in all the automation channels. The grid can be shown or hidden by

checking or unchecking Show Automation Grid in the View menu. This grid is a guide

that facilitates a higher degree of rhythmic precision when editing Automation channels.

The Automation Grid updates as you zoom in, providing a detailed representation of

rhythmic time at any resolution.

SNAP

Snap provides the most exact approach to beat-based mouse editing within Automation

channels. It can be enabled/disabled for each channel individually by right-clicking within

the empty space of an Automation channel and selecting Snap. Unlike the Automation

Grid itself, Snap is not a global setting as it may only be appropriate for the control of

certain parameters. The resolution of snapping is variable and can be changed using the
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Automation Snap Resolution item of the Edit menu. If Visible grid lines is selected, all

points will snap to the nearest visible grid line when editing. You can also snap to Bars,

Beats, or a specified rhythmic unit, which you select from the drop down list. By default,

Beats are divided into 48 subdivisions, which allows for fine-grained grid snapping. You

can also create your own custom rhythmic units by selecting Other... from the drop down

list. If one of the Automation Snap Resolution values is selected, points will snap to the

nearest relevant value. Snap will function whether the Automation Grid is displayed or

hidden.

Note: pressing and holding down the Alt key while editing points or markers will cause

the edit to behave contrary to the current Snap mode (i.e. if Snap is enabled, Alt click will

edit the point without Snapping). This modifier applies to all but Range values.

AUTOMATION LOOPING

Another feature of Automation is the ability to loop a section of automation over and over

again. This feature is particularly useful for refining an automated section within a larger

piece but can also be used in performance to define a repeating section of automation

that can be modified as the performance progresses.

To enable Looping, click on the Loop icon within the Transport Toolbar or double-click

in the area above the text on the Automation Ruler. This displays a Loop point marker on

the upper edge of the Automation ruler. By grabbing the handles at either end of the

marker with the mouse you can define the length and position of the looped section. By

grabbing the centre of the loop it is possible to move the entire marker to a different

position within the composition. When moving either the handles or the entire loop the

marker will Snap to the current Automation Snap Resolution setting. The loop can be

disabled by re-clicking the Loop button on the toolbar or by double clicking the loop point

markers on the Automation Ruler.

Note: when Automation looping is disabled and then re-enabled by clicking the Loop

icon, the Loop point markers reappear in the position they last occupied.

AUTOMATION RECORDING

It is possible to record parameter changes directly into Automation channels from MIDI

and on-screen controls (knobs, sliders etc.). To record parameter changes, set up

automation for the desired parameters and enable recording for their Automation

Channel Panels by pressing the Record Enable button on the left of each Channel Panel.
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The master record button on the Transport tool bar must also be enabled for

Automation recording to occur. When the Play button is pressed the Automation channel

will start recording. By pressing Ctrl-R on the keyboard the master record can be toggled

on and off at any time, allowing you to drop in and out of Automation record in one or

multiple channels. When more than one Automation channel is recording you can drop in

and out of record more selectively by using each channel's individual record button.

Note: you cannot Undo a recorded Automation sequence.
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Editing an Automation Sequence

Automation time splicing behaves in a similar fashion to the way text may be edited in

a word processor, or the way sound files are edited in a sound file editor. You can set an

insertion point or select a time range and apply familiar operations such as Cut, Copy,

Paste and Delete Time and also use the Insert Time command to insert a specified

amount of time. All of these operations are available from the Edit menu. The

Automation view indicates the current selection as follows: An insertion point is indicated

by a flashing vertical bar in the channels to which it applies. A selected time range appears

as a highlighted background in the applicable channels.

Creating a Selection

The insertion point or selected time range can apply to any combination of automation

channels. To select a time range spanning all channels, click and drag in the center region

of the automation Time Ruler (the cursor will change to an I-beam to indicate that the

mouse is in the time selection area). To set the insertion point across all channels click and

release the mouse in the time selection area of the automation ruler. A selection range or

insertion point can be made for an individual automation channel by clicking and

dragging in empty space within the channel (the cursor changes to an I-beam to indicate

the appropriate area from which to perform the selection). A selection spanning multiple

channels may be created in similar fashion by beginning a selection on one channel and

dragging the mouse across other channels to include them in the selection.

Modifying an Exisiting Selection

Once the insertion point has been set, or a time range has been selected, it is possible to

modify the selection by holding down the SHIFT and/or CTRL keys on the keyboard while

clicking or dragging with the mouse.

The selected time range can be modified by holding down the SHIFT key and clicking and

dragging in the ruler, or in any channel which is currently part of the selection. By SHIFT-

clicking before the beginning of the current selection range (or insertion point), the

beginning of the selection can be modified. By SHIFT-clicking after the end of the current

selection range, the end of the selection can be modified.
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SHIFT-clicking can also be used to extend the selection across currently unselected

channels. By SHIFT-clicking in an unselected channel, the channel and all channels

between it and the current selection become part of the selection. SHIFT-clicking always

modifies the start or end location of the selection, for this reason, using the CTRL key (see

below) may be more useful for altering which channels are included in the selection.

It is possible to add or remove channels from an existing selection or insertion point by

clicking while holding down the CTRL key on the keyboard. CTRL-clicking a channel within
the selected time range will toggle the channel between being a member and not being a

member of the selection (or insertion point.) A CTRL-click and drag across multiple

channels will include or preclude them from the selection.

Insert Time

When the insertion point is set for one or more channels the Insert Time command from

the Edit menu lets you insert a specified period of time into the selected channels. The

time is specified in bars and beats, based on the time signature present at the insertion

point.

Delete Time

To delete the selected time range in the selected channels, choose Delete Time from the

Edit menu (CTRL+DELETE on the keyboard).

Cut, Copy and Clear

You can access Cut, Copy, Clear and Delete Time from the Edit menu. Use Cut and

Copy to place the automation selection on the clipboard. When you use Cut, the selected

time range will be removed from the selected channels. Select Clear (or use the DELETE

key) to clear the automation points in the selected time range in the selected channels.

Paste

The Paste command from the Edit menu can be used to insert the contents of the

clipboard into the automation selection. When an insertion point is selected, the Paste

command will insert the time range in the clipboard into the automation view and push all

following automation forward in time. When a time range is selected in the Automation

view, Pasting will replace the selected time range with the time range on the Clipboard.

Automating AudioMulch - Editing an Automation Sequence 138



The Paste command behaves slightly differently depending on whether the Clipboard

holds a clipping from only one automation channel, or if it holds clippings from multiple

channels.

When the Clipboard contains only a single channel, a Paste operation may be performed

on any compatible channel. Channels are considered compatible if they are of the same

type (ie Trigger, Preset, Boolean (check box), Value or Range) and in the case of Value and

Range channels the allowable value range must also match. Note that to use this Paste

mode, the insertion point must not include multiple channels.

When the Clipboard contains more than one channel of automation information, data is

always pasted into the same channel from which it was cut or copied. Irrespective of the

number of channels on the Clipboard, a Paste operation only ever applies to the channels

that are part of the selected range or insertion point – channels on the clipboard which

are not selected are not pasted. When the selection spans multiple channels, and some of

those channels are not present on the clipboard the Paste command will insert blank time

into the channels not present on the clipboard.
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Time Signatures and Rhythmic
Units
Time Signatures ...................................................................140

Rhythmic Units.....................................................................143

AudioMulch supports two concepts used to deal with musical rhythm: time signatures and

rhythmic units (rhythmic durations). Time signatures are used for describing the grids used

for rhythmic patterns and the automation timeline, rhythmic units are used in contraptions

that deal with clock synchronized pulses, such as the Quantize setting on granulators or

delay times in the tempo-synced SDelay contraption. AudioMulch uses numbers, fractions

and ratios to describe these values rather than western music notation symbols.

Time Signatures

Rhythmic music is usually based on cycles of regular, counted beats or pulses. A time

signature specifies how many beats there are in each rhythmic cycle. In western music

each cycle is called a “bar.” A time signature also specifies the duration of each beat.

Western pop music usually has four beats in a bar, but there are many other possibilities,

found in classical and folk music.

A time signature is written as a fraction, for example:

The upper number (the numerator) is the number of beats in each bar, and the lower

number (the denominator) forms a fraction representing the duration of each beat. The

above example indicates bars comprising of 3 beats, each of which has the duration of a

quarter note, i.e. 3 times 1/4.

Often the lower number is only important in understanding the relative duration of beats

when the time signature changes. For example, when the time signature changes from 3/
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4 to 3/8, the duration of each beat halves (the effective beat-rate or tempo doubles). The

lower number also determines the relationship of beats to the global tempo, and in

AudioMulch to any external synchronization such as MIDI clock sync.

GROUPING BEATS WITHIN A BAR

There are common-practice rules for how beats are grouped within each bar. For example,

6/8 is usually grouped as two groups of three beats. In performed music this may

determine how the performer accents each beat. However, in the computer there is no

such interpretation – each beat is equal. That said, it may still be useful to group beats to

make it easier to visually orient yourself within an bar – AudioMulch will draw grid lines

with different weights to indicate the grouping, and with custom time signatures it is

possible to explicitly specify how beats are grouped (see below).

EDITING TIME SIGNATURES

AudioMulch uses time signatures whenever you specify a rhythmic pattern, such as in the

Drums contraption or in the Automation timeline. The main use of time signatures is to

select the grid used for snapping events and pattern lengths. Some contraptions also

synchronize their mute/unmute controls to bar boundaries.

On each timeline, AudioMulch displays a Time Signature Channel. Click on the

horizontal line in the center of the channel to create time signature changes. Clicking on

the time signature numbers displays a popup context menu with a list of different time

signatures that you can select. You can also choose Other... to specify a custom time

signature (see below). By clicking on the dark bar line to the left of the time signature

numbers you can drag time signature left or right to determine the time at which the time

signature will change. As with other automation channels, you can delete a time signature

by dragging it up or down off the channel.

When dragging time signatures they will snap to the beat boundaries of the preceeding

time signature. The time signature channel displays special indicators when a time

signature change is not aligned to a bar or beat boundary (which might cause a rhythmic

glitch).
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When the time signature change is beat-aligned but not aligned to a bar boundary an

asterisk (*) is displayed at the start of the preceding bar. For example, in the image above

notice how the second 4/4 bar only has 3 beats.

When a time signature change is not beat-aligned an indicator showing three vertical

break marks is drawn at the left of the time signature change. Usually this happens when

you change the preceding time signature so the next one is no longer beat aligned.

CUSTOM TIME SIGNATURES

Selecting Other... from the time signature's popup context menu displays a dialog box that

lets you specify a custom time signature. Two text boxes let you type in the numbers for

the upper and lower part of the time signature fraction. You can enter any integers you

like into these boxes, for example 13/27 is a valid time signature in AudioMulch. Using

unusual numbers in the denominator (lower number) is most useful when creating

multiple patterns with beats with different relative durations. For example, two Drums

contraptions might be set up with time signatures of 13/27 and 13/26, resulting in a

complex but predictable relationship between rhythms in each.

Once a custom time signature has been created it will be displayed at the top of the

popup list of time signatures so you can select it from any other time signature editor in

AudioMulch. Custom time signatures are stored with the document, and only remain in

the list while they are being used. Unused time signatures are discarded when the

document is closed.

Grouping beats

It is possible to explicitly specify groupings of beats within a bar. For example 5/4 can be

written as 2+3/4 or 3+2/4 as shown below. More complex groupings such as

(3+2+2)+(3+2+2)+(2+2+3+2+2), the 25 pulse Bulgarian Sedi Donka, are also possible.

AudioMulch indicates the groupings by drawing grid lines with different thicknesses.

You can group beats by using a combination of plus signs + and brackets (). Nested

groups are also possible, eg 2 + (1+3 + (2+1))/4
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Fractional Denominators

AudioMulch also allows the lower number (the denominator) to be specified as a fraction

of two integers. This provides another way to create patterns with the same number of

beats but with different durations for each beat.

For example, bars of 4/(8/3) are 1.5 times longer than bars of 4/4. In 4/(8/3) the beat

duration is 1/(8/3) which simplifies to 3/8, or, 1.5/4 (although the latter isn't a valid

AudioMulch time signature).

Rhythmic Units

AudioMulch lets you specify some rhythmic quantities as multiples of a rhythmic unit. For

example: granulator contraption quantization periods, delay times, and automation snap

resolutions. The popup context menus for selecting rhythmic units present the standard

options, usually fractions of a whole note. These fractions are equivalent to the fractions

formed by the denominators (lower numbers) of time signatures, as described above.

Triplets are indicated by the [3:2] ratio next to the fraction.

As with time signatures, you can specify custom rhythmic units by selecting Other... from

the drop down list. When you select Other..., a dialog box is displayed which allows you to

specify the rhythmic unit as a fraction optionally combined with a tuplet ratio.

The tuplet ratio X:Y (where X and Y are integers) means “X pulses take the time of Y

pulses specified by the rhythmic unit fraction". Common examples are 3:2 (three in the

time of two, or triplets) and 5:2 (five in the time of two, or quintuplets), but more complex

relationships are possible.

Time Signatures and Rhythmic Units 143



Using MIDI with AudioMulch
Controlling AudioMulch Parameters from MIDI .............................................................145

Synchronizing AudioMulch to Other MIDI Hardware and Software................................152

Using MIDI with AudioMulch 144



Controlling AudioMulch Parameters from
MIDI

In AudioMulch you can use MIDI to control various aspects of the program. Messages

from a MIDI device can be used to control the parameters of contraptions, the

Metasurface and AudioMulch's clock. You can also use Audiomulch to play VST

instruments from your MIDI keyboard or other MIDI device, such as a MIDI sequencer,

fader box, or other software capable of sending MIDI controller messages.

A knob, slider or other MIDI controller can be quickly and easily mapped to a parameter

using AudioMulch's Quick-Mapping feature. You can also create and fine tune your

mapping settings via the Parameter Control window.

Further information about all of these features can be found in the sections below.

With AudioMulch you can also play in time with an external MIDI clock source by

synchronizing AudioMulch with another piece of audio software or hardware such as a

MIDI sequencer or a drum machine. Go to the Synchronizing AudioMulch to Other MIDI

Hardware and Software (p. 152) page of this Help File for more information.

• Setting up MIDI Control (p. 145)

• Mapping a Contraption Parameter to a MIDI Control Source Using Quick-Mapping (p.

146)

• Mapping a Contraption Parameter to a MIDI Control Source with Parameter Control

(p. 147)

• MIDI Control of the Metasurface (p. 148)

• Parameter Control for VST Plugins (p. 148)

• MIDI Control of the Clock (p. 149)

• Sources Tab (p. 149)

• Mapping Tab (p. 149)

SETTING UP MIDI CONTROL

Before you create your parameter mapping settings, set up AudioMulch for MIDI control.

First, make sure that your MIDI device is connected to your computer and switched on.
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If you're connecting a new MIDI device to your computer, assign your device to one of

AudioMulch's MIDI input ports:

Open the Settings/Preferences dialog box (on Windows select Settings... from the Edit

menu; on Macintosh select Preferences... from the AudioMulch application menu) and

select MIDI Input and Control from the list. Select a MIDI device from the drop-down

menu (your device should appear in the menu) of one or more of AudioMulch's MIDI

input ports (MidiIn1 — MidiIn8).

With your device connected and assigned to an input port, enable MIDI control by

selecting Enable MIDI from the Control menu or by clicking the Enable MIDI icon on

the Transport toolbar.

If you have already assigned a MIDI device to an AudioMulch input port in a previous

session but it is not connected or switched on, you can connect it and/or switch it on

while AudioMulch is running. However, before AudioMulch will receive messages from it

you will need to disable and re-enable MIDI by selecting Enable MIDI from the Control

menu or by clicking the Enable MIDI icon on the Transport toolbar.

MAPPING A CONTRAPTION PARAMETER TO A MIDI CONTROL SOURCE
USING QUICK-MAPPING

Quick-mapping allows you to rapidly assign MIDI controllers to parameters and is a

particularly useful method to use during a performance.

First, make sure your MIDI device is switched on and connected, selected in AudioMulch's

settings and that MIDI control is enabled, as described above in Setting up MIDI Control

(p. 145).

In a contraption's Property Editor, right-click on the controller of the parameter you want

to control (e.g. a knob or a slider) and select Quick Map MIDI Control from the popup

context menu, or Alt-double-click. Move the controller (i.e. a slider, knob or wheel) on

your MIDI device that you want to use to control the parameter. When AudioMulch

receives your controller message it will close the Quick-Map dialog box and automatically

map the controller to the parameter you selected.
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To view and edit your mapping settings, use the Parameter Control window (see Mapping

a Contraption Parameter to a MIDI Control Source with Parameter Control (p. 147)

below).

MAPPING A CONTRAPTION PARAMETER TO A MIDI CONTROL SOURCE
WITH PARAMETER CONTROL

You can use the Parameter Control window to create, view and edit your settings for

controlling parameters with MIDI.

Open the Parameter Control window by selecting it from the View menu or by pressing

the F3 key on your keyboard. On the left of the Parameter Control window a menu

displays all of the contraptions in the current document. Expand the menu items by

clicking on the + (Windows) or arrow (Macintosh) symbols, or by double-clicking on a

contraption name in the list. This will display the controllable parameters for that

contraption. Click on a parameter to select it, and the MIDI control source settings for that

parameter will appear on the right hand side of the window in the Sources tab.

In the Sources tab you can manually enter your MIDI control source settings: Control

Type, Port / Channel, and Control number.

Alternatively, you can get AudioMulch to automatically generate these settings. To do this,

first, make sure your MIDI device is switched on and connected, selected in AudioMulch's

settings and that MIDI control is enabled, as described above in Setting up MIDI Control

(p. 145). Then click the Capture Next MIDI Controller button in the bottom right

corner of the Sources tab, then manipulate a controller on your MIDI device. When

AudioMulch receives your controller message it will automatically register that controller as

the control source.

An icon representing a MIDI connector is displayed next to each parameter in the list that

has a MIDI modulation source assigned to it.

Note: You can also open the Parameter Control window with your parameter

automatically selected. To do this, right-click on the parameter you want to control in the

contraption's Property Editor and select Parameter Control from the popup context

menu. Alternatively, Ctrl-double-click on the controller (e.g. a knob or a slider) and the

Parameter Control window will open. If you want to open the Parameter window with all

the parameters for a contraption displayed and ready for selection, right-click on the title
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bar of the contraption's Property Editor and select Parameter Control from the popup

menu.

MIDI CONTROL OF THE METASURFACE

The X and Y parameters of the Metasurface can be externally controlled with MIDI. An XY

pad, for example, is an ideal MIDI controller for controlling the Metasurface. Alternatively

you can use two separate controllers, such as a pair of knobs or sliders. Metasurface

parameters are mapped to MIDI controllers via the Parameter Control window.

To set up MIDI control of the Metasurface:

1. Follow the instructions for setting up MIDI control as described above (see Setting up

MIDI Control (p. 145) above).

2. Open the Parameter Control window from the View menu. Find the Metasurface in

the menu and double click it to access the Metasurface's Interpolate_X and

Interpolate_Y parameters.

3. Select a parameter by clicking on it.

4. In the right side of the window in the Sources tab, set the Control Type and Control

number of your MIDI control source for both the Interpolate_X and Interpolate_Y

parameters.

You can also use MIDI quick-mapping or jump directly to the Interpolate_X and

Interpolate_Y parameters in the Parameter Control window by right-clicking on the

Metasurface's Interpolation Surface and selecting from the items in the X Axis and Y Axis

menus.

PARAMETER CONTROL FOR VST PLUGINS

You can control most of the parameters of your VST plugins via MIDI control. You can set

up the MIDI control mappings for your VST plugin parameters using the Parameter Control

window (see Mapping a Contraption Parameter to a MIDI Control Source with Parameter

Control (p. 147) above).

When a VST plugin is displayed using the Generic Editor (right-click in the VST contraption

editor title area and choose Generic Editor from the popup menu) it is also possible to use

MIDI quick mapping by right clicking or Alt-double-clicking the sliders in the Generic

Editor (see Mapping a Contraption Parameter to a MIDI Control Source Using Quick-

Mapping (p. 146) above).
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MIDI CONTROL OF THE CLOCK

In the Parameter Control window you can set up MIDI control for AudioMulch's clock

parameters, including Tempo and transport functions (start, stop, etc.). Double-click on

Clock in the menu on the left to access these controls. You can also set up MIDI control

for these parameters by right-clicking the buttons on the Transport Toolbar and selecting

from the context menu.

Transport functions such as Start and Stop use the trigger parameter type. It is possible to

specify how incoming MIDI signals are interpreted as triggers using the Mapping Tab

described below.

SOURCES TAB

Here you can edit the MIDIIn port, controller type, number and channel. These settings

can be assigned automatically: First, make sure you have followed the steps in see Setting

up MIDI Control (p. 145) above, then click the Capture Next MIDI Controller button in

the bottom right corner of the Sources tab. The next controller received will be assigned

as the control source.

MAPPING TAB

Use the Mapping tab to fine tune the way your MIDI controller modulates the selected

parameter.

When working with numeric parameters the Mapping tab allows you to specify an Upper

and Lower limit, Smoothing and a Mapping Curve. When working with boolean
parameters (an on/off value, a check box) the Mapping tab allows you to select Toggle

mode, Inverted mode, and to set a switching Threshold. When working with trigger
parameters (such as the Tansport buttons and buttons on the LiveLooper) the Mapping tab

allows you to set a trigger threshold. These settings are described below.

Numeric Parameters

Upper Limit and Lower Limit denote the range over which the parameter is modulated.

For example, by setting the Upper Limit to 300 and the Lower Limit to 100, the maximum

input value from the MIDI controller will translate to a parameter value of 300, and the

minimum input value will map to a value of 100.
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Smoothing applies an averaging algorithm to the MIDI data to dampen any rapid

fluctuations in controller message values. A longer smoothing time results in more gradual

parameter value changes over time.

The mapping Curve interface allows you to adjust the way the controller input values are

mapped to the parameter values over the range between the upper and lower limits. The

curve can be edited in the same way as editing Automation curves: Click and drag to

move handles; click on the line to add new handles; drag handles outside the mapping

curve interface to delete them. The curve will always have at least two handles to specify

the mapping at the upper and lower limits.

Boolean (checkbox) Parameters

MIDI mapping of boolean (checkbox) parameters is based on detecting whether the MIDI

controller value is above the threshold set in the Threshold number editor. In the normal

mode (Toggle checkbox unchecked), when the MIDI controller value is above the

threshold, the parameter value will be on and when the MIDI controller value is at or

below the threshold the parameter will be off. You can change the Threshold to determine

the point at which the parameter switches. By checking the Inverted check box, the

behavior is reversed such that when the MIDI controller value is at or below the threshold

the parameter value is on and when the MIDI controller value is above the threshold, the

parameter value is off.

The Toggle checkbox alters the way the mapping works. When Toggle mode is selected,

the parameter value is toggled (switched to the opposite state) each time the MIDI

controller value crosses the threshold in a single direction. In Toggle mode, when the

Inverted checkbox is unchecked, the parameter value is toggled whenever the MIDI

controller value passes above the threshold (from at or below it to above it.) When the

Inverted checkbox is checked, the parameter value is toggled whenever the MIDI controller

value passes from above the threshold to at or below it.

Trigger (button) Parameters

As with MIDI mapping of boolean parameters (described above), mapping trigger

parameters is based on detecting whether the MIDI controller value is above the threshold

set in the Threshold number editor. The parameter will be triggered every time a source

MIDI message is recieved whose value is above the set Threshold.
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Contraption Preset Number and Metasurface Snapshot Number

The reason for this setting is primarily for backwards compatibility with earlier AudioMulch

versions.

AudioMulch labels the first preset or snapshot slot, "1" and counts upwards from there.

By default, this first preset/snapshot corresponds to the first MIDI controller values (such as

Control Change values or Program Change numbers). The first MIDI value may be labeled

0 or 1 on your controller, since some controllers display MIDI values in the range 0-127

while others display them in the range 1-128.

The Offset number editor alters the correspondence between the AudioMulch Preset or

Snapshot number and MIDI controller values. This works by adding the Offset to the

incoming MIDI value. The default Offset setting of 0 (zero) means that the first incoming

MIDI Controller value corresponds to the first Preset or Program change. Offset values can

be positive or negative. Positive Offset values result in the first MIDI value recalling higher

Preset (or Snapshot) numbers. For example, if Offset is set to 1, sending a MIDI controller

value of 0 (the first value) will recall AudioMulch preset 1. Negative values lead to earlier

MIDI values being ignored. For example, if Offset is set to -1, sending a MIDI controller

value of 0 will result in that message being ignored.

Note that prior to AudioMulch version 2.2, the effective Offset was always -1. For

backwards compatibility old documents are loaded with that value.
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Synchronizing AudioMulch to Other MIDI
Hardware and Software

With AudioMulch's MIDI clock synchronization features you can synchronize AudioMulch

to hardware or software that can send or receive MIDI clock sync. Commonly used

hardware includes MIDI sequencers, drum machines and groove boxes. You can also

synchronize AudioMulch with other software. When using this feature, the tempo,

rhythmic timing and Automation location of AudioMulch and the hardware/software

stay locked in tight synchronization. This lets you perform synchronized, rhythmic music

using AudioMulch in combination with other hardware and software.

MIDI clock sync works by having a master clock that generates and sends clock sync to a

slave, which receives and chases clock sync. AudioMulch can work as a MIDI Clock

Master and/or as a MIDI Clock Slave. These two modes are handled separately by

AudioMulch's Generate MIDI Sync and Chase MIDI Sync features. You can also

generate and chase MIDI sync at the same time.

MIDI synchronization is only useful if you're using an AudioMulch document that employs

clock-based contraptions to create rhythms (e.g. Bassline, Drums, quantized granulators,

etc).

How to use Generate MIDI Sync

Use Generate MIDI Sync when you want AudioMulch to act as the MIDI Clock Master

for other hardware or software such as a drum machine or MIDI sequencer. The other

hardware or software should be configured as a MIDI Clock Slave, so that it follows

AudioMulch's clock's start, stop and timing.

To start a MIDI Clock Slave synchronized to AudioMulch:

Before following the steps below, ensure you have a MIDI Clock Slave such as a
drum machine or MIDI sequencer connected to your computer via a MIDI interface.
The MIDI output of the computer must be connected to the MIDI input on your
MIDI Clock Slave.

Now, configure AudioMulch to send MIDI clock sync to the MIDI Clock Slave:
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1. Open the Settings/Preferences dialog box. To do this in Windows, open the
Edit menu and choose Settings... On Macintosh, open the AudioMulch
application menu and choose Preferences...

2. Choose MIDI Sync from the list on the left. The MIDI Sync page will open on
the right.

3. In Generate MIDI Sync settings, choose a Device from the drop down list –
this should correspond to the MIDI interface output that your MIDI Clock Slave
is connected to. Note: It is possible to select the same Device for MIDI sync and
MidiOut contraptions.

Then, make sure the MIDI Clock Slave is configured to receive MIDI clock
sync:

• Sometimes this mode is called "MIDI clock sync SLAVE". If you're unsure how
to do this, check the instructions for your hardware/software.

You can now enable Generate MIDI Sync:

1. Open the Control menu and choose Generate MIDI Sync.

2. Press the Play button on the Transport toolbar. When you start and stop
AudioMulch's clock, the MIDI Clock Slave will start, stop and synchronize with
AudioMulch.

Using Generate MIDI Sync with "Pattern Mode" devices (Korg Electribe™, Nord

Micromodular et al)

When Generate MIDI Sync is enabled, AudioMulch usually uses MIDI's standard Song

Position Pointer message (SPP) to inform the MIDI Clock Slave of the sequence location

(beat position). Some hardware does not support MIDI SPP. As a result, some hardware

may start, stop and synchronize to the correct tempo, but may not always start on the

correct beat. This is common with simple "pattern mode" sequencers such as the Nord

Micromodular and Korg Electribe™ family. AudioMulch's Generate MIDI Sync has an

alternative mode for compatibility with such hardware. You can select the alternative

mode in the Settings/Preferences Dialog Box's MIDI Sync settings. See Settings/

Preferences Dialog Box: MIDI Sync Settings (p. 173) for details.

How to use Chase MIDI Sync

Use Chase MIDI Sync when you want AudioMulch to start, stop and follow the beat of

another (hardware or software) MIDI Clock Master, such as a drum machine or MIDI
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sequencer. The hardware or software will act as the MIDI Clock Master, and AudioMulch

will act as the MIDI Clock Slave, locking to the timing of the MIDI Clock Master.

To start AudioMulch synchronized with the MIDI Clock Master:

Before following the steps below, ensure you have a MIDI Clock Master such as a
drum machine or MIDI sequencer connected to your computer via a MIDI interface.
The MIDI output of the MIDI Clock Master must be connected to a MIDI input on
your computer.

Now, configure AudioMulch to receive MIDI clock sync from the MIDI Clock
Master:

1. Open the Settings/Preferences dialog box. To do this in Windows, open the
Edit menu and choose Settings... On Macintosh, open the AudioMulch
application menu and choose Preferences...

2. Choose MIDI Sync from the list on the left. The MIDI Sync page will open on
the right.

3. In the Chase MIDI Sync settings, select a Device from the drop down list on
the right – this should correspond to the MIDI interface input that your MIDI
Clock Master is connected to. Note: It is possible to select the same Device for
MIDI sync, MidiIn contraptions and MIDI parameter control (p. 145).

Then, make sure the MIDI Clock Master is configured to transmit MIDI clock
sync:

• Sometimes this mode is called "MIDI clock sync MASTER". If you're unsure how
to do this, check the instructions for your hardware/software.

You can now enable Chase MIDI Sync:

• Open the Control menu and choose Chase MIDI Sync. When you start and
stop the MIDI Clock Master, AudioMulch's clock will start, stop and synchronize
with it.

Note:

• MIDI clock sync only works when AudioMulch's audio is enabled. You can

ensure audio is enabled by clicking on the Enable Audio button (make
sure it's down).

• AudioMulch will take a small amount of time to lock synchronization; for this
reason it is advisable to send a one bar count-in to ensure clean sync.

• Due to the inherent latency in generating audio in a computer, AudioMulch
often can't act fast enough to synchronize to the first MIDI clock (beat) it
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receives. You may find that AudioMulch skips the down-beat or first 16th note
when the external clock master starts (or when it re-syncs after looping). One
solution is to send a one bar count-in as mentioned above. In some cases, an
alternative solution is to specify a Chase MIDI Sync Offset (see below, and
also Settings/Preferences Dialog Box: MIDI Sync Settings (p. 173)) so that
AudioMulch's clock synced beats are delayed more than your sound card's
audio latency.

Offset settings: when AudioMulch plays ahead or behind
the beat

Sometimes AudioMulch plays slightly ahead of or behind the beat (relative to the other

hardware/software) when chasing or generating MIDI sync. In every computer there are

many sources of latency that can delay audio, MIDI or both. Sometimes this leads to slight

de-synchronization, and AudioMulch cannot always automatically compensate for these

delays. You can resolve this problem by manually tuning timing offset settings to better

synchronize AudioMulch with your other devices. Use AudioMulch's synchronization

Offset settings to move AudioMulch's (or a MIDI Clock Slave's) clock ahead of or behind

the beat with sub-millisecond resolution. See Settings/Preferences Dialog Box: MIDI Sync

Settings (p. 173) for details.

See Also

Settings/Preferences Dialog Box: MIDI Sync Settings (p. 173)
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The Metasurface
With the Metasurface you can change multiple contraption parameters at once just by

moving the mouse. You can store snapshots of settings for an entire document and

selectively recall parameter values from these snapshots. This is similar to contraption

presets (p. 75), except that it can be applied to some or all parameters in the entire

document, not just those of a single contraption. The snapshots can be placed in the

Metasurface window and you can move between them by clicking and dragging the

mouse around the surface.

To display the Metasurface select the Metasurface item from the View menu, click the

Metasurface button on the Views toolbar, or use the keyboard shortcut (F10 on

Windows, Command-0 on Macintosh).

Open the Metasurface1.amh (p. 353) example file for an example of how the Metasurface

can be used to move smoothly between different parameter settings. To open this file,

click on Open in the Files menu, and select the Examples folder. Select this example file

from the list.
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Metasurface window panes

The Metasurface window has three panes: the Interpolation Surface, the Snapshot List

and the Parameter Selection Tree. Each is described below.

THE INTERPOLATION SURFACE

The Interpolation Surface lets you place snapshots in arbitrary positions and move

smoothly between them by dragging the mouse. The surface has two modes: the

snapshot placement mode and the interpolation mode. You can switch between modes

using the Interpolate button at the top of the Metasurface window, or by right-

clicking and selecting Interpolate from the popup context menu. In snapshot placement

mode you can move snapshots around the surface. To do this, place the mouse over the

small circle icon on the snapshot you want to move. Once the circle lights up you can click

on the snapshot and drag it around the window. In interpolation mode, clicking and

dragging on the surface interpolates between the nearest snapshots. CTRL-clicking on the

interpolation surface (COMMAND+click on Macintosh) creates a new snapshot (based on

the settings at that point of the surface) and simultaneously places it on the surface.
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You can view the Interpolation Surface in full screen mode by clicking on the View Full

Screen button at the top of the Metasurface window, or by right-clicking and

selecting View full screen from the popup context menu. Exit full screen mode using the

right-click menu or by pressing the escape key.

THE SNAPSHOT LIST

The Snapshot List shows the list of snapshots. Each of the snapshot "cells" in the list

have Store , Recall and Clear buttons on them. To create a new snapshot

click the New Snapshot button above the Snapshot List, or click on the Store

button in a snapshot cell. To name the snapshot, single-click on it in the list and type in a

name. Alternatively, you can create a name for a snapshot before creating the snapshot

itself. To do this, type in the text edit box to the left of the New Snapshot button. Then

click on the New Snapshot button and a new snapshot will appear with the name you

just typed. Another way of getting the new snapshot to appear in the list is to hit

CTRL+ENTER after you've typed the name. You can recall a snapshot by double-clicking on

the snapshot's name in the list or by clicking the Recall button on the snapshot's cell.

To delete a snapshot from the list, Click on the Clear button.

Right-clicking on a snapshot displays a popup context menu that lets you recall a

snapshot, store a new set of values in it, delete the snapshot, rename it, or change the

color that is used to display the snapshot on the surface. You can also access the

Parameter Control menu and Quick-Map MIDI Control of snapshot recall from this

popup menu. You can reorder the snapshots in the list by dragging them with the mouse

from one slot to another. To place a snapshot on the Interpolation Surface, drag it onto

the surface from the list. You can place each snapshot on the surface multiple times. To

remove a snapshot from the surface simply drag it off the surface while in interpolation

mode.

THE PARAMETER SELECTION TREE

The Parameter Selection Tree lets you choose which parameters will be recalled by the

Metasurface. The chosen parameters are indicated by the check boxes next to each

parameter. All available parameters are listed under each contraption and all are chosen by

default. You can click on the check box next to a parameter to enable (checked) or disable
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(unchecked) it from being recalled by the Metasurface. For example, you can disable

parameters that you control by other means such as Automation or MIDI control. Only the

parameters that have been checked will be recalled when using the Metasurface's

Interpolation Surface or when recalling individual Metasurface snapshots. Clicking the

check box of a contraption (rather than a parameter) will enable or disable all parameters

belonging to that contraption.

Right-clicking anywhere on the Parameter Selection Tree displays a popup context menu

that lets you enable or disable multiple parameters at once. Choose Enable All

Parameters or Disable All Parameters to enable or disable all of the document's

parameters at once. Choose Enable Selected Parameters or Disable Selected

Parameters to enable or disable only the selected (highlighted) parameters. You can

select multiple parameters at once by clicking on parameters using the usual mouse

dragging and modifier key techniques: click and drag the mouse to select multiple

parameters, use CTRL-click or SHIFT-click to extend or modify the selection.

The Metasurface is limited to controlling only numeric parameters; for example it can't be

used to switch sound files or patterns.

MIDI and Automation Control of the Metasurface

You can control the Metasurface interpolation location using automation or MIDI control.

You can also recall Metasurface snapshots under MIDI control. To configure automation or

MIDI control you can use either the Parameter Control window or the Quick-Map MIDI

and Automate context menu items. This works in the same way as automating or MIDI-

controlling contraption parameters.

To use the Parameter Control window, select Parameter Control in the View menu or

press F3. Open the Metasurface item in the Parameter Control Window's Parameters tree

and select Interpolate_X, Interpolate_Y or Shapshot Number. The Interpolate parameters

correspond to the horizontal and vertical position of the interpolation cross hairs on the

Interpolation Surface. You can enable Automation for these parameters by checking the

Automate check box on the right. Similarly, you can select MIDI control sources in the

same way that you would for contraption parameters. The Snapshot Number item in the

Parameter Control Window's Parameters tree relates to the recalled snapshot in the

Snapshot List. You can select a MIDI control source for it.

You can access these functions quickly by right-clicking the Interpolation Surface or the

Snapshot List. In the Interpolation Surface the context menu has two relevant items: X Axis
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and Y Axis, relating to controlling the horizontal and vertical axis of Metasurface

interpolation. From the X Axis and Y Axis submenus you can choose from Parameter

Control, Quick-Map MIDI Control... or Automate. When you click in the Metasurface

Snapshot List the Quick-Map MIDI Control... context menu item allows you to set a MIDI

control source for recalling Metasurface snapshots.

Please refer to the Automation Overview (p. 129) and Controlling AudioMulch Parameters

from MIDI (p. 145) pages of this Help file for further information about Automation and

MIDI Parameter Control.
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Guide to the Document
Switcher Window
The Document Switcher is a floating window that contains a list of AudioMulch (.amh)

documents. You can use this window to switch between a list of documents, either by

using the mouse, or under MIDI control. You can open and close the window using the

Document Switcher menu item in the View menu, by clicking on the icon in the

toolbar, or by pressing F9.

Document Sets

The Document Switcher works with a Document Set (.ams file), which is a file containing a

list of .amh documents. The first four buttons on the Document Switcher toolbar

provide New, Open, Save and Save As functions. These buttons allow

you to open an existing set, create a new document set, and save sets.

Note: The Document Set only stores the file paths where the .amh documents are

located; it doesn't actually contain the document data.
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Documents Grid

The Documents Grid contains slots for up to 128 documents. To place a document in a

particular slot, use the slot's Select Document button and navigate to the document

you want to list. You can also drag and drop AudioMulch documents from Macintosh

Finder or Windows Explorer into the Documents Grid. You can select a slot by clicking on

it, which will highlight the slot with a dotted line.

Use the Insert Current Document button in the toolbar to insert the currently loaded

document into the selected slot. Clear a slot by clicking on the Clear Document button

. Click on the Clear All button in the toolbar to clear all slots.

You can move documents between slots by dragging and dropping them with the mouse.

Dragging a document into an already occupied slot causes the other documents to shuffle

up or down. If you want to replace the document in a particular slot, hold down the Alt

key while you drag a new document into the slot. If you want to duplicate a document

and place the copy in another slot, hold down the Ctrl key while dragging the document.

The original copy of the document will remain in its original slot as well.

To open a document from the Documents Grid, double-click on it from the list. The

currently loaded document will be highlighted with a tinted background colour in the grid.

If a document cannot be found its icon will be displayed with a question mark in the

Documents Grid.
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You can also use the keyboard to change the selected document. Use the up and down

arrows to select a new document, and hit the the enter key to load the document.

When using the mouse or the keyboard to load a new document from the Documents

Grid, you will be prompted to save any changes that have been made to the current

document. You can suppress this prompt (and discard any changes) by holding down the

Ctrl key when double clicking or pressing enter.

MIDI Control

You can configure the Document Switcher to load documents under MIDI control on the

Document Switcher page of Settings/Preferences Dialog box (p. 175). You can select the

MIDI control source that will be used to switch documents, and select how AudioMulch

will save any changes made to the current document before loading a new document.

With these settings you can switch documents via MIDI without any other interaction with

the user interface. The Document Switcher Settings are stored globally and are not specific

to the currently loaded Document Set.

On Windows you can access the Settings/Preferences dialog box by choosing Settings...

from the Edit menu or by pressing the F4 function key. On Mac OS you can access the

Settings/Preferences dialog box by choosing Preferences... from the AudioMulch

application menu or by pressing command-, (command-comma).

The Enable MIDI document switching icon on the Document Switcher toolbar enables

MIDI controlled document switching. Note that both Audio and MIDI control must be

enabled in the main AudioMulch window for MIDI controlled document switching to

operate.
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Guide to the Notes Window
The Notes window is a simple notepad that you can use to write down information about

an AudioMulch .amh document. You can use it for performance notes or other

information you want to remember. Your notes will be stored in the current AudioMulch

document when you save it.

The Notes window will also pop up when you open an Example File (p. 353), and contains

detailed information about that file.

To open Notes, do one of the following:

• Click on the button in the Views toolbar.
• Open the View menu and choose Notes.

Once the Notes window is open:

1. Type in the Notes window.
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2. Your note will be automatically saved and stored with the current document. To
reopen the notes window at any time while using this document, follow the
instructions above.
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Box
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The Settings/Preferences dialog box provides a series of pages for configuring various

aspects of AudioMulch including audio driver settings, channel assignments and level

meters, MIDI control and synchronization devices, network synchronization, document

switcher behavior, VST Plugins directory, low level File Streaming configuration and actions

that AudioMulch performs when it starts.

On Windows you can access the Settings/Preferences dialog box by choosing Settings...

from the Edit menu or by pressing the F4 function key.
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On Mac OS you can access the Settings/Preferences dialog box by choosing Preferences...

from the AudioMulch application menu or by pressing command-, (command-comma).

You can show a specific page by clicking on it in the list at the left side of the dialog box.

Each page is described in detail below.

Note: Changes to settings within the Settings/Preferences dialog only take effect once you

have clicked Apply or OK.

Audio General

Sample rate

The Sample rate drop down list contains a complete list of the sample rates supported by

AudioMulch (22.05 kHz, 32 kHz, 44.1 kHz (CD quality), 48 kHz, 64 kHz, 88.2 kHz, 96

kHz, 192 kHz). When first installed AudioMulch will default to 44.1 kHz (CD quality). The

higher the sample rate selected the higher the audio quality - and CPU load.

Once selected the sample rate applies globally to all documents.

Note: Your audio interface might not support all sample rates that AudioMulch does. It is

important that you consult your audio interface documentation to confirm the

compatibility between software and hardware settings.

Dither output

When checked, the Dither output checkbox enables Dithering, a process that introduces a

small amount of noise to improve the percieved sound quality of very quiet output signals.

Audio Driver

The Audio Driver page allows you to select a driver type and configure settings specific to

that driver type.

On Windows, AudioMulch supports the use of ASIO, DirectSound and Windows

Multimedia audio drivers. On Mac OS AudioMulch supports Apple's Core Audio drivers.
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Driver Type

The Driver Type drop down list lists the Driver Types supported by AudioMulch. The other

settings displayed on this page depend on which Driver Type is selected. Note that some

audio interfaces only support certain driver types.

Driver Settings

The Driver Settings section of the Audio Driver page allows for the selection of Devices

and configuration of their associated settings. When using ASIO drivers, the selected

Device handles both input and output, with DirectSound and Core Audio you can select

input and output devices separately. The devices selected here determine the devices

available in the Audio Input, Audio Output and Sound File Preview pages. In the case of

Windows Multimedia drivers all devices are always available on these pages.

Buffer Size and Number of Buffers

To provide seamless audio output, AudioMulch continuously streams a number of buffers

to and from the audio device(s). The number and size of these buffers can be changed

using the Buffer Size and Number of Buffers drop down lists.

The Buffer Size and Number of Buffers parameters affect the total audio latency (time

delay) of AudioMulch when generating or processing sound. Some driver types allow both

the Buffer Size and Number of Buffers to be adjusted whereas others allow only the

adjustment of Buffer Size.

Depending on the speed of your system and the quality of your audio interface and

drivers, different values for the Buffer Size and Number of Buffers settings will be optimal.

If desired you can experiment to determine the lowest working values on your system by

reducing both buffer size and number of buffers until the audio output begins to break up

with clicks and gaps.

The buffer options available for configuration within the Settings/Preference Dialog may

be constrained when using some ASIO drivers. When this occurs AudioMulch will

automatically display the audio interface's currently configured buffer settings. These

values cannot be edited from within AudioMulch but should be accessible within the ASIO

control panel of your audio interface (see below).
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For more information on the optimisation of audio buffer settings please consult the

Optimizing Real-Time Performance (p. 179) section of this help file.

Control Panel

(ASIO only)

The Control Panel... button, located on the right of the Audio Driver tab, launches the

control panel of the currently selected ASIO driver. All ASIO driver control panels are

different. Often they allow the configuration of buffer settings and may support other

driver-specific settings. It is important to note that any changes made within the ASIO

driver control panel will not be reflected in the AudioMulch Settings Dialog until you click

the Reset Audio button, located on the bottom right of the AudioDriver tab.

Reset Audio

(ASIO only)

The Reset Audio button re-initialises the audio engine at the core of AudioMulch. In a

process similar to closing and re-opening AudioMulch all audio settings are re-scanned to

ensure that any updates or changes made within other programs or control panels have

been applied.

Open all channels

(ASIO only)

The Open all channels checkbox can be used to force AudioMulch to open all channels of

the selected hardware device. When unchecked, AudioMulch will only open the audio

channels used by the current document (based on which SoundIn, AuxIn, SoundOut and

AuxOut contraptions are present in the document).

By default, Open all channels is selected for maximum hardware device compatibility but it

may introduce additional CPU load, and prevent sharing of the device between multiple

clients (this will only apply when a multi-client driver is available for the selected hardware

device).

If the selected audio device functions properly with Open all channels unchecked there is

no significant advantage to enabling this setting.
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Overdrive

(Windows Multimedia only)

The Overdrive checkbox allows you to trade off performance for stability under marginal

conditions. When checked, AudioMulch will give stable real-time output priority even

when the CPU load is high (approaching or beyond 100%). When audio production is

given high priority the user interface may become sluggish and could even freeze.

Unchecking the overdrive checkbox may result in less stable audio output when the CPU

load is high, but guarantees that the program will not freeze.

It is recommended that Overdrive be disabled except when using documents that are

known not to overload the computer (ie. those that dont exceed 85% CPU Load).

Disable Desktop Window Manager MMCSS scheduling

(Windows Vista and Windows 7 only)

If you notice that audio is disrupted by switching windows or window animation effects

you may gain some improvement by using this setting. When checked, this setting

disables the Desktop Window Manager from being scheduled using Windows' high-

priority Multimedia Class Schedule Service (MMCS).

AUDIO INPUT

AudioMulch supports up to 256 channels of real-time audio input using 128 stereo pairs

provided by the SoundIn and AuxIn1-127 contraptions. Obviously, this is of most use to

users running multi-channel audio interfaces.

The Audio Input Devices and Channels grid allows you to select which audio interface

devices and channels are used by which audio input contraptions.

Clicking on cells in the device column reveals a drop down list displaying all available

devices. Clicking on cells in the columns labelled Left and Right allows selection of device

channels used as the contraption's left and right outputs respectively.

When you change the Driver settings in the Audio Driver tab the Audio Input tab will be

configured with the available devices and input channels assigned to the corresponding

input contraptions. For example, the SoundIn contraption will use input channels 1&2,

AuxIn1 will use input channels 3&4 and so on. In many cases these settings will be
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appropriate without you needing to make changes to the Audio Input Devices and

Channels settings.

As with all AudioMulch settings, experimentation may reveal a number of different uses

for this routing system and users are encouraged to configure these settings to suit their

specific use of the software.

AUDIO OUTPUT

The Audio Output settings configuration is identical to that of the Audio Input settings

(see previous section) except that they apply to audio output.

SOUND FILE PREVIEW

The Sound File Preview tab allows for the independent routing of audio from the Play and

Auto play preview features of the Select a Sound File... dialogs used throughout

AudioMulch where sound files are read from or written to (SoundIn (p. 196), SoundOut

(p. 200), BubbleBlower (p. 224), Drums (p. 229), LoopPlayer (p. 234), FilePlayer (p. 207),

Export to Sound File... (p. 125)). This feature is provided for people running multi-channel

audio who may want to monitor Sound File Previews through outputs other than their

primary performance outputs. One application of this feature is in the creation of an

independent headphone mix.

Sound File Preview configuration is similar to the configuration of both the Audio Input

and Audio Output settings. In the relevant channel row (Channel 1 &2 for stereo files)

select the desired device from the list provided, and then in the final two columns identify

the device channels to which you want to direct the Sound File Previews.

Additional channel rows are provided for previewing multiple channel sound files.

Audio Input & Output Meters

The Audio Input Meters and Audio Output Meters pages allow you to select which level

meters are displayed on the user interface. Each page presents a check list of audio input/

output contraptions. Checking a check box causes the corresponding contraption's level

meters to be displayed.
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MIDI Input and Control

The MIDI Input and Control page allows you to select MIDI devices used for MIDI input

and parameter control. Up to eight separate MIDI input devices may be selected using the

Select MIDI Input devices grid. Each row of the grid corresponds to one of eight

internally routed MidiIn ports. When assigning a particular MIDI device for control of a

contraption parameter you select its corresponding MIDIIn port within the Parameter

Control dialog (p. 145). MidiIn contraptions (p. 205) are available in the patcher for

routing MIDI signals to contraptions such as VST plugins which accept MIDI input.

The same device can be used for MIDI Input and MIDI Sync (see below).

When a selected MIDI device is not turned on or not connected to your computer the grid

will display "(Not Connected)" next to the device name. You can connect and/or turn on

the MIDI device at any time. If a selected device is connected while AudioMulch is running

you will need to disable and re-enable MIDI by selecting Enable MIDI from the Control

menu or by clicking the Enable MIDI icon on the Transport toolbar before AudioMulch

will receive messages from that device.

Quick-Map control change resolution

The Quick-Map control change resolution buttons let you choose which resolution (7 or

14 bit) AudioMulch will use when you perform an automatic Quick-Map MIDI controller

operation using the next received MIDI message. Most control surfaces only send 7 bit

control information, in which case the 7 bit option should be chosen. When using a

control surface which sends 14 bit controllers, choose the 14 bit option so that Quick-Map

operations automatically select a 14 bit controller. Note that this option only affects the

automatically selected resolution. It is always possible to manually change the MIDI

controller type later using the Quick-Map or Parameter Control windows.

MIDI Output

The MIDI Output page lets you select MIDI devices used for MIDI output via MidiOut

contraptions (p. 205). You can select up to eight separate MIDI output devices using the

Select MIDI Output devices grid. Each row of the grid corresponds to one of eight

internally routed MidiOut ports. MidiOut contraptions (p. 205) can be used in the Patcher

Pane to route MIDI signals from contraptions such as VST and AudioUnit plugins, which

generate MIDI output.
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When a selected MIDI device is not turned on or not connected to your computer, the grid

will display "(Not Connected)" next to the device name. You can connect and/or turn on

the MIDI device at any time. If a selected device is connected while AudioMulch is running

you will need to disable and re-enable MIDI by selecting Enable MIDI from the Control

menu or by clicking the Enable MIDI icon on the Transport toolbar before AudioMulch

will send messages to that device.

MIDI Sync

The MIDI Sync page lets you select the MIDI devices used for receiving (Chasing) and

sending (Generating) MIDI clock synchronization (p. 152). You can fine tune the behavior

of AudioMulch's MIDI clock synchronization using the settings below.

Note: Depending on the combination of audio and MIDI hardware in your setup, it is not

uncommon to find some time delay between audio and MIDI. The Offset settings let you

compensate for these timing differences when using MIDI synchronization. As a general

principle, in AudioMulch, positive synchronization Offset values always delay the clock

chaser (slave) relative to the generator (master), while negative Offset values make the

slave earlier relative to the master. There are no recommended values for Offset settings,

and tuning is purely a matter of experimentation. We recommend beginning with Offset

set to zero, and adjusting forwards or backwards until you can hear that the audio and

MIDI timing is aligned.

CHASE MIDI SYNC SETTINGS

Offset

You can use the Chase MIDI Sync Offset setting to compensate for timing differences

between an external MIDI clock source and AudioMulch's Audio output. The Offset

setting is measured in milliseconds and moves AudioMulch's timing forwards (or

backwards) by that amount. When AudioMulch is chasing MIDI clock, positive Offset

values will make AudioMulch beats occur later (relative to the master's beats), while

negative Offset values will make AudioMulch's beats occur earlier.
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GENERATE MIDI SYNC SETTINGS

Offset

You can use the Generate MIDI Sync Offset setting to compensate for timing differences

between AudioMulch's Audio output and an external MIDI clock slave. The Offset setting

is measured in milliseconds and moves the slave's timing forwards (or backwards) by that

amount. When AudioMulch is generating MIDI clock, positive Offset values will make the

slave's beats occur later (relative to AudioMulch's beats), while negative Offset values will

make the slave's beats occur earlier.

Synchronize sequence location

AudioMulch has two different modes for keeping the slave's sequence position

synchronized with AudioMulch:

1. The default mode transmits MIDI Song Position Pointer (SPP) whenever

AudioMulch's clock is started or the transport location changes. This is the standard

synchronization mechanism dictated by the MIDI specification. It ensures that the

slave device is always informed of AudioMulch's automation sequence location. This

is the usual mode to select.

2. Some "groovebox"-style sequencers and drum machines (notably some of Korg's

Electribe™ devices) do not respond to MIDI Song Position Pointer when in "Pattern

Mode." Instead they rely on the master sending MIDI start messages only at the start

of pattern cycles. To support these devices, AudioMulch provides the option to

always start MIDI clock on "pattern" boundaries. AudioMulch provides settings

for the "pattern" length and time signature used in this mode. You should select a

pattern length that matches the synchronization period you want to use with your

external device: a common setting would be one bar, or the length of your patterns if

they are longer than one bar.

Network Sync

Network sync lets you sychronize the clocks of one or more copies of AudioMulch running

on different computers on a local area network (LAN). The Network Sync page contains

settings that identify the computers network sync is sent to, and determine the UDP port

used to send and receive sync.
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The available UDP network ports are numbered from 1024 to 65535. Both the Generate

network sync port of the computer generating sync and the Chase network sync port

of the receiver(s) must be set to the same port number. Although the default value of

7000 is usually sufficient, if another program on any of the computers is already using this

value, you will need to change the port number on all computers to a different value. For

most purposes we recommend using ports above 49152.

The Generate network sync Send to address must be set to the IP address of the

computer you wish to send sync to, or to the local broadcast address. For example, an IP

address consisting of the subnet followed by .255 (eg. 192.168.0.255) will broadcast sync

to all computers on that subnet.

There are separate time Offset settings for Chase network sync and Generate network

sync. These are expressed in milliseconds and work in the same way as the MIDI

synchronization Offset settings described in the previous section. When AudioMulch is

chasing network sync, positive Chase network sync Offset values move AudioMulch's

beats later (relative to the master), while negative values move the beats earlier. When

AudioMulch is generating network sync, positive Generate network sync Offset values

move the (remote) slave's beats later, while negative values move the slave's beats earlier.

Document Switcher

The Document Switcher (p. 161) can be controlled via MIDI. The MIDI Control Source

section of this page allows you to select which MIDI Control Source (if any) will cause the

Document Switcher to switch documents.

The Document Saving options allow you to choose whether AudioMulch will prompt,

save or discard changes before the document is switched under MIDI Control. (When you

switch documents using the mouse you will always be prompted if the document has

changed).

The Display full paths checkbox determines the display format of file names within the

Document Switcher's Documents Grid (p. 161). When unchecked only the file name itself

will be visible, when checked the full path of folders to the file will be displayed.
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VST Plugins

VST Plugins folder

As explained in the VST Plugins (p. 345) section of this help file, VST and VST2 plugins

must be placed in or installed into a specific folder for AudioMulch to find them. On

Windows AudioMulch defaults to its own VSTPlugins folder, something like C:\Program

Files\AudioMulch 2.0\VSTPlugins; on Mac OS it defaults to the system VST plugins folder

at Hard disk/Library/Audio/Plug-Ins/VST but other locations are possible.

The VST Plugins folder setting allows you to configure this location to wherever your

VST and VST2 plugins are currently installed. By using this setting it is possible to eliminate

the need for duplication of plugins accross your hard disk.

To selected a different folder click Browse... and select the folder you want AudioMulch to

use as its VST Plugins folder. As with the default folder, the subfolder structure of the

selected folder will be reflected in the VST Plugins section of the contraptions palette and

the VST Plugins submenu of the new contraptions menu.

File Streaming

The File Streaming page provides settings for fine tuning the performance of sound file

recording and playback.. In general, the effect of these settings is only noticable when

streaming a large number of sound file channels simultaneousy.

The default settings have been selected for reliable operation on most systems and should

only be adjusted if problems are experienced while playing or recording sound files.

Usually such problems will take the form of glitches in sound file playback (but not with

real-time audio) and or glitches in recorded sound files.

Buffer size

This is the size of individual blocks written to and read from disk. Often there is a size

which works best with a particular disk. The effect of this setting is highly dependent on

the hardware and operating system used. Adjusting it up or down may improve sound file

streaming performance on some systems.
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Input / Output queue length

As with Buffer size, increasing the value of both the Input(playback) and Output(recording)

queue lengths will assist in the reduction of disk access glitches. Importantly however,

higher queue lengths may significantly increase RAM usage.

Always wait for disk access to complete

The Always wait for disk access to complete checkbox is the easiest way to ensure

sound file recordings are glitch free. When checked, this setting shifts AudioMulch's

priority from real-time audio to disk access. This option is most suited to situations where

you are recording to a sound file through SoundOut. When this mode is enabled, the

recorded file will always be free of glitches no matter how much the real-time audio

breaks up. In doing so however it is necessary to reduce the reliability of the real-time

audio stream making live glitching far more likely. Any sound from a real-time input such

as SoundIn will also be less reliable.

Startup Actions

The Startup Actions page determines actions to be performed each time AudioMulch

starts. Some of these settings are generally useful for configuring AudioMulch, such as

always enabling Audio and MIDI when AudioMulch starts. Other settings are more useful

for particular situations, for example for a performance you may want AudioMulch to

always start with a particular Document or Document Set loaded. This can also be useful

for installations where you want AudioMulch to automatically load and play a document

when it is launched.

In the General startup actions section, the Open Document setting allows you to select

a document which AudioMulch will open when it starts. This corresponds to opening a

document using the Open... item in the File Menu (p. 364). The Enable Audio, Enable

MIDI and Play From Start options correspond to items with the same names in the Control

Menu (p. 364). The Show Welcome Screen button can be checked (or unchecked) in order

to show (or hide) the Welcome Screen when AudioMulch starts.

The Document Switcher startup actions section allows you to specify a Document Set

to be opened and to choose whether to enable MIDI document switching when

AudioMulch starts.
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MIDI and Network Sync startup actions control whether AudioMulch will chase or

generate MIDI and/or Network sync when it starts. These settings correspond to items

with the same names in the Control Menu (p. 364).

Appearance

The Appearance page lets you choose AudioMulch's color scheme. You can also change

the color scheme's brightness and contrast.

There are two color scheme options: light and dark.

Brightness and contrast can be changed by moving the sliders. To return to the default

brightness and contrast settings, click Reset.

Any changes you make to color scheme, brightness or contrast will be previewed in real

time, but will only become permanent after you click Apply or OK. Clicking Cancel

reverts to the previous Appearance settings.
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Optimizing Real-Time
Performance
When AudioMulch is installed the default configuration allows it to perform glitch-free

audio synthesis and processing on most systems. Due to various factors, optimal real-time

performance can only be achieved by tuning AudioMulch for a specific computer,

operating system and audio interface. It is worth taking the time to tune AudioMulch to

take advantage of the capabilities of your system because the program can be much more

responsive than when used with the default settings.

This section discusses optimal performance in terms of two parameters: stability and

latency. Stability is concerned with the reliability of the audio input and output. A stable

system will deliver hours of continuous sound without a problem, an unstable system will

contaminate the audio stream with glitches, clicks, pops, stutters and drop outs. Latency

manifests as delays between audio entering your audio interface and emerging from your

audio interface after having been processed by AudioMulch (audio latency), and as delays

between modifying parameter values on screen or via MIDI and hearing the results

(control latency). The lower the latency, the more usable the system is for real-time

performance, as the system will be perceived to be operating in the moment rather than

with a perceptible delay. Achieving a stable system with the lowest possible latency should

be your goal when tuning AudioMulch.

One major cause of stability problems is external programs that perform periodic disk

activity. On Windows, the following are commonly known to interfere with the stable

operation of digital audio software:

• System Agent (included in the Microsoft Plus! pack) can be set to schedule disk

scanning and defragmentation at any time. You should avoid having it wake up while

using AudioMulch.

• Find Fast for Microsoft Office

• Screen Savers

• CD-ROM Auto-Insert Notification

• Other programs performing processor-intensive operations while using AudioMulch.

• Certain keyboard and mouse drivers.
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As discussed below, you may also want to search the internet for the latest information

about software that can interfere with stable low-latency audio performance.

Once known sources of instability have been reduced to a minimum AudioMulch settings

can be altered to reduce latency until the audio begins to break up, and then eased off

until reliable operation is achieved. The settings which determine latency are the audio

buffer sizes and number of buffer settings associated with the audio driver. Some driver

types provide individual settings for input and output, while others provide only one

setting for both. Some driver types allow both the size and number of buffers to be

adjusted, while others only allow adjustment of buffer sizes. In all cases latency can be

reduced by decreasing the buffer sizes and/or the number of buffers. These settings can

be altered on the Audio Driver page of the Settings/Preferences dialog box (p. 166).

Many factors including the speed of the computer, audio interface and quality of audio

drivers affect the minimum workable size and number of buffers. In extreme cases you

should be aware that some computers or audio drivers may crash if you attempt to use

too few, or too small buffers.

Where separate settings are available for input and output buffers it is advisable to use the

same buffer sizes for input and output. If audio output is generally stable but glitches

occur when using audio input it may be necessary to increase the number of audio input

buffers.

In general, using more buffers produces greater stability. A few larger buffers are usually

preferable to a large number of small buffers. However, there are no hard and fast rules

that can be applied to all systems. The best thing to do is to experiment.

One other alternative is to experiment with the sample rate used within a patch. While it is

accepted that higher sample rates produce better audio quality it should also be noted

that higher sample rates result in higher CPU loads. In situations where quality is of lesser

concern, a lower sample rate can be employed to reduce CPU load and thereby increase

stability. This setting can be selected using the Audio General page of the Settings/

Preferences dialog box (p. 166)

In addition to the AudioMulch and audio interface settings outlined above there are also a

number of operating system tunings that may increase audio performance. At present

there is a significant body of web-discussion devoted to these "tweaks". For this reason

we have chosen not to go into any great detail within this document. If you are interested

in exploring these ideas further a google search for "Your_OS_Name audio tweaks"
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should provide myriad resources for research. Your audio interface manufacturer may also

provide guidance specific to their products on their web site.
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Contraptions Guide
This section includes Help Files for each of AudioMulch's contraptions. Below is a

comprehensive list of the contraptions, grouped by category, and a brief explanation of

what each contraption does. To find out more information about any contraption, click on

the links in the list.

Note: To directly access a contraption's Help File page while using the program, click on

the ? button on the title bar of the contraption's Property Editor.

Input/Output

*FilePlayer ..................................................................................................................188

Plays one or more multichannel sound files with multitrack synchronization.

*FileRecorder..............................................................................................................192

Records one or more multichannel sound files with multitrack synchronization.

SoundIn.......................................................................................................................196

Inputs live sound from the audio interface or plays a sound file.

SoundOut ...................................................................................................................200

Outputs sound to the audio interface. Optionally, records sound to a file.

AuxIn / AuxOut..........................................................................................................203

Additional live audio interface inputs and outputs for multichannel and surround

sound.

MidiIn / MidiOut ........................................................................................................205

Inputs or outputs live MIDI to or from a MIDI interface or other software application.

(For use with VST and Audio Unit plugins).

FilePlayer ....................................................................................................................207

Plays a stereo sound file.

FileRecorder................................................................................................................210

Records a stereo sound file.

Contraptions Guide 182



Signal Generators

Arpeggiator ................................................................................................................213

A synthesizer and tone generator that plays arpeggios.

Bassline.......................................................................................................................219

Synthesizes and sequences a melody or chops up and filters a sound input.

LoopPlayer..................................................................................................................234

Plays a looped sound file synchronized to the beat or stretches a loop for pitch and

time distortion effects.

Drums..........................................................................................................................229

Plays back samples sequenced in repetitive patterns, sometimes used as a drum

machine.

BubbleBlower.............................................................................................................224

Randomly chops up and scrambles sound files to create fractured or smooth textures

(granular synthesis).

RissetTones .................................................................................................................237

Synthesizes a continuously ascending or descending tone.

10Harmonics...............................................................................................................240

Synthesizes a harmonic tone by controlling the amplitude of the first 10 harmonics

(additive synthesis).

TestGen .......................................................................................................................243

Generates tones: a sine wave or noise.

Effects

PulseComb..................................................................................................................275

Creates a pulse-like chopping of sound input and a pitch-shifting effect.

DLGranulator..............................................................................................................253

Randomly chops up and scrambles live sound to create fractured or smooth textures

(granular synthesis).

SDelay.........................................................................................................................286

Applies stereo delays, repetitive echo and stereo ping-pong effects.
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CanonLooper ..............................................................................................................245

Captures sound and loops it in multiple layers to create musical canons (rounds).

LiveLooper..................................................................................................................262

Captures and controls up to 16 tracks of looping sound.

DigiGrunge .................................................................................................................250

Applies digital distortion effects (bit depth reduction, sample rate decimation).

Shaper.........................................................................................................................290

Adds distortion with direct control over distortion harmonics (Chebychev

waveshaping).

SSpat...........................................................................................................................294

Creates the illusion of sound moving in space in looped paths using panning and

doppler shift.

NastyReverb ...............................................................................................................270

A digital reverb effect.

Flanger........................................................................................................................258

Creates a sweeping, whooshing filter effect with a metallic, ringing sound.

Phaser .........................................................................................................................272

Creates a sweeping, whooshing filter effect with a hollow, resonant sound.

FrequencyShifter........................................................................................................260

Shifts harmonics to create metallic sounds, or sweeping phaser-like effects when used

with subtle settings and feedback.

RingAM.......................................................................................................................279

Adds shifted frequencies, and can produce metallic sounds (ring and amplitude

modulation).

SChorus.......................................................................................................................282

Creates a sweeping, detuned thickening and stereo-widening chorus effect.
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Filters

Nebuliser.....................................................................................................................303

Randomly chops up and scrambles live sound with random filtering to create watery

sounds (filtered granular synthesis).

SouthPole ...................................................................................................................312

Applies resonant filtering and amplitude-chopping effects controlled by rhythmic

patterns or sound input (envelope following and pattern controlled ADSR filtering

and amplitude gating).

RissetFilters.................................................................................................................308

Applies continuously ascending or descending sweeping bandpass filters - a filtering

version of RissetTones (p. 237).

*ParaEQ ......................................................................................................................301

Equalizer filter boosts or cuts certain frequencies (parametric with high and low shelf,

and two sweepable mid bands). (M=Mono, S=Stereo).

5Combs .......................................................................................................................298

Filters sounds through tuned comb filters that sound like resonating strings.

Dynamics

*Limiter.......................................................................................................................322

Limits the peak level of a sound to avoid harsh clipping distortion.

*Compressor...............................................................................................................318

Controls the level of a sound to reduce dynamic range or shape transients.

*NoiseGate .................................................................................................................325

Allows loud sounds to pass while suppressing quiet ones (or vice-versa).

Mixers

Matrix .........................................................................................................................328

Switches and combines different input channels to different outputs.

Crossfader...................................................................................................................330

Smoothly mixes and fades from one stereo input to another.
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Frosscader...................................................................................................................332

Smoothly fades a stereo input between two different stereo outputs.

Invert...........................................................................................................................334

Inverts the polarity of an audio input (useful for stereo wide illusion and other tricks).

*Gain...........................................................................................................................337

Volume control knob for one or more channels (M=Mono (1), S=Stereo (2), Q=Quad

(4), O=Oct (8)).

M*Mixer .....................................................................................................................335

Mono mixers with volume control for each input.

P*Mixer.......................................................................................................................339

Stereo mixers with mono inputs and a pan control for each input.

S*Mixer.......................................................................................................................341

Stereo mixers with volume control for each stereo input pair.

Buses

M*Bus .........................................................................................................................343

Mixes mono signals without volume control. Useful as a patch-point for complex

patches. (Provided for backward compatibility).

S*Bus...........................................................................................................................344

Mixes stereo signals without volume control. Useful as a patch-point for complex

patches. (Provided for backward compatibility).

Plugins

As well as its own contraptions, AudioMulch supports the industry standard VST (Virtual

Studio Technology) and VSTi (also known as VST2) plugin formats, and on Macintosh,

Apple's Audio Unit plugin format. This gives you access to a large number of third-party

effects and instruments to expand AudioMulch.

VST Plugins .................................................................................................................345

Third-party plugins you install on your computer to provide additional effects and

instruments.
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Audio Unit Plugins (Macintosh only)........................................................................350

Third-party plugins you install on your computer to provide additional effects and

instruments.
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*FilePlayer

Plays one or more multichannel sound files with multitrack synchronization.

The multichannel *FilePlayer lets you play a number of sound files at the same time. The

prefix number of the contraption (4, 6, 8, 16, 24 or 32) indicates both the maximum

number of channels that can be played, and the number of outputs the contraption has.

You can simultaneously play back files with different numbers of channels. For example,

the 4FilePlayer can play four mono files, or two stereo files, or one four-channel file, or

any other possible combination of up to four channels.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio input and file playing contraptions: SoundIn (p. 196), AuxIn (p. 203), FilePlayer (p.

207), LoopPlayer (p. 234), Drums (p. 229).

Audio output and recording: SoundOut (p. 200), AuxOut (p. 203), FileRecorder (p. 210),

*FileRecorder (p. 192) (multi-file recorder).
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Parameters

Files Grid Selects sound files for each channel. Click on a folder icon to select a
file. Drag files to reorder them. (See below for more details).

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Auto
Rewind

(AutoRewind)

Rewinds the file to the beginning after each time it is played.

Loop Plays the file continuously, looping from the start when the end has
been reached.

Delay

(LoopDelay)

Controls the length of silence inserted between the end and the start
of the input file as it is looped. Loop needs to be enabled for Delay
to function.
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Instructions

If the lengths of the files differ, the total duration of playback is that of the longest file.

This is also the case when Loop is enabled. Silence is played once the end of any shorter

files is reached.

Using the Files grid

The Files grid contains one row for each output channel of the contraption. You can load

a sound file into any channel using the Select File and Close File buttons. You can

reorder files in the list by dragging and dropping them.

Once a file is loaded into the grid, the total number of output channels required by the file

will be displayed in the second column.

The third column displays how each sound file channel is routed to a contraption output.

Routing always begins from the output channel corresponding to the row of the grid that

the sound file has been loaded into, and continues routing to subsequent output

channels.

For example, a stereo file in the first row will have its left channel routed to contraption

output one, and its right channel routed to output two.

If there happened to be a sound file already loaded into row two of the Files grid, it is

ignored, with output channel two occupied by the second channel of the stereo file in row

one. Ignored files are shown in grey (see below).

If a sound file has more channels than can be routed in the Files grid (for example, loading

a stereo file into row 4 of a 4FilePlayer), only the channels that fit will be used. An

asterisk (*) next to the number of channels indicates that not all channels of that sound

file were routed to outputs (see below).
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Suggested Uses and Practical Applications

Steve Adam says: “*FilePlayer is useful for playback and subsequent processing of multi-

track files or multiple files simultaneously.”

Warren Burt says: “Have several files of very different sounds in the player, all about the

same length. Put each sound through a different effect. Put the different effected sounds

into a mixer. Control the inputs of the mixer with Automation channels. Have the

Automation loop be a different length than the loop of the file player so that with repeats

of the Automation loop, different samples are heard. Instant collage! As an alternative,

have several files of spoken word material in the Multiple File Player; do a similar

Automation loop mixing the different spoken word inputs. Instant algorithmic poetry or

Burroughsian cutups!”

Andrew Bencina says: “Not only can *FilePlayer be used to play back a series of

multitrack separations for backing tracks, these outputs can be submixed to varying

numbers of physical outputs, depending on what interface or number of inputs you have

available for a particular gig.”
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*FileRecorder

Records one or more multichannel sound files with multitrack synchronization.

The multichannel *FileRecorder lets you record a number of sound files at the same time.

The prefix number of the contraption (4, 6, 8, 16, 24 or 32) indicates both the maximum

number of channels that can be recorded, and the number of outputs the contraption

has. You can simultaneously record files with different numbers of channels. For example,

the 4FileRecorder can record four mono files, or two stereo files, or one 4 channel file, or

any other possible combination of up to four files.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio output and recording: SoundOut (p. 200), AuxOut (p. 203), FileRecorder (p. 210).

Audio input and file playing contraptions: SoundIn (p. 196), AuxIn (p. 203), FilePlayer (p.

207), *FilePlayer (p. 188) (multi-file player), LoopPlayer (p. 234), Drums (p. 229).
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Parameters

Files grid Selects the locations that files will be recorded to. Click on a folder
icon to select a location. Drag files to reorder them. (See below for
more details).

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Record
Mode

(FileMode)

Determines whether any recorded sound in the output file is
overwritten or appended the next time record is selected. Append
allows you to record more than one take, one after the other.
Overwrite will destroy any previous recording.

Punch
Mode

(PunchMode)

Determines when to start and stop recording. In Manual mode,
recording begins when you press the record button and stops when
you press the stop button. In SoundIn Sync mode, recording begins
when the SoundIn starts and stops when the SoundIn stops, or when
you press the stop button. Timed mode starts recording when you
press the record button and continues for the time specified, or until
you press stop, whichever comes first.
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Instructions

When recording with *FileRecorders, the sample rate of the outgoing sound files always

conforms to the currently assigned Sample Rate, as reflected in the Audio General page

of the Settings Dialog (p. 167).

The *FileRecorders always record all sound files simultaneously, so they can be used to

make multichannel recordings for export to other applications. In append mode, all files

must be the same length or the *FileRecorders will not start recording.

Using the Files grid

The Files grid contains one row for each input channel of the contraption. You can load

an existing sound file or assign the name and destination for a new sound file recording

using the Select File and Close File buttons located on the right of each channel.

You can reorder files in the list by dragging and dropping them.

The third column contains a drop down menu allowing you to select the number of

channels for the sound file in that row. It also indicates the number of channels in a sound

file if an existing file is loaded.

Once an existing file or new file destination is loaded into the grid, the second column

displays the routing of each contraption input to its corresponding sound file. Routing

always begins from the input channel corresponding to the row of the grid that the sound

file has been loaded into, and continues routing to subsequent input channels up to the

number of channels in the sound file.

For example, a stereo file in the first row will have its left channel take input from

contraption input one, and its right channel routed from input two.

If there happened to be a sound file already loaded into row two of the Files grid, it is

ignored, with input channel two routed to the second channel of the stereo file in row

one. Ignored files are shown in grey (see below).

Contraptions Guide - *FileRecorder 194



If a sound file has more channels than can be routed in the Files grid (for example, loading

a stereo file into row four of a 4FileRecorder) only the channels which fit will be used. An

asterisk (*) next to the number of channels indicates that not all channels of the sound file

received input (see below).

Relevant Example Files

The following files provide some examples of how *FileRecorders can be used:

BBMultitracker.amh & MultiChan_IO+Record.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Steve Adam says: “Use *FileRecorder for multi-track recording for a stereo mix-down.

You can also use it to create multiple “stems” for a multi-channel speaker format, such as

5.1 surround.”
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SoundIn

Inputs live sound from the audio interface or plays a sound file.

SoundIn is the main stereo input for feeding sound into AudioMulch, in the form of pre-

recorded sound files, or real-time sound input from an external source such as a

microphone or audio interface input. SoundIn also lets you play back a sound file. This

playback can be synchronized with SoundOut (p. 200) recording or the Export to Sound

File (p. 125) option for tightly synchronized recording of processed sound files.

Note: AuxIn (p. 203) contraptions can be used to provide additional channels of real-time

input.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio input and file playing contraptions: AuxIn (p. 203), FilePlayer (p. 207), *FilePlayer (p.

188) (multi-file player), LoopPlayer (p. 234), Drums (p. 229)

Audio output and recording: SoundOut (p. 200), AuxOut (p. 203), FileRecorder (p. 210),

*FileRecorder (p. 192) (multi-file recorder)
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Parameters

Use Input
File

Toggles between playing back a sound file or bringing in sound from
an audio interface input.

File Selects a sound file. Check the Use Input File box and select a file by

clicking on the Select Sound File button . Alternatively, drag a
sound file into the contraption's sound file slot directly from the
Macintosh Finder or Windows Explorer. The name and path of the
file will be displayed in the sound file slot.

File Position
Trackbar

Selects the current playback position of the input file. Click and drag
the “thumb” to move the position. You can use it when a file is
playing or paused.

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Auto
Rewind

(AutoRewind)

Rewinds the file to the beginning each time it is played.

Loop Plays the file continuously, looping from the start when the end has
been reached.
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Delay

(LoopDelay)

Controls the length of silence inserted between the end and the start
of the input file as it is looped. Loop must be enabled for Delay to
function.

Play / Stop

(Active)

Starts and stops playback of the input file.

Instructions

Only one SoundIn contraption can be used at a time in AudioMulch. You can switch

between using a sound file and a real-time sound input from an external source. To feed a

real-time sound source into AudioMulch, make sure the Use Input File checkbox is not
selected. To switch to a pre-recorded sound, check the Use Input File box and select a file

by clicking on the Select Sound File button . Press Play / Stop on the Properties

Editor window to start and stop file playback.

You can configure which audio interface inputs are routed to SoundIn using the Settings /

Preferences dialog box. Go to the Settings / Preferences Dialog Box (p. 170) section of this

Help File for information about how to adjust these settings.

Relevant Example Files

The following files provide some examples of how SoundIn can be used:

SimplePlugnPlay.amh, LooperJam.amh & MultiChan_IO+Record.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Ross Bencina says: “Using SoundIn for sound file playback provides a couple of unique

features: SoundIn playback and SoundOut recording can be synchronized, and the Export

to Sound File menu command has features to support processing the selected SoundIn
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file. But you can only use one SoundIn contraption in a document. File playback tasks such

as playing back many sound files at once, or playing back sound files synchronized to the

clock are better done with FilePlayers (p. 207), LoopPlayers (p. 234) or even the Drums (p.

229) contraption.”

Ross Bencina says: “When working on a patch designed for processing live input you

can switch SoundIn to use a sound file to test the effects that a patch will have on a

sound, without the need to use a live input. During performance, or whenever the live

input is available just switch of Use Input File. That way there's no need to use separate

file player and live input contraptions.”
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SoundOut

Outputs sound to the audio interface. Optionally, records sound to a file.

SoundOut is the main channel for outgoing stereo sound. You can also use SoundOut to

record sound to a file. Playback from SoundIn (p. 196) can be synchronized with

SoundOut recording and the Export to Sound File (p. 125) option for tightly synchronized

recording of processed sound files.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio output and recording: AuxOut (p. 203), FileRecorder (p. 210), *FileRecorder (p. 192)

(multi-file recorder)

Audio input and file playing contraptions: SoundIn (p. 196), AuxIn (p. 203), FilePlayer (p.

207), *FilePlayer (p. 188) (multi-file player), LoopPlayer (p. 234), Drums (p. 229)

Parameters
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File Selects the file that SoundOut records to. Create a new file, or use an
existing file. To record a file, first click on the Select Sound File button

and select an existing file or create a new one.

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Record
Mode

Determines whether existing sound in the output file is overwritten or
appended in subsequent record operations.

Use Append if you want to do multiple takes of a recording.
Overwrite destroys any existing sound in the file.

Punch
Mode

(PunchMode)

Determines when to start and stop recording. The different modes
operate as follows:

Manual: recording begins when you press Record and stops when
you press Stop.

SoundIn Sync: recording begins when the SoundIn is started and
stops when the SoundIn stops, or when Stop is pressed. The record
button must be pressed to arm it before it will begin recording. This
mode can be good to use if you're processing a sound file.

Timed: record for a specified amount of time. The timer starts when
you press Record and continues for the time specified, or until the
Stop button is pressed.

Record /
Stop

Controls the start and end of the recording.

Play / Stop

(PlayActive)

Starts and stops playback of the output file from the beginning, so
you can hear what the recording sounds like.
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Instructions

When recording with SoundOut, the sample rate of the outgoing sound file always

conforms to the currently assigned Sample Rate, as reflected in the Audio General page

of the Settings Dialog (p. 167).

You can configure which audio interface outputs are routed to SoundOut using the

Settings / Preferences dialog box. Go to the Settings / Preferences Dialog Box (p. 170)

section of this Help File for information about how to adjust these settings.

Relevant Example Files

The following file provides an example of how SoundOut can be used:

MultiChan_IO+Record.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “When working with a static mulch patch or a looped

automation sequence, another option is to use Export to Sound File (p. 125) from the File

menu to make recordings of a pre-determined length. This is especially useful when trying

to create your own loops.”
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AuxIn / AuxOut

Additional live audio interface inputs and outputs for multichannel and surround sound.

AuxIn and AuxOut are input and output contraptions for multi-channel audio interfaces.

By using AuxIn and AuxOut, separate channels in AudioMulch can be assigned to specific

channels of the interface.

Related Contraptions

SoundIn (p. 196) and SoundOut (p. 200)

Instructions

AuxIn and AuxOut contraptions have no parameters or Property Editor.

You can configure which audio interface inputs and outputs map to which AuxIn and

AuxOut contraptions in the Settings / Preferences dialog box. Go to the Settings /

Preferences Dialog Box (p. 170) section of this Help File for information about how to

adjust these settings.

Relevant Example Files

The following file provides an example of how AuxIn / AuxOut can be used.
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MultiChan_IO+Record.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “While designed for use with multichannel audio interfaces it's

worth noting that these contraptions may also come in handy when working with a much

more basic setup. For example, when using the SoundIn (p. 196) contraption to play a

sound file from the hard disk, an AuxIn contraption may be used to channel audio into

AudioMulch via your audio interface's microphone or line input.”

Contraptions Guide - AuxIn / AuxOut 204



MidiIn / MidiOut

Inputs or outputs live MIDI to or from a MIDI interface or other software application. (For

use with VST and Audio Unit plugins).

MidiIn contraptions let you route MIDI data from external MIDI sources, such as keyboard

controllers, drum pads and sequencers, into contraptions that accept MIDI input.

MidiOut contraptions let you route MIDI data from contraptions that generate MIDI (such

as sequencing plugins) to external MIDI devices such as hardware synthesizers and effects

modules.

Related Contraptions

VST Plugins (p. 345) and (on Macintosh only) Audio Unit Plugins (p. 350)

Instructions

MidiIn and MidiOut contraptions have no parameters or Property Editors. The MIDI devices

used for input can be configured on the MIDI Input and Control page of the Settings /

Preferences Dialog Box. The MIDI devices used for output can be configured on the MIDI

Output page. Go to the Settings / Preferences Dialog Box (p. 172) section of this Help File

for further information.

In the Patcher Pane, MIDI inputs and outputs are displayed at the right side of

contraptions. Like audio inputs and outputs, inputs are displayed along the top edge and

outputs along the bottom edge. Patch cords carying MIDI messages appear as dotted lines
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in the Patcher Pane. MIDI outputs can only be connected to MIDI inputs. A MIDI output

can't be connected to an audio input nor an audio output to a MIDI input. Go to the

Routing MIDI in the Patcher (p. 117) page for further information.

MidiIn contraptions have a single MIDI output. This can be connected to a MIDI input on

any other contraption. MidiOut contraptions have a single MIDI input. This can be

connected to a MIDI output on any other contraption. The only other contraptions that

support MIDI input and output are VSTi instrument plugins (p. 345) and Audio Unit

instrument plugins (p. 350). However, not all plugins have MIDI inputs or outputs.
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FilePlayer

Plays a stereo sound file.

FilePlayer lets you input a single mono or stereo sound file into AudioMulch. The file can

be looped to play repeatedly or played once each time the play button is pressed. You can

specify a length of silence to be inserted between looped repeats of the file.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio input and file playing contraptions: *FilePlayer (p. 188) (multi-file player), SoundIn

(p. 196), LoopPlayer (p. 234), Drums (p. 229).

Audio output and recording: FileRecorder (p. 210), *FileRecorder (p. 192) (multi-file

recorder), SoundOut (p. 200).

Parameters
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File Selects a sound file. Select a file by clicking on the Select Sound File

button . Alternatively, drag a sound file into the contraption's
sound file slot directly from the Macintosh Finder or Windows
Explorer. The name and path of the file will be displayed in the sound
file slot.

File Position
Trackbar

Selects the current playback position of the input file. Click and drag
the “thumb” to move the position. You can use it when a file is
playing or paused.

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Auto
Rewind

(AutoRewind)

Rewinds the file to the beginning each time it is played.

Loop Plays the file continuously, looping from the start when the end has
been reached.

Delay

(LoopDelay)

Controls the length of silence inserted between the end and the start
of the input file as it is looped. Loop must be enabled for Delay to
function.

Play / Stop

(Active)

Starts and stops playback of the input file.

Relevant Example Files

The following file provides an example of how FilePlayer can be used:

Lucier.amh
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To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Ross Bencina says: “Unlike LoopPlayer, FilePlayer is free-running. It does not synchronize

to the clock, but you can automate its Active property to make it start at a certain point in

an automation sequence.”
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FileRecorder

Records a stereo sound file.

FileRecorder lets you record audio to a sound file. You can record to a new file, overwrite

or append additional audio to an existing file. Except when playing back the recorded file,

the output of the FileRecorder is the same as its input. You can choose from several

different Punch Modes for recording; each determines when FileRecorder will start and

stop recording. The contraption lets you play the file to hear its contents before and after

recording.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

Audio output and recording: *FileRecorder (p. 192) (multi-file recorder), SoundOut (p.

200).

Audio input and file playing contraptions: FilePlayer (p. 207), *FilePlayer (p. 188) (multi-file

player), SoundIn (p. 196), LoopPlayer (p. 234), Drums (p. 229).

Live looping recorders: LiveLooper (p. 262), CanonLooper (p. 245).
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Parameters

File Selects the file that SoundOut records to. Create a new file, or use an
existing file. To record a file, first click on the Select Sound File button

and select an existing file or create a new one.

Current /
Total Time

Indicates the current playback time and the total duration of the file.
Time is indicated in MM:SS.mmm format (minutes, seconds and
milliseconds). Hours are also indicated when the duration is greater
than one hour.

Record
Mode

Determines whether existing sound in the output file is overwritten or
appended in subsequent record operations.

Use Append if you want to do multiple takes of a recording.
Overwrite destroys any existing sound in the file.

Punch
Mode

(PunchMode)

Determines when to start and stop recording. The different modes
operate as follows:

Manual: recording begins when you press Record and stops when
you press Stop.

SoundIn Sync: recording begins when the SoundIn is started and
stops when the SoundIn stops, or when Stop is pressed. The record
button must be pressed to arm it before it will begin recording. This
mode can be good to use if you're processing a sound file.

Timed: record for a specified amount of time. The timer starts when
you press Record and continues for the time specified, or until the
Stop button is pressed.
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Record /
Stop

Controls the start and end of the recording.

Play / Stop

(PlayActive)

Starts and stops playback of the output file from the beginning, so
you can hear what the recording will sound like.

Instructions

When recording with FileRecorder, the sample rate of the outgoing sound file always

conforms to the currently assigned Sample Rate, as reflected in the Audio General page

of the Settings Dialog (p. 167).

Relevant Example Files

The following files provide examples of how FileRecorder can be used:

BBMultitracker.amh & MultiChan_IO+Record.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Arpeggiator

A synthesizer and tone generator that plays arpeggios.

Arpeggiator lets you create repeating sequences of pitches (“arpeggios”) with a variety of

cycle lengths, directions and pitch ranges. It has a piano keyboard interface for selecting

pitches and a pattern editor for controlling when and how the Arpeggiator advances to

the next pitch. You can specify the rhythmic pattern with the rhythmic matrix, and can

also add ties so that notes glide from one to the next. The speed of the glide can also be

determined. Other parameters control the direction, range, and regularity of the

arpeggios.

Arpeggiator generates sound using two oscillators. You can select the waveform of each

oscillator, control the balance between them, and decide how they are tuned against each

other.

This contraption synchronizes to the global clock. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Bassline (p. 219)
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Parameters

Volume Controls the output level of the Arpeggiator

Mute Disables sound output when check-box is checked

Osc 1, Osc 2

(Oscillator1Waveform,
Oscillator2Waveform)

Selects the oscillator's waveform.You can choose between a
saw, sine and square wave for each oscillator.

Osc 2 Trans

(Osc2Transpose)

Controls the transposition of oscillator 2 relative to oscillator
1. Transposition is specified as the number of semitones
above oscillator 1.

Detune

(DetuneAmount)

Provides fine adjustment of the tuning of oscillator 2. Shifts
oscillator 2 above its nominal pitch (determined by Osc 2
Trans) by up to one semitone.
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Balance

(OscBalance)

Functions as a crossfader between the two oscillators. At 0
only Osc 1 is audible while at 1 only Osc 2 is audible. At 0.5
both oscillators are evenly mixed.

Feedback

(OscFeedback)

Controls the amount of oscillator cross-feedback. The two
oscillators are connected in a feedback loop where each
modulates the other's frequency. Small amounts of
Feedback lead to changes in timbre or brightness, larger
amounts create distorted sounds. 0 being no feedback, 1
being the maximum amount.

Glide Affects notes tied together in the trigger grid. The higher the
Glide setting the more the pitches of the tied notes slide
from one to the next. With a maximum Glide setting of 1.0,
the pitch sliding between tied notes is completely fluid so
that you can't determine the exact point at which each note
starts.

Pitch Set Selects the notes in the arpeggio. Choose notes by clicking
on them.

Direction Controls the movement of the arpeggio. The arpeggio can
move Up, Down, Up/Down (up, then down), or in a Random
pattern.

Base Octave

(BaseOctave)

Defines the position of the Pitch Set keyboard within the full
range of musical pitches. Also determines the Base Octave
of the arpeggio (Osc 1), with 1 being the lowest and 8 the
highest.

With Base Octave set to 1, the lowest note of the Pitch Set
keyboard is C0 (~16.35Hz) - the C below the lowest C on a
full piano keyboard. With Base Octave set to 8, the middle C
on the Pitch Set keyboard corresponds to C8 (~4186Hz) –
the highest note on a full 88 key piano keyboard.
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Range Controls the number of times a sequence (as determined on
the Pitch Set) will recur. Functions in tandem with Cycle
Transpose to define the total pitch range of the arpeggio.

Cy. Trans

(CycleTranspose)

Controls the number of semitones by which a sequence is
transposed, each time it recurs. This parameter is only
activated when Range is set to 2 or more. Every time the
sequence recurs it is transposed by the number of semitones
specified as the Cycle Transpose.

For example, if Range is set to 3 and Cycle Transpose is set
to 12 (twelve semitones, or an octave), the sequence will
play three times: (1) the original pitches specified by the
Pitch Set and Base Octave, (2) shifted up by an octave, and
finally (3) shifted up by a further octave. Then the sequence
returns to the Base Octave and the cycling process starts
again.

Skip

(RandomSkip)

Introduces randomness into the arpeggios by controlling the
probability that notes in the melodic sequence will be
skipped over. Higher values increase the likelihood that notes
will be skipped.

Repeat

(RandomRepeat)

Introduces randomness into the arpeggios by controlling the
probability that notes in the melodic sequence will be
repeated. Higher values increase the likelihood that notes
will be repeated.

Pattern Editor Determines the rhythmic pattern used to advance to the
next note of the arpeggio, as well as ties between notes. See
the Instructions section below for more information.
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Cycle Length

(CycleLength)

Determines the number of beats/bars that occur in a
sequence before it returns to the start of the cycle.
Arpeggiator does not necessarily produce regularly cycling
sequences. If the number of notes selected on the Pitch Set
differs from or is not a factor of the number of triggers
selected in the Trigger Grid, the sequence may take any
number of beats to return to its starting point.

Cycle Length allows you to control irregularities. For
example, in 4/4 time when using a rhythmic value of
semiquavers, a Cycle Length of 16 represents a one bar
cycle, 32 a two bar cycle and so on. A Cycle Length of 0 will
have no effect on the sequence and it will carry out its
defined course.

Cycle Length uses the same units as the currently selected
rhythmic value, as displayed in the drop down menu to the
left of the Trigger Grid.

Instructions

PATTERN EDITOR

The pattern editor displays a rhythmic matrix, which determines the rhythmic pattern used

to advance to the next note of the arpeggio. The pattern consists of a matrix of equally

spaced cells. You can vary the spacing of the cells, the pattern (loop) length and include

one or more time signature changes. Bar and beat numbers are marked along the top of

the matrix. By default, the cells are spaced a sixteenth note (semiquaver) apart within a

two bar loop of 4/4 time.

The Triggers row indicates the on/off state of each note in the rhythmic pattern. Notes can

be toggled on and off by clicking on cells. Click on a cell and drag to "paint" (select)

multiple cells without releasing the mouse.

The Ties row indicates whether a note is tied to the following note. Ties are toggled on

and off by clicking on cells. See Glide (in the Parameters section above) for more

information on ties. Click on a cell and drag to "paint" (select) multiple cells without

releasing the mouse.
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To select a different rhythmic value (instead of semiquavers) for the cell spacing, click on

the drop down list to the left of the matrix and select the desired value. You can also add

customized rhythmic values (p. 143) by selecting Other... from the list and entering new

values.

To learn about changing the length of the pattern and including time signature changes

go to the Editing Rhythmic Patterns (p. 71) and Time Signatures and Rhythmic Units (p.

140) pages of this Help File.

Relevant Example Files

The following files provide some examples of how Arpeggiator can be used:

ArpeggioDrone.amh, HappyPenguins.amh. SidechainingSouthPole.amh, Aava.amh,

Chemutengure-MbiraMelody.amh & ChordProgression.amh

(p. 353) To open the Example Files directory, go to the File menu, select
Open, and double-click on the Examples folder. Read descriptions of the
example files here (p. 353).

Suggested Uses and Practical Applications

Ross Bencina says: “Connect an Arpeggiator to a SouthPole (p. 312) filter contraption to

create traditional analog synthesizer sounds.” Also: “Select a single note for the Pitch Set

to generate single note drones.”

Andrew Bencina says: “In the case of the Arpeggiator, it is one of the few harmonic

contraptions in AudioMulch that can allow for chordal composition through the

automation of pitch sets via presets. In addition, you can get it to perform melodic lines

with varying degrees of randomization.”

Technical Discussion

Arpeggiator combines the functionality of an analog dual oscillator synthesizer with an

arpeggiating sequencer. It is built around two separate sine, square or saw-tooth

oscillators.
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Bassline

Synthesizes and sequences a melody or chops up and filters a sound input.

Bassline lets you create repeating melodies with a variety of pitches, rhythms and accents.

It has a pattern editor for specifying melodies and rhythms, as well as ties and accents.

Bassline can be used with the built-in oscillator (sawtooth or squarewave waveforms), or

you can process (filter) audio by connecting the output of any other contraption to

Bassline's input.

This contraption synchronizes to the global clock. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Arpeggiator (p. 213), SouthPole (p. 312)
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Parameters

Mute Disables sound output when checked.

Sawtooth/
Square
waveform
select

(Waveform)

Lets you select a sawtooth or squarewave waveform

Volume Controls the output level.

Cutoff

(CutoffFreq)

Controls the cutoff frequency of the resonant filter.

Resonance Controls the resonance of the filter.

Env mod

(EnvMod,
envelope
modulation)

Controls the amount by which the envelope modulates the filter cutoff
frequency.
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Accent Controls the intensity of accent applied to accented notes in the
sequence grid.

Decay Controls the release length of the envelope. Higher values create
longer decays.

Overdrive Overdrives the filter input, resulting in a distorted, raspy-sounding
filter. Use large amounts of resonance to make this effect more
obvious.

LFO Rate

(LFORate)

Controls the rate (speed) of the LFO (low frequency oscillator). LFO
Rate is a sinusoidal LFO that modulates the Env mod parameter.

LFO Depth

(LFODepth)

Controls the modulation range of the LFO (low frequency oscillator).
At its minimum setting, no LFO modulation is applied.

Pattern
Editor

Represents the melody and rhythm being played, as well as ties and
accents. See the Instructions section below for more information.

<

Reframe
Left

Rotates the pattern left by one rhythmic unit. Triggers that would have
moved before the beginning of the pattern appear at the end of the
pattern. This function acts on the active time range and does not
modify any pattern elements past the end time.

>

Reframe
Right

Rotates the pattern right by one rhythmic unit. Triggers that would
have moved before the beginning of the pattern appear at the end of
the pattern. This function acts on the active time range and does not
modify any pattern elements past the end time.

R~

(Randomise
Pattern)

Randomly generates a new sequence. This function acts on the active
time range and does not modify any pattern elements past the end
time.
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+/-

(Transpose)

Transposes the entire melody up or down. Specified in semitones. For
example, a setting of +3 will transpose the melody up three semitones
and a setting of -3 will transpose the melody down three semitones.

This function acts on the active time range and does not modify any
pattern elements past the end time.

Instructions

If you input a sound into Bassline instead of using the oscillator, the pitch cells of the

pattern editor won't change the pitch of the sound. This is because the input sound is

substituted for the contraption's internal oscillator. Bassline will, however, affect the

input's rhythm and timbre.

Pattern Editor

Use the pattern editor to determine the melody and the rhythm, as well as specify accents

and ties. The pattern editor consists of a matrix of equally spaced cells. You can vary the

spacing of the cells, the pattern (loop) length and include one or more time signature

changes. Bar and beat numbers are marked along the top of the matrix. By default, the

cells are spaced a sixteenth note (semiquaver) apart within a one bar loop of 4/4 time.

The pattern editor has four rows:

The On / Off row determines the rhythm.

The Accents row creates accents. The effect of these accents on each note is controlled by

the Accent parameter (see above).

The Ties row indicates whether a note is tied to the following note. A tie connects one

note to the next without rearticulating the second note. A pitch slide is created if the

notes have different pitches.

The Notes row displays the pitch of each note. Edit these by clicking on the cells. This will

display a piano keyboard so that you can choose a new pitch. Please note: if you are

zoomed out too far, the pitches won't be displayed and will be replaced by '...'. You can

still click on the cells to select a different pitch. You can roll over a cell to see the pitch

displayed in a popup tooltip.
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You can toggle cells in the On / Off, Accents and Ties rows by clicking them. Click on a cell

and drag to "paint" (toggle) multiple cells without releasing the mouse.

To select a different rhythmic value (instead of semiquavers) for the cell spacing, click on

the drop down list at the top left left of the matrix and select the desired value. You can

also add customized rhythmic values (p. 143) by selecting Other... from the list and

entering new values.

To learn about changing the length of the pattern and including time signature changes

go to the Editing Rhythmic Patterns (p. 71) and Time Signatures and Rhythmic Units (p.

140) pages of this Help File.

Relevant Example Files

The following files provide some examples of how Bassline can be used:

RingModBassline.amh, RissetSquelchBass.amh, ShapeSynth.amh, TechnoAutomation.amh,

TranceRiffer.amh, ChordProgression.amh, MulchOnly01 & 05.amh,

OvertonesAutomation.amh & TxtStpBtBxr.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “Bassline functions as both a random and compositional bassline

editor suitable for a wide range of popular electronic music styles. By utilizing the unit's

audio input function, the contraption is extended to make use of a range of filters capable

of transforming incoming sound signals. Of particular interest is the ability of the pattern

editor to superimpose new rhythmic structures onto existing sound files.”

Technical Discussion

Bassline is a simulation of an analog, monophonic synthesizer with a pattern editor.
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BubbleBlower

Randomly chops up and scrambles sound files to create fractured or smooth textures

(granular synthesis).

BubbleBlower is a granular synthesizer (granulator) that operates on a sample loaded from

a sound file. The sample is chopped into small grains that can be output at varying

densities, creating clouds of grains ranging from sparse tics to dense drones and textures.

Each grain has a randomly determined amplitude, pan, inskip (location in the sample),

transposition, duration and envelope shape. In addition to grain density you can quantize

grain onset times to create rhythmic patterns. BubbleBlower is limited to using (at most)

the first 15 seconds of the loaded sound file.

Many parameters make use of range sliders to specify a range of values; in such cases

each grain is assigned a random value from within the specified range. A single value is

selected for each grain, and the value doesn't change for the lifetime of the grain.

This contraption synchronizes to the global clock when using the Quant
(Quantize) parameters. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.
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Related Contraptions

DLGranulator (p. 253), Nebuliser (p. 303)

Parameters

File Selects a pre-recorded sound file to be used as the
granulation source. Click on the Select Sound File button

to choose a file. Alternatively, drag a sound file into
the contraption's sound file slot directly from the
Macintosh Finder or Windows Explorer. The name and
source of the file will be displayed in the sound file slot.

Amp

(Amplitude)

Specifies the range of possible amplitude values available
for each grain.

Pan

(Panning)

Specifies the range of possible stereo panning locations
available for each grain.

Inskip Specifies the range of possible sample inskips available
for each grain. Each grain uses a separately selected
segment of the specified file.
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Trans

(PitchScaler)

Specifies the range of possible transposition factors
available for each grain. The range is +/- 2400 cents (+/-
two octaves) from the original pitch. Positive
transposition factors shift the output higher in pitch.
Negative factors lower the pitch. Trans affects the rate
(speed) at which each grain is played back.

Densi

(Density)

Specifies the average density of grains, expressed in
number of grains per second.

Quant

(QuantizeAmount)

When the clock is running, BubbleBlower allows the
onset times of all grains to be quantized. Set the amount
of quantization from none (0%) to total (100%). The
clock must be running for Quant to work.

Q. Period

(QuantizePeriodMultiplier)

The Quantize Period settings below the Quant slider lets
you specify the quantization period (spacing of
quantization pulses) as a rhythmic unit multiplied by a
number.The clock must be running for grain
quantization to work.

Gdur

(GrainDuration)

Specifies the range of possible durations available for
each grain. The available range is 5 - 500 milliseconds.

Shape

(AttDecRatio)

Each grain has an amplitude envelope consisting of an
attack, sustain and decay portion. Shape determines the
duration of the sustain portion relative to the duration of
the attack and decay portions. When shape is 0, the
envelope is a triangle, when it approaches 1, the attack
and decay portions shorten and the envelope becomes
more rectangular.
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Skew

(GrainSkew)

Specifies the range of possible envelope skew factors
available for each grain. Skew adjusts the relative
duration of the attack and decay portions of the grain
envelope. Smaller values of skew decrease the attack
time and increase the decay time. Larger values of skew
decrease the decay time and increase the attack time.

Max Grains

(MaxGrains)

Controls the maximum number of simultaneously
overlapping grains, ranging from 1-200. Due to the
limited processing power of computers, you cannot mix
an infinite number of overlapping grains in real time.
Even the maximum number of grains in BubbleBlower
(200), can be too hard for slower computers to mix.
Avoid audio glitches on slower computers by lowering
the Max Grains setting. Lower Max Grains settings will,
however, result in a thinner texture.

DCor

(Decorrelation)

Controls the level of correlation/decorrelation between
randomized grain parameters. When set to 0,
parameters for a single grain are correlated so that, for
example, higher pitched grains are panned to the right.
When set to 1, the relationship between grain
parameters is decorrelated, or completely random.

Instructions

As the whole sound file is loaded in to the computer's memory (RAM), be careful of using

large files if you have a computer with a small amount of RAM. The total amount of RAM

used by samples is indicated in the Status Bar at the bottom of the main AudioMulch

window.

Relevant Example Files

The following files provide examples of how BubbleBlower can be used:

TempoAutoTimeStretchSim.amh, BBlowerSoundscape.amh, BBMultitracker.amh,

MetaSSpatosaurus.amh & PondLife.amh
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To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here (p. 353).

Historical Background

BubbleBlower is a stored sample granulator based on the CloudGenerator program by

Curtis Roads and John Alexander.
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Drums

Plays back samples sequenced in repetitive patterns, sometimes used as a drum machine.

Drums is a clock-synchronized contraption that uses pre-recorded sound files (samples) to

create repetitive rhythmic patterns. You can load up to eight sound files into individual

channels. Each channel has its own volume control and mute button and you can program

a rhythmic pattern for it. Channels 1 and 2 can be gated against each other for 'closed

gates open' high-hat sequencing.

This contraption synchronizes to the global clock. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.
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Parameters

Volume

(Volume_1 -
Volume_8)

Controls the volume. The knob on the far left controls the overall
output volume of the contraption. The numbered knobs control the
volume of each channel.

Gate 1 & 2

(Gate1And2)

Prevents (when checked) both drum channels 1 and 2 from being
heard simultaneously. If channels 1 and 2 both have a note
sequenced on the same pulse, channel 1 is heard. This is intended to
replicate the effect of a closed high-hat stopping the ringing of an
open high-hat.

Mute and
Channel
Enable
Checkboxes

(Enable_1 -
Enable_8)

Mute controls (when checked) muting of the whole contraption. The
Channel Enable Checkboxes (at the left of each channel) enable or
disable each channel individually. Check the button to enable a
channel, and click it again to disable (mute) it. In all cases muting
begins or ends at the beginning of the next bar.

Rhythmic
Pattern

Defines the rhythm of each channel. See Instructions section below
for further information.
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<

Reframe
Left

Rotates the pattern left. The amount of shift to each trigger is
determined by the selected snap resolution in the drop-down Snap to
menu. Triggers that would have moved before the beginning of the
pattern appear at the end of the pattern. If the snap resolution is set
to "bars" or "beats," the duration of these quantities in the first time
signature of the pattern is used. Reframe has no effect if the snap
resolution is set to "visible grid."

>

Reframe
Right

Rotates the pattern right. The amount of shift to each trigger is
determined by the selected snap resolution in the drop-down Snap to
menu. Triggers that would have moved before the beginning of the
pattern appear at the end of the pattern. If the snap resolution is set
to "bars" or "beats," the duration of these quantities in the first time
signature of the pattern is used. Reframe has no effect if the snap
resolution is set to "visible grid."

Snap to Determines the snap resolution when inserting and moving triggers
(see below), and also the rotation amount when using the Reframe
buttons (see above). When Snap to Visible grid lines is selected the
snap resolution depends on the zoom level. In this case, each beat
will be subdivided into up to 48 subdivisions.

Instructions

For Drums to operate, at least one channel must have a sound file loaded, be enabled,

have its volume turned up and have a rhythmic pattern entered in the pattern editor. The

master volume must be turned up, the master mute unchecked and the clock running.

As the whole sound file is loaded in to the computer's memory (RAM), be careful of using

large files if you have a computer with a small amount of RAM. The total amount of RAM

used by samples is indicated in the Status Bar at the bottom of the main AudioMulch

window.

PATTERN EDITOR

The lower part of the Property Editor is a pattern editor with eight rows of identical

controls. Each channel has its own row, and is numbered on the left.
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Next to the channel number is a Channel Enable Checkbox, described above.

To the right of the Channel Enable Checkbox is the Sound File Selector / Indicator. This

button indicates the sound file being used for that channel. Click on the button to load a

new sound file. The Sound File Selector / Indicator displays "click to select..." when no file

is selected. An exclamation mark (!) next to the file name indicates that the file can't be

found. You can right-click and select “Close Sound File” to clear the channel. You can also

do this by holding down the Control key (on Windows) or Option key (on Macintosh)

while clicking the button.

To the right of the Sound File Selector / Indicator is a pattern editor channel for entering

the rhythmic pattern. To add a trigger, click on the horizontal central line in the channel.

When you do this, a triangular shaped marker appears, which indicates when the channel

will be triggered. To remove a trigger, click on a triangular marker. You can also drag

triggers left and right. Dragging them vertically outside the channel will also delete them.

By default, triggers are snapped to the grid. Select a different snap to setting, including

bar, beat, or a range of different rhythmic units, in the Snap to drop-down menu. Select

Other... from the drop-down menu to create your own rhythmic unit and/or tuplet ratios.

By holding down the Control key while dragging, snapping is temporarily disabled so that

you can adjust a trigger's place in time off the grid.

Bar and Beat numbers and divisions are indicated near the top of the pattern editor in the

time ruler. The end of the pattern is indicated by the darkened region of the pattern

editor. You can change the length of a pattern by dragging the pattern end marker

located at the end of the pattern in the time ruler. You can also include one or more time

signature changes in your pattern. Go to the Time Signatures and Rhythmic Units (p. 140)

page and Editing Rhythmic Patterns (p. 71) section of this Help File for more information.

Relevant Example Files

The following files provide examples of how Drums can be used:

BeatProcess.amh, DrumLooper.amh, GrungeDrumOne.amh, RissetSquelchBass.amh,

SidechainingSouthPole.amh, TechnoAutomation.amh, BBMultitracker.amh &

TxtStpBtBxr.amh
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To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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LoopPlayer

Plays a looped sound file synchronized to the beat or stretches a loop for pitch and time

distortion effects.

LoopPlayer is a clock-synchronized sample loop player. Use it to play looped sound files in

time with other clock-synchronized contraptions, or to stretch files, resulting in pitch and

time distortions. You can specify the duration of the loop in bars, and shuffle samples

forwards or backwards relative to the clock. You can also specify the duration's time

signature, and the rhythmic unit by which the sample is shuffled.

The contraption has a mute control that switches on bar boundaries.

This contraption synchronizes to the global clock. Remember to press play.

See the Loading Sound Files (p. 122) page for information about supported
file types and how to load sound files.

Related Contraptions

FilePlayer (p. 207), *FilePlayer (p. 188), Drums (p. 229).
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Parameters

File
Selects a pre-recorded sound file. Click on the Select Sound File
button to choose a file. Alternatively, drag a sound file into the
contraption's sound file slot directly from the Macintosh Finder or
Windows Explorer. The name and location of the file will be displayed in
the sound file slot.

Mute Disables sound output (when checked) from the start of the next bar.
When mute is unchecked, audio output resumes from the start of the
next bar.

Length:
bars of

(BarCount)

Specifies the number of bars contained within the sample loop. This
determines how often the sample is re-triggered, and when stretch is
active, how to transpose the sample to conform to the current tempo.

Phase Shuffles the sample forwards or backwards relative to the clock. Use the
drop-down menu at the bottom right of the property editor to specify
the rhythmic unit.

Stretch Transposes the sample so that its playback duration exactly matches the
duration specified by the Length: bars of parameter, at the current
tempo. With Stretch checked, the sample will remain synchronized to
the clock even if the tempo is altered. The pitch of the sample will be
altered.
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Instructions

As the whole sound file is loaded in to the computer's memory (RAM), be careful of using

large files if you have a computer with a small amount of RAM. The total amount of RAM

used by samples is indicated in the Status Bar at the bottom of the main AudioMulch

window.

Relevant Example Files

The following files provide examples of how LoopPlayer can be used:

MulchJungle.amh & TxtStpBtBxr.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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RissetTones

Synthesizes a continuously ascending or descending tone.

RissetTones produces the acoustic illusion of a gliding tone (glissando) that seems to move

continuously up or down in pitch in one direction. The tone is created by mixing a number

of sine wave oscillators together.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

RissetFilters (p. 308)

Parameters
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Rate Controls the speed and direction of the frequencies of the
individual sine wave oscillators. Rate ranges from -5 to 5 Hz. At 0
Hz (default) the tone is stationary. At negative rates (between -5
and 0 Hz) the tone sounds like it is continually descending. At
positive rates (between 0 and 5 Hz) the tone sounds like it is
continually ascending.

Spacing Defines the pitch spacing between individual sine waves in the
tone in cents. The lower the Spacing setting, the greater the
number of oscillators required to complete the acoustic illusion for
a given Range.

Range Defines the upper and lower frequency limits of the tone. The
wider the Range setting, the greater the number of oscillators
required to complete the acoustic illusion for a given Spacing
setting.

Max Oscs

(MaxOscillators)

Defines the maximum number of oscillators used to synthesize the
tone. Lets you limit the number of oscillators in use at one time,
helping avoid CPU overload. The recommended number of
oscillators is displayed to the right of the text box. This number will
ensure that the illusion is maintained. A lower setting than the
number recommended may result in irregularities or gaps in the
tone, which will spoil the illusion. A higher setting has no effect on
the quality of the illusion. However, lowering this number will help
prevent CPU overload while adjusting other parameters.

Relevant Example Files

The following file provides an example of how RissetTones can be used:

RissetPan.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Contraptions Guide - RissetTones 238



Historical Background

The RissetTones contraption is based on the acoustic illusion originally developed by Roger

Shepard in the 1960s and later developed by Jean-Claude Risset. The Risset tone illusion

has been likened to the aural equivalent of the “barber shop pole” on which spiraling

lines appear to continuously move from one end of the pole to the other as it spins.
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10Harmonics

Synthesizes a harmonic tone by controlling the amplitude of the first 10 harmonics

(additive synthesis).

10Harmonics is a ten harmonic additive signal generator. The output is the sum of ten

sinusoidal oscillators spaced at integer multiples of the fundamental frequency. You can

select the fundamental frequency of your tone, and then add varying amounts of the first

ten harmonics to create tones with different harmonic content. A display of the output

waveform is provided and you can adjust the overall gain of the output.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

TestGen (p. 243)

Parameters
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Frequency Controls the fundamental frequency (f1). Frequency ranges from
20 to 2000 Hz.

Gain Controls the output volume.

Harmonic
Amplitudes

(f1-f10,
Amp_1-Amp_10)

Controls the amplitude of each harmonic. The sliders indicate
the gain of each harmonic.

Waveform Displays a normalized view of the composite waveform.

Relevant Example Files

The following files provide examples of how 10Harmonics can be used:

ShapeSynth.amh, TheAudienceIsMulching.amh, TheBells.amh, WaveSequence.amh &

OvertonesAutomation.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Technical Discussion

10Harmonics is based on the concept of additive synthesis – synthesis of sound by

summing (mixing) sinusoidal components. This derives from the idea that complex musical

sounds can be created by combining a series of individual sine waves (sinusoids),

otherwise known as harmonics or partials. In a physical system such as a string or tube,

these partials would correspond to the resonant modes of the system.

As the partials in 10Harmonics are tuned according to the harmonic series (i.e. each partial

has a frequency which is an integer multiple of the fundamental), the resulting sound is

often percieved as a single tone at the fundamental frequency, rather than as a mixture of
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sine tones. The relative strengths of the harmonics affect the timbre of the resultant

sound.
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TestGen

Generates tones: a sine wave or noise.

TestGen generates sine tones and white noise. You can control the volume of the sound

and choose the pitch of the sine tone (frequency range 10 Hz-20,000 Hz).

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

10Harmonics (p. 240)

Parameters

Sine

(Frequency)

Selects a sine wave. Controls the frequency of the sine wave (10 to
20,000 Hz).

Noise Selects white noise.

Contraptions Guide - TestGen 243



Volume

(Amplitude)

Controls the output volume.

Relevant Example Files

The following files provide examples of how TestGen can be used:

GrainMod.amh, MulchJungle.amh, ShapeSynth.amh, SidechainingSouthPole.amh,

TranceRiffer.amh & Chemutengure-MbiraMelody.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “TestGen's white noise source can be used on its own or mixed

with other sounds prior to filtering as a means of thickening or making more noticeable

any filtered effects.”
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CanonLooper

Captures sound and loops it in multiple layers to create musical canons (rounds).

CanonLooper records and loops a single track, playing multiple copies of the track (up to

16 copies) at equally spaced intervals to form a musical canon or round. Each copy is

routed through its own mono output, so it can be mixed or have effects added to it using

additional contraptions. You can also choose from a variety of Ending modes, or ways to

end each track in the canon. You can get each track to complete its cycle before before it

ends, or end all tracks in sync with the others.

This contraption synchronizes to the global clock when using Sync to mode.
Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

LiveLooper (p. 262)
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Parameters

Ending Mode

(EndingType)

Controls how the canon will stop. There are four Ending Modes,
which are activated when you press the End button. The four
modes are:

End all tracks when first track reaches the end of the loop (or
loops).

Once the first track ends its loop(s), end all subsequent
tracks when they reach the end of their loop.

End each track when it reaches the end of its loop.

End all tracks immediately.

Sync to clock
bars
(0.0625-128)

(SyncToClockBars)

Quantizes the onset of each phase to the selected number of
bars in the selected time signature, after you press the phase
advance button (top left corner of the Property Editor). To
activate this parameter, the Sync to checkbox must be checked.

Reset Immediately ends all playing tracks and clears all recorded tracks,
returning the CanonLooper to the Idle phase.

Record Monitor

(RecordMonitor)

When checked, Record Monitor passes the CanonLooper's input
through to output 1 during recording. When unchecked, output
1 will be muted until you stop recording Track 1. You cannot
change the Record Monitor parameter during recording.
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Repeat Limit (0
to 100000)

(RepeatLimit)

Controls the number of times the primary track will loop. When
set to 0, the track will not loop. A value between 1 and 100000
will loop the track the specified number of times. When Track 1
reaches the end of its loop(s) as specified by this value, the
CanonLooper will automatically switch from the Looping phase
to the Ending phase.

Uncheck the Repeat Limit checkbox to enable continuous
looping, and use the End button to manually stop it. Once
recording is stopped, the playback Repeat number is displayed in
the looping phase panel (the button in top left corner of the
Property Editor).

Track Limit
(1-16)

Limits the number of tracks that can be played (including the
original). When the number of tracks reaches the limit, the
CanonLooper automatically switches from the Recording, added
tracks mode to the Recording, all tracks added mode. The
number of active (currently playing) tracks is also displayed next
to Track Limit.

Instructions

CANON PROCESS

The operation of CanonLooper is based on a process of clicking one button to advance

between each phase of the process. This button is located in the upper left hand corner of

the Property Editor, and is labelled Start Recording when the CanonLooper is idle. As you

move through each phase, the label on this button changes to reflect each forthcoming

action (Start first canon track, Stop adding canon tracks, Stop recording, End). The current

phase is also indicated along the bottom of the Property Editor. The phases are listed in

order: Idle, Recording, Recording, adding tracks, Recording, all tracks added, Looping,

Ending.

Button Following
Phase

Description
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Start
Recording

Recording Starts recording.

Start First
Canon
Track

Recording,
adding
tracks

Starts the first canon track and sets the interval (the time
taken between pressing Start Recording and Start First
Canon Track) at which all subsequent canon tracks will be
added.

Stop
Adding
Canon
Tracks

Recording,
all tracks
added

Stops adding canon tracks. This occurs automatically
when the number of active tracks reaches the limit
specified by the Track Limit parameter.

Stop
Recording

Looping Stops recording of Track 1 and sets loop length (equal to
the length of Track 1) for all tracks .

End Ending Activates the Ending mode.

Each track displays a progress indicator, which displays the current Track location or

playback position of that track and a Track Status indicator (see below) showing whether

the track is recording, playing or stopped.

TRACK STATUS

The Status indicator displays an icon indicating the current status of each track, which can

be one of the following:

The track is empty, no sound has been recorded into it.

The track is recording.

The track has a loop recorded into it, but it is currently not playing; it is stopped.

The track is playing.
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The track is playing, but will stop as soon as the next synchronization point arrives.
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DigiGrunge

Applies digital distortion effects (bit depth reduction, sample rate decimation).

DigiGrunge can be used to create digital distortion and extremely clipped and distorted

sounds characteristic of low bit rate sampling techniques. With DigiGrunge you can apply

two types of digital distortion to a sound: bit depth quantization noise and sample rate

decimation aliasing.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Shaper (p. 290)

Parameters
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Input Gain

(InputGain)

Adjusts the input signal to achieve an optimal amount of quantization
noise. This is important as the bit depth quantization technique
employed in this contraption is dependent on the input level.

Bit Depth

(BitDepth)

Controls the number of bits being used to represent the signal.

Decimation Controls the amount of effective sample rate reduction. A decimation
setting of 1 keeps the signal at its original sampling rate, a decimation
setting of 2 reduces the sample rate to half the original, and so on.

Use Decimation to add digital distortion to the sound.

Relevant Example Files

The following files provide some examples of how DigiGrunge can be used:

GrungeDrumOne.amh & MulchJungle.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here (p. 353).

Suggested Uses and Practical Applications

Ross Bencina says: “Select a bit depth of 1 to create an extreme, clicking distortion. This

reduces the signal to either on or off (plus a sign bit). The distorted signal can then be

used as an input for resonant contraptions like 5Combs (p. 298) or Phaser (p. 272) to

create sounds with a percussive quality.”

Also: “Use less extreme settings of bit depth to create the type of digital noise commonly

associated with early digital samplers and computers.”
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Technical Discussion

The Bit Depth control applies the process of quantization to reduce the number of bits

(effectively, the range of numbers) used to represent the audio signal. At its most extreme,

the signal is reduced to 1 bit – one of two values: 0 (off) and 1 (on), which produces

extremely distorted clicking.

The Decimation control produces an effect called digital aliasing, which causes all

frequencies in the input signal that are above half the effective sample rate (technically

referred to as the Nyquist frequency) to be reflected around the Nyquist frequency.

Therefore, as the Decimation parameter is increased, frequencies above the Nyquist

frequency get reflected progressively lower below it, often resulting in low frequency

tones and other artifacts.
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DLGranulator

Randomly chops up and scrambles live sound to create fractured or smooth textures

(granular synthesis).

DLGranulator is a delay line granulator that operates on audio input buffered in a delay

line. The buffered audio is chopped into small grains that can be output at varying

densities, creating clouds of grains ranging from sparse tics to dense drones and textures.

Each grain has a randomly determined amplitude, pan, transposition, delay time,

feedback, duration and envelope shape. You can quantize grain onset times to create

rhythmic patterns, and the interonset time parameter (IOT) lets you determine the time

between the start of one grain and the next. You can also statically sample the delay line

with the freeze parameter. The mix (ratio) of the input signal and the granulated sound

can also be controlled.

Many parameters make use of range sliders to specify a range of values; in such cases

each grain is assigned a random value from within the specified range. A single value is

selected for each grain, and the value doesn't change for the lifetime of the grain.

This contraption synchronizes to the global clock when using the Quant
(Quantize) parameters. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.
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Related Contraptions

Nebuliser (p. 303), BubbleBlower (p. 224).

Parameters

InGain

(InputGain)

Adjusts the volume of the input signal before it is
granulated.

Amp

(Amplitude)

Specifies the range of possible amplitudes available for
each grain.

Pan

(Panning)

Specifies the range of possible stereo panning locations
available for each grain.
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Delay

(DelayTime)

Specifies the range of possible sampling delay times
available for each grain. Each grain uses a separately
selected segment of audio from the delay line. If the
minimum and maximum values of Delay are the same,
the output will be a time-aligned, amplitude-modulated
version of the input signal, delayed by the amount
specified. If the minimum and maximum values of Delay
specify a range, this has the effect of time-smearing the
input signal (each grain will be assigned a random delay
time from the specified range). Delay ranges from 0 to
9.5 seconds.

Feed

(Feedback)

Specifies how much of the granulated output is fed back
into the delay line input.

Mix

(WetDryMix)

Specifies the ratio between granulated and input sound.

Trans

(PitchScaler)

Specifies the range of possible transposition factors
available for each grain. The range is +/- 2400 cents (+/-
two octaves) from the original pitch. Positive
transposition factors shift the output higher in pitch.
Negative factors lower the pitch. Trans affects the rate
(speed) at which each grain is played back.

IOT

(InteronsetTime)

Determines the time from the beginning of one grain to
the beginning of the next. If the grain duration (GDur) is
less than the interonset time, a particled texture will
result. If the grain duration exceeds the interonset time,
grains overlap, making it possible to create smooth
textures. Interonset time ranges from 0.5 ms - 2 seconds.

Quant

(QuantizeAmount)

When the clock is running, DLGranulator allows the
onset times of all grains to be quantized. Set the amount
of quantization from none (0%) to total (100%). The
clock must be running for Quant to work.
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Quant. Period

(QuantizePeriodMultiplier)

The Quantize Period settings below the Quant slider lets
you specify the quantization period (spacing of
quantization pulses) as a rhythmic unit multiplied by a
number.The clock must be running for grain
quantization to work.

Shape

(AttDecRatio)

Each grain has an amplitude envelope consisting of an
attack, sustain and decay portion. Shape determines the
duration of the sustain portion relative to the duration of
the attack and decay portions. When shape is 0, the
envelope is a triangle, when it approaches 1, the attack
and decay portions shorten and the envelope becomes
more rectangular.

Skew

(GrainSkew)

Specifies the range of possible envelope skew factors
available for each grain. Skew adjusts the relative
duration of the attack and decay portions of the grain
envelope. Smaller values of skew decrease the attack
time and increase the decay time. Larger values of skew
decrease the decay time and increase the attack time.

Freeze Pauses input to the delay line, allowing the delay line to
be statically sampled for time-freezing effects.

Max Grains

(MaxGrains)

Controls the maximum number of simultaneously
overlapping grains, ranging from 1-200. Due to the
limited processing power of computers, you cannot mix
an infinite number of overlapping grains in real time.
Even the maximum number of grains in DLGranulator
(200), can be too hard for slower computers to mix.
Avoid audio glitches on slower computers by lowering
the Max Grains setting. Lower settings will, however,
result in a thinner texture.
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DCor

(Decorrelation)

Controls the level of correlation/decorrelation between
randomized grain parameters. When set to 0,
parameters for a single grain are correlated so that, for
example, higher pitched grains are panned to the right.
When set to 1, the relationship between grain
parameters is decorrelated, or completely random.

Relevant Example Files

The following files provide examples of how DLGranulator can be used:

ArpeggioDrone.amh, BeatProcess.amh, GrainMod.amh, SimplePlugnPlay.amh,

TheAudienceIsMulching.amh, BBMultitracker.amh, Chemutengure-MbiraMelody.amh,

LooperJam.amh, MetaSSpatosaurus.amh & OvertonesAutomation.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Ross Bencina says: “Combining moderate levels of Feedback with a non-unity Transpose

setting will create ascending or descending chords. Since each transposition is fed back

into the stream, which then gets transposed again, the result is a chord comprising a stack

of equal intervals. By also increasing the Delay parameter from zero, you can create

transposed delays where each repeated delay is transposed by the Transpose factor,

creating arpeggios.”
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Flanger

Creates a sweeping, whooshing filter effect with a metallic, ringing sound.

Flanger applies a modulated whooshing sound (resulting from phase reinforcement and

cancellation) to the input signal. A comb filter, frequency modulated by a sine wave, is

used to create this effect. You can specify the range of frequencies over which the filter

sweeps, and how fast the filter sweeps up and down. The amount of resonance can be

controlled, and the mix ratio of the input signal to the effected signal can be adjusted

(wet/dry mix).

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Phaser (p. 272)

Parameters
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Range

(FrequencyRange)

Specifies the minimum and maximum frequencies that the filter
sweeps between, ranging from 20 Hz - 4000 Hz.

Rate Specifies how fast the filter is swept up and down in pitch
between the minimum and maximum frequencies, specified by
Range. The rate ranges from 1 cycle every 100 seconds to 100
cycles per second.

Feedback Controls the amount of feedback. Higher values of feedback
cause the flanger to ring or resonate producing a more
noticeably pitched effect.

Wet/dry mix

(WetDryMix)

Controls the ratio of input vs. flanged signal.

Relevant Example Files

The following files provide examples of how Flanger can be used:

BeatProcess.amh, FlangerVsPhaser.amh, HarpoonedFeedback.amh, SimplePlugnPlay.amh,

TechnoAutomation.amh & TheBells.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Historical Background

The flanger effect was originally produced by using two slightly out of sync reel-to-reel

tape machines playing the same sound. By leaning on the flange of one of the tape reels,

the speed of one of the tape decks could be slightly altered, resulting in subtle phase

cancellations between the sounds played from the two tape machines. This contraption is

a digital implementation of a flanger.
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FrequencyShifter

Shifts harmonics to create metallic sounds, or sweeping phaser-like effects when used

with subtle settings and feedback.

FrequencyShifter shifts all frequencies in the input signal up or down by the amount

specified by the Rate parameter. Frequency shifting is not the same as pitch shifting; pitch

shifting maintains the harmonic relationship between all frequencies, while frequency

shifting shifts all frequencies by the same amount. When used subtly (for example, at a

rate of less than 10Hz), FrequencyShifter can stretch or compress the harmonic series of a

sound. At rates higher than this an effect similar to ring modulation is created. You can

also control the ratio of the input signal to the frequency shifted signal (wet/dry mix). If

you use a low rate and a 50% wet/dry mix, you can create a whooshing sound similar to a

Phaser or Flanger. You can then use the Rate parameter to control the speed of the

whooshing.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

RingAM (p. 279), Flanger (p. 258), Phaser (p. 272)
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Parameters

Rate

(ShiftFrequency)

Specifies the amount by which frequencies are shifted, with a
range of +/-20000 Hz. When the Wet/dry mix parameter is set to
around 50%, the Rate parameter determines the speed at which
the whooshing sound sweeps.

Wet/dry mix

(WetDryMix)

Controls the ratio of input vs. frequency-shifted signal.

Relevant Example Files

The following files provide examples of how FrequencyShifter can be used:

FrequencyShifterHarmonicFeedback.amh, TranceRiffer.amh & ResonantString.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “By combining both the wet and dry signals (using a Wet/Dry mix

of 50% for example) and using a small amount of frequency shifting (less than +/-5Hz for

example), an upwards or downwards phasing effect can be created which is somewhat

like that created by the Phaser (p. 272) and the Flanger (p. 258). This technique works

best with broadband sounds (those with a broad range of frequencies).”
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LiveLooper

Captures and controls up to 16 tracks of looping sound.

LiveLooper records and plays back up to 16 synchronized loop tracks. Each track can be a

different length and a number of options are provided for starting and stopping tracks

independently, or in sync with each other.

This contraption synchronizes to the global clock when using Sync to mode.
Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

CanonLooper (p. 245)
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Parameters

Start/Stop

(RecordActive)

Starts or stops recording. Depending on the Record Mode and
Sync to settings, recording may not start immediately, but will
start or stop at the next synchronization cycle boundary (see
the Sync to parameter below).

Next

(NextRecordTrack)

Advances the recording process to the next track. Use Next
when recording a chain of tracks in Manual mode to advance
recording to the next track. In the Auto-chaining modes,
recording is advanced automatically, and the Next button will
only be enabled for recording the first loop in Auto-chain
(fixed) mode or the first loop of each chain in Auto-chain
(variable) mode. In all modes, the next track will start recording
at the next synchronization cycle boundary (see the Sync to
parameter below).
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Manual/Auto-
chain
(fixed)/Auto-
chain (variable)

(RecordMode)

LiveLooper has 3 record modes: Manual, Auto-chain (fixed) and
Auto-chain (variable).

In Manual mode, you control everything. Press the Start/Stop
button to start and stop recording, and advance recording to
the next track with the Next button. Once the first track has
been recorded, each subsequent track can be a different length
(see the Sync to section below to see how these lengths are
related).

In Auto-chain (fixed) mode each track is recorded with the
same length as Track 1. Recording is always advanced to the
next track once this length has been reached. Tracks will be
recorded one after the other until the Chain limit is reached
(see the Chain limit parameter below). If you want to stop
recording before the limit is reached, press the Stop button. If
you start recording more tracks later LiveLooper will continue
to automatically advance to the next track when the current
track reaches the same length as Track 1.

Auto-chain (variable) mode works like Auto-chain (fixed),
except that the first loop of each chain (and hence all the other
loops in that chain) can be a different length.

Chain limit

(ChainedTrackLimit)

Determines how many tracks will be recorded one after the
other once Start is pressed. This setting applies to the Auto-
chain modes.
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Sync to Tracks are recorded in sync with each other so that their loop
lengths match. The boundaries at which recording starts and
stops are called synchronization cycle boundaries. When you
press Stop or Next, recording will stop, or advance, when the
next synchronization cycle boundary arrives.

With the default settings, Track 1 can be any length, and all
subsequent loops will be multiples of Track 1's length. It is
possible to make the synchronization boundaries occur at
multiples or subdivisions of Track 1 by selecting Multiples of
Track 1 or Subdivisions of Track 1 from the drop-down list to
the right of Sync to. Select the multiple or subdivision you want
using the number edit box. The Clock Bars setting, also in the
drop down list to the right of Sync to, lets you synchronize
tracks to the global clock. Enter the number of bars (or a
decimal fraction of a bar) into the number edit box.

End all Stops all currently playing tracks. Each track will stop according
to its own Enable mode.

Reset Allows you to clear all tracks. You will be prompted to confirm
the operation before it proceeds.

Record Monitor

(RecordMonitor)

When checked, passes the LiveLooper's input through to the
output channel corresponding to the Track being recorded.
When unchecked, the corresponding output channel will be
muted during recording. This parameter cannot be changed
during recording.

Tracks For information about all parameters in the Track Grid, see
Instructions below.
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Instructions

TRACKS

LiveLooper supports recording and playback of up to 16 tracks. Each track has a separate

audio output. While recording, the input is played through to the track's output if the

record monitor check box is checked. Once recorded, each track can be started and

stopped independently, although they will always maintain synchronization with the other

recorded tracks. The Property Editor contains a Track Grid, consisting of 16 columns. The

grid contains information about each track and lets you control the tracks. The various

indicators and controls in the grid are described below.

Clear

Use the Clear button , at the top of each column (except Track 1) to clear a recorded

loop (during playback or while stopped). When you click Clear, a confirmation dialog pops

up to ensure you don't accidentally delete a track. Holding down Ctrl on a PC, or Option

on a Mac when clicking Clear bypasses the confirmation dialog and automatically clears

the track.

Track 1 provides master timing information that the other tracks depend on. Once track 1

is recorded it cannot be cleared unless you click on Reset.

Length

The Length indicator displays the track's length as a fraction or multiple of Track 1's

length. For example, a value of 2 indicates a track twice the length of Track 1, a value of

11/3 indicates a length that is eleven thirds of Track 1's length. If the length ratios are

complicated, the value will be displayed as an approximate decimal value.

Location

Each recorded track displays a circular location indicator, which indicates the current

playback position of each track (even if the track is stopped). This makes it easy to see

when each track will reach the end of its cycle.
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Status

The Status indicator displays an icon indicating the current status of each track, which can

be one of the following:

The track is empty, no sound has been recorded into it.

The track will be the next track recorded. You can click the record button on any

empty track to select it as the next track to record into.

The track is armed for recording. As soon as the next synchronization point arrives,

the track will start recording.

The track is recording.

The track is recording but will finish recording and start playing as soon as the next

synchronization point arrives.

The track is recording but will finish recording and stop as soon as the next

synchronization point arrives.

The track has a loop recorded into it, but it is currently not playing, it is stopped.

The track is stopped, but will begin playing as soon as the next synchronization point

arrives.

The track is playing.

The track is playing, but will stop as soon as the next synchronization point arrives.
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Control

The Control button lets you control the activity of each track. When the track is empty, the

Record button is displayed. Clicking on it will make the track the next one to be

recorded (the Status indicator will reflect this).

Note: Recording is started and stopped using the Start/Stop and Next buttons at the top

left of the Property Editor.

Once a loop has been recorded to a track, it can be started and stopped with the Control

button. When the track is playing, the Stop button is displayed. Clicking on it will stop

the track. When the track is stopped, the Play button is displayed. Clicking on it will

start the track.

Note: Depending on the Enable mode, the track may not start or stop immediately.

Enable (Enable mode)

Each track has a pop-up menu to set its Enable mode. To access this menu, click on the

button in the Enable row, at the bottom of each track's column. The Enable mode

determines when each track will be started or stopped. This allows each track to be

brought in and out of sync with Track 1, or with its own cycle (for example, always

starting to play at the start of a cycle, and ending at the end of a cycle). The Enable modes

and their abbreviations are described below.

Immediate (i) The track will start and stop in direct response to the Control button.

End of Track (t) The track will wait until the end of its loop before it stops or starts

playing.

End of Sync Cycle (s) The track will wait until the end of the synchronization cycle before

it stops or starts playing. See the description of the Sync to controls above for more

information about the synchronization cycle.

End of Track 1 (1) The track will wait until the end of Track 1's loop before it stops or

starts playing.
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End of Composite Cycle ( c ) The track will wait until all tracks end simultaneously

before it stops or starts playing. The length of the composite cycle depends on the lengths

of different tracks. Depending on when you start recording each track it is possible for a

composite cycle to never occur.

Relevant Example Files

The following files provide some examples of how LiveLooper can be used:

DrumLooper.amh & LooperJam.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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NastyReverb

A digital reverb effect.

NastyReverb is a primitive-sounding digital reverb effect. It roughly simulates the sound of

a reverberant space such as a room, hall or drainpipe. You can adjust the time the reverb

takes to decay and also the ratio of the input signal to the reverberated output (wet/dry

mix).

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

5Combs (p. 298)

Parameters
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Reverb
time

(ReverbTime)

Controls the time the reverb takes to decay, ranging from 100ms to
10 seconds.

Wet/dry
mix

(WetDryMix)

Controls the ratio of input vs. reverberated signal.

Relevant Example Files

The following files provide examples of how NastyReverb can be used:

Aava.amh, BBlowerSoundscape.amh & MetaSSpatosaurus.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “Used subtly, NastyReverb can create the illusion of space when

applied to an otherwise flat mono input.”
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Phaser

Creates a sweeping, whooshing filter effect with a hollow, resonant sound.

Phaser applies a modulated whooshing sound (otherwise known as selective phase

reinforcement and cancellation) to the input signal. A series of all-pass filters, frequency

modulated by a sine wave, are used to create this effect. You can specify the range of

frequencies over which the filter sweeps, and how fast the filter sweeps up and down.

The amount of resonance can be controlled, and you can control the level of phased

signal that is mixed back in with the input.

Phaser is conceptually related to the Flanger (p. 258), but each contraption produces a

different sound. Phaser produces a hollow, resonant sound, whereas the Flanger produces

a more ringing effect, like a resonating string.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Flanger (p. 258), FrequencyShifter (p. 260)
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Parameters

Range

(FrequencyRange)

Specifies the minimum and maximum frequencies that the filter
sweeps between, ranging from 20 Hz - 4000 Hz.

Rate Specifies how fast the filter is swept up and down in pitch
between the minimum and maximum frequencies, specified by
Range. The rate ranges from 1 cycle every 100 seconds to 100
cycles per second.

Feedback Controls the amount of feedback. Higher values of feedback
cause the flanger to ring or resonate producing a more
noticeably pitched effect.

Depth Controls the level of phased signal mixed back in with the input
signal.

Relevant Example Files

The following files provide examples of how Phaser can be used:

FlangerVsPhaser.amh & Aava.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Historical Background

Unlike the flanger, the phaser effect has been developed entirely within the electronic

field.

Contraptions Guide - Phaser 274



PulseComb

Creates a pulse-like chopping of sound input and a pitch-shifting effect.

PulseComb can be thought of as a delay line where each repeat of the delay has its own

envelope. The envelope can be curved (like a cosine bell) or rectangular. You can vary the

duration of the envelope: the maximum duration is equal to the delay repeat rate. The

delay line has feedback, and you can transpose each repeat of the delay. You can also set

a Hold Period so that not every repeat of the delay receives a fresh input signal. This can

create stuttering or more static drone effects.

This contraption synchronizes to the global clock when using the Quant
(Quantize) parameters. Remember to press play.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.
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Parameters

Frequency Controls the frequency of the comb filter, which can also
be thought of as the frequency of the generated pulse
train.

FQuant. Div. & Mult

(FrequencyQuantize

Division &
FrequencyQuantize
Multiplier)

The frequency may be quantized according to a subdivision
of the clock multiplied by the quantize multiplier.

FQuant. Amt

(FrequencyQuantize

Amount)

The amount of quantization applied to the pulse frequency.
The more quantization applied, the closer to the ideal
quantized rhythm each pulse will be snapped.
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Duty Cycle

(DutyCycle)

Controls the duration of the pulse envelope relative to the
period of repetition as determined by the Frequency
parameter. Lower values of Duty Cycle create shorter
pulses, higher values allow more of the source signal
through.

Smoothing Determines the duration of the attack and decay portions
of the pulse envelope. Higher values create a curved, bell-
like envelope, lower values tend towards a rectangle. Very
low values of smoothing cause audible clicks at the start
and end of each pulse repetition.

Transpose Transposes each pulse repetition by the value specified.

Decay Time

(DecayTime)

Determines the decay time of the comb filter.

Hold Period

(HoldPeriod)

PulseComb has the ability to not update the delay line each
time it recycles. This is referred to as "holding". Hold Period
determines the rate at which the delay line is updated from
the input source. Very low values have the effect of
updating the delay line every cycle. High values create
repeated stutterings that only update once per Hold Period.

HoldQuant. Div. &
Mult.

(Hold Period Quantize
Division & Hold Period
Quantize Multiplier)

The hold period can be quantized according to a
subdivision of the clock multiplied by the quantize
multiplier.

HoldQuant. Amt.

(HoldQuantizeAmount)

The amount of quantization applied to the hold frequency.
The more quantization applied, the closer to the ideal
quantized rhythm each hold period will be snapped.
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Relevant Example Files

The following files provide some examples of how PulseComb can be used.

Pulsar.amh, PondLife.amh & ResonantString.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Technical Discussion

PulseComb is an amplitude modulated comb filter implementing a type of Pulsar

synthesis.

Contraptions Guide - PulseComb 278



RingAM

Adds shifted frequencies, and can produce metallic sounds (ring and amplitude

modulation).

RingAM applies the process of ring modulation or amplitude modulation to an input.

RingAM multiplies the input with either an internal sine wave oscillator or an external

input. The resulting sound is usually an inharmonic spectrum, which includes the sum and

difference frequencies between the input and the oscillator frequency (or frequencies

present in the external modulator). You can adjust the frequency of the internal modulator

and select between two different modulation modes. For more information about the

differences between amplitude modulation and ring modulation, see the Technical

Discussion section below.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

FrequencyShifter (p. 260)

Contraptions Guide - RingAM 279



Parameters

Frequency

(ShiftFrequency)

Controls the frequency of the modulator, with a range of 20Hz -
1500Hz.

Ring Mod Selects ring modulation.

Amp. Mod

(AM)

Selects amplitude modulation.

Instructions

When you attach an external modulator at the second input, the internal sinusoidal

modulator is disabled, and the Amp. Mod and Ring Mod settings have no effect.

Relevant Example Files

The following files provide examples of how RingAM can be used:

Elementals.amh, GranPrix.amh, GrungeDrumOne.amh, NoiseResearch01.amh,

RingModBassline.amh & TheBells.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Technical Discussion

RingAM is based on the processes of ring modulation and amplitude modulation. In these

processes, an input (carrier input signal) is combined with either an internal sinusoidal

modulator, or a second input serving as a modulator. The two signals are multiplied to

produce a single output, which consists of both the sum of and difference between the

frequencies in the carrier and modulator. These new sum and difference frequencies are

called sidebands, the upper sideband relating to the sum of the frequencies, and the lower

relating to their difference.

RingAM lets you use three different versions of this process: amplitude modulation (Amp.

Mod), ring modulation (Ring Mod), and external modulation. To use external modulation,

connect an external modulator at the second input. Amp. Mod and Ring Mod use an

internal sinusoidal modulator and external modulation uses full cycle (AC) ring

modulation.

Both Amp. Mod and Ring Mod use an internal sinusoidal modulator. Amp Mod multiplies

the input signal by a positive sinusoid ranging in amplitude from 0.0 to 1.0, while Ring

Mod uses an AC sinusoid ranging from -1.0 to 1.0.
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SChorus

Creates a sweeping, detuned thickening and stereo-widening chorus effect.

SChorus creates a thickening and widening effect which results from mixing the stereo

input with delayed, pitch-modulated and stereo-panned versions of the input. Separate,

modulated delays are applied to the left and right channels. The lengths of the delays are

varied (modulated by LFOs), which detunes the delayed sounds slightly above and below

the input.

You can vary the rate of delay change and the amount of delay to alter the amount of

detuning. Feedback can be applied to create sweeping resonance effects similar to a

flanger or phaser. You can also adjust the mix ratio of the input signal to the effected

signal (wet/dry mix).

With SChorus you can process a stereo input and create enhanced stereo effects. One way

to do this is by altering the relative phase of the left and right channel delay modulations

using the Right LFO Phase Offset parameter. The other way is by using the Stereoness

parameter, which controls the width of the stereo panning of the delayed sounds. Settings

higher than 100% use phase inversion to create a kind of "super stereo" effect.

With SChorus you can also create a range of more extreme delay modulation effects. For

example, by using fast Rate, and/or extreme Feedback settings.

Connecting a patch cord to only one side of a stereo input on this
contraption bridges the audio to both inputs.
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See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Phaser (p. 272), Flanger (p. 258)

Parameters

Min Delay Controls the minimum amount that the chorus voices are
delayed. This will be most noticeable on percussive sounds,
but is also relevant when using the Feedback parameter, as
this delay contributes to the tuning of the feedback loops.

Delay Sweep
Depth

Controls the range of delay used for sweeping. A longer delay
swept at the same Rate setting leads to greater detuning
(pitch differences) and thus a thicker chorus effect.
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Rate Modulation rate. Speed at which the delay sweeps across the
full range determined by Delay Sweep Depth. This is the
rate at which a triangle wave LFO (low frequency oscillator)
sweeps from minimum delay, to maximum, and back to
minimum. The rate ranges from 1 cycle every 1000 seconds
(0.001 Hz) to 100 cycles per second (100 Hz).

Right LFO Phase
Offset

Controls the relative phase of the delay modulation in the
right channel relative to the left channel, in degrees. Values
greater than zero cause the right LFO to lead the left, while
values less than zero cause the right LFO to trail the left.
Typical values to create a stereo effect are 90 and 180.

Feedback Controls the amount of delayed output fed back into the
input of each delay. Creates a pitched resonance similar to a
flanger. The Feedback parameter can be set to positive or
negative values. At each extreme (-95%/+95%) the sound is
more resonant. Each extreme has its own characteristic sound
due to the different overtone structures of positive and
negative feedback delay loops.

HF Rolloff

(HFRolloffFrequency)

Reduces the amount of high frequencies fed to the chorus. At
its highest setting, the high frequencies will be more or less
unaffected, lower values produce a duller tone. This
parameter is the cutoff frequency of a 6dB/octave lowpass
filter.
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Stereoness Controls the width of the stereo panning of the chorused
voices. At zero both voices are panned to the center. At 100%
the voice derived from the left input channel is panned left,
and the voice derived from the right input channel is panned
right. Beyond 100% a "super stereo" effect is used that mixes
a phase inverted signal in the opposite channel to give a
rough illusion of extra stereo width. Negative values cause the
left and right channels to be swapped, e.g. -100% pans the
chorus voice from the left input channel to the right output,
and the right input channel to the left output. Between
-100% and -200% extra anti-phase signal is mixed in.

Wet/dry mix

(WetDryMix)

Controls the ratio of input vs. chorus. Setting the wet/dry mix
to around 50% blends the delayed voices equally with the
input sound. This thickens the sound, creating the intended
chorus effect. A value of 0% outputs just the original input,
while 100% only outputs the processed sound.
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SDelay

Applies stereo delays, repetitive echo and stereo ping-pong effects.

SDelay takes a stereo input and replays each channel (left and right) after a specified delay

time. The delay times for each channel can be specified separately. The delayed sound can

be mixed with the original input to create an echo effect. By recirculating the delayed

input back through the delay line (Feedback), the number of repetitions can be increased.

You can select from different feedback modes, including Stereo, Ping-Pong, Ping-Left and

Ping-Right, each of which creates a different stereo echo effect. The delay times for the

left and right channels can be adjusted separately, either in milliseconds, or with rhythmic

units.

This contraption synchronizes to the global clock tempo when using the
Sync to rhythmic units mode.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.
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Parameters

Mode

(FeedbackMode)

Selects the feedback mode. There are four feedback modes:
Stereo, Ping-Pong, Ping-Left, and Ping-Right. Each mode results in
the left and right delays combining and repeating in a different
way.

Stereo : provides two mono delay lines, each with independent
feedback paths.

Ping-Pong : provides a full stereo ping-pong effect, by using
crossed-over inputs and crossed-over feedback between the two
delays.

Ping-Left : feeds the left delay outputs back into both inputs
providing a less dense, "half ping-pong" effect.

Ping-Right : feeds the right delay outputs back into both
inputs providing a less dense, "half ping-pong" effect.

Delay units

(DelayUnits)

Determines whether delay times are to be specified in milliseconds
or rhythmic units. Choose a rhythmic unit from the Sync to drop-
down menu or select Other... from the drop-down menu to create
your own unit or tuplet ratio.

Contraptions Guide - SDelay 287



Delay times

(LeftDelay,
RightDelay)

Specifies separate delay times for the left and right channels.
Delay times can range from 0 to 2000 milliseconds (0 to 2 seconds
) when Delay units is set to Milliseconds. When Delay units is set
to Sync to, delay times range from 0 to 32 units in any rhythmic
unit. When Sync to is selected, the actual delay times (in seconds)
will vary based on the current global tempo.

Feedback Controls the amount of delayed signal that is fed back into the
input. Larger values of feedback cause the delays to echo for
longer. Feedback values close to maximum can be problematic as
they can cause the delay line to get louder and distort.

Wet/dry

(WetDryMix)

Controls the ratio of input vs. delayed signals.

Relevant Example Files

The following files provide examples of how SDelay can be used:

BeatProcess.amh, FrequencyShifterHarmonicFeedback.amh, SimplePlugnPlay.amh,

TechnoAutomation.amh, TheBells.amh, TranceRiffer.amh, Aava.amh, Chemutengure-

MbiraMelody.amh, LooperJam.amh, Lucier.amh & ResonantString.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Andrew Bencina says: “SDelay can be useful for filling out or widening an instrument's

sound. This widening can serve a range of purposes, depending on the contraption or

context.

For example, when combined with Drums (p. 229), SDelay can be used to "swing" the

programmed sequence, or to increase the complexity of a simple rhythmic pattern. Using

a small Delay time, equivalent to or less than a semiquaver (125ms), with no Feedback and
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Wet/Dry set at 0.00%, the rhythmic pattern is shifted off the beat in relation to other

clock-synchronized signals, creating a swing feel.

By running live vocals or instruments through an SDelay with a Delay time of between

50-100ms and Wet/dry set to 50%, you can create a doubling effect that gives the illusion

of another vocalist/instrumentalist singing or playing in unison.”
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Shaper

Adds distortion with direct control over distortion harmonics (Chebychev waveshaping).

Shaper creates harmonic distortion using a technique called waveshaping. It lets you

graphically edit the relative strength of the first 27 harmonics in the distortion. The

resulting signal varies, depending on the harmonic content and amplitude of the input

signal.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

DigiGrunge (p. 250), Compressor (p. 318), Limiter (p. 322)
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Parameters

Input Gain

(InputGain)

Controls the level of the input signal. Because of an internal scaling
algorithm, Input Gain affects only the amount of shaping distortion
applied, and not the output level of Shaper.

Output
Gain

(OutputGain)

Controls the output level independent of the Input Gain.
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Harmonic
weightings

(Weight_1 -
Weight_27)

Controls the relative strengths of the harmonics. Move the mouse
over the graph to highlight individual harmonics, numbered from 0 to
27.

Harmonic 0 is equivalent to the input signal only, and you will hear no
variation to the harmonic weightings if this is the only harmonic
selected. To select other harmonics, click on any harmonic from 1 to
27 and drag up and down with the mouse to change the strength of
the harmonic. Odd harmonics are displayed red, and even harmonics
are blue.

Holding down the shift key while positioning the mouse over the
Harmonic weightings graph will highlight all of the even-numbered
harmonics. When shift is held down, you can drag the mouse
horizontally over the harmonic graph to “paint” the even harmonics.
If you hold down the control key instead, all of the odd-numbered
harmonics will be highlighted, and can then be “painted”. When
both the shift and control keys are depressed, all harmonics can be
“painted”.

Shaping
function

Displays a graph of the distorting function. Input is graphed on the
horizontal axis, and output on the vertical axis.

Instructions

Shaper is very sensitive to input level. Varying amounts of distortion will be produced

depending on the level of the input. If you vary the Input Gain, you can create interesting

shifts in the harmonic balance. Overdriving Shaper may produce harsh clipping distortion.

Relevant Example Files

The following files provide some examples of how Shaper can be used:

ShapeSynth.amh, Chemutengure-MbiraMelody.amh & TranceRiffer.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Suggested Uses and Practical Applications

Ross Bencina says: “Use Shaper as a flexible distortion processor. You may need to

distort only the first few harmonics to create complex distortion effects. The more complex

the input sound is, the less distortion is required to create a noticeable effect.” Also: “Use

Shaper for non-linear waveshaping synthesis. Use a sine wave or other simple waveform

(such as those generated by TestGen or 10Harmonics) as your input, and modulate the

Input Gain to synthesize various harmonic spectra. With a 0dB sine wave as input and

maximum Input Gain, the relative strength of the harmonics in the output will match

those specified in the Harmonic weightings graph. Changing the Input Gain will produce

different harmonic weightings.”

Technical Discussion

Shaper uses the Chebychev polynomial technique to compute the waveshaping function.

Whenever a harmonic weighting is changed, Shaper recomputes the waveshaping

function. As this is a time consuming operation you can expect the CPU usage to increase

if you control the weightings using automation, MIDI or the Metasurface.
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SSpat

Creates the illusion of sound moving in space in looped paths using panning and doppler

shift.

SSpat is a stereo spatializer that allows you to project a moving mono source signal into a

virtual plane lying behind a pair of stereo speakers. The sound travels in a looped path.

You can specify the path that the sound will travel along, the velocity of motion, as well as

parameters that affect the apparent dimensions of the virtual plane.

The sound source can move at a speed dictated by the Velocity parameter, or alternatively,

it can traverse the path synchronized with the clock (cycling every 8 bars for example).

This contraption synchronizes to the global clock tempo when using the
Sync Period mode.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.
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Parameters

Path Allows you to specify the spatialization path. The path defines
the shape (but not necessarily the position or scale) of the
trajectory that the source signal travels along. The path
consists of a looped spline, comprising 3 or more segments.
Extra segments can be added by clicking anywhere along the
existing path. To change the shape of the path, you need to
move the segments. To do this, click and drag a handle
(square box). To delete a segment, hold down the control key
and click on the handle of the segment you want to delete.

Trajectory

(PathOriginX,
PathOriginY,
PathRotation,

PathScale)

Controls the location of the path within the virtual plane. The
L and R boxes at the bottom of the Trajectory panel indicate
the location of the speakers relative to the trajectory (viewed
from above, with the listener below the pane). To move the
path within the plane, click on it and drag it with the mouse.
To rotate the path, hold the control key down while dragging
up and down. To change the scale of the path, hold the shift
key down and drag up and down with the mouse.

Velocity and Sync
Period radio
buttons

(RateMode)

Determines whether the spatialization path is traversed
asynchronously (with speed determined by the Velocity slider)
or in time with the beat (clock-synchronously). In clock-
synchronous mode the path is synchronized to the beat, with
a period determined by Sync Period and Sync Period Units, and
with a phase determined by Sync Phase.
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Velocity Controls the rate at which the source signal travels around the
trajectory. Velocity is used to control the rate when the
Velocity rate mode radio button is selected.

Sync Period / Sync
Period Units

(SynchronousPeriod)

Controls the rate at which the source signal travels around the
trajectory. Sync Period is used to control the rate when the
Sync Period rate mode radio button is selected. The Sync
Period number box is used to specify the period (duration) of a
full cycle around the trajectory. The period is expressed in
rhythmic units, the rhythmic units combo box to the right of
the Sync Period number box is used to select the units used to
specify both the Period and the Phase (for example 1/16s).

Sync Phase

(SynchronousPhase)

Controls the relative phase of the trajectory when in clock
synchronous rate mode. The units are those specified for Sync
Period.

Scale Controls the relative size of the virtual plane. This affects the
amplitude and doppler shift of the source signal. Larger values
of scale make the rear of the virtual plane seem further away.

Doppler

(DopplerAmount)

Controls the amount of doppler shift. At the minimum setting,
no doppler shift is applied to the source.

Amp Amount

(AmplitudeAmount)

Controls the amount of attenuation applied to the source
signal as a result of its distance from the virtual listener. At the
minimum setting, no attenuation is applied to the source.

Separation Affects the apparent width of the stereo image. Larger values
of separation produce more pronounced left-right panning.
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Reverb Scaling

(ReverbScaling)

Works similarly to Amp Amount, but applies to the distance-
based scaling of the source signal as it is sent to the reverb
send output. The reverb send allows a more realistic room
simulation to be achieved. It consists of a delayed version of
the input, amplitude-scaled relative to its distance from the
rear of the virtual plane.

Relevant Example Files

The following files provide some examples of how SSpat can be used:

GranPrix.amh, SSpatChorus.amh, BblowerSoundscape.amh, MetaSSpatosaurus.amh,

PondLife.amh & Elementals.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Ross Bencina says: “Typically the Reverb send output would be connected to a

reverberation contraption (such as Nasty Reverb).”

Steve Adam says: “SSpat can be useful in creating a repeating amplitude variation to a

sound, i.e. Amplitude LFO, when doppler amount is low, or pitch LFO when doppler shift

is up and amplitude amount is low. Also can be used as a stereo panner by keeping the

trajectory path quite close to the “front” of the sound field.”
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5Combs

Filters sounds through tuned comb filters that sound like resonating strings.

A comb filter is a very short delay line with feedback. The delay is usually so short that you

can hear it resonating at a specific pitch. 5Combs is a bank of five comb filters in parallel.

You can change the frequency, volume and decay time of each filter, as well as adjust the

overall volume level of the combined signals.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

PulseComb (p. 275), NastyReverb (p. 270).

Parameters
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Master Gain

(InputGain)

Controls the gain (level) of the overall output.

Frequency

(Frequency_1
-

Frequency_5)

Controls the fundamental frequency of each comb filter, ranging
from 16Hz-12kHz. You can specify frequency with the slider. Or, you
can choose the frequency by typing a value into the box at the right
of the slider, or use the up/down arrows to select a value. You can
also choose the note on a keyboard interface. To access the
keyboard, click on the note name to the right of the frequency value
box and the keyboard will appear. Click on a key to select a note.

Note: The new frequency value is always displayed as a musical
pitch name in the box at the right of the value box. When the
frequency doesn't correspond exactly to a musical pitch, the distance
from the exact pitch is shown in cents (+ means that the frequency is
above the exact note frequency, and - means below).

Decay time

(DecayTime_1
-

DecayTime_5)

Determines how long each filter rings for, ranging from 0.02 of a
second to 10 seconds. The actual decay time will be affected by the
type of sound you use.

Gain

(Gain_1 -
Gain_5)

Controls the gain (level) of each comb filter.

Relevant Example Files

The following files provide examples of how 5Combs can be used:

BeatProcess.amh, TranceRiffer.amh, MetaSSpatosaurus.amh & ResonantString.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Suggested Uses and Practical Applications

Andrew Bencina says: “By setting each filter to a different note, with moderate decay

times it is possible to create a chordal drone by processing any signal, even those that

originally seemed to possess no harmonic quality (e.g. Drums).”

Technical Discussion

As mentioned above, the comb filter is a very short delay line with feedback, with the

delay so short that it appears to resonate at a specific pitch. This occurs as the result of

periodic cancellation and reinforcement, which in turn creates a series of harmonically

related peaks and notches throughout the audio frequency range. These peaks and

notches are evenly spaced and of equal height and depth; when the frequency response is

visualized it has the appearance of a comb, hence the name.
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*ParaEQ

Equalizer filter boosts or cuts certain frequencies (parametric with high and low shelf, and

two sweepable mid bands). (M=Mono, S=Stereo)

MParaEQ and SParaEQ are mono and stereo versions of a parametric equalizer. Each

contraption consists of a high shelf filter, two midrange peak/notch filters (boost/cut) and

a low shelf filter. The range of each filter section is listed in the parameters section below.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Parameters

Cutoff/Center frequency (cf) Bandwidth (bw ) Gain
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Hi 500Hz-18KHz - +/- 30db

Mid1 20Hz-18KHz 85Hz-2KHz +/- 30db

Mid2 20Hz-18KHz 85Hz-2KHz +/- 30db

Low 20Hz-10KHz - +/- 30db

Relevant Example Files

The following files provide examples of how *ParaEQ can be used:

Aava.amh, Chemutengure-MbiraMelody.amh & ResonantString.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here (p. 353).
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Nebuliser

Randomly chops up and scrambles live sound with random filtering to create watery

sounds (filtered granular synthesis).

Nebuliser is a delay line granulator and granular filter that operates on audio input

buffered in a delay line. The buffered audio is chopped into small grains, each of which

passes through a bandpass filter. The grains can be output at varying densities, creating

clouds of grains ranging from sparse tics to dense drones and textures. Each grain has a

randomly determined amplitude, pan, transposition, delay time, feedback, duration,

envelope shape, filter cutoff and resonance amount (Q). You can quantize grain onset

times to create rhythmic patterns, and the interonset time parameter (IOT) lets you

determine the time between the start of one grain and the next. You can also statically

sample the delay line with the freeze parameter. The mix (ratio) of the input signal and the

granulated sound can also be controlled.

Many parameters make use of range sliders to specify a range of values; in such cases

each grain is assigned a random value from within the specified range. A single value is

selected for each grain, and the value doesn't change for the lifetime of the grain.

All of the processes above are shared with DLGranulator (p. 253). The main difference

between the contraptions is that Nebuliser also passes each grain through a bandpass

filter. You can specify the frequencies of these bandpass filters, as well as the widths of

the filters used on each grain.

This contraption synchronizes to the global clock when using the Quant
(Quantize) parameters. Remember to press play.
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See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

DLGranulator (p. 253), BubbleBlower (p. 224)

Parameters

InGain

(InputGain)

Adjusts the volume of the input signal before it is
granulated.

Amp

(Amplitude)

Specifies the range of possible amplitudes available for
each grain.

Pan

(Panning)

Specifies the range of possible stereo panning locations
available for each grain.
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Delay

(DelayTime)

Specifies the range of possible sampling delays times
available for each grain. Each grain uses a separately
selected segment of audio from the delay line. If the
minimum and maximum values of Delay are the same,
the output will be a granulated version of the input
signal, delayed by the amount specified. If the minimum
and maximum values of Delay specify a range, this has
the effect of time-smearing the input signal (each grain
will be assigned a random delay time from the specified
range). Delay ranges from 0 to 9.5 seconds.

Feed

(Feedback)

Specifies how much of the granulated output is fed back
into the delay line input.

Mix

(WetDryMix)

Specifies the ratio between granulated and input sound.

Trans

(PitchScaler)

Specifies the range of possible transposition factors
available for each grain. The range is +/- 2400 cents (two
octaves) from the original pitch. Positive transposition
factors shift the output higher in pitch. Negative factors
lower the pitch. Trans affects the rate (speed) at which
each grain is played back.

IOT

(InteronsetTime)

Determines the time from the beginning of one grain to
the beginning of the next. If the grain duration (GDur) is
less than the interonset time, a particled texture will
result. If the grain duration exceeds the interonset time,
grains overlap, making it possible to create smooth
textures. Interonset time ranges from 0.5 ms to 2
seconds.

Quant
(QuantizeAmount)

When the clock is running, Nebuliser allows the onset
times of all grains to be quantized. Set the amount of
quantization from none (0%) to total (100%). The clock
must be running for Quant to work.
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Quant. Period

(QuantizePeriodMultiplier)

The Quantize Period settings below the Quant slider lets
you specify the quantization period (spacing of
quantization pulses) as a rhythmic unit multiplied by a
number.The clock must be running for grain
quantization to work.

Shape

(AttDecRatio)

Each grain has an amplitude envelope consisting of an
attack, sustain and decay portion. Shape determines the
duration of the sustain portion relative to the duration of
the attack and decay portions. When shape is 0, the
envelope is a triangle, when it approaches 1, the attack
and decay portions shorten and the envelope becomes
more rectangular.

Skew

(GrainSkew)

Specifies the range of possible envelope skew factors
available for each grain. Skew adjusts the relative
duration of the attack and decay portions of the grain
envelope. Smaller values of skew decrease the attack
time and increase the decay time. Larger values of skew
decrease the decay time and increase the attack time.

Freeze Pauses input to the delay line, allowing the delay line to
be statically sampled for time-freezing effects.

Max Grains (MaxGrains) Controls the maximum number of simultaneously
overlapping grains, ranging from 1-200. Due to the
limited processing power of computers, you cannot mix
an infinite number of overlapping grains in real time.
Even the maximum number of grains in Nebuliser (200),
can be too hard for slower computers to mix. Avoid
audio glitches on slower computers by lowering the Max
Grains setting. Lower settings will, however, result in a
thinner texture.

Contraptions Guide - Nebuliser 306



DCor

(Decorrelation)

Controls the level of correlation/decorrelation between
randomized grain parameters. When set to 0,
parameters for a single grain are correlated so that, for
example, higher pitched grains are panned to the right.
When set to 1, the relationship between grain
parameters is decorrelated, or completely random.

FFreq

(FilterFrequency)

Defines the range of possible frequencies from which
each grain's bandpass filter center frequency is
selected.The frequency range is from 20 – 18,000 Hz.

FQ

(FilterQ)

Defines the range of possible widths for the bandpass
filters used on each individual grain. The higher the
setting the narrower the range. A narrower range will
result in tone-like sounds that ring more, as the filter will
accentuate tighter bands of frequencies.

Relevant Example Files

The following files provide examples of how Nebuliser can be used:

TranceRiffer.amh, ChordProgression.amh & MetaSSpatosaurus.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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RissetFilters

Applies continuously ascending or descending sweeping bandpass filters - a filtering

version of RissetTones (p. 237).

RissetFilters is a variation of the RissetTones (p. 237) contraption. Both contraptions

produce the acoustic illusion of a gliding tone (glissando) that seems to move continuously

up or down in pitch. RissetFilters applies this sweeping effect to a sound input by filtering

it with bandpass filters. The effect created by RissetFilters is similar to that of a flanger or

phaser, except that instead of sweeping up and down, the filters sound as if they are

always sweeping in one direction.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

RissetTones (p. 237), Nebuliser (p. 303), 5Combs (p. 298)
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Parameters

Rate Controls the speed and direction of the center frequencies of each
bandpass filter in the filter bank. Rate ranges from -5 to 5 Hz. At 0 Hz
(default) the filter's center frequencies are stationary. Negative Rate
values produce a continually descending sweep. Positive Rate values
produce a continually ascending sweep.

Spacing Defines the distance between the center frequencies of each successive
bandpass filter.

Range Defines the upper and lower limits of the bell-shaped frequency versus
amplitude envelope applied to each filter band.

Max Filts

(MaxFilters)

Defines the maximum number of filters utilized within the filter bank.
This can be used to limit the maximum CPU load consumed. If you
choose a figure that matches the required value (on the right of the
text box), the sweeping illusion will be maintained. Higher settings
won't have any effect, and lower settings create irregularities and gaps
in the filter bank.

Q

(FilterQ)

Determines the ratio of filter bandwidth to frequency. Higher values of
Q lead to narrower filter bands, which can sound like whistling tones,
and make the sweeping effect more obvious. Higher Q values can also
result in less input signal being passed by the filters, which can lead to
low output levels. Correct this by adding a Gain (p. 337) contraption to
your patch.
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Relevant Example Files

The following files provide some examples of how RissetFilters can be used:

RissetSquelchBass.amh & OvertonesAutomation.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Suggested Uses and Practical Applications

Steve Adam says: “RissetFilters can be useful in providing cyclic variations in otherwise

relatively static textures.”

Warren Burt says: “Have a static drone of several pitches go through the Risset Filters.

Have a low positive Rate (ca 0.191 for example), very close spacing of the bands, a low

range that the bands move through, and Hi Q. This will create a sense of harmonic tension

rising (the axe murderer approaches slowly....heh heh heh) without the listener necessarily

being aware that the filter pitch is rising.”

Technical Discussion

The Shepard/Risset tone illusion has been likened to the aural equivalent of the “barber

shop pole” on which spiraling lines appear to continuously move from one end of the

pole to the other as it spins.

RissetFilters uses a bank of bandpass filters in place of the oscillator bank used in

RissetTones (p. 237). As the center frequencies of the bandpass filters are evenly spaced a

kind of comb filter is created.

Larger Spacing settings and/or narrower Range settings will reduce the number of filters

required by the effect, and hence the CPU load required. Similarly, smaller Spacing or a

wider Range will require more filters and hence will use more CPU.

Historical Background
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RissetFilters is based on the same principle as the RissetTones (p. 237) contraption,

implementing a variation of the acoustic illusion originally developed by Roger Shepard in

the 1960s and later developed by Jean-Claude Risset.

The idea for a Risset filter bank was introduced to the creator of AudioMulch by Steve

Adam who designed the effect for use in his composition Chromophony.
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SouthPole

Applies resonant filtering and amplitude-chopping effects controlled by rhythmic patterns

or sound input (envelope following and pattern controlled ADSR filtering and amplitude

gating).

SouthPole applies a resonant low-pass filter and gain control to an audio input. Gain,

along with the filter's cutoff frequency and resonance can be controlled by a number of

built in modulators. The modulators are:

• 3 ADSR envelope generators that can be triggered by clock-synchronized patterns,

external audio input, or a combination of both.

• 2 LFOs (low frequency oscillators) that can be clock synchronized or free running.

• Envelope followers that follow the amplitude of an audio input.

Triggers and envelope followers are provided for the main audio input and a side chain

audio input. Any combination of modulators can be mixed to control each of filter cutoff,

resonance and gain.

This contraption synchronizes to the global clock. Remember to press play
(applies to clock sync low frequency oscillators and pattern triggered ADSR
envelope).

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.
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Related Contraptions

Bassline (p. 219)

Instructions

BASE PARAMETERS AND MODULATION

The Cutoff, Resonance and Gain knobs, all in the Base column, control the base levels of

these parameters.

Cutoff controls which frequencies will be audible from your input sound. As Cutoff

controls a low-pass filter in SouthPole, frequencies above the set level are attenuated,

thereby allowing the lower frequencies to pass. This affects the timbre of the sound, i.e.

how bright or mellow it sounds.
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Resonance controls how much the frequencies around the Cutoff frequency are

increased in volume. This parameter also affects the timbre of the sound, and can be used

to add a more nasal quality to the filtering.

Gain controls the overall volume of the sound before it leaves the contraption.

Each of these parameters can be modulated by a combination of modulation sources

using the 24 knob modulation mixer at the bottom of SouthPole's Property Editor. Each

source has a mixer knob on the same row as each of the Base parameters. The modulation

sources are: Input Follower, Side Chain Follower, Envelopes 1-3, and Low Frequency

Oscillators 1 and 2 (LFOs).

The modulation sources are summed with (added to or subtracted from) the base value of

each parameter by an amount determined by the corresponding mixer knob.

Base parameter values are expressed in the natural units of the parameter (Hz for

frequency, dB for gain), but modulation knobs specify a modulation amount ranging from

-1.0 to +1.0, which represents a proportion of the full scale Base parameter range. When

set to 0.0, the modulation knob has no effect on the parameter. Turning clockwise (+

values) adds the modulation source to the corresponding base parameter. Turning anti-

clockwise (- values) subtracts the modulation source from the corresponding base

parameter.

ENVELOPES (ENV 1 – ENV 3, ATTACK (A) DECAY (D) SUSTAIN (S) AND
RELEASE (R) KNOBS, GATE DURATION, TRIGGER SOURCE)

There are three identical, pattern-sequenced ADSR envelopes in SouthPole (Envelope 1, 2

and 3). With the Attack (A), Decay (D), Sustain (S) and Release (R) knobs you can control

the attack, decay, and release times, as well as the sustain level. You can also control the

Gate Duration (the time from when the envelope is triggered until the start of the release

segment.)

The envelope can be triggered by the Pattern Editor, or by an external input, or a

combination of the two. See the following sections for a discussion of external input

triggering and the Pattern Editor used for pattern sequencing.

Envelopes can be positive or negative, depending on the relative settings of the Base

Cutoff and Env 1-3 Cutoff. Positive Envelope amounts cause the envelope to sweep

upwards, and negative values cause it to sweep downwards.
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ENVELOPE TRIGGER SOURCE

Trigger Source lets you trigger the envelope in a number of ways: Pattern (triggers the

envelope with the pattern in the Pattern Editor); Input Trigger (derived from the main

audio input signal and controlled by the Input Trigger section at the top of the editor);

Side Chain Trigger (derived from the side-chain input and controlled by the Side Chain

Trigger section at the top of the editor); or by combining the pattern with the external

triggers (Input, Side Chain) so that the envelope only triggers when both a pattern trigger

is present and an external trigger is also detected (Pattern * Input Trigger and Pattern *

Side Chain Trigger).

EXTERNAL AUDIO TRIGGERS (INPUT TRIGGER AND SIDE CHAIN TRIGGER)

SouthPole's external audio triggers are simple mechanisms that can be used to trigger an

envelope when the incoming audio signal exceeds a threshold. For example, the threshold

can be set to detect the onset of percussive sounds such as a drum beat. The Input trigger

responds to the audio signal which feeds SouthPole's filter. The Side Chain Trigger

responds to SouthPole's second “Side Chain” input.

Both the Input Trigger and the Side Chain Trigger may be used to trigger any of the three

envelopes by selecting them using the Trigger Source settings described above. The

controls for the triggers are located at the top of the contraption editor. Each trigger has

two parameters: Threshold and Delay. Threshold determines the lowest input level that

causes a trigger to be generated. Delay determines the time that the trigger generator

waits after generating a trigger before generating another trigger - this may be useful

with some types of input to prevent multiple triggering.

PATTERN EDITOR

The pattern editor displays a rhythmic matrix, which determines the rhythmic pattern used

to trigger the envelope (if Trigger Source is set to Pattern – see above). The pattern

consists of a matrix of equally spaced cells. You can vary the spacing of the cells, the

pattern (loop) length and include one or more time signature changes. Bar and beat

numbers are marked along the top of the matrix. By default, the cells are spaced a

sixteenth note (semiquaver) apart within a two bar loop of 4/4 time.

The Triggers row indicates the on/off state of each note in the rhythmic pattern. The Ties

row indicates whether a note is tied to the following note. Cells in each row can be
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toggled on and off by clicking on cells. Click on a cell and drag to "paint" (toggle)

multiple cells without releasing the mouse.

To select a different rhythmic value (instead of semiquavers) for the cell spacing, click on

the drop down list at the upper left of the pattern editor and select the desired value. You

can also add customized rhythmic values (p. 143) by selecting Other... from the list and

entering new values.

To learn about changing the length of the pattern and including time signature changes

go to the Editing Rhythmic Patterns (p. 71) and Time Signatures and Rhythmic Units (p.

140) pages of this Help File.

LFOS

There are two identical LFOs (low frequency oscillators) in South Pole. As the name

suggests, a low frequency oscillator oscillates slowly, typically slower than the speed we

usually associate with audio frequencies, i.e. slower than 20 cycles per second, and often

much slower. Thus, they're useful for creating rhythmical or slowly modulating changes to

the filter settings.

Each LFO has a variety of waveforms that you can choose from the drop-down menu.

Each LFO also has two basic modes: Clock Synchronous and Asynchronous.

The Clock Synchronous mode lets you create LFOs that stay in time with the beat (cycling

every 8 bars for example). The Period parameter determines the duration of a single LFO

cycle, expressed in rhythmic units. Select the unit you want from the drop-down menu. By

default, the unit is 1/16, a sixteenth note (semiquaver).

Use the Phase setting to adjust the phase of the oscillator. When set to 0.0 (default), the

waveform is aligned with clock time. The phase is expressed in the same unit as the

period. Changing this setting offsets the waveform by this amount, moving the start of

each cycle forward or backwards in time, so that it is out of phase with the clock.

Asynchronous mode provides a more traditional, free-running oscillator. Use the Async

Rate knob to control the oscillation rate (frequency). The asynchronous LFO rate is

specified in Hz.
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ENVELOPE FOLLOWERS (INPUT FOLLOWER (IN FOL.), SIDE CHAIN
FOLLOWER (S.C. FOL.))

Each input – the main audio input and the side chain audio input - has an envelope

follower that is available as a modulation source in the In Fol. and S.C. Fol. columns on the

modulation mixer.

The envelope tracks the overall amplitude of the input signal. This can be used to impart

the amplitude profile of one sound onto another, for example. Each envelope follower has

a Smoothing parameter (knobs located at the top of the Property Editor) that controls how

rapidly the envelope follower tracks the input signal.

Relevant Example Files

The following files provide some examples of how SouthPole can be used:

GrungeDrumOne.amh, HappyPenguins.amh, SidechainingSouthPole.amh,

SimplePlugnPlay.amh, MetaSSpatosaurus.amh & StayingSane.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)

Historical Background

The name SouthPole was a logical choice given that the contraption was inspired by

NorthPole, a free plugin from Prosoniq. While the GUIs of the two contraptions are rather

different, the basic idea is the same: a resonant low-pass filter with some modulation

sources. Actually, NorthPole also includes a delay effect; you could easily add that in

AudioMulch with a separate SDelay contraption.
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*Compressor

Controls the level of a sound to reduce dynamic range or shape transients.

MCompressor and SCompressor are mono and stereo dynamic range compressors.

MCompressor and SCompressor provide parameters to determine the compression curve:

Threshold, Knee Width, Ratio, and parameters that determine how fast the *Compressor

reacts to and recovers from changes in the input signal level: Attack, Hold and Release.

Level meters indicate the input level, output level and amount of gain reduction applied.

The compression curve is also shown.

The *Compressor usually reacts to the level of the input signal. By connecting an alternate

source to the right-most input (the side chain input), it is possible to get the *Compressor

to compress based on a different signal. For example, a filtered version of the input.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Limiter (p. 322), SouthPole (p. 312)
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Parameters

Bypass When enabled, passes the unprocessed input through to the
output.

Input Gain

(InputGain)

Adjusts the gain of the input sound before compression is
applied.

Makeup Gain

(MakeupGain)

Adjusts the gain of the output after compression is applied.
This may be used to compensate for the fact that the
compressor "turns down" the loudest parts of the sound.
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Auto Makeup
Gain
(AutoMakeupGain)

When checked, applies an automatic gain factor related to the
selected compression curve settings. This may reduce the need
to apply manual makeup gain, although this will depend on the
type of sound being compressed.

Attack

(AttackTime)

Adjusts the speed with which the compressor turns down the
gain in response to louder sounds.

Hold

(HoldTime)

Adjusts the time the compressor will hold any gain reduction
before recovering.

Release

(ReleaseTime)

Adjusts the speed with which the compressor recovers after
compression is no longer needed.

Ratio
(CompressionRatio)

Controls the amount by which loud sounds are attenuated. At
a ratio of 1:1 no compression is applied, at 2:1 sounds above
the threshold will be attenuated by half the increase in their
volume. Higher ratios result in more extreme compression. At
the extreme, the volume of the sound will not be allowed to
exceed significantly past the Threshold level - creating a type of
limiting.

Threshold Sets the level around which compression begins. See also Knee
Width below.

Knee Width
(KneeWidth)

Determines how the compressor introduces compression
around the Threshold. When Knee Width is 0, compression
commences as soon as the input signal reaches the Threshold
level (this is called "hard knee" compression). With higher
values, Knee Width determines the width of a "soft knee"
transition band around the Threshold level, where compression
gradually takes effect.
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Instructions

Meters

*Compressor provides a number of meters to allow you to monitor its operation.

The Key (Key), Gain Reduction (GR) and Output (Out) meters use the same scale. It is a

stretched scale which makes it easier to see the top 12dB, which is usually of most interest

when applying compression

From left to right:

The input meter (Key) displays the level of the incoming signal after Input Gain has been

applied. The Threshold level is indicated by an arrow at the left of the meter and the knee

range is indicated by a line at the right. When something is connected to the side chain

input, this meter will indicate the side chain level.

The compression curve grid indicates how the output gain will be reduced as the input

increases. The curve visualizes the threshold, knee width and ratio and also displays the

current input/side-chain level. Each grid line marks a 12dB increment.

The Gain Reduction meter (GR) indicates how much gain reduction is being applied by the

compressor.

The Ouput meter (Out) shows the output level after makeup gain has been applied.

Suggested Uses and Practical Applications

Ross Bencina says: “A common use of a compressor's side chain input is to send a

separately equalized version of the primary input into the side chain (e.g. by using

SParaEQ (p. 301)). For example, feeding a version of the input with fewer high frequencies

to the compressor's side chain will cause the compressor to be less sensitive to high

frequency transients, and possibly create a brighter or more punchy sound.”
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*Limiter

Limits the peak level of a sound to avoid harsh clipping distortion.

MLimiter and SLimiter are mono and stereo peak limiters. A limiter prevents the peak level

of an input signal from exceeding a threshold level. MLimiter and SLimiter provide

parameters for setting the maximum input level and output level, and parameters for

controlling how quickly the limiter recovers after limiting has been applied.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Compressor (p. 318), Shaper (p. 290)

Parameters
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Bypass When enabled, passes the unprocessed input through to the output.

Input Gain

(InputGain)

Adjusts the gain of the input sound before limiting is applied.

Threshold Specifies the maximum allowable input level. Input above this level is
limited.

Ceiling Specifies the resulting maximum output level.

Hold

(HoldTime)

Adjusts the time the limiter will maintain gain reduction. This can be
useful for reducing distortion when limiting low frequency sounds.

Release

(ReleaseTime)

Adjusts the speed with which the limiter recovers after limiting a
peak.

Instructions

Meters

Limiter provides a number of meters to allow you to monitor its operation.

The Input (In), Gain Reduction (GR) and Output (Out) meters use the same scale. It is a

stretched scale which makes it easier to see the top 12dB, which are usually of the most

interest.

From left to right:

The Input meter (In) displays the level of the incoming signal after Input Gain has been

applied. The Threshold level is indicated by an arrow at the side of the meter.

The Gain Reduction meter (GR) indicates how much gain reduction is being applied by the

Limiter.

The Ouput meter (Out) shows the output level. The Ceiling is indicated by an arrow at the

side of the meter.
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Technical Discussion

Limiter uses a "lookahead" algorithm. This employs a fixed 64-sample lookahead buffer

so that it can preempt rapid transients. As a result, all signals passed through this

contraption are delayed by 64 samples.
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*NoiseGate

Allows loud sounds to pass while suppressing quiet ones (or vice-versa).

MNoiseGate and SNoiseGate are mono and stereo noise gates. A noise gate opens and

closes, allowing louder sounds through while muting or reducing the gain of quieter

sounds. *NoiseGate also provides a “duck” mode which attenuates loud sounds while

leaving quieter sounds unchanged. Parameters are provided that determine when the gate

opens and closes, how much gain reduction is applied when the gate is closed, and how

fast the gate opens and closes.

The right-most input is a side chain input. When connected, this input is used to control

the opening and closing of the gate. This can be used to create rhythmic gating effects

where one sound is gated according to the rhythm of the sound connected to the side

chain input.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

SouthPole (p. 312), Bassline (p. 219)
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Parameters

Bypass When enabled, passes the unprocessed input through to the output.

Mode Determines whether the gate opens for loud sounds (Gate mode) or
for quiet sounds (Duck mode). In Gate mode, the gate opens for
loud sounds (those above the threshold) and closes (attenuates) for
quiet sounds (those below the threshold). In Duck mode, the
contraption "ducks" loud sounds, attenuating them, while leaving
quiet sounds unaffected.

Input Gain

(InputGain)

Adjusts the gain of the input sound before being gated.

Threshold Specifies the input level at which the gate opens and closes. The
threshold parameter uses a range slider. The upper (maximum) value
specifies the open threshold, while the lower (minimum) value
specifies the close threshold. Although the gate will work with both
thresholds set the same, using a lower close threshold reduces the
chance of the gate "chattering" as the input level varies around the
threshold.

Range Specifies the amount of gain reduction applied when the gate is
closed. When set to infinite (-oo) no signal is passed when the gate is
closed.
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Attack

(AttackTime)

Adjusts the speed with which the gate opens when the threshold is
exceeded.

Hold

(HoldTime)

Adjusts the time the gate will stay open after the signal passes below
the threshold. This can be useful for reducing chattering.

Release

(ReleaseTime)

Adjusts the speed with which the gate closes.

Instructions

Meters

NoiseGate provides a number of meters to allow you to monitor its operation.

The Key, Gain Reduction (GR) and Output (Out) meters use the same scale. It is a stretched

scale which makes it easier to see the top 12dB, which is usually of most interest.

From left to right:

The Input meter (marked Key) displays the level of the incoming signal after Input Gain

has been applied. The Threshold levels are indicated by arrows at the side of the meter:

the left arrow indicates the open threshold, the right arrow indicates the close threshold.

When something is connected to the side chain input, this meter will indicate the side

chain level.

The Gain Reduction meter (GR) indicates how much gain reduction is being applied by the

gate. The line at the right of the Gain Reduction meter indicates the amount of gain

reduction applied when the gate is closed (determined by the Range parameter).

The Output meter (Out) shows the output level.
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Matrix

Switches and combines different input channels to different outputs.

The 4x4Matrix, 8x8Matrix and 16x16Matrix contraptions let you dynamically route signals

without repatching the document. Each input can be routed to any combination of

outputs. More than one input can be connected to an output at the same time. In this

case, the signals are mixed together. When an input is switched on to an output it is faded

in, and faded out when you switch it off. The time taken to fade in and out can be

controlled.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Mixers category (p. 185).
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Parameters

Grid Creates connections between different inputs and outputs. Each input is
represented by a horizontal row, and each output by a vertical column.
Click on cells to toggle connections between specific inputs and
outputs.

Fade time

(FadeTime)

Determines the time taken for a newly connected input to be faded into
the output, or a disconnected input to be faded from the output.
FadeTime can range from 0 ms to 100 seconds (100,000 ms).

Use short values of fade time to prevent clicks when switching, and
longer fade times to create slowly fading mixes.

Relevant Example Files

The following files provide examples of how Matrix can be used:

WaveSequence.amh & MultiChan_IO+Record.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Crossfader

Smoothly mixes and fades from one stereo input to another.

Crossfader lets you crossfade between two stereo input signals. You can control the

volume of each stereo input pair, as well as the overall volume of the contraption's output.

Connecting a patch cord to only one side of a stereo input on this
contraption bridges the audio to both inputs.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Frosscader (p. 332), Mixers (p. 185)

Parameters
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Master

(MasterGain)

Controls the gain (level) of the output.

1&2

(TrimA)

Controls the gain of the first input stereo pair.

3&4

(TrimB)

Controls the gain of the second input stereo pair.

Fade Controls the crossfade from one stereo input to the other. When the
slider is set to 0.00%, only 1&2 are heard. When the slider is at
100.00%, only 3&4 are heard. When at 50%, there is an equal mix of
both input stereo pairs. As you move the crossfade slider from one
end to the other, you can achieve a smooth transition from one input
stereo pair to the other.

Relevant Example Files

The following files provide examples of how Crossfader can be used:

SimplePlugnPlay.amh, MultiChan_IO+Record.amh & TxtStpBtBxr.amh.

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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Frosscader

Smoothly fades a stereo input between two different stereo outputs.

Frosscader lets you fade a stereo input source between two separate stereo outputs. You

can control the volume of each stereo pair, as well as the overall volume of the

contraption's output.

Connecting a patch cord to only one side of a stereo input on this
contraption bridges the audio to both inputs.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Crossfader (p. 330), Mixers category (p. 185)

Parameters
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Master

(MasterGain)

Controls the gain (level) of the overall output.

1&2

(TrimA)

Controls the gain of the first stereo output pair.

3&4

(TrimB)

Controls the gain of the second stereo output pair.

Fade Balances the input between one stereo output pair and the other.
When the slider is set to 0.00%, the input is only sent to outputs
1&2. When the slider is at 100.00%, the input is only sent to outputs
3&4. When at 50%, the input is sent equally to both output stereo
pairs. As you move the fade slider from one end to the other, you can
achieve a smooth transition from one output stereo pair to the other.

Suggested Uses and Practical Applications

Ross Bencina says: “Unlike the Crossfader which is useful for blending separate inputs,

the Frosscader is useful for controlling the balance of a single sound sent to two different

effects chains. The distinction may be subtle, but if you have an effect (such as distortion)

which behaves differently depending on how loud the input is, then you may want to

control how much sound you feed into it rather than just adjusting the level of its output.

For example you could use a Frosscader to send audio to two different Shaper

contraptions with different settings – the Frosscader would control the balance between

the distortion introduced by each Shaper in a more complex way than simply crossfading

the output of two Shaper contraptions.”
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Invert

Inverts the polarity of an audio input (useful for stereo wide illusion and other tricks).

Invert lets you invert the polarity of an audio input . This is sometimes referred to as phase

inversion or a 180-degree phase shift. You can use Invert to implement phase-related

stereo encoding and decoding schemes, and create the illusion of stereo with mono

sources.

Related Contraptions

Mixers category (p. 185)

Suggested Uses and Practical Applications

Andrew Bencina says: “You can create a simple, pseudo-stereo effect by panning a

mono sound to one speaker and an inverted version to the other speaker.”
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M*Mixer

Mono mixers with volume control for each input.

M*Mixers (* indicates the number of inputs) are mono mixers with a master gain control

and individual gain controls for each input channel (1, 2, etc.). You can also solo or mute

each of the channels.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

P*Mixer (p. 339), S*Mixer (p. 341), Crossfader (p. 330), Frosscader (p. 332)

Parameters

M

(MasterGain)

Adjusts the output gain.
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m

(Mute,

MasterMute,

Mute_1 -
Mute_12)

Mutes an input. Mute an input by pressing the m button of the input
you want to mute. Mute the output by pressing the m button of the
MasterGain (M) knob.

s

(Solo,
Solo_1 –
Solo_12)

Solos an input Press the s button of the input you want to solo. You
can solo more than one input at a time. Holding down the Control
key (Command on Mac) while clicking a solo button solos the clicked
input and causes all other channels to be un-soloed. Solo will always
override mute.

Relevant Example Files

The following file provides an example of how M*Mixer can be used:

GrungeDrumOne.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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*Gain

Volume control knob for one or more channels (M=Mono (1), S=Stereo (2), Q=Quad (4),

O=Oct (8)).

MGain, SGain, QGain and OGain are one, two, four and eight input/output modules that

boost or attenuate their inputs. Use these contraptions to adjust the gain of an input or to

apply the same amount of gain to a number of sources/channels patched into one *Gain

contraption. *Gain contraptions also provide a Mute button for muting the output.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

Mixers category (p. 185)

Parameters

Gain Adjusts the gain of one or a series of inputs.

Contraptions Guide - *Gain 337



m

(Mute)

Mutes the output of all channels. Toggle this button on and off with the
mouse.

Relevant Example Files

The following file provides an example of how MGain can be used:

HarpoonedFeedback.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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P*Mixer

Stereo mixers with mono inputs and a pan control for each input.

P*Mixers (* indicates the number of inputs) are mixers with mono inputs and a stereo

output. There is a master gain control and individual pan and gain controls for each input

channel (1, 2, etc.). You can also solo or mute each of the channels.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

M*Mixer (p. 335), S*Mixer (p. 341), Crossfader (p. 330), Frosscader (p. 332)

Parameters
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Gain

(MasterGain,
Gain_1 -
Gain_12)

Master Gain adjusts the output gain. Individual knobs control the gain
of each input (1 – 12).

m

(Mute,
MasterMute,
Mute_1 -
Mute_12)

Mutes an input. Mute an input by pressing the m button of the input
you want to mute. Mute the output by pressing the m button of the
MasterGain (M) knob.

s

(Solo,
Solo_1 –
Solo_12)

Solos an input. Press the s button of the input you want to solo. You
can solo more than one input at a time. Holding down the Control
key (Command on Mac) while clicking a solo button solos the clicked
input and causes all other channels to be un-soloed. Solo will always
override mute.

Pan

(Pan_1 -
Pan_12)

Specifies the stereo panning location of each input channel (1 – 12).

Relevant Example Files

The following file provides an example of how P*Mixer can be used:

MultiChan_IO+Record.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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S*Mixer

Stereo mixers with volume control for each stereo input pair.

S*Mixers (* indicates the number of stereo input pairs) are stereo mixers with a master

gain control and gain controls for each pair of inputs (1&2, 3&4, etc.). You can solo or

mute each of the input pairs.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Related Contraptions

M*Mixer (p. 335) & P*Mixer (p. 339), Mixers category (p. 185)

Parameters
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Gain

(MasterGain,
Gain_1-2 -
Gain_23-24)

Master Gain adjusts the output gain. Individual knobs control the
gain of each stereo input pair (1-2 – 23-24).

m

(Mute,
MasterMute,
Mute_1-2 -
Mute_23-24)

Mutes an input. Mute an input by pressing the m button of the input
you want to mute. Mute the output by pressing the m button of the
MasterGain knob.

s

(Solo,
Solo_1-2 –
Solo_23-24)

Solos an input. Press the s button of the input you want to solo. You
can solo more than one input at a time. Holding down the Control
key (Command on Mac) while clicking a solo button solos the clicked
input and causes all other channels to be un-soloed. Solo will always
override mute.

Relevant Example Files

The following file provides an example of how S*Mixer can be used:

RissetSquelchBass.amh

To open the Example Files directory, go to the File menu, select Open, and
double-click on the Examples folder. Read descriptions of the example files
here. (p. 353)
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M*Bus

Mixes mono signals without volume control. Useful as a patch-point for complex patches.

(Provided for backward compatibility).

M*Buses (* indicates the number of inputs) are mono summing buses. All inputs are

mixed to the output with unity gain. This contraption is mainly present for historical

reasons. It was more useful before AudioMulch automatically mixed multiple connections

to one input. It remains useful for providing a single neutral connection point for

combining signals in complex patches, or when you need a placeholder for connecting

and disconnecting signals during a live performance.

Related Contraptions

S*Bus (p. 344)

Instructions

M*Buses have no parameters or Property Editor.
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S*Bus

Mixes stereo signals without volume control. Useful as a patch-point for complex patches.

(Provided for backward compatibility).

S*Buses (* indicates the number of stereo input pairs), are stereo summing buses. All

signals are mixed to the output with unity gain This contraption is mainly present for

historical reasons. It was more useful before AudioMulch automatically mixed multiple

connections to one input. It remains useful for providing a single neutral connection point

for combining signals in complex patches, or when you need a placeholder for connecting

and disconnecting signals during a live performance.

Connecting a patch cord to only one side of a stereo input on this
contraption bridges the audio to both inputs.

Related Contraptions

M*Bus (p. 343)

Instructions

S*Buses have no parameters or Property Editor.
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VST Plugins

As well as its own contraptions, AudioMulch also supports the industry standard VST

(Virtual Studio Technology) and VSTi (also known as VST2) plugin formats. This gives you

access to a large number of third-party effects and instruments to expand AudioMulch.

There are thousands of free, shareware and commercial plugins available on the internet;

check the AudioMulch website (http://www.audiomulch.com) for links to some relevant

sites.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Installing VST plugins

VST plugins must be placed inside a special “VST Plugins” folder, which AudioMulch scans

to find plugins. AudioMulch has a default VST Plugins folder, but you can also tell it to use

a different one. See the next section for the location of the VST Plugins folder.

To install a plugin, copy it into the VST Plugins folder, or if the plugin has a special installer

program, specify the VST Plugins folder when prompted by the installer.

You can also install a plugin into a sub-folder of the VST Plugins folder. These sub-folders

will be displayed in AudioMulch as additional sub-categories in the Patcher Pane's

Contraptions Palette and New contraption menu.

If you add or install a new plugin while AudioMulch is running, you can update the VST

Plugins contraption menu without restarting the program. You can do this in several ways:

select the Refresh Plugins List item located below the list of installed plugins in the New

contraptions menu (right-click in the Patcher Pane, and select New > VST Plugins >

Refresh Plugins List) from the popup context menu. You can also right-click on the

Contraptions Palette and select Refresh Plugins List. Alternatively, use the keyboard

shortcut; on Windows: Ctrl+F5 or on Macintosh: Command+Shift+5.
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LOCATION OF THE VST PLUGINS FOLDER

On Microsoft Windows, AudioMulch creates a VST Plugins folder in the AudioMulch

parent directory when the program is installed. On a Macintosh, AudioMulch usually looks

in the system VST Plugins folder located at /Library/Audio/Plug-Ins/VST.

AudioMulch lets you configure any folder as the VST Plugins folder. If you share plugins

with other music software you can use a common plugin folder for all programs. This

removes the need for plugin duplication.

To change the VST Plugins folder, access the VST Plugins page of the Settings/Preferences

Dialog box. In Windows, click on the Edit menu, select Settings... Alternatively, use the

keyboard shortcut F4. To access the Preferences Dialog box on a Macintosh, select

Preferences... from the AudioMulch application menu. Choose the VST Plugins page from

the list at the left. Click on the browse button to select or create a new folder for your

VST Plugins.

Selecting and organising VST Plugins in AudioMulch

Once VST Plugins are installed, you can use them in the same way as you use built-in

AudioMulch contraptions. They can be selected for use in AudioMulch from the VST

Plugins section of the Contraptions Palette. You can also select plugins from the New

contraptions menu in the Patcher Pane. To do this, right-click in the pane, select New from

the popup context menu, and then select VST Plugins from the list. As mentioned above,

this menu shows the file structure of the VST Plugins folder, which lets you group plugins

by nesting folders. This can be useful for organizing plugins according to type or creator.

Graphical user interfaces, parameters and values

VST Plugins can be used just like other contraptions. Some plugins have their own

graphical user interface that will appear as their Properties Editor. For other plugins,

AudioMulch provides a generic editor displaying all parameters and their values. It is

possible to use the generic editor for any plugin, including those with their own user

interface. This can be selected by right-clicking on the Properties Editor's title bar and

selecting Generic Editor. This can be useful when trying to manage screen real estate. For

example, the graphical user interfaces of some VST plugins can take up too much room

on the screen. In such cases, use the Generic Editor instead. You can also use the Generic

Editor when a VST plugin's custom user interface is causing other problems, for example,

if it is not functioning correctly due to an incompatibility.
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Presets and VST fxb program file format

AudioMulch also provides selective support for the VST fxb program file format. Many

plugins come packaged with a set of programs, and some host platforms allow the

creation of further custom programs using the fxb format. AudioMulch lets you access

and save these externally-produced programs and also lets you store additional presets in

AudioMulch's own preset system. However, only AudioMulch's own preset system can be

used to automate (p. 129) preset changes.

Many VST and VSTi plugins automatically load a set of programs when opened. Right-click

in the Property Editor's title bar and select the VST Programs item of the pop-up menu to

see these programs. If there are more than 127 programs for a contraption, they will be

organised into submenus.

To manually load a new set of programs or to replace a pre-loaded set, right-click on the

Properties Editor's title bar, select the VST Programs item of the pop-up menu, and then

select the Load VST Program Bank (fxb)... item. Locate the fxb file in the Load VST
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Program Bank dialog box. Once loaded, the new set of programs will replace the previous

set. To save a VST Program Bank for use with other applications, select the Save VST

Program Bank (fxb) As... item.

MIDI control of VST plugin parameters

VST plugin parameters can be controlled by external MIDI control sources. Mapping of

external controllers to VST parameters follows the same procedure as for AudioMulch

contraptions. Go to the Controlling AudioMulch Parameters from MIDI (p. 145) page of

this Help File for further information.

Note: the Quick Map MIDI Control function only works with the Generic Editor. When

using a VST with a custom editor use the Parameter Control window instead.

Routing MIDI to VST plugins

VST instrument plugins are designed to respond directly to MIDI input. They are often

played by pressing keys on a real MIDI keyboard, or triggered from a MIDI drum pad.

There are also VST plugins that are designed to generate MIDI data (for example, a step-

sequencer plugin), and others that let you transform MIDI data (for example, by

transposing incoming notes, or filtering certain messages).

In AudioMulch, you use the Patcher Pane to route MIDI data from one plugin to another

(and also to and from AudioMulch). Note that this is separate from MIDI parameter

control described in the previous section.

Plugins designed to respond to MIDI input have a MIDI input port at the top right of the

contraption in the Patcher Pane. In the case of a VST instrument, this MIDI input must be

connected to a MidiIn (p. 205) contraption or to the MIDI output of another contraption

in order for the plugin to receive MIDI messages. Plugins that generate or process MIDI

have a MIDI output at the lower right of the contraption in the Patcher Pane. MIDI outputs

can be connected to the MIDI inputs of other plugins, or to MidiOut (p. 205) contraptions.

See Routing MIDI in the Patcher Pane (p. 117) for more information.

MIDI INPUT CHANNEL

By default the plugin will receive messages on all incoming MIDI channels (1-16). You can

assign the plugin's MIDI input channel using the Parameter Control dialog box. The dialog

box allows you to select a single MIDI channel or configure the contraption to receive
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messages from all incoming MIDI channels. To access this setting, display the Parameter

Control dialog box (from the View menu, F3 key, or right click in the Property Editor's title

bar) and select the VST plugin in the tree at the left of the Parameter Control dialog box.
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Audio Unit Plugins (Macintosh only)

As well as its own contraptions, AudioMulch also supports Apple's Audio Unit plugin

format. This gives you access to a large number of third-party effects and instruments to

expand AudioMulch.

There are thousands of free, shareware and commercial plugins available on the internet;

check the AudioMulch website (http://www.audiomulch.com) for links to some relevant

sites.

See the Adjusting Contraption Properties (p. 49) section for information
about using sliders, knobs, presets etc.

Installing Audio Unit plugins

To install an Audio Unit plugin, follow the plugin manufacturer's instructions. Often,

Audio Unit plugins will come with an installer application that simplifies the installation

process. Sometimes you'll be asked to manually copy the Audio Unit to your plugins

folder.

In case you need to manually copy a plugin to install it, you will need to place it in one of

two special folders so that AudioMulch and other applications can find it. These locations

are:

/Library/Audio/Plug-Ins/Components

~/Library/Audio/Plug-Ins/Components ("~" represents your home directory.)

Plugins installed in /Library are available to all users on the computer, whereas plug-ins

installed to ~/Library are only available to the user in whose home folder they reside.

We recommend that you follow the manufacturer's instructions about which folder to

use. If in doubt use the folder under /Library.
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Scanning for new Audio Unit plugins

When AudioMulch starts it will scan for new Audio Unit plugins and update its list of

available plugins. If you add or install a new plugin while AudioMulch is running, you can

update the Audio Units contraption menu without restarting the program. You can do this

in several ways: select the Refresh Plugins List item located below the list of installed

plugins in the New contraptions menu (right-click in the Patcher Pane, and select New >

Audio Units > Refresh Plugins List) from the popup context menu. You can also right-click

on the Contraptions Palette and select Refresh Plugins List. Alternatively, use the keyboard

shortcut Command+Shift+5.

Using Audio Unit plugins in AudioMulch

Once Audio Unit plugins are installed, you can use them in the same way as you use built-

in AudioMulch contraptions. They can be selected for use in AudioMulch from the Audio

Units section of the Contraptions Palette. You can also select plugins from the New

contraptions menu in the Patcher Pane. To do this, right-click in the pane, select New from

the popup context menu, and then select Audio Units from the list.

Graphical user interfaces, parameters and values

Audio Unit plugins can be used just like other contraptions. AudioMulch provides a

generic Properties Editor displaying all parameters and their values. Some plugins also have

their own graphical user interface that can be accessed by clicking the Show Editor

button on the plugin's Properties Editor.

MIDI control of Audio Unit plugins

Audio Unit plugin parameters can be controlled by external MIDI control sources. Mapping

of external controllers to Audio Unit parameters follows the same procedure as for

AudioMulch contraptions. Go to the Controlling AudioMulch Parameters from MIDI (p.

145) page of this Help File for further information.

Note: the Quick Map MIDI Control function only works with the Generic Editor. When

using a Audio Unit with a custom editor use the Parameter Control window instead.
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Routing MIDI to Audio Unit plugins

Audio Unit instrument plugins are designed to respond directly to MIDI input. They are

often played by pressing keys on a real MIDI keyboard, or triggered from a MIDI drum pad.

There are also VST plugins that are designed to generate MIDI data (for example, a step-

sequencer plugin), and others that let you transform MIDI data (for example, by

transposing incoming notes, or filtering certain messages).

In AudioMulch, you use the Patcher Pane to route MIDI data from one plugin to another

(and also to and from AudioMulch). Note that this is separate from MIDI parameter

control described in the previous section.

Plugins designed to respond to MIDI input have a MIDI input port at the top right of the

contraption in the Patcher Pane. In the case of an Audio Unit instrument, this MIDI input

must be connected to a MidiIn (p. 205) contraption or to the MIDI output of another

contraption in order for the plugin to receive MIDI messages. Plugins that generate or

process MIDI have a MIDI output at the lower right of the contraption in the Patcher Pane.

MIDI outputs can be connected to the MIDI inputs of other plugins, or to MidiOut (p. 205)

contraptions. See Routing MIDI in the Patcher Pane (p. 117) for more information.

MIDI INPUT CHANNEL

By default the plugin will receive messages on all incoming MIDI channels (1-16). You can

assign the plugin's MIDI input channel using the Parameter Control dialog box. The dialog

box allows you to select a single MIDI channel or configure the contraption to receive

messages from all incoming MIDI channels. To access this setting, display the Parameter

Control dialog box (from the View menu, F3 key, or right click in the Property Editor's title

bar) and select the VST plugin in the tree at the left of the Parameter Control dialog box.
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Guide to the Example Files
The Examples directory in AudioMulch contains a range of documents that demonstrate

different ways you can use AudioMulch. To open the directory, go to the File menu, select

Open, and double-click on the Examples folder. These files are a good starting point for

experimentation with AudioMulch as they provide pre-built contraption combinations for

you to practice on. By moving the knobs and sliders, each of the individual contraption

parameters can be changed so that you can experience the changes that these make to

the sound in real-time. You can also connect new contraptions to the example files, or

dismantle each file to examine its individual parts.

Each example file is described briefly below. For further information about each file, read

the Notes (p. 164) window that pops up when you open an example.

To hear an example file, press the Enable Audio button on the toolbar or select Enable

Audio from the Control menu. To hear some of the examples you need to have the clock

running. To do this, press the Play button on the toolbar or select Play from the

Control menu.

Although these examples mostly demonstrate the capabilities of AudioMulch to synthesize

sounds, many can be modified to take their input from a sound file instead by using

SoundIn (p. 196).

BASIC EXAMPLES

The examples in the Basic folder primarily demonstrate narrowly focused techniques and/

or basic AudioMulch functionality. These techniques, or Patches, may then be combined to

create more complex compositions or live performance environments.

ArpeggioDrone

ArpeggioDrone employs a series of four Arpeggiators (p. 213) to produce an evolving pad

or drone. While all four feature the same Pitch Set, each Arpeggiator is configured with

varying Cycle Length and some degree of Skip and Repeat randomness applied. The
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resulting effect is one of a constantly shifting, though effectively static harmonic field. A

pair of DLGranulators (p. 253) add some irregularity to an otherwise sustained texture.

BeatProcess

As the name suggests, this example explores the use of AudioMulch for the processing of

beats. The patch uses a Flanger (p. 258)->5Combs (p. 298)->DLGranulator (p. 253) chain

to create a series of modulated chordal textures which evolve through the use of

parameter automation (p. 129). An automated SDelay (p. 286) contraption introduces a

series of rhythmic variations. This patch also provides a good example of the use of Drums

(p. 229) contraption presets (p. 75) to create a varied pattern sequence.

DrumLooper

DrumLooper provides a simple demo of many of the samples bundled with this version of

AudioMulch. A series of two and four beat patterns employing a varying selection of

samples are played in sequence, composed through the automation (p. 129) of the Drums

(p. 229)' contraption presets (p. 75). This patch also demonstrates a relatively basic use of

the LiveLooper (p. 262). The Drums output is recorded using the LiveLooper, with each

loop triggered via automation. At the completion of the initial sequence the loops are

replayed independently by automating each LiveLooper track's Control button (p. 262).

FlangerVsPhaser

FlangerVsPhaser provides an example of the sonic differences between the Flanger (p.

258) and Phaser (p. 272) contraptions. It also demonstrates parameter automation (p.

129) in switching between the processed output of each contraption.

FrequencyShifterHarmonicFeedback

This example uses SDelay (p. 286) and FrequencyShifter (p. 260) contraptions within a

feedback loop to create an upward cycling resonant feedback.

GrainMod

This example demonstrates the use of the DLGranulator (p. 253) to create a kind of

flexible amplitude modulation. The granulator is applied to a sine wave generated by a

TestGen (p. 243). The regular interonset time of the DLGranulator creates a formant-like
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sound with the fundamental controlled by the granulator's interonset time, and the

formant frequency controlled by the sine wave's frequency. Automation (p. 129) is used to

create an evolving timbre.

GranPrix

GranPrix demonstrates the use of multiple SSpat (p. 294) contraptions to simulate a

number of moving sound sources.

GrungeDrumOne

This example demonstrates the use of DigiGrunge (p. 250) as an effects processor. A

Drums (p. 229) sequence is processed via a short automated loop. In this patch the

DigiGrunge is augmented by RingAM (p. 279) and SouthPole (p. 312) contraptions and

demonstrates the use of feedback and side-chaining (p. 312). Solo the M*Mixer (p. 335)

channels to hear the effect of each processing chain on the mix.

HappyPenguins

HappyPenguins provides an example of the possible uses of the Arpeggiator (p. 213). Its

primary aim however, is to demonstrate the use of the SouthPole (p. 312) filter. Through a

sequence of automated changes the patch produces a range of the effects made possible

by SouthPole. The inclusion of this automation (p. 129) sequence also allows the user to

experiment with the concept of parameter automation.

HarpoonedFeedback

Based on a patch created by Warren Burt, HarpoonedFeedback demonstrates a self-

generating feedback loop using an MGain (p. 337) and a Flanger (p. 258).

MulchJungle

A jungle-inspired example, using automated (p. 129) LoopPlayer (p. 234) presets (p. 75)

with different phase settings to achieve a sequenced cut-up of the beat. This patch also

demonstrates the use of an automated TestGen (p. 243) distorted by a DigiGrunge (p.

250) to create a descending bass tone.
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PolyRhythmic

PolyRhythmic demonstrates AudioMulch's ability to accommodate different time

signatures (p. 140) concurrently. A Drums (p. 229) (Drums_1) contraption acts as a

metronome following the pulse of the automation timeline (p. 131), via preset automation

(p. 75), while two other Drums contraptions (Drums_2 & Drums_3) play rhythms based on

different time signatures. As Drums_1 follows the timeline time signature changes a

variety of polyrythmic relationships can be heard.

Pulsar

This patch demonstrates one use of the PulseComb (p. 275) hybrid pulsar filter. Here it is

applied to filtering a simple drum pattern (p. 229). The automation (p. 129) sequence was

recorded to demonstrate a variety of possible PulseComb effects.

RingModBassline

As the name suggests this example demonstrates a simple ring modulation of two

Basslines (p. 219) using a RingAM (p. 279) to create a different synth texture.

RissetSquelchBass

RissetSquelchBass demonstrates one use of RissetFilters (p. 308) to generate cyclic filter

variations within a defined frequency spectrum. This is perhaps heard most clearly in the

contraption chain processing the Bassline (p. 219) (Channel 1-2 of the S4Mixer (p. 341))

but is also reflected in the processing of both Drums (p. 229) contraptions.

RissetPan

In this example seven parallel RissetTones (p. 237) generators are panned across the stereo

field to create a sonic effect. Each of the RissetTones move at a different rate causing the

tones to slowly move in and out of tune with each other. Don't spend too long listening to

this patch otherwise you may find yourself entering the Twilight Zone.

ShapeSynth

This example explores the use of the Shaper (p. 290) contraption. In this patch the Input

Gain parameter of the Shaper is swept over time using parameter automation (p. 129)
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leading to timbral changes. ShapeSynth also uses TestGens (p. 243) and 10Harmonics (p.

240) for source tones and a Bassline (p. 219) contraption as a pattern-based envelope

filter.

SidechainingSouthPole

SidechainingSouthpole demonstrates how the side-chain input of SouthPole (p. 312) (in

this case, a pattern from the Drums (p. 229) contraption) can be used to "gate" a

continuous (Arpeggiator (p. 213) & TestGen (p. 243)) signal fed into the main input so it

effectively plays along with the side-chain source.

SimplePlugnPlay

SimplePlugnPlay shows one approach to an entry-level live processing setup. The SoundIn

(p. 196) is routed to a DLGranulator (p. 253), SDelay (p. 286), Flanger (p. 258), and

SouthPole (p. 312) in a parallel configuration. Follow the instructions provided in the

Notes window to configure your live input or, if you don't have access to an external

sound source, press Play on the SoundIn to loop a loaded guitar sample. Use the

Crossfader (p. 330) to blend the dry and processed signals. An SLimiter (p. 322) is

connected before the SoundOut (p. 200) as a master bus limiter; to avoid overloading the

output.

SSpatChorus

This example demonstrates the use of four SSpat (p. 294) contraptions to create a warm

and fat chorus effect. It also shows one of the ways AudioMulch users have creatively

employed contraptions to expand the range of internal processing possibilities.

TechnoAutomation

TechnoAutomation draws on a basic techno patch, employing Bassline (p. 219), Drums (p.

229), Flanger (p. 258) and SDelay (p. 286) contraptions, to demonstrate some possible

uses of automation (p. 129) within AudioMulch.
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TempoAutoTimeStretchSim

This example demonstrates both the use of the Bubbleblower (p. 224) to achieve time-

stretching effects, and the automation (p. 129) of Clock Tempo (p. 37). For further

information and explanation read the Notes window of this example.

TheAudienceIsMulching

This example primarily focuses on the use of DLGranulators (p. 253) as pitch shifters,

generating a rich harmonic texture from two 10Harmonics (p. 240) sets, via automation

(p. 129), to simultaneously glide upward and downward to their final resting pitches.

TheBells

TheBells creates bell-like tones by automating the amplitudes of the harmonics in a

10Harmonics (p. 240) contraption. The harmonics' automation curves use a simple bell-

like decay envelope. The harmonics are ring modulated using a RingAM (p. 279)

contraption to create inharmonic tones, and feed through Flangers (p. 258) and an SDelay

(p. 286) to thicken and animate the timbre. This document also demonstrates the use of

Automation cut and paste (p. 137) as a quick way to create similar control curves for

different parameters.

TranceRiffer

Expanding on the ShapeSynth example, this patch recreates a classic trance synth sound,

employing a novel way to generate chords by filtering noise from a TestGen (p. 243) with

a 5Combs (p. 298) contraption. The continuous pitched output of the 5Combs is then fed

to a Bassline (p. 219) via its external input to enable rhythmic pattern programming. To

create a harder edge, the Bassline is patched to a Shaper (p. 290) and the clean and

processed sounds are recombined before being routed to a Nebuliser (p. 303) for the all-

important bandpass filter sweep. A couple of FrequencyShifters (p. 260) here act

somewhat like a Phaser (p. 272) and help to create a richer, warmer sound. To complete

the patch, an SDelay (p. 286) is inserted to achieve a rhythmic delay, another signature of

this musical style.
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WaveSequence

In this example, eight 10Harmonics (p. 240) contraptions, all set to different waveshapes,

are slowly crossfaded by the 8x8Matrix (p. 328) mixer to create an animated synth pad.

APPLIED EXAMPLES

The examples in the Applied folder demonstrate complete musical applications of

AudioMulch. Some are demos while others show particular ways in which the program

can be used.

Aava

This example demonstrates one way of creating an evolving synth pad within AudioMulch.

A series of Arpeggiators (p. 213), each producing a constant tone, are faded in and out to

create a slowly morphing chordal drone. Filter sweeps are then provided by automated (p.

129) *ParaEQ (p. 301), Phaser (p. 272) and Flanger (p. 258) contraptions. SDelays (p. 286)

and a NastyReverb (p. 270) are used to fatten and smooth the pad.

BBlowerSoundscape

As its name suggests, this example demonstrates the use of Bubbleblowers (p. 224) to

create a rich evolving soundscape. A feature of this patch is the diversity of textures that

can be created using only limited additional sound files (p. 122) - in this case less than

700kb. An SSpat (p. 294) and NastyReverb (p. 270) contribute a further sense of depth

and movement to the soundscape.

BBMultitracker

A second BubbleBlower (p. 224) example, BBMultitracker creates a four piece

BubbleBlower band. Drum, bass and guitar duties are handled by five separate

Bubbleblowers each loaded with a small sample. The keyboard element is produced by a

simple Drums (p. 229) sequence processed through a DLGranulator (p. 253). This example

demonstrates some of the rhythmic effects that can be achieved using the BubbleBlower.

Note the use of automated (p. 129) Snare Quant (quantisation) grid (p. 224) via

contraption presets (p. 75) to add an improvised feel to the drum performance. In

addition, BBMultitracker demonstrates how multitrack recordings can be made within

AudioMulch using the FileRecorder (p. 210) family of contraptions.
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Chemutengure-MbiraMelody

This patch is based on a transcription of an Mbira (Zimbabwean thumb piano) melody

composed in the 1800's. It uses a series of automated (p. 129) TestGen (p. 243) and

Arpeggiator (p. 213)->DLGranulator (p. 253) contraptions to create melodic and rhythmic

patterns which have then been affected tonally using *ParaEQ (p. 301) and Shaper (p.

290) contraptions. Again, we see the use of the SDelay (p. 286) as a means of adding

rhythmic complexity or variation. For further information and explanation, read the Notes

window of this example.

ChordProgression

This patch provides an example of how you can automate (p. 129) a chord progression in

AudioMulch using Arpeggiators (p. 213) and Basslines (p. 219). It also uses a Nebuliser (p.

303) to create strange but pleasant textures in harmony with the bass tones. For further

information and explanation, read the Notes window of this example.

DoumbekDoubler

This example is designed to illustrate how AudioMulch can be used to enhance rhythmic

sources and also to demonstrate AudioMulch's support of non-4/4 time signatures and

compound rhythms (p. 140). A percussion pattern is sequenced in a Drums (p. 229)

contraption. These patterns are varied over time through the automation (p. 129) of

contraption presets (p. 75). The patch then employs an SDelay (p. 286), two

DLGranulators (p. 253) and a SouthPole (p. 312) contraption to vary the basic pattern with

a variety of repeat, randomisation, transposition and timbral effects. An MCompressor (p.

318) is placed immediately after the drummer to control the dynamics of the clicky

percussive source. An SLimiter (p. 322) is connected before the SoundOut (p. 200) as a

master bus limiter; to avoid overloading the output.

Elementals

Elementals is an attempt to model environmental sounds (water, fire, air). It demonstrates

the use of a wide variety of contraptions and features the Metasurface (p. 156) as a

means of moving between different patch states or Snapshots. An SLimiter (p. 322) is

connected before the SoundOut (p. 200) as a master bus limiter; to avoid overloading the

output. For further information and explanation, read the Notes window of this example.
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LooperJam

Focusing on the LiveLooper (p. 262) contraption and the varying applications of parameter

automation (p. 129), this example demonstrates how materials can be effectively

reinjected into a mix after transformation (by a combination of pitch shifting

DLGranulators (p. 253) and RingAM (p. 279)), thus creating a complex, evolving looping

machine. Rhythmic variations are introduced via the automation (p. 129) of SDelay (p.

286) contraption presets (p. 75). LooperJam also provides an opportunity to experiment

with external input sources via the SoundIn (p. 196).

Lucier

Using a FilePlayer (p. 207), NastyVerb (p. 270) and multiple SDelays (p. 286), this example

applies the concept behind the piece "I am Sitting in a Room" by Alvin Lucier. For further

information, read the Notes window of this example.

MetaSSpatosaurus

MetaSSpatosaurus is an improvised network based on a single sound source provided by a

BubbleBlower (p. 224) and demonstrates Metasurface (p. 156) automation (p. 129). The

posthistoric behemoth is unleashed with the assistance of Nebuliser (p. 303),

DLGranulator (p. 253), SSpat (p. 294), 5Combs (p. 298), NastyReverb (p. 270) and

SouthPole (p. 312) contraptions. An SLimiter (p. 322) is connected before the SoundOut

(p. 200) as a master bus limiter; to avoid overloading the output. For further information

and explanation, read the Notes window of this example.

Metasurface1

This patch demonstrates the use of the Metasurface (p. 156). Click and drag the mouse

on the colored Metasurface to glide smoothly between document snapshots.

MulchOnly01 & 05

The two example files entitled MulchOnly: synthesis without samples were created by

Michael Upton (http://www.nonwrestler.com). They demonstrate how AudioMulch

contraptions can be used to synthesize a range of drum sounds, basslines, chords, pads

and evolving sonic textures. For further information and explanation, read the Notes

window of each example.
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MultiChan_IO+Record

This example demonstrates routing, mixing and recording signals in AudioMulch.

Incoming signals are routed into the patch using SoundIn (p. 196) and AuxIn (p. 203)

contraptions. Signals are then routed (Matrix (p. 328)) and mixed (P*Mixers (p. 339) and

Crossfader (p. 330)) to a range of external outputs (SoundOut (p. 200) and AuxOuts (p.

203)). A multichannel FileRecorder (p. 210) at the heart of the patch allows for the capture

of input signals prior to their mixing for Live Monitor and/or Playback outputs. For further

information and explanation, read the Notes window of this example.

NoiseResearch01 &02

A pair of examples created by DDN exploring the use of AudioMulch in the creation of

noise music. In these patches you will find clicking beats (NoiseResearch01) and

squelching grooves (NoiseResearch02). For further information and explanation, read the

Notes window of each document.

OvertonesAutomation

This example is a combination of two separate patches. In one patch, a series of parallel

DLGranulators (p. 253), each with different settings, is used to create a 10Harmonics (p.

240) drone, resulting in rich, granulated textures. In the other patch, a second

10Harmonics is filtered by a RissetFilters (p. 308) contraption and several Basslines (p.

219), utilizing its pattern-based envelope functionality to create ascending rhythmic

textures.

PondLife

Pondlife is an example comprised of simulated frog, bird and flying insect sounds.

PulseComb (p. 275) and SSpat (p. 294) contraptions feature in many of the simulations.

Other animal sound models employ Bubbleblower (p. 224) contraptions with specific

sound files (p. 122) selected to achieve the desired effect.

ResonantString

This example simulates the random plucking of a resonant string using feedback loops

containing a FrequencyShifter (p. 260)->MParaEQ (p. 301)->5Combs (p. 298) chain. The
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patch then uses an SDelay (p. 286), slight stereo frequency variation and PulseCombs (p.

275) to further animate the sound.

SelfSynthesis

SelfSynthesis is a complex, atmospheric piece designed to demonstrate the use of

feedback loops as sound generators. This example also features an extended automation

sequence (p. 129) and thus evolves over a long period of time. For further information and

explanation, read the Notes window of this example.

StayingSane

StayingSane provides an example of the use of parameter automation (p. 129) to create a

sequenced track. Also note the use of the SouthPole (p. 312) contraption in the creation

of the filtered drum parts.

TheButler

TheButler is an example of a complex patch using an extended automation sequence (p.

129). Due to its complexity, it is worth listening to all of this piece so that you can

experience the full range of effects in the different sections. Affectionately known by its

creator as "the beast", this piece would not have been out of place on the soundtrack of

2001: A Space Odyssey.

TxtStpBtBxr

TxtStpBtBxr uses a variety of parallel signal chains to process the output of the Drums (p.

229) contraption, and demonstrates the use of various kinds of automation (p. 129) tracks

(knobs (p. 60), single (p. 60) and dual range sliders (p. 60) and contraption presets (p. 75)).

This example also demonstrates the creation of a synth line through the processing of

Bassline (p. 219) output. The synth chain also employs an SCompressor (p. 318) as a

means of dynamic control. In this case it is applied heavily to create a power pad with

constant amplitude. A LoopPlayer (p. 234) is included to provide an alternate or

simultaneous input via Crossfader (p. 330). An SLimiter (p. 322) is connected before the

SoundOut (p. 200) as a master bus limiter; both to avoid overloading the output and to

help glue the track together.
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Menu Item Reference
File

New Create a new, empty AudioMulch document

Open... Open an existing AudioMulch document

Reopen Open a recently used document

Revert Abandon all edits since last save

Save Save the current document

Save As... Save the current document under a different name

Save a Copy... Save an alternate copy of the current document

Save a Copy with
Sound Files... (p. 122)

Save an alternate copy of the current document with
sound files

Export to Sound
File... (p. 125)

Save an audio segment to a sound file

Exit Exit AudioMulch

Edit

Undo functions only within the Patcher (p. 83) and Automation
panes (p. 129)

Redo functions only within the Patcher (p. 83) and Automation
panes (p. 129)

Menu Item Reference 364



Cut Cut current selection to clipboard

Copy Copy current selection to clipboard

Paste Paste clipboard data

Clear Clear the current selection

Select All Select all

Insert Time Insert Time within an automation sequence (p. 137)

Delete Time Delete the selected time range within an automation
sequence (p. 137)

Automation Snap to Select Automation Snap to (p. 129) resolution

Settings... Adjust settings in the Settings dialog box (p. 166)
including audio and MIDI device settings, synchronization,
VST plugins path and start up actions.

View

Toolbars Show or hide the various toolbars and level meters

Status Bar Show or hide the status bar

Patcher (p. 16) Show or hide the patcher pane

Properties (p. 16) Show or hide the properties pane

Automation Show or hide the automation pane (p. 129)

Metasurface Show or hide the Metasurface (p. 156)
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Parameter Control (p.
145)

Configure Automation and MIDI parameter control

Notes (p. 164) Show or hide the notes window

Document Switcher Show or hide the document switcher (p. 161)

Show Contraption
Input/Output Info

Show or hide roll over tool tips describing each
contraption input and output in the patcher

Show Contraption
Input/Output Activity
Indicators

Show or hide the flashing level indicators on contraption
inputs and outputs in the patcher

Scroll Automation
with Playback (p. 129)

Enable or disable Scroll Automation with playback

Show Automation
Grid (p. 129)

Show or hide the Automation Grid

Windows Volume
Control...

Display the audio interface's volume control window

Control

Enable Audio Enable or disable real-time audio

Enable MIDI Enable or disable real-time MIDI parameter control (p.
145)

Play From Start Start playback from clock position 1-1.00

Play Start playback from current clock position

Toggle Playback Stop if playing or start playback from current clock
position if stopped
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Stop Stop the clock

Enable Automation
Recording

Enable or disable automation recording

Go to Start Reset clock position to 1-1.00

Go to End Move clock position to end of automation sequence

Enable Automation
Loop

Enable or disable automation looping

Chase MIDI Sync (p.
152)

Enable synchronisation with a MIDI clock source

Generate MIDI Sync
(p. 152)

Enable transmission of MIDI clocks

Chase Network Sync Enable synchronisation with a Network clock source (p.
166)

Generate Network
Sync

Enable transmission of Network clocks

Help

AudioMulch Help Displays this Help File

What's New in This
Version (p. 8)

Displays What's New topic in this Help File

Check for Updates Goes online to check whether a new version of
AudioMulch is available

AudioMulch Web Site Displays the AudioMulch web site in your web browser
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Buy AudioMulch (p.
15)

Displays information about purchasing AudioMulch

Enter Authorisation
Key...

Enter your purchased AudioMulch licence authorisation
key

About AudioMulch Displays version and Copyright information
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AudioMulch on the Web

The AudioMulch web site is located at:

http://www.audiomulch.com

You can reach this site by entering the above URL into your web browser, or by selecting

AudioMulch Web Site from the Help menu within the AudioMulch program.

The AudioMulch web site always contains up-to-date news regarding the latest

AudioMulch version, and a variety of other useful resources.
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Sending Suggestions and Bug Reports

We can only fix the things we know about, so we'd love to hear from you. If you

encounter a bug, or have a feature you'd like to see included, please don't hesitate to

contact AudioMulch's lead developer Ross Bencina via email: rossb@audiomulch.com. You

can also post bugs and suggestions to the AudioMulch forums

(http://www.audiomulch.com/community)

Bugs include unusual or unexpected program behavior and program crashes.

Information that will will assist in locating and fixing bugs includes:

The version of AudioMulch you are using, for example 2.2. This information is displayed in

the about box, which can be viewed by selecting About AudioMulch from the Help

menu (Windows) or from the AudioMulch application menu (Mac OS).

A description of the bug, including:

• What operation you were performing in AudioMulch when it happened?

• Whether you can repeat the bug?

• Were real-time audio or MIDI controllers enabled when the bug occurred?

• Any crash information provided by Windows, including addresses. For example:

MULCH caused an invalid page fault in module MULCH.EXE at 0167:005c23db.

You can either write this information down, or take a screen-grab of the error

message window (press Alt-Print Screen, paste into the Windows Paint application, or

MS Word, then Save.)

• Any other information that seems relevant (i.e., third-party VST plugins used within

current document).

A quick spec of your machine including:

• OS version (win98, winXP, NT4.0 etc.)

• CPU and Speed (eg. Pentium 4 3.2)

• Amount of physical RAM (eg. 512MB)

• Audio interface brand and model
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About Us

AudioMulch is developed by a small team of people based in Melbourne, Australia, with

most software development undertaken by Ross Bencina. From the beginning, the

program has been independently owned and developed, and is self-funded from sales of

the software. AudioMulch started its life as a program developed by Ross with occasional

help from family and friends. Over the years the team has grown to include a small group

of contractors and employees that helps to create and promote AudioMulch.

Ross studied music, majoring in electroacoustic composition. Since then he has worked in

research and as an independent consultant developing software for music and audio

applications. AudioMulch was originally developed for use in Ross' own performances and

has been in continuous development since 1997. The first Internet release of the program

was in March 1998. AudioMulch Version 1.0 was released for Microsoft Windows in

February 2006 after a lengthy development period. The release of Version 2.0 in 2009

provided versions of the program for both Windows and Macintosh platforms.
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Contacting Us

If you need help with AudioMulch, please email support@audiomulch.com or visit the

AudioMulch support forum (http://www.audiomulch.com/forums/support-help-and-ideas).

AudioMulch's lead developer Ross Bencina can be reached by email at

rossb@audiomulch.com

Alternatively, you can send postal mail to:

Ross Bencina

GPO Box 1117

Melbourne

Victoria 3001

AUSTRALIA

Up-to-date contact information is always available at AudioMulch.com:

http://www.audiomulch.com/contact
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Further Reading

Below is a short list of books covering various aspects of making music with computers.

You may find these useful to expand your understanding and use of AudioMulch. Books

covering history, theory and technique are included. The Links section of the AudioMuch

website contains a list of online resources that may also be useful.

Chadabe, J. 1997. Electric Sound: The Past and Promise of Electronic Music, Prentice Hall,

New Jersey.

Dodge, C. & Jerse, T. A. 1997. Computer Music : Synthesis, Composition, and

Performance (2nd Edition), Schirmer Books.

Huber, D. & Runstein, R. 2005. Modern Recording Techniques (sixth edition), Focal Press.

Leider, C. N. 2004. Digital Audio Workstation, McGraw-Hill.

Miranda, E. 1998. Computer Sound Synthesis for the Electronic Musician, Focal Press.

Owsinski, B. 1999. The Mixing Engineer's Handbook, Mix Books, Vallejo, California.

Polansky, L. et al 2001. Music and Computers. Web Book. http://www.keycollege.com/

catalog/titles/music_and_computers.html

Roads, C. 1996. The Computer Music Tutorial, MIT Press, Massachusetts.

Roads, C. 2002. Microsound, MIT Press.

Russ, M. 2003. Sound Synthesis and Sampling (2nd Edition), Focal Press.

Schafer, R. M. 1977. The Tuning of the World, Alfred A. Knopf, New York.

Toop, D. 2004. Haunted Weather : Music, Silence, and Memory, Serpent's Tail Publishing,

London.

Wishart, T. 1994. Audible Design, Orpheus the Pantomime Ltd. York.

If your are interested in sampling some of the music created by others using AudioMulch a

discography has been assembled at the AudioMulch web site

(http://www.audiomulch.com/discography.htm).
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Selected Technical Bibliography

Below is a list of the books and articles that have been particularly useful while developing

AudioMulch. The list is not complete, notable exceptions include many miscellaneous

articles in Computer Music Journal (MIT Press), Proceedings of the International Computer
Music Conference (ICMC), Proceedings of the DAFX Conference, Journal of the Audio
Engineering Society (JAES) and Doctor Dobbs Journal. The music-dsp mailing list has also

been an indispensable resource, you can find out about the music-dsp mailing list at their

web site: http://www.music.columbia.edu/cmc/music-dsp/

For a more musically oriented reading list, see Further Reading (p. 374) in this help file.

COMPUTER MUSIC AND SIGNAL PROCESSING

Zolzer, U. (ed) 2002. DAFX: Digital Audio Effects, John Wiley and Sons, New York, New

York.

Moore, F.R. 1990. Elements of Computer Music, Prentice Hall, Englewood Cliffs, New

Jersey.

Orfanidis, S. J. 1996. Introduction to Signal Processing, Prentice Hall, Upper Saddle River,

New Jersey.

Puckette, M. 1988. The Patcher, Proceedings, ICMC. San Francisco: International

Computer Music Association, pp. 420-429.

Roads, C. 1996. The Computer Music Tutorial, MIT Press, Massachusetts.

Truax, B. 1988. Real-Time Granular Synthesis with a Digital Signal Processor. Computer
Music Journal 12(2): 14-26.

Chamberlin, H. 1980. Musical Applications of Microprocessors, Hayden Book Co., Rochelle

Park, New Jersey.

Matthews, M. V. et al. 1969. The Technology of Computer Music, MIT Press,

Massachusetts.
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SOFTWARE DEVELOPMENT

Fowler, M. 1999 Refactoring: Improving the Design of Existing Code, Addison-Wesley

Longman Publishing Co., Boston, Massachusetts.

Austern, M. H. 1998.Generic Programming and the STL: Using and Extending the C++

Standard Template Library, Addison-Wesley Longman Publishing Co., Boston,

Massachusetts.

Fowler, M. 1996. Analysis Patterns: Reusable Object Models, Addison-Wesley Longman

Publishing Co., Boston, Massachusetts.

Meyers, S. 1996. More Effective C++, Addison-Wesley Longman Publishing Co., Boston,

Massachusetts.

Gamma, E. et al. 1995. Design Patterns: elements of reusable object-oriented software,

Addison-Wesley Longman Publishing Co., Boston, Massachusetts.

Booch, G. 1995. Object-Oriented Analysis and Design, 2nd Ed. Benjamin/Cummings,

Redwood City, California.

Martin, R. C. 1995. Designing Object-Oriented Applications Using the Booch Method,

Prentice Hall, Englewood Cliffs, New Jersey.

Sedgewick, R. 1992. Algorithms in C++, Addison-Wesley, Reading, Massachusetts.

Meyers, S. 1991. Effective C++, Addison-Wesley Longman Publishing Co., Boston,

Massachusetts.

Stroustrup, B. 1991. The C++ Programming Language, 2 nd Ed. Addison-Wesley, Reading,

Massachusetts.

Szyperski, C. 1998. Component Software Beyond Object-Oriented Programming, Addison-

Wesley Longman Ltd., Edinburgh Gate, Essex.

SOURCE CODE

Listed below are some openly distributed sources of musical signal processing code.

Although I have not used this source code in AudioMulch, I learnt much of what I know

about implementing audio signal processing systems and algorithms from studying this

code.
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Csound software sound compiler

http://www.csounds.com

Princeton CMIX sound processing toolkit

http://www.music.princeton.edu/winham/cmix.html

NeXT / CCRMA Music Kit

http://www-ccrma.stanford.edu/CCRMA/Software/MusicKit/MusicKit.html

Supercollider 3

http://www.audiosynth.com
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Glossary Terms

180-degree phase shift

See phase inversion

4-pole filter

A class of electronic or digital filters whose frequency response exhibits a maximum

change of 24dB per octave (before taking into account resonance). This is the most

common type of filter used in analog music synthesizers.

See also filter.

4/4 time

This time signature indicates that there are four quarter note (crotchet) beats per bar.

See also time signature.

AC

Abbreviation for Alternating Current. In a sound synthesis context this term usually

refers to an oscillating signal representing audio, as opposed to a slow moving control

signal such as an envelope, which might be considered DC or Direct Current.

accent

Emphasis given to a musical note. An accented note is usually louder than those

surrounding it. An accent can be used to emphasize the important notes in a

particular metre/time signature (each metre has its own prescribed rules about

emphasizing particular beats), but can also be used to accent other notes.

additive synthesis

A sound synthesis method where spectrally rich timbres are created by mixing

together a number of simple sounds, usually sine tones. It is called "additive" in

contrast to "subtractive synthesis" where a spectrally rich sound is filtered to shape

its timbre.

Getting Help and Further Information - Glossary Terms 378



ADSR envelope

ADSR stands for Attack-Decay-Sustain-Release. It refers to an envelope shape which is

commonly used in sound synthesis to control amplitude, pitch or filtering over time. It

is a crude approximation of the time dynamics of natural sounds. Each of A, D, S, and

R is called a segment. In an ADSR envelope, the user controls the duration of the

Attack, Decay and Release segments and the level of the Sustain segment. Usually

the Sustain segment lasts as long as the musical note is sustained (for example, by

keeping a key depressed on a keyboard).

See also modulation.

all-pass filter

A type of filter which passes all frequencies, often used as a building block for other

types of filters. All-pass filters typically delay different frequencies by different

amounts, causing frequency-dependent phase changes. As a result, mixing an all-pass

filtered signal with its (unfiltered) input will usually lead to phase cancellations and

reinforcements at different frequencies -- thus creating a filter which exhibits a

frequency dependent amplitude response.

amplitude

A measure of the "strength" of a digital or electrical representation of an (audio)

signal. Corresponds to the height of an audio waveform. It roughly corresponds to

the perceptual quantity of loudness. Amplitude may be measured in volts, but more

commonly in decibels (dB), a logarithmic measure relative to an absolute quantity

such as a fixed voltage (dBV) or the maximum representable amplitude in a digital

audio system (dBFS).

amplitude gating

see gating.

amplitude modulation

The process of changing (modulating) the amplitude of a signal with another signal.

The process has certain well understood spectral properties -- for example, the

resultant signal will contain frequencies at the sum and difference of frequencies

present in the inputs.
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See also modulation.

analog

A process or sound synthesis method implemented using analog electronic hardware

as opposed to digital methods implemented using digital circuitry or computer

software.

arpeggio

A sequence of musical notes corresponding to the notes in a chord, but played one

after another instead of all at once.

arpeggiator

AudioMulch includes an arpeggiator which plays continuously repeating arpeggios --

this is often a standard function on synthesizers. The arpeggiator cycles repeatedly

through each note of a chord, possibly spanning multiple octaves. For example, given

a chord C-E-G, the arpeggiator would play the related in a repeated sequence: C-E-

G-E-C-E-G... Variations such as playing the notes in only an ascending or descending

sequence are also possible. e.g. C-E-G-C-E-G-C... or G-E-C-G-E-C-G-...

attenuate / attenuation

The process of reducing (attenuating) the strength of a signal. In audio this usually

means "turn the volume down" or "reduce the gain."

bandpass filter

A filter which passes only a certain band of frequencies. Frequencies outside the pass-

band are rejected or attenuated.

bandwidth

The range of frequencies present in a signal, or the allowable range of frequencies

supported by a transmission medium or filter.

See also broadband.
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bar line

A vertical line on a music stave which delineates the end of one bar and the start of

the next.

bar / bars

The space in between two bar lines. Indicates a full measure of time in the given time

signature. For example, in 3/4 time, one full bar would consist of three quarter note

(crotchet) beats of music.

See also bar line.

bit depth reduction / bit depth quantization

Bit depth reduction is a type of audio format conversion which reduces the amount

of computer memory (disk space or RAM) consumed by an audio segment. A

reduction of the the bit depth (see below) of digital audio is often performed when

mastering audio for CD. Audio production is often performed using 24 or more bits

per sample whereas CDs use 16 bit samples. Bit depth reduction may also be used

arbitrarily as an audio effect (for example to simulate older sampling technologies

which used 8 or 12 bits per sample) to create a kind of distortion. Quantization is one

method of reducing bit depth where each sample is "snapped" to the nearest

available value at the new bit depth -- this process may introduce audible distortion.

See also quantization.

bits / bit depth

Computers represent numbers using the binary counting system. Binary digits are

called bits. A binary number with more bits (digits) can represent a larger range of

numbers. For example, in the decimal system 2 digits support numbers from 0 to 99,

while 4 digits support numbers from 0 to 9999. In binary, 2 digits support numbers

from 0 to 11 (0 to 3 in decimal) while 8 bits support numbers from 0 to 11111111 (0

to 255 in decimal). Computers represent sounds using sequences of numbers

(samples) -- assuming a fixed maximum loudness, the greater the number of bits used

to represent each audio sample (called the bit depth), the greater the detail which

can be represented. Thus, higher bit depths generally lead to clearer, less distorted

sound, but also take up more computer memory.
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broadband

An adjective used to describe a sound or signal with "wide bandwidth," which in

audio terms equates to sounds with a range of different frequencies accross the

whole audio spectrum, from high to low. Typical broadband sounds include human

speech, white noise, or recordings of rock music with drums, bass and guitar.

Conversely, narrowband sounds only contain frequencies in a narrow range, such as a

single sine wave, birds chirping, or a low frequency rumble.

canon

A musical structure where the same melodic pattern is repeated by multiple voices,

delayed by a fixed interval.

See also round.

carrier (signal)

A signal which gets modulated by a modulator. A carrier-modulator system is typically

found in radio transmission, for example AM radio (where the amplitude of the

carrier is modulated) or FM (where the frequency of the carrier is modulated). Both of

these techniques have also been employed in audio synthesis.

See also modulation.

cents

A unit of measurement used to refer to the distance between two musical pitches. A

cent is 1/100th of a semitone. Thus there are 1200 cents per octave. Relative pitch

values can be positive or negative, for example middle C +50 cents is a quarter tone

above middle C, middle C -100 cents is the B below middle C.

chord

Two or more musical pitches played simultaneously. Usually organized according to a

system of harmony.

comb filter

A type of audio filter which passes or cuts narrow bands of frequencies spaced in a

harmonic series -- i.e. the bands are centered on integer multiples of the lowest band.
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The filter is so named because its frequency response looks like like the equally

spaced tines of a comb.

compression / dynamic range compression

The process of dynamic range compression reduces the dynamic range of a sound.

This usually means that loud sounds are turned down so that they are not so loud.

This is sometimes called "levelling" and can be used to make the loudness of a

recording more consistent, which may make it easier to mix sounds together without

unusually loud elements "poking out" inconsistently. The devices used to perform

compression are called compressors. Compressors can produce a wide range of

different sonic effects and are often used to apply distortion, rather than simply to

change the dynamic range of a sound.

Further reading: http://en.wikipedia.org/wiki/Dynamic_range_compression

consonance

The musical concept of two or more notes played simultaneously sounding pleasing.

For example, a fifth is said to be more consonant than a semitone. The opposite of

consonance is dissonance.

Although there is some physical basis in consonance relating to beat-frequencies,

there is no objective measure of what constitutes consonance and the term's exact

definition has varied over the centuries. It is probably best to think of consonance and

dissonance as the two extremes of a continuum.

See also dissonance.

cosine bell

A bell shaped curve described by the path of a single cycle of a cosine (or sine)

waveform travelling from its minimum value up to its maximum value, and then back

down to its minimum again.

CPU overload

When the computer's central processing unit (CPU) is unable to compute fast enough

to achieve the desired result in the allocated time, the CPU is said to be overloaded.

In audio processing applications this may mean you are trying to perform too much
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audio processing and the computer is not fast enough to keep up. The result is

usually audio glitching and drop outs.

Note that despite the glitchy audio, the overload does not indicate a fault with the

computer. It's not broken; it's just not coping.

cross-feedback

A feedback network which forms a cross or figure-eight loop (eg output from A feeds

input of B, output of B feeds input of A. Stands in distinction to a simple feedback

loop where the output of a process feeds back into its input.

See also feedback.

crossfader / crossfade

The process of crossfading involves mixing together two audio streams such that one

fades out to silence as the other fades in. A crossfade refers to a single execution of

the process of crossfading. A crossfader is a device (traditionally a mechanical slider

on a DJ mixer) which allows you to perform the crossfading process by moving the

slider from one end to the other to crossfade from one sound to another.

cycles per second

A unit of measure for frequency, usually used in audio systems to refer to the

frequency of audio oscillators or low frequency oscillators. This unit is also known by

the SI unit Hertz. It is used to refer to the number of times a vibrating system

oscillates in a second.

See also Hertz.

Further reading: http://en.wikipedia.org/wiki/Cycle_per_second

dB (decibels)

A logarithmic unit of measure often used for representing measures of audio power.

This is more meaningful than using linear voltage, as a logarithmic scale approximates

more closely our perception of loudness. A change of approximately 6.02dB is more

or less equivalent to a doubling in amplitude. However, it must be noted that there

are many more subtleties to the way humans perceive loudness than can be captured

by simply switching from a linear to logarithmic scale.
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Decibels are relative units, thus always measured relative to a reference level. In a

digital audio system such as AudioMulch the reference level is often dBFS (decibels

relative to full scale -- the largest signal the audio hardware can reproduce). In this

case 0dB corresponds to full scale, -6db is half of full scale and +6dB would be twice

full scale.

Further reading: http://en.wikipedia.org/wiki/Decibel

delay / delay line

A delay line (sometimes simply delay) is a device which delays a signal (such as an

audio signal) by a fixed or variable time. At least in principle, a delay line reproduces

(outputs) its input acurately at some later time. Delay lines may have a fixed delay

time, or the delay time may be varied (either by a user control, or using modulation

such as a low frequency oscillator). A delay line may be tapped at multiple points to

yield multiple outputs which are each a version of the input delayed by a different

amount.

dissonance

The musical concept of two or more notes played simultaneously sounding

displeasing. For example, a semitone is said to be more dissonant than a fifth. The

opposite of dissonance is consonance.

See also consonance.

distortion

An effect where the quality of an audio signal is modified or degraded, it is

commonly achieved by overdriving an electrical circuit beyond its normal range. There

are as many types of distortion as there are circuits which produce it. Distortion

always adds additional harmonics, which can make sounds more harsh and raspy.

Some kinds of distortion, like tape saturation and tube amplifier distortion, are

considered more "musical" than others, as they add subtle levels of additional

harmonics, or interact in complex relationswith the amplitude of the source signal.

More extreme distortion effects are commonly used with electric guitar.
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doppler effect (doppler shift)

The doppler effect happens when the pitch of moving sounds is perceived as a

shifting pitch that depends of the speed and direction of the sound source relative to

the listener. This can be heard in everyday life as the sound of car and motorcycle

engines appears to have a higher pitch as they approach and then shift lower as they

pass and recede. This effect is due to the sound wavefronts compressing in front of

the moving object, and expanding in its wake.

dynamic range

1. A measure of the variation in loudness within a signal or sound recording. For

example, a piece of music which includes very quiet and very loud passages is said to

have a wide dynamic range. The dynamic range of a sound can be reduced or limited

using a compressor or limiter.

2. A measure of the variation in loudness that can by accommodated by a recording

or transmission medium. Often dynamic range is limited by noise in the recording

system -- sounds which are too quiet can not be captured because they are masked

by noise.

dynamic range compressor

A dynamic range compressor (often just called a compressor, sometimes called a

"leveller") acts to reduce the volume of loud signals. This creates a less dynamic

sound that mixes more evenly with other sounds. Depending on the settings, a

compressor can have other effects, such as making percussion sound more punchy.

envelope (loudness envelope)

The envelope of a sound refers to its overall loudness contour. Given an existing

sound, we can impose a different envelope on it by changing its amplitude over time.

Different sounds have different characteristic loudness envelopes. For example, a

sound generated by striking a drum begins with an almost instantaneous rise to

maximum loudness and then decays slowly. Other sounds may start quietly and

slowly build to maximum amplitude, such as the sound of a passing car.

See also modulation.
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envelope generator

A device which generates an envelope control signal.

See also ADSR envelope.

feedback

The term feedback refers to the (audible) results of a feedback loop. A feedback loop

is a configuration of connections where the output of a process is fed back into it's

input to be processed again (and again, and again, ad infinitum). This could be

acoustical, for example where the output of a speaker is picked up by a microphone

which is fed to a speaker. It could also be electronic or digital, for example, where the

output of a digital delay is fed back to it's input to create repeating delays. Any

process which has an input and an output may be subjected to feedback by

connecting the output to the input.

The term feedback may also refer to the amount of gain or attenuation applied to the

signal passing through the feedback loop -- applying more gain to a feedback loop

typically results in greater audible feedback.

filter / filtering

An audio filter is a device which alters an audio signal, usually by boosting or cutting

certain frequencies. Filters which make fine adjustments are often called equalization

filters (abbreviated EQ). Others have more extreme effects such as removing whole

areas of the frequency spectrum (lowpass, highpass, bandpass). Some filters only alter

the phase of the signal (see all-pass filter).

flanger

A device which imposes a type of audio effect called flanging on an audio signal.

Flanging was originally achieved by playing the same sound on multiple tape

recorders and varying their relative speed by leaning on the tape reel flange. More

commonly, a flanger is implemented using an electronic or digital circuit which

approximates the sound of the tape process.

frequency

1. A quantity describing the rate at which a periodic cycle occurs, such as the rate of

vibration of a membrane or string, or other sound producing mechanism. Frequency
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is measured using units of Hertz, the number of cycles per second, abbreviated Hz.

E.g. "The oscillator generates a sine wave with a frequency of 200Hz." Sometimes

kHz (1000's of cycles per second) is used. The human auditory system is generally

said to be able to detect frequencies from 20Hz to 20Khz, although adults usually

can't hear much above 16kHz.

2. The terms frequency and frequencies are sometimes used to refer to specific

sounds, or components of a sound. For example, an individual sine tone may be

referred to as a 'frequency'.

3. Similarly to (2) frequency and frequencies may be used to refer to a specific region

of the sound spectrum. For example, "we boosted all frequencies below 50Hz to

achieve the brown note." Less specifically, one might refer to "high frequencies,"

"low frequencies," "mid-range" frequencies.

fundamental (frequency)

The lowest frequency in a harmonic tone. If all harmonics are present in a tone then

this is also the spacing between adjacent harmonics. This is also the frequency which

determines the musical pitch of a tone. Humans are able to perceive the fundamental

frequency (or pitch) of a sound even the actual frequency is not physically present.

For example, a small speaker cannot physically reproduce the fundamental frequency

of a low bass instrument, but we may still perceive it to be present from the higher

harmonics.

gain

In simple terms, applying gain turns the volume up or down. Positive gain increases

the amplitude of an audio signal. A negative amount of gain decreases the

amplitude. "Unity gain" means not changing the amplitude of the signal.

gate / gated / gating

The process of repeatedly switching an audio signal on and off, possibly in a rhythmic

pattern. Gating can be thought of as applying an amplitude envelope with a fast

attack and release time. Gating may be applied manually using a switch, by

programming a rhythmic pattern or it may be applied automatically, based on the

level of a sound (as in a noise gate).

See also noise gate.
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glissando

A smooth slide from one pitch to another.

granular synthesis / granulation

A sound synthesis technique where an aggregate sound mass is created by mixing

together many small grains of sound. When the grains of sound are created by

cutting and splicing together small fragments of a pre-existing sound source, the

process is referred to as granulation.

harmonic

A single frequency component in a harmonic series. Harmonics are, by definition, sine

waves. Sometimes called a partial.

See also harmonic series, harmonics.

harmonics

A group or subset of individual harmonic components in a harmonic series. This is

often qualified, as in odd-harmonics, even-harmonics, upper harmonics. Sometimes

used to draw a distinction with the fundamental frequency of a harmonic series.

See also harmonic series, harmonic.

harmonic series

A group of sine wave components whose frequencies are related by being integer

multiples of a fundamental frequency. Vibrating systems such as strings and tubes

tend to produce tones comprising frequencies which are harmonically related due to

the physical constraints of the system -- a string only supports vibrations which fit

exactly along the length of the string (one times its length, half its length, one third

its length and so on).

Further reading: http://en.wikipedia.org/wiki/Harmonic_series_(music)

high-hat

A mechanism of two cymbals mounted on a single pole often found as part of a

drum kit. The cymbals can sit apart ("open") or can be temporarily clamped together
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("closed") by the player using a foot pedal. When struck, the high-hat makes

different sounds when open or closed. It is possible to strike it while open and to

then close it to gate the sound while it is ringing out. Playing a high-hat often

involves intricate patterns of opening and closing the cymbals while striking them

with drum sticks.

high shelf filter

A filter that allows adjustment of the gain of frequencies above a specific shelf

freqency. Shelving filters can boost or cut frequencies.

See also low shelf filter.

Further reading: http://en.wikipedia.org/wiki/Filter_design

Hz (Hertz)

The SI unit for frequency. Frequency, measured in Hertz, is the number of times a

periodic event such as an audio vibration occurs in one second.

See also frequency.

Further reading: http://en.wikipedia.org/wiki/Hertz

inharmonic spectrum

A sound spectrum which includes partials which are not harmonically related. For

example, most bells and gongs produce sounds with resonances which are not

harmonically related.

See also harmonic.

Further reading: http://en.wikipedia.org/wiki/Inharmonicity

inskip

Offset from the start of a sound file or sound sample. The distance from the start of a

sound file to a specific location within the file.
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LFO (low frequency oscillator)

An oscillator which generates a slowly varying waveform which is often used to

modulate the amplitude, pitch or filter settings in a synthesizer. Here low frequency
refers to frequencies below the audio rate (less than approximately 20Hz). Instead of

hearing the oscillator as a pitch (as in an audio rate oscillator), a low frequency

oscillator is usually heard as a repeated rhythmic modulation of synthesis parameters.

low bit rate

An attribute of a digital audio stream (or other digital stream) which uses a small

number of bits per second to represent a signal. Usually this corresponds to low audio

fidelity. Most often this is used when referring to compressed audio (such as mp3

audio) but it also applies to linear audio of either a low sample rate, low bit depth, or

both.

See also bit depth, sample rate.

low shelf filter

A filter that allows adjustment of the gain of frequencies below a specific shelf

freqency. Shelving filters can boost or cut frequencies.

See also high shelf filter.

Further reading: http://en.wikipedia.org/wiki/Filter_design

low pass filter

A low pass filter is a filter which passes low frequencies, and consequently elminates

high frequencies. The cutoff frequency is the point where the filter transitions from

pass band to stop band. Usually practical filters don't exhibit a perfect pass/stop

frequency response, there is a gradual transition from passband to stop band, and

attenuation in the stop band is not complete but rather significantly stronger than in

the pass band. For example, a common characteristic of musical lowpass filters is that

they reduce gain by 24dB for each octave above the cutoff frequency.

low pass resonant filter

A type of low pass filter (see above) which exhibits a resonant peak around the cutoff

frequency. That is, it boosts frequencies around the cutoff frequency. This can create a
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nasal or formant-like quality to filtered sounds, and is a key characteristic of the

classic "analog filter sweep" sound. Lowpass filters with resonance typically allow you

to adjust the amount of resonance, which is sometimes called "Q" -- the engineering

term for resonance.

melody

A sequence of notes, heard one after the other, consisting of a variety of pitches.

Rhythm also plays a part in defining the character of a melody.

See also rhythm.

midrange filter

A filter which operates on frequencies in the middle of the audible frequency

spectrum. Approximately from 100Hz to 2000Hz.

See also filter.

mixer

A device which combines (mixes) multiple audio streams into a single stream. Usually

a mixer allows the relative amplitude (loudness) of each stream to be adjusted

separately and may allow other changes to each stream. For example, a stereo mixer

might allow each stream to be panned separately.

modulation / modulator

To "modulate" means to change or vary. Hence, modulation is the process of

changing something and a "modulator" is that which effects the change. In sound

synthesis, modulation usually means to apply an ongoing time-varying change to

some sound parameter such as frequency, amplitude, etc. Most often the modulation

is performed by an ongoing or automatic process, for example, an LFO (low

frequency oscillator) or envelope follower -- such modulation sources are referred to

as "modulators". ADSR envelopes are another common form of modulation sources.

mono / monophonic / monaural

Mono is an abbreviation of monophonic or monaural. The term has two uses, one in

conjunction with spatial (stereo or multichannel surround audio) and another in
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relation to instruments capable of only producing one tone at a time (the human

voice for example, as opposed to a polyphonic instrument such as a pipe organ).

A single audio source. For example, audio emanating from a single loudspeaker. Or

audio passing through a single wire or connection. Usually used in contrast to stereo

or multichannel.

Further reading: http://en.wikipedia.org/wiki/Monaural

multichannel

An audio system which maintains audio in multiple discrete channels. This is usually

used to mean more than one (mono) or two (stereo) channels. For example, a

multichannel speaker system, often used in surround sound reproduction, employs a

number of speakers, each fed with a different audio signal. A multi-channel audio

interface supports output of more than two audio signals. A multi-channel sound file

contains more than two audio channels.

multitrack

A recording or playback system where multiple tracks or channels of independent

audio are recorded and played back. Often multitrack systems are used in recording

studios, where each instrument in a performance is recorded on a separate track --

sometimes multiple tracks are used to capture different microphones capturing a

single instrument. Multitrack is different from multichannel in that a multitrack

recording may be (and often is) mixed down to mono or stereo -- in this sense it is a

recording technology, whereas multichannel is usually used to describe a delivery

system or a capability to deal with many channels of independent audio.

noise gate

A noise gate (sometimes just "gate") is an audio processing device originally intended

to suppress background noise. It opens and closes, allowing louder sounds through

while muting or reducing the gain of quieter sounds. Traditionally, it has been used to

mute out background noise when foreground sound is not present. Some noise gates

can be configured as "duckers" which mute loud sounds. In a side chain

configuration a ducker can be made to turn down one sound (such as background

music) while another sound is present (such as a voice over).

See also side chain.
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Further reading: http://en.wikipedia.org/wiki/Noise_gate

normalize

The process of adjusting the volume of an audio signal or waveform to a specified

level. Usually this would mean adjusting the volume of a waveform so its maximum

level is the maximum level representable in the system, perhaps with a small safety

margin, for example normalizing the peak level to 3db below maximum.

octave

A musical term for a distance between pitches which corresponds to a doubling (or

halving) in frequency. Musical notes an octave apart belong to the same pitch class

(for example, the C above middle C is an octave above middle-C). There are 7 notes

in a diatonic scale, the eighth being the note an octave above the first -- this is the

origin of the "oct" in the word "octave", as the Latin name for the number 8 is

"octo".

oscillator

A device which repeatedly performs the same action is said to oscillate and is called

an oscillator. An audio oscillator produces a repeated audio waveform, which results

in a tone of fixed pitch and consistent timbre. Audio oscillators may vary in frequency,

which alters their pitch, and may produce a variety of waveforms, which determines

their timbre.

pan / panning

Derived from the word "panorama," panning refers to the process of placing a sound

at a specific location in a spatial mix. In a stereo environment, this means placing the

sound somewhere between the left and right loud speakers. Panning is usually

performed with a pan control, such as a knob, which allows you to dial in the

location.

parametric equalizer

A type of filter used to adjust an audio signal. An equalizer allows the adjustment of

certain frequency bands within an audio signal -- for example a simple tone control

found on a hi fi system which allows boosting or reducing high and low frequencies

is a type of equalizer. A parametric equalizer is a type of equalizer allowing more
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precise control over the frequencies which are adjusted by the equalizer. A typical

parametric equalizer allows tuning in to specific frequency bands by adjusting cutoff

frequencies and bandwidths -- the ability to tune in to these frequencies (the

parameters) is what makes a parametric equalizer parametric.

phase cancellation

When two audio signals are mixed, some frequencies may coincide and reinforce or

cancel out each other. Phase cancellation refers to cancellation effects due to two

frequencies being the same but out-of-phase such that one partially or totally cancels

the other. The phase difference may be accidental, due to the time delay effects of

capturing the same source using multiple microphones. It can also be deliberate,

achieved by splitting the signal into two paths, and processing each path differently

before recombining both signals. Phase cancellation is most often an undesirable

effect which reduces the strength of an audio signal and weakens some harmonics

making the sound sound "thin".

See also phasing.

phase inversion

The process of inverting the polarity of an audio signal. Such a signal is said to be

"out of phase" with the non-inverted original. In this sense, phase inversion is only

relevant when there is some "in phase" signal to compare with. Mixing an audio

signal with a phase-inverted copy results in cancellation and therefore silence. The

effect of phase inversion is perhaps most commonly encountered when one miswires

one channel of a stereo speaker system so that the wires are swapped on one

speaker. This creates a kind of stereo-wide sensation as sounds which should be

heard as common between the two speakers are completely out of phase and are

heard as though they were emanating "beyond the speakers".

phaser

An audio effect which filters and recombines multiple streams of its input in such a

way as to produce sweeping resonant peaks or swooshing sounds. Often the rate

and depth of the effect can be controlled.
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phasing

1. An audible effect heard as a high-frequency swishing sound which results from

phase cancellation. The effect may arise from mixing back two very similar audio

sources. It can result from mixing audio recorded from multiple microphones at

different locations, from mixing sounds processed by different effects, or by special

audio processing effects such as phasers and flangers which mix together sounds

filtered in different ways to create sweeping effects.

2. The outcome of playing back multiple streams of repeated or looped rhythmic or

time structured audio (such as speech) of different lengths such that at each length

the streams are heard against each other at different phases. This kind of phasing can

produce slowly changing patterns (if loop lengths are very close) or more chaotic

variations (if the phases at each repeat vary dramatically). Some music, such as that

by Minimalist composer Steve Reich, makes heavy use of phasing as a compositional

technique.

See also phase cancellation, phaser, flanger.

pitch

1) A musical term used to describe the fundamental frequency of a musical tone

within a particular tuning system. Usually the 12-tone tuning system is used where

each octave is broken up in to 12 equally spaced intervals and these are referred to by

the pitch classes A, A#/Bb, B, C, C#/Db, D, D#/Eb, E, F, F#/Gb, G, G#/Ab.

2) A descriptive term used to refer to the relative frequency of an audio signal (e.g. "a

high pitched sound").

pulsar synthesis

A form of sound synthesis which generates a train of pulses with regular period.

Depending on the rate of pulse generation, the pulse train may be perceived as a

regular rhythm, or at faster rates, as a pitched tone. The ability of pulsar synthesis to

span these two perceptual domains is one of its key features. At is simplest, the

pulses may be impulses (clicks) repeated at a certain rate, as in a classical analog pulse

generator used in early electronic music. More commonly, the pulses are small grains

of sampled sound, making pulsar synthesis a variation on granular synthesis.

Further reading: http://en.wikipedia.org/wiki/Pulse_generator
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pulse train

A repeated sequence of pulses. In this context, a pulse is a short click-like sound,

usually approximating a dirac-pulse, which is a click with energy at all frequencies.

Unlike most audio waveforms, whose higher harmonics are weaker (ie the sound has

more low frequency energy than high frequency) a pulse train is a periodic (pitched)

sound all of whose harmonics have equal amplitude.

quantization

The process of adjusting something (such as the time of events) such that it snaps to

a regular grid. For example, it is possible to quantize pitches to conform to a musical

scale, or perhaps more commonly, to quantize rhythmic events such that the conform

to a regular pulse. Quantization need not be all-or-nothing, it's possible to have

partial quantization where events are moved some way towards a regular pulse.

The term quantization can also refer to a process of bit depth reduction.

See also bit depth reduction.

resonance

A region in the frequency response of a system where frequencies are amplified or

reinforced. This may be heard as a "ringing" sound, where the system (an audio filter,

and effect, a bell, a room) continues to sound even when no energy is fed into the

system. Acoustic systems such as bells resonate at discernible pitches; others such as

the bodies of guitars emphasize a broad range of frequencies.

See also resonant filter.

resonant filter

A filter which exhibits resonance at a certain frequency or frequencies. Often this

refers to a low pass resonant filter, although the term covers any filter which rings or

resonates. Other examples combine filters with feedback (as found in AudioMulch's

5Combs contraption) or more complex filters which simulate resonant physical

structures such as tubes or plates.

See also low pass resonant filter.
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reverberation

The resonant characteristic of rooms and other large architectural spaces.

Reverberation is the result of sound reflecting off the many surfaces of the room and

being refracted and delayed as it travels through the air. The sound reaches the

listener through many of these different paths as it bounces around the room; the

result is a delayed and smeared effect, which is perceived as a sense of the size and

character of a space.

The sound of reverberation is heard when clapping in a particular space, perhaps

most easily in a big church or cathedral. Rooms designed for musical performance are

often acoustically treated and proportioned to create reverberation which enhances

the musical experience. Reverberation may be simulated by artificial means using a

reverb processor. This effect is often used in order to create a sense of depth in

electronic and recorded music without necessarily seeking to simulate a real space.

rhythm / rhythmic

Rhythm in its most basic sense means the duration of a note. Rhythm is part of a

complex system of musical time which, in Western culture, also involves time

signatures, beats, stresses, and tempo/speed. Rhythm is typically used to create beats

and patterns, and the rhythm in a piece of music is often made up of a range of

durations. In Western music many rhythmic values are based around subdivisions of

time, and tend to be related to one another by simple mathematical equations such

as division or multiplication by two (in duple time signatures such as 2/4 and 4/4) or

three (in compound time signatures such as 3/8 and 6/8). Rhythms and durations are

subject to a number of rules in traditional Western music systems, including how

particular rhythmic values should be grouped, and which beats or notes should be

accented in a particular time signature.

See also time signature.

ring modulation

An electronic effect which involves modulating one signal with another. It is

equivalent to multiplying the instantaneous amplitude of one signal by another,

which produces a resulting sound with harmonics at the sums and differences

between all frequencies in the two input sounds. Often ring modulation is performed

with one signal being a sine wave. This results in two shifted copies of all of the

frequencies in the non-sine wave signal: one set (the sums) shifted upwards by the
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frequency of the sine wave, the other set (the difference) being shifted relative to the

difference between the source and the sine wave.

round

A simple form of musical canon, usually sung. It is often for three or more voices,

each singing the same melody in unison or an octave apart. Rhythmically, the entry

point of each singer is offset, usually by a regular interval of time, so that each new

entry of the melody overlaps with the others to form harmonies. A well known round

is "Frere Jacques".

sample

1. A captured segment of digital audio. Usually refers to a recording of an individual

sound (such as a drum hit) or a portion of a prexisting piece of recorded music.

2. An individual number, which forms part of a sequence of numbers which together

represent the changing values of a digital audio signal over time.

See sample rate.

sampling

The process of creating recorded digital audio segments from pre-existing acoustic or

recorded music sources. This process is sometimes part of a cultural practice where

recognisable or obscure segments of other people's music is sampled and used to

make new music through a process of bricolage.

Further reading: http://en.wikipedia.org/wiki/Sampling_(music)

sample inskip

See inskip.

sample rate

Computers represent digital audio as a sequence of numbers called samples. Each

sample represents a voltage level in an electronic audio system, usually measured

from a microphone, or used to drive a loud speaker. These voltages correlate to

changing air pressure levels as sound travels through the air. The sample rate or

sampling rate then, is the rate at which voltages are measured to create the sequence

Getting Help and Further Information - Glossary Terms 399

http://en.wikipedia.org/wiki/Sampling_(music)


of sample values. CD audio for example, is sampled at a rate of 44100 samples per

second.

See also sample.

sample rate decimation

The process of reducing the sample rate by discarding samples. For example, the

sample rate can be (naively) reduced by a factor of two by dropping every second

sample. Note that decimation performed in this manner introduces aliasing distortion

(see below), more often careful filtering operations are used to avoid negative effects

of sample rate conversion.

sample rate decimation aliasing

The distortion which results from performing sample rate conversion using the simple

process of discarding samples to reduce the sample rate. When aliasing occurs,

audible frequencies present in the original signal which were above half the new

sample rate are reflected across this half-sample-rate boundary, and will be heard as

(usually undesirable) distortion frequencies. This phenomenon is the digital audio

correlate of wagon wheels being seen to spin backwards in movies because the film

frame rate is not fast enough to capture their forward motion.

sample rate reduction

The process of reducing the sample rate of a digital audio signal.

See also sample rate, sample rate decimation.

sawtooth wave

A waveform which looks like a saw blade: one vertical edge and another ramped

edge. Such waveforms are commonly used in analog synthesizer oscillators. Sawtooth

waves have both odd and even harmonics which decay slowly, producing a distinctive

bright sound which is suitable for filtering with a lowpass filter.

semiquaver

A note that is one sixteenth of a whole note in duration. In a bar of 4/4 time, there

are sixteen sixteenth notes (semiquavers) in a bar. In traditional Western musical
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notation, the note head is filled in black and has two tails (flags) attached to its stem.

It is half the duration of an eighth note (quaver).

See also time signature, rhythm.

semitone

The difference between two adjacent musical pitches in the western diatonic system.

This is the distance between two adjacent notes on a piano keyboard (when using

both white and black keys) or two adjacent frets on a guitar.

sequencing

The process of composing or specifying a musical sequence comprising rhythm and

pitch, usually of musical notes and chords, although it may also include specification

of dynamics, timbral modulations and so on. Sequencing is often accomplished by

specialized software called a sequencer, or it may be accomplished using sequencer-

like functionality embedded in other software as is the case in AudioMulch.

sidebands

The resultant harmonic components generated by some modulation synthesis

techniques such as amplitude modulation.

side chain

A separate chain of audio processing or filtering which sits to the side of a main

processing chain. Commonly this is used in audio processes where the processing is

controlled by the audio input. Rather than use the same audio as the source to be

processed, and the source to control the process, a separate side chain may be used

to provide the control signal. For example, a kick drum may be used to control a nose

gate which processes a bass guitar. In some cases, the side chain may be a separately

filtered version of the source signal -- for example, applying separate filtering to the

control signal used for a compressor to make the compressor more or less sensitive to

transients.

(audio) signal generator

The electronic equivalent of a sound producing object. Signal is a general term for a

fluctuating electrical voltage and current. In audio systems, signals often represent

acoustical fluctuations captured by microphones and/or reproduced by speakers. A
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signal generator then, is an electronic (or digital) circuit or system which produces

fluctuating voltages.

sign bit

Digital systems represent numbers (and hence audio signals) using the binary

counting system, where digits can be either 0 or 1. Such binary digits are called

"bits". One way of representing negative numbers in a binary counting system is to

use a bit to indicate whether the number is positive or negative - such a bit is called

the "sign bit."

sine wave

A waveform distinguished by its lack of harmonics. It contains only a single frequency

component. A sine wave is curved, and its shape is related to the motion on a single

axis of a point travelling around the perimeter of a circle.

sinusoidal

In the shape of a sine wave.

See also sine wave.

sixteenth note (semiquaver)

See semiquaver.

spatializer

A device which "spatializes" sound. The process of spatialzing involves imbuing a

sound with spatial properties, which often but not always includes motion in space. A

spatializer may create different illusions: that a sound source is placed in space

between two or more speakers, that it is moving between the speakers or that they

are placed at different depths, seeming to be closer or further away. There are many

different techniques for creating a sense of sound in space; some of them employ

physical properties of sound (e.g. distant sounds are quieter, doppler shift of moving

sounds) while others address specifics of the human auditory system (e.g. stereo

panning between two speakers, arrival time differences between the two ears).
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square wave

A waveform with two constant level states of equal length, each of equal level but

opposite polarity. Such waveforms have only odd harmonics and as a result have a

"hollow" sound like a clarinet or other woodwind instrument.

stereo

A method of audio recording and reproduction where two distinct audio channels

(left and right) are used to reproduce a lateral sound field using either two loud

speakers or headphones. The term stereo may be used to denote a device using 2

audio channels as opposed to 1 (mono), or more than 2 (quad, surround, octaphonic

etc).

summed / summing

The process of adding two or more things together. In audio this refers to mixing two

or more audio signals together at equal strength.

(audio) synthesis

The process of creating audio using one or more mechanisms (electronic or software

based) in combination. For example, additive synthesis mixes sinewaves, subtractive

synthesis combines oscillators and filters.

synthesize(r)

A device which performs audio synthesis.

tempo

The speed of the beat in rhythmic music. The plural of tempo is 'tempi'. In music

software, tempi are usually specified as a rate of "beats per minute".

timbre

A term used to refer to the quality of a sound not covered by notions of loudness or

pitch. The term has a number of meanings but a common ones are tone-color. It may

be used to discuss the tone colour of a specific instrument (e.g. "that violin has a

different timbre to the other one") or to distinguish between different sound
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categories (e.g. "a church bell has a completely different timbre to the sound of

waves crashing at the seaside").

Further reading: http://en.wikipedia.org/wiki/Timbre

time signature

A numerical sign, usually placed near the start of a piece of music - after the clef and

key signature, if any - that represents the timing or metre of the music. It can also be

placed at any other point in a piece of music. A time signature usually consists of two

numbers, one one top of the other. The upper number tells you how many beats

there are in each bar, while the lower number indicates the type of beat. The lower

number represents the duration of each beat as a fraction of a whole note, or

semibreve. Therefore, in the time signature 3/8, the bottom number indicates that the

beat is 1/8 the length of a whole note, which is an eighth note (or quaver). The upper

number, 3, indicates that there are three of these eighth note (quaver) beats per bar.

See also bar, rhythm.

transpose / transposition

The musical process of transposition, transposing (verb) a melody or sound means

changing all of its pitches from one pitch level to another. A transposition (noun)

refers to an instance of a melody at a particular pitch level. Chromatic transposition is

performed by shifting all pitches up or down by the same interval. The interval may

be expressed in semitones or (for microtonal transpositions) in cents. Diatonic
transposition moves pitches by scale degree rather than chromatic interval -- resulting

in a melody which is in the same key as the untransposed original.

Further reading: http://en.wikipedia.org/wiki/Transposition_(music)

trigger

A instantaneous signal to initiate an action. In sound synthesis this could mean to

cause an envelope to begin, or to cause a sound to be played. Unlike a musical note,

which has a start, a duration and an end, a trigger is an instantaneous event.

waveshaping

A sound synthesis technique where an input waveform is warped or bent by

subjecting it to a waveshaping function which specifies for each input level a
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corresponding output level. Waveshaping is a form of distortion which always adds

additional harmonics to a sound. Methods for computing wave shaping functions

exist which allow exact specification of the added harmonics given a certain input (for

example the Chebyshev waveshaping technique used in AudioMulch's Shaper

supports specifying output harmonics for a sine wave input). Like distortion,

waveshaping is a nonlinear process which means the sonic results can be highly

dependent on the nature and loudness of the input sound.

white noise

A type of noise which on average contains equal energy at all frequencies.

Further reading: http://en.wikipedia.org/wiki/White_noise
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Copyright

The AudioMulch software, documentation and web site is Copyright © 1997-2012 Ross

Bencina. AudioMulch is a trademark of Ross Bencina.

ASIO audio driver support based on the Steinberg ASIO SDK. VST PlugIn support based on

the Steinberg VST (Virtual Studio Technology) PlugIn SDK. The Steinberg ASIO SDK and

Steinberg VST PlugIn SDK are Copyright Steinberg Media Technologies GmbH. ASIO and

VST are trademarks of Steinberg Media Technologies GmbH.

This product includes software developed by the OpenSSL Project for use in the OpenSSL

Toolkit (http://www.openssl.org). This product includes cryptographic software written by

Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson

(tjh@cryptsoft.com).

AudioMulch includes source code from the following open source libraries: PortAudio,

Destroy FX Audio Unit Utilities, Speex, Aladdin MD5 Library, OpenSSL, David Gay floating-

point string conversion routines. As required, the licences for these source code libraries

are included below.

PortAudio Licence

PortAudio Portable Audio I/O Library

Copyright © 1999-2010 Ross Bencina, Phil Burk, Stephane Letz & Robert Marsanyi

Permission is hereby granted, free of charge, to any person obtaining a copy of this

software and associated documentation files (the "Software"), to deal in the Software

without restriction, including without limitation the rights to use, copy, modify, merge,

publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to

whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or

substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
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FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE

AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER

LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER

DEALINGS IN THE SOFTWARE.

Destroy FX Audio Unit Utilities Library Licence

Copyright © 2003-2006 Sophia Poirier

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

• Neither the name of Destroy FX nor the names of its contributors may be used to

endorse or promote products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE

POSSIBILITY OF SUCH DAMAGE.

To contact the author, please visit http://destroyfx.org/ and use the contact form.
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Speex Licence

Speex Codec Library

Copyright © 2002-2004 Jean-Marc Valin

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

• Neither the name of the Xiph.org Foundation nor the names of its contributors may

be used to endorse or promote products derived from this software without specific

prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE

FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER

CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,

OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE

USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Independent MD5 Implementation by L. Peter Deutsch

Copyright © 1999, 2002 Aladdin Enterprises. All rights reserved.

This software is provided 'as-is', without any express or implied warranty. In no event will

the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including

commercial applications, and to alter it and redistribute it freely, subject to the following

restrictions:
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1. The origin of this software must not be misrepresented; you must not claim that you

wrote the original software. If you use this software in a product, an

acknowledgment in the product documentation would be appreciated but is not

required.

2. Altered source versions must be plainly marked as such, and must not be

misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

L. Peter Deutsch

OpenSSL Licence

Copyright © 1998-2004 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the

following acknowledgment: "This product includes software developed by the

OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse

or promote products derived from this software without prior written permission. For

written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may

"OpenSSL" appear in their names without prior written permission of the OpenSSL

Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the

OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
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NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR

SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER

CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,

OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE

USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The

implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following

conditions are adheared to. The following conditions apply to all code found in this

distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL

documentation included with this distribution is covered by the same copyright terms

except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to

be removed. If this package is used in a product, Eric Young should be given attribution as

the author of the parts of the library used. This can be in the form of a textual message at

program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions

and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the

following acknowledgement: "This product includes cryptographic software written

by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the

rouines from the library being used are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from the apps

directory (application code) you must include an acknowledgement: "This product

includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO

EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this

code cannot be changed. i.e. this code cannot simply be copied and put under another

distribution licence [including the GNU Public Licence.]

Floating Point String Conversion Routines by David M. Gay

http://www.netlib.org/fp/

The author of this software is David M. Gay.

Copyright (c) 1991, 2000, 2001 by Lucent Technologies.

Permission to use, copy, modify, and distribute this software for any purpose without fee is

hereby granted, provided that this entire notice is included in all copies of any software

which is or includes a copy or modification of this software and in all copies of the

supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED

WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY

REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY

OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
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History of AudioMulch Changes

Important Note: Due to changes made to the SSpat contraption in the 2.2.0 release,

documents saved with AudioMulch 2.2 (or later) that use SSpat will not load correctly in

AudioMulch 2.1. Users who wish to continue using these documents with AudioMulch

2.1 are advised to make backup copies for use with AudioMulch 2.1 before saving them

with AudioMulch 2.2.

Version 2.2.4
July 12, 2013

• Fixed LoopPlayer bug where a muted LoopPlayer would sometimes start unmuted

until the beginning of the next bar. This happened if a document was first played

starting from anywhere other than the start of a bar (including when synced to MIDI

or Network Sync).

• Fixed extremely distorted audio when using over-unity floating point sound files in

some contraptions (e.g. LoopPlayer).

• Fixed LiveLooper crash when creating very short loops.

• Fixed LiveLooper assertion failure crash "Assertion failed: (state_ == RECORDING)" if

automation or MIDI control tried to clear a track while it was recording.

• Fixed intermittent LiveLooper assertion failure crash "Assertion failed:

(nextRecordTrack_ == 0)" when all tracks were empty.

• Fixed AudioUnit hosting bug: sliders in the generic editor were not updating when

parameters were changed using the custom editor or automation.

• Fixed Network Chase Sync bug where tempo could sometimes become unstable

(even after resetting sync by toggling enable audio off and on again).

• Fixed rare crash in automation graphics rendering triggered by MIDI and/or Network

Chase Sync bug(s) above.

• Windows: fixed issue where no audio devices were listed if any ASIO device returned

an error at startup. The MOTU "MOTU PCI Video ASIO" device was triggering this

behavior when not connected and powered on.
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Version 2.2.3
December 14, 2012

• Fixed bug where clicking the LiveLooper Start button would sometimes not start

recording, especially with high CPU load or when the audio driver buffer size was not

set to a multiple of 64 samples.

• Fixed crash: assertion failure "length >= fadeLengthSamples_" if you changed the

sample rate in AudioMulch's Audio General settings while LiveLooper was recording.

• Fixed bug where PulseComb hold would get permanently stuck on if you set the Hold

Quantize Divisions multiplier to zero with Quantize Amount set to non-zero.

• Fixed bug in PulseComb hold quantize behavior (present since version 2.1): Hold

Quantize was taking priority over the Hold Period causing rapid holds when the hold

duration should have been at least as long as Hold Period. To get the previous

"buggy" behavior use a very short Hold Period.

• Fixed bug in SDelay where delay times would not be displayed correctly (clamped to a

maximum value of 32) when recalling presets that switched delay units from rhythmic

units to milliseconds.

• Display preset names in preset automation hover tooltips.

• Fixed crash when recalling AudioMulch presets with DFX Transverb VST Plugin.

• Mac: fixed crash when selecting the contraption editor "Close All" menu item when

the mouse cursor was positioned over a sub-control of the editor.

• Mac: fixed bug where using the "Refresh Plugins List" context menu would cause

subsequent documents to load the wrong VST plugins until AudioMulch was

restarted.

• Mac: increased limit on concurrently open file handles to improve compatibility with

some streaming sampler plugins (e.g. NI Kontakt). Fixes crashes when selecting File >

Open... or File > Save As... after using a Kontakt sample set that streams many files

from disk.

• Mac: fixed VST plugin unloading logic that could cause crashes when mixing VST and

AU versions of some plugins (e.g. Korg Legacy).

• Mac: fixed white flashes when closing some Audio Unit plugin custom editor

windows.

• Mac (OS X 10.7 Lion only): fixed intermittent crash when switching Metasurface to

full screen.
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Version 2.2.2
October 18, 2012

• Added 16 channel Matrix and Mixer contraptions.

• Added right-click for Matrix contraption grid cells allowing Automate, Quick-map and

direct access to parameters in the Parameter Control window for each grid cell.

• Fixed bug where automation loop was sometimes skipped when the audio driver

buffer size was not a multiple of 64 samples.

• Fixed input/key meters on Limiter, NoiseGate and Compressor to reflect the input level

after InputGain has been applied.

• Fixed bug where patch was sometimes scrolled off screen when it was first opened.

• Fixed bug in Flanger contraption that caused audio drop outs, extreme CPU load and

crashes when using low Frequency Range settings when the audio interface sample

rate was set to 96kHz or higher.

• Added code to sanitize bad audio data coming from VST plugins, which could cause

audio drop outs.

• Mac: fixed crashes when quitting or closing patcher and automation panes if they

were floating/undocked.

• Mac: fixed bug where the Patcher pane new contraptions palette would sometimes

disappear and not come back after docking/undocking the Patcher pane.

• Mac: fixed issue with Bassline contraption note names being partially cropped,

especially C# and G#.

• Mac: fixed bug where automation zoom button would overlap window size grip if

status bar was hidden.

• Mac: Made AudioUnit MIDI output code more resilient to bad data from plugins.

• Mac: fixed bug where sometimes clicking the horizontal splitter would undock the

pane instead of moving the splitter.

• Mac: fixed bug where floating windows and popup menus would remain visible

when clicking to drag other windows.

• Mac: changed title of Settings dialog box to "AudioMulch Preferences" (was

"Settings").
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Version 2.2.1
August 17, 2012

• Mac: Fixed crashes when using keyboard shortcuts at startup or on exit, including

quitting with Command-Q or using keyboard shortcuts before the main window was

visible.

• Fixed crash: assertion failure "PortAudioStreamController Line 1118..." when using

the Open Sound File dialog box to preview sound files when AudioMulch master

audio was not enabled.

• Fixed problems with level meters (SoundIn, SoundOut, Patcher activity indicators)

flickering, freezing and/or not working under certain conditions.

• Fixed bug where Bassline note name hover tooltips were sometimes not displayed

when note cells displayed "...".

• Mac: don't display Windows-specific DWM MMCSS audio setting on Mac.

Version 2.2.0
July 26, 2012

New Features

• Added MIDI output contraptions (MidiOut1 - MidiOut8).

• Added support for switching Metasurface snapshots via MIDI control.

• Frequency parameters are now also displayed as musical pitches in parameter tool

tips. They can also be edited as musical pitches using piano keyboard interface in the

Set Value dialog box.

• New SChorus stereo chorus contraption.

• New header bar in contraption Preset window.

• New Welcome Screen giving access to recent files and other options.

Enhancements

• Switched to internal 64 sample control rate with no lower limit on sound card buffer

size. Results in higher stability with buffer size settings lower than 256 samples.

• Mac: Removed 256 sample buffer size limit to support lower latency.

• New timing engine for MIDI and network clock synchronization. Stable sync.

Increased hardware compatibility.
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• Added “pattern mode” for MIDI sync generation for compatibility with Electribe and

Nord Micro Modular step sequencers.

• Added clock-synchronous period and phase mode to SSpat contraption. Synchronize

spatialization paths to the global clock pulse.

• Reworked and updated help file with a clear, modular, step-by-step tutorial format.

• Added ability to clear automation points without deleting the time range. Using the

DELETE key or selecting the Clear item in the Edit menu deletes the selected points.

Using the Delete Time item in the Edit menu deletes the time range, which used to be

the default behavior.

• Removed limit on the number of presets per contraption.

• Added Auto Hide button to contraption Preset Window.

• Adjustable brightness and contrast of the user interface color scheme on the

Appearance page of the Settings/Preferences Dialog Box.

• Made MIDI and network sync offset settings have consistent meaning (positive values

always make the slave later).

• New sync offset settings for network sync.

• The Metasurface parameters tree now supports multiple selection (using drag,

SHIFT+click and CTRL+click) and enabling/disabling selected items. Added "Enable

Selected Parameters" and "Disable Selected parameters" context menu items.

• Unified handling of drag-and-drop behavior between Metasurface snapshots,

contraption Presets, Document Switcher document entries, File Player and File

Recorder. These should now all behave consistently.

• Windows Vista and 7: Added Settings > Audio Driver > "Disable Desktop Window

Manager MMCSS scheduling" option. May reduce graphics card related audio

glitching on some systems.

• Reworked generic plugin editor grids for VST and AU plugins.

• Mac: switched to “Cocoa” user interface framework for improved compatibility with

plugin user interfaces.

• The interpretation of MIDI Control Change and Program Change messages has been

updated to be more conformant with the MIDI specification when controlling presets

and Metasurface snapshots. By default the first (0th) MIDI value now maps to the first

(1st) preset/snapshot. There’s also an option to change the offset.

• Mac: added support for two-finger pan gesture for scrolling automation and

contraption rhythmic pattern editors.

• Use AudioMulch’s Open Sound File dialog box when locating missing sound files to

allow previewing soundfiles.
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Note

• Mac: Dropped support for Mac OS X 10.4 (Tiger).

Bug Fixes

• Fixed crash in Patcher if the right mouse button was clicked while dragging a patch

cord.

• Fixed rare automation recording corruption and crash "Assertion failure

AMTimelineEditWidget.cpp line 407" while zooming automation.

• Fixed bug where automation recording could write additional points after transport

was stopped if you pressed the Stop button before toggling the Record button.

• Fixed crash when editing Drums contraption events when an automated preset/

pattern change occurred.

• Fixed bug where SouthPole envelopes would continuously re-trigger if Automation

stopped but was at a pattern trigger location (i.e. time 0).

• Fixed issues with VST plugin property values not being synchronized after recalling or

loading a VST program or program bank. This should allow all VST plugins (e.g. u-he

Zebra and NI Reaktor) to work correctly with the Metasurface.

• Keep VST parameter name displays in sync with plugins that dynamically change

parameter names (e.g. Reaktor, FXpansion Guru).

• Fixed bug in VST generic property editor where sliders didn't match property values

after switching from custom to generic editor.

• Windows: Fixed issue with Reaktor VST plugin Delete key presses not going to plugin

but instead deleting items in the Patcher.

• Mac: Fixed issue with some VST plugins not receiving some keyboard events, such as

ENTER key and DELETE key presses.

• Mac: Fixed bug where Audio Unit plugin parameters were not saved/loaded correctly

into the Metasurface. Loading an old document wouldn't load Metasurface

parameters for Audio Units.

• Parameter knobs and sliders now respond to Metasurface and MIDI control even

when Audio is not enabled.

• Fixed bug where Chase MIDI and Network sync settings were always unchecked/reset

whenever Settings/Preferences Dialog Box was displayed.

• Mac: Improved timing stability for MIDI sync output.

• Fixed zipper noise when moving SDelay Feedback parameter and the Wet/Dry

parameters on SDelay, FrequencyShifter, DLGranulator, NastyReverb, Flanger,

Nebuliser.
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• Fixed potential crash when MIDI messages were received while disabling audio.

• Fixed bug: AuxOut contraptions not showing inlets when creating by drag and drop.

• Fixed micro-jittering of property values during Metasurface interpolation if all

snapshots hold the same value.

• Reduced CPU load when interpolating Metasurface snapshots if there were many

parameters with no value changes.

• Fixed crash: shift+clicking on a contraption or connection in the Patcher Pane when it

was the only selected contraption or connection and then deleting it, would crash.

• Windows: Fixed bug in .amh document save and load routines which would

sometimes cause values to be lost on systems which used a decimal comma ","

instead of a decimal point ".".

• Fixed issue with SSpat glitching/clicking when using a large "Scale" value, and also

when using audio buffer sizes < 256 samples.

• Fixed bug that would cause distortion/zipper noise in Compressor and NoiseGate

when sample rate was greater than 48k.

• Improved number display in number edit boxes such as those used to specify the

tempo and the loop length in LoopPlayer. Should no longer display a long string of

0.9999999999999999 or 0.0000000000001 e.g. when incrementing and

decrementing values using the mouse or the arrow keys.

• Fixed problems with long strings of decimal places in Tempo number edit box after

clock-syncing tempo.

• Optimized speed of display/rendering for sliders and knobs.

• Fixed "green fur" display issue on combo boxes in contraption editors, when

hovering mouse over combo box and there are overlapping contraption editors with a

pattern editor behind.

• Fixed bug: sample rates not updating in Settings/Preferences dialog box latency labels

(e.g. Windows Multimedia) after changing sample rate.

• Reflect the names of renamed input/output contraptions in level meters and settings.

Display I/O contraption name text as well as contraption type name in level meters,

patcher tool tips, settings window audio device table tool tips.

• Mac: Fixed issue where clicking on some buttons didn't work if you clicked near the

edge.

• Windows: Fixed Main Window title blinking "*" and document name changes during

opening or switching documents.

• Fixed layout of SouthPole LFO2 tab: when switching between SouthPole LFO 1 and

LFO 2 the controls were not aligned.
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Version 2.1.2
December 9, 2011

• Fixed bug where contraption preset window could spontaneously disappear when

one of the button tooltips was shown and then hidden.

• Fixed bug in audio settings where setting devices to None did not work. Instead the

default device would be selected next startup.

• Fixed bug/crash assertion failure "DRAG_STATE_NONE" when trying to drag 5Combs

contraption editor while pitch selection window was visible.

• Fixed bug where selection of AIFF files was not possible when searching for missing

sound files.

• Fixed intermittent bug on Windows where evaluation period was indicated as expired

immediately after first installation.

• Improved scroll wheel behavior in properties pane. Scroll wheel now only acts on

number editors when they already have focus. Scroll wheel never acts on combo

boxes and FilePlayer/Recorder location bars.

• Mac: improved stability of MIDI clock sync generation output. It was stuttering on

some systems.

Version 2.1.1
September 3, 2010

• Fixed bug where documents that used a missing VST plugin would load with an

arbitrary placeholder VST rather than warning that the plugin was missing.

• Fixed bug where a LoopPlayer with an automation mute change at the beginning of

bar 1 wouldn't recognize the mute change until bar 2 when playing from start or

exporting.

• Fixed bug in Arpeggiator where selecting only one note in Random and UpDown

Direction mode would play more than one note. Made Random Direction mode more

uniformly random.

• Fixed bug where changing Settings/Preferences for MIDI sync offsets or MIDI generate

sync device would cause MIDI control and chase sync to stop functioning until you

restarted AudioMulch, disabled/re-enabled these functions, or selected a different

MIDI device.

• Fixed crash if you quit while a contraption preset window was visible.

• Mac (OSX 10.6 only): fixed intermittent audio freeze when selecting a file in the open

sound file dialog box (previously fixed in 2.0.4 but back in 2.1.0)
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• Mac: fixed Preferences and Export To Sound File dialog boxes to not stay on top of all

applications. Resolves issues with file selection and help windows appearing behind

these dialog boxes.

• Mac: fixed crash when creating Audio Units that provide MIDI output (e.g. Bidule,

Chipsounds, Kore2)

• Mac: fixed crash on exit with 'BuilderNotFoundException' when some Pluggo-based

Audio Units are installed.

• Mac: fixed bug where some Audio Unit editors (e.g. Prosoniq) would display as a

blank white window.

• Mac: Removed Audio Unit Instrument/Effect category, listed these Audio Units in the

Effect category.

• Windows: Fixed bug where View > Windows Volume Control menu item didn't work

on Windows Vista and Windows 7

• Fixed bug where opening a document and saving it with Save As... would not add

the original document to the Reopen/Recent Items menu.

• Fixed Play and Record buttons on File Players and Recorders so that you can right-click

and choose Automate, Quick-map MIDI etc, even when the buttons are disabled

because no file is selected in the contraption.

• Fixed bug where the patcher contraption input/output info tooltip was not hidden

correctly after connecting a patch cord. Tooltips are now updated while connecting/

reconnecting patch cords.

• Fixed bug in pattern editors (Drums, Bassline, SouthPole, Arpeggiator) where you

couldn't easily scroll or zoom past bar 32 unless there were pattern triggers present

near the end of the pattern -- the sequence length was ignored.

• Fixed bug in Bassline where you couldn't always see the note name cell text if you

were zoomed in too far.

• Fixed bug where automation lines weren't always highlighted correctly when you

hovered the mouse cursor over them (e.g. minimum line for Range parameters)

• Streamlined layout of Parameter Control window

• Prevent multi-file Player and Recorder contraption editors from being resized beyond

the maximum useful height.

• Changed increments on MIDI sync offset number boxes to increment by +/- 1ms

(previously 200ms)

• Refined button and label text in Settings/Preferences dialog box and elsewhere.
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Version 2.1.0
August 4, 2010

New Features

• Added support for non-4/4 time signatures, time signature changes and custom

rhythmic units.

• New rhythmic matrix pattern editors for Arpeggiator, SouthPole and Bassline.

• New dynamics processing contraptions: Compressor, Limiter and NoiseGate.

• Added Audio Unit plugin support on Mac OSX.

• New light gray color scheme (selectable from Settings/Preferences > Appearance).

• Updated help files including MIDI control and contraption reference pages. Added

glossary.

Enhancements

• Sped up program start up by adding plugin scan caching including progress bar and

text in splash screen.

• Support for hot-plugging MIDI devices.

• Added parameter control context menus to the Metasurface (right-click Metasurface)

and main window transport controls (right-click transport buttons, and metronome

icon for Tempo mappings).

• Added double-click on contraptions in contraption palette to create new

contraptions.

• Added right-click Create Contraption and Help context menu items to new

contraptions palette.

• Added contraption editor context menu items for Close/Close all/Close all but this;

added shift-click close button to close all.

• Included property names in contraption editor knob and slider popup value tool tips.

• Added Recall button to contraption presets grid.

• Added Close Sound File button to LoopPlayer and BubbleBlower. Added ability to

close sound files in Drums with Ctrl-click or Right-click > Close Sound File.

• Added HH:MM:SS.sss elapsed / total displays to file players and recorders (replaces

old display of duration in seconds).

• Beats are now divided into 48 subdivisions (previously 12), to allow finer-grained grid

snapping in Drums and Automation.

• Added 64th and 64th-triplets to the list of standard rhythmic units.

• Added 10 channel variant of multi-file players and recorders.
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• Allowed use of enter key (Ctrl-Enter) to create new Metasurface snapshots after

typing a snapshot name.

• Changed some default settings for new installations: automation grid visible, patcher

input/output tool tips visible, audio enabled on startup; status bar visible.

• VST generic plugin editor now displays up to the first 8 parameters by default instead

of the first 3.

• The preset pop-up for a contraption now scrolls when it is displayed so that currently

selected contraption preset is visible.

• Windows: Audio, midi and network devices are disabled/enabled on APM suspend/

resume (i.e. the audio device closes when the computer goes to sleep).

Bug Fixes

• Fixed SDelay to update the delay time when the tempo changes when using tempo-

synced delays.

• Fixed bug where WAV and AIFF sound files were saved with incorrect internal size

fields. This caused warnings when opening the files in some audio editors (e.g.

Goldwave).

• Fixed bug where SDelay delay time combo boxes didn't have the correct range set

when you first opened the editor (was possible to set delay time in semiquavers

beyond 32, for example).

• Fixed bug where locating a missing soundfile in SoundIn, FilePlayer, SoundOut or

FileRecorder wouldn't cause the contraption play button to be enabled (it would stay

disabled and you couldn't click it).

• Fixed loading of track status indicator icons in CanonLooper (previously they weren't

displaying).

• Improved handling of display range and zooming in Drums contraption pattern editor.

• Fixed bug where timeline maximum zoom level was dependent on zoom level when

window was resized.

• Fixed bug in BeatProcess.amh where thumb could go negative.

• Tweaked patcher object hit testing by adding extra margin at edges. Partially resolves

issues with mis-hits on OSX due to location of OSX cursor hotspot.

• Fixed help file not displaying for AuxIn and AuxOut above 7.

• Fixed bug where sometimes pasting into patcher from another document would

locate the pasted fragment way off the screen (now pasted selection always appears

in the centre of the patcher).

• OSX: Fixed bug where automation breakpoint right-click context menu could be

obscured by tool tips.
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• Removed the ability to automate Clock.Start (because it didn't make sense)

• Disabled slide-out of Patcher new contraptions palette while patcher pop-up menu is

visible.

• Fixed bug where altering values in a Drums contraption while the contraption

changed preset in automation playback would crash with the following error: "Invalid

parameter passed to (null), (null), (null) line 0".

• Fixed input labels on RingAM contraption: they used to say Left and Right when they

should have said Carrier and External Modulator. Similar fixes to M2Bus, M2Mixer,

P2Mixer, MNoiseGate etc.

• Fixed isAbsolute() assertion failure crash when loading old documents which had

been saved in the root of a drive (e.g. D:).

• Fixed bug where VST parameter name cleaning would crash if parameter name only

contained spaces (caused a Starplugs plugin to crash).

• Mac: fixed bug where plugins protected by PACE iLok copy protection would hang

and you couldn't click through their authorization screen.

Cosmetic Refinements

• Positioned patcher output port info tooltips below ports so they don't obscure the

contraption.

• Improved appearance of 10Harmonics, Shaper, SSpat plots.

• Fixed AMNumberEdit to render in a more consistent style.

• Added '+' to Arpeggiator Osc 2 Transpose items to indicate upwards transposition

• Fixed color of '>>' (show more) buttons in toolbars, and hide and undock buttons in

Patcher and Automation pane (on Windows they were black and not visible against

the dark background).

• Fixed timeline tooltips to not display beyond the borders of the timeline they are

associated with.

• Made patcher connection bundle handle resemble a green circle instead of a red

rectangle.

• Added tool tips to level meters.

• Fixed glitchy contraption pane scrolling.

• Improved error message text when enabling MIDI when no devices are selected.

• Added instruction text to Metasurface pane when no snapshots have been placed.

• Indicate that the current document has unsaved changes in the window title area

(using an asterisk on Windows, dot in close button on Mac).

• Improved "Do you want to save changes?" dialogs by using Save/Discard buttons

instead of Yes/No. Similar for Locate Missing Sound Files dialog box.
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Version 2.0.4
April 30, 2010

• Fixed hung notes and/or plugin crashes when using VSTi plugins controlled by MIDI.

The bug occurred when MIDI data is received on multiple MIDI channels

simultaneously and the plugin Receive Channel is set to a single channel (i.e. not

"None" or "All").

• Fixed intermittent crash when displaying a VST generic editor while audio is running:

"assertion failed: slider != 0"

• Fixed rare crash while previewing a sound file in the open sound file dialog:

"assertion failed: lastAlloc_->Blocksize()==size"

• Mac 10.6 (Snow Leopard): Fixed audio freeze when selecting files in open sound file

dialog.

• Mac: Fixed crash on startup if Preferences .plist file had become corrupted. Fixed

preferences mechanism to avoid Preferences corruption.

• Mac: Fixed bug where sometimes double clicking on an AudioMulch document in

Finder would launch the help viewer instead of AudioMulch.

Version 2.0.3
October 31, 2009

• Fixed crash bug when loading AudioMulch 1.0 documents that contain Drums

contraptions with MIDI-controlled or automated channel volumes.

• Fixed bug where you wouldn't be prompted to save changes before closing the

document if the only change you made was renaming contraptions.

• Fixed bug where VSTs with a MIDI output and no audio output would receive

incoming MIDI messages twice.

• Windows: Fixed "cannot load sqlite database driver!" error while trying to access the

help file on some machines.

• Mac: Fixed bug where Save a Copy with Sound Files command would display "An

error occurred while creating a directory in which to save the referenced sound files"

when trying to overwrite a previously saved document and sound files directory.

• Mac: Fixed bug where contraption names were not displayed on small contraption

editors such as those for MGain, SGain and OGain.

• Fixed bug where LoopPlayer, FilePlayer etc would sometimes not show the question-

mark icon when AudioMulch could not find the sound file.
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• Fixed glitch where the sound file name in LoopPlayer, FilePlayer would sometimes be

abbreviated with "..." even when there was space for a longer name.

• Fixed bug where the Notes window was given focus after loading a document, so

you couldn't immediately use transport key-shortcuts (because they would type in the

Notes window instead).

• Fixed bug where you couldn't close the Set Value dialog box by pressing the Enter

key.

• Fixed bug where triggering Clock.GoToStart via MIDI didn't update the transport

position on the GUI if the clock was stopped.

• Fixed document switcher to scroll back to top when a new document set is Opened,

on New, and on Clear All.

• Fixed patcher display glitch where some ports would remain incorrectly colored after

reconnecting patch cords.

Version 2.0.2
August 3, 2009

• Fixed bug where help pages were not available and displayed "The page could not be

found" error if the computer was upgraded to a new version of AudioMulch.

• Improved event deletion in Drums contraption pattern editor. Supresses creation of

hits on top of each other which made them confusing to delete. Fixed bug where

click-delete didn't work if the mouse was moved while clicking.

• Fixed bug where contraption positions were sometimes scrambled after reloading a

document. Contraption locations were not saved correctly if the contraptions had

been connected using drag-and-drop patching.

• Added support for cut/copy/paste/select all of contraption names in the Patcher using

context menu and keyboard shortcuts while editing contraption name.

• Added F2 keyboard shortcut to start editing contraption names (Command-2 on

Mac).

• Windows: fixed bug where the first time a custom VST editor was displayed it

appeared partially behind other contraption property editors.

• Mac: fixed intermittent crash on OSX 10.4 (Tiger) after using the select sound file

dialog box.

• Mac: improved timing of MIDI and Network sync.

• Mac: made changes to address bug where VU meters, transport and automation

playback position would intermittently stop updating after 20 minutes to an hour on

some machines.
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• Mac: changed MIDI device name handling for better compatibility. Fixes problems

with some devices not working. Akai devices are still not 100% functional, see

KnownBugs.txt for workaround.

• Mac: Fixed bug where AudioMulch would freeze at startup if VST plugins displayed

an activation dialog box when they were scanned.

• Fixed alignment of beat number indicators on Arpeggiator pattern editor.

• Fixed height of status bar and appearance of soundfile loading progress bar.

• Fixed incorrect positioning of MIDI output ports on some contraptions.

• Fixed bug with contraptions palette not auto-showing if AudioMulch didn't have

focus.

Version 2.0.1
June 29, 2009

• Fixed crash in patcher when ctrl-drag-duplicating a contraption and immediately

docking it into another contraption without releasing the mouse. Crash only occurred

when Show Contraption Input/Output Info was enabled and mouse was released

over one of the new contraption's input or output ports.

• Fixed bug where Export to Sound File function would not terminate (it exported until

the disk was full) if an automated clock stop marker was encountered while prerolling

or exporting.

• Fixed bug where pressing the Return (Enter) key when editing parameter values in

number editors and Metasurface snapshot and contraption preset names would

cause the clock to stop and go to start rather than completing text editing. Also

changed number editor behavior so Space bar starts/stops the clock even when a

number editor has focus.

• Fixed bug where typing numbers into a number edit in some places (e.g. Parameter

Control window) would enter the numbers in reverse order (right-to-left).

• Fixed bugs where tempo automation always defaulted to 120 bpm and did not pick

up current tempo when first enabled, nor would it record tempo changes from the

GUI (it would record tempo changes from MIDI).

• Fixed bug where choosing Change Color... for a Metasurface snapshot, then pressing

Cancel in the Select Color dialog box always made the snapshot black.

• Fixed bug where SoundIn Sync mode didn't function correctly in all File Recorder

contraptions.

• Fixed bug where MIDI mapping curve editor in the Parameter Control dialog would

not allow insertion of new breakpoints on vertical line segments including at the left

and right edges of the editor.
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• Fixed bug where automation scroll bar would not take loop end and selection end

location into account so you couldn't drag the scroll bar thumb to the loop end and

had to use the arrow buttons.

• Mac: added additional audio i/o buffer size settings to the Audio Driver page of the

Preferences dialog box (previously this setting was fixed at 256 samples.)

• Mac: fixed bug where selecting sample rates used sample-rate-conversion instead of

switching the hardware sample rate. This should resolve problems with glitches at low

CPU loads and high sample rates e.g. 96kHz.

• Mac: fixed bug where non-hardware "virtual" MIDI devices were not available (e.g.

from Numerology and OSCulator).

• Mac: fixed issues with number edit boxes being too tall (eg in Parameter Control

window).

• Mac: removed close button on Preferences dialog box window header to avoid

confusion with OK vs. Cancel behavior.

• Mac: fixed graphical glitches around the edges of SSpat and Shaper contraption

editors.

• Mac: added command-shift-f5 keyboard shortcut to refresh VST Plugins list.

• Mac: changed VST enumeration algorithm to only load bundles with .vst extension.

• Windows: fixed bug where Select Sound File dialog for recording and export did not

display on some Windows XP systems.

• Windows: fixed bug where Reaper's ReaRoute ASIO driver did not appear in the

device list.

• Windows: fixed VST GUI window creation bug which resolves issues with Bidule VST

freezing/crashing at startup or during use.

• Windows: fixed implementation of VST audioMasterPinConnected which was causing

"assertion failed currentOps_!=0" with some plugins including TinyGod Pegger 3.

• Windows: fixed handling of VST GUIs which change their size using the non-standard

method of directly resizing their parent (e.g. Schwa Olga).

• Added Rename menu item to Metasurface snapshots context menu.

• Fixed Export to Sound File dialog box to remember the preroll duration setting from

the last time it was displayed.

• Fixed bug where piano keyboard pitch selection popup window didn't show the

correct note name when it was displayed (always showed C#8).

• Fixed broken links to Crossfader and Frosscader help pages.

Version 2.0.0
June 5, 2009
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